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Vision

Overview

The Vision Module is a tool for creating and maintaining an interactive, accurate Human-Machine
Interface (HMI) for your site. Many other modules, as well as platform level features, seamlessly

integrate with the Vision Module, providing a simple method of visualizing and presenting data to
your users.

Windows

Vision Windows are the basic building blocks for all of your HMI screens. There are three basic
window configurations that define how a window behaves:

® Main Windows - A main window is one that is set to start maximized (taking up
all available screen space (minus space used by any docked windows).

® Popup Windows - A popup window is one that appears (pops up) when the user
performs an action such as clicking the mouse, pressing a function key, or touching a
button (if using a touchscreen). Popup windows usually remain on top of the current
window until closed, enabling users to quickly choose options or settings before returning
to the previous window.

® Docked Windows - A docked window is set to a static location on the screen. Docked
windows are often used to hold navigation trees or status information that needs to remain
on the screen at all times.

By changing a window's properties, you can transform any window into various configurations, with
each behaving differently based on those settings. Passing custom parameters into windows
allows you to create the window once, and then re-use your screens multiple times within the
same project. You get to choose what windows are available on startup and how your navigation is
configured. The following is an example of a Vision Module screen.
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Navigation

A large number of navigation options exist in the Vision module. For example, docked windows
can be set up with navigation trees, tab strips, or menu bars. Components such as buttons can be
used to navigate to other windows. A graphic or photograph of a map can be customized with
clickable zones. Many of the common options are available as project templates that you can take
advantage of when first creating your project. Here are some examples:
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Components

Components are building blocks for your project. The Vision Module has a variety of built-in compo
nents such as displays, buttons, charts, and other elements that display information. Each
component has multiple properties that control its appearance, behavior, and data. For example, a
Tank has a level, capacity, and a liquid color, while a Label has text, font, and an image. You can
enhance components with custom properties to create additional functionality.

Vision Property Editor S | |
B 4| == e %
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Name Tank 3
E Data
Value & 220 €
Capacity 100.0 @
=l Appearance
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Vision Property Editor a - X 7
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- Data T
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Bindings

A binding is a mechanism that allows a property on a component to change based on a a change
to a value elsewhere in Ignition. For example, with binding, the liquid level displayed in a tank
graphic can be bound to the realtime liquid level in a tank. The value of a Tag could be bound to a
linear scale, a meter, or a label on your window. The power of bindings comes from the variety of
binding types.

Click on the following links for complete information about binding types:

® Properties - Property Binding, Cell Update Binding, Component Styles
® Tags - Tag Binding, Indirect Tag Bindings in Vision, Tag History Binding

Navigation
Strategies

Watch the Video

@ INDUCTIVI
UNIVERSI]

Component
Overview

Watch the Video
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® Expressions - Expression Binding
® Databases - DB Browse Binding, SQL Query Binding, Named Query Bindings
® Functions - Function Binding

Graphics
In addition to standard components, the Vision module supports the use of SVG, PNG and JPEG @ IN DUCTIV]

images on Vision Windows. You can create your own images and import them into your project or U NIVE RS I']
use Ignition's 2D Drawing tools to create graphics.

Scalable Vector Graphics Images (png, jpg,
Scalable Vector Graphics (SVG) have several advantages over other graphic types. Because they g If)
are vector graphics, they can be scaled without a loss of clarity or resolution. Additionally, you can
drill into an SVG to change individual parts of the image. To use an SVG in Ignition, simply drag Watch the Video
the file directly onto the window in which you want it to appear.
Vision Property Editor B X
B4 | = B %
El Common -
Name Blue pilot light 1 Sl
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Mouseover Text = 2
El Data
Quality = &
El Position
X 180 &2 |+

Other Images

You can use the built-in SVGs from Symbol Factory which contains hundreds of ready-to-use
graphics, or use the raster image library with an Image component to get a jump start on your
project.

Templates
Components and images can be combined to create Vision Templates. These are re-usable @ IN DUCTIV]

objects that can be configured once and used throughout your project. Templates work under a U NIVE RS I']
principal of inheritance. When a change is made to a template, that change is inherited by each

instance of that template. Most templates use one or more custom properties (Template

Parameters) to tie data from a window to the internals of the template.

The Cloud Templates Browser portal in the Designer gives you access to pre-built templates. About Tem plates
Ignition community members can also share their own templates in the Cloud Templates.

Watch the Video

SPEED.

POWER

e
Amps
true

In This Section ...


https://www.inductiveuniversity.com/videos/images-png-jpg-gif/8.0/8.0
https://www.inductiveuniversity.com/videos/images-png-jpg-gif/8.0/8.0

Vision Client Launcher

The Vision Client Launcher opens Vision Clients from any Ignition Gateway. The launcher browses
all Gateways for Vision projects that are available on your local network and remote locations. .
Once your Vision projects are added to the Vision Client Launcher, they will be displayed under On this page
My Applications and organized by Gateway.

This page will show you how to setup the launcher so both designers and users can launch Vision
clients easily.

x ® What s an
Application?
® Download and

3 \gnition Vision Client Launcher - m}

‘_/ Ignition Vision Client Launcher (D About XX Settings

i My Applications Install the Launcher

® Windows Silent
v CONTROLLER Installations

http:/flocalhost:3088

NewProject i NewProject 2

o) | [T @ INDUCTIV]
UNIVERSI]

Vision Client

What Is an Application? Launcher

For the purposes of the Vision Client Launcher, an Application is a configuration in the launcher,
which is associated with a Vision Project. A Vision Project is an Ignition project that contains at Watch the Video
least one Vision resource, such as a Window or a Template.

The Vision Client Launcher can only launch applications. Thus, if a new project is created via the
Designer, the Launcher will not be able to launch the project, until an Application has been
configured in the Launcher.

In the image below, we see two applications. One titled University, and the other titled Dashboard
. Each application is a separate tile in the Launcher and contains unique settings and
configurations.

Ignition Vision Client Launcher - o x

'.“’ Ignition Vision Client Launcher (@ About XX Settings

i My Applications

~ INDUCTIVE_UNIVERSITY

http://localhost:2088

University H Dashboard
Examples Running tatals

Launch Windowed v Launch Windowed 7

Download and Install the Launcher

Best Practice

It's good practice to download and install the Vision Client Launcher every time you install a new release of Ignition. The Vision
Client Launcher is a separate application and is not part of an Ignition release, so it's important not to have an outdated Vision
Client Launcher shortcut residing on your desktop. Each time you install a new version of Ignition, download and install the Vision
Client Launcher, then let the install process create a new desktop shortcut for you automatically.


https://www.inductiveuniversity.com/videos/vision-client-launcher/8.0/8.0

The following feature is new in Ignition version 8.0.10
Click here to check out the other new features

The Vision Client Launcher can now be installed as an "all user" application on a Windows operating system providing launcher acess to all
users on the same machine from a single installation. The first time the Vision Client Launcher is installed, you will be prompted to select
your install mode: "Install for me only" or to "Install for all users." If the Vision Client Launcher was already installed, subsequent install
attempts are treated as an upgrade and you will not be prompted to select the install mode. This new option will only appear on new launcher
installations or after uninstalling a prior version of the installer.

@ Vision Client Launcher Destination Folder

When installing for "all users," the installer will be placed in the following folder: "%lgnition Installation Directory%\Program
Files\Inductive Automation”
When installing for "me only," the installer will be found under the "\AppData\Roaming\Inductive Automation" folder.

The Vision Client Launcher for Windows, Linux, and Mac OS are available on the Home tab of the Gateway Webpage. Use the following
steps to do an install of the Vision Client Launcher.

1. From the Home tab on the Gateway Webpage, click on the Download Vision Client Launcher link.

= (m] X
Controller - Ignition Gateway X 4
& C @ localhost:8088/web/home?26 a a [~ ] Paused &
2 controller Zadmin | SignOurd

4 - :
ion
E # Home > Get Started

Jdu Download Ignition Designer Launcher
Status

* ) Ignition Designer Launcher
iy { Download the Ignition Designer Launcher to create or modify your projects.

Download Application Launchers

/ Vision Client Launcher / Perspective Session Launcher
Y \Y

Download the Native Client Launcher to open Vision Launch a Perspective sessicn directly in your
clients from any Ignition Gateway. browser or download the native application.

Download Vision Client Launcher View Projects

Learn Ignition

Take advantage of our tools to get designing quickly and take your ideas from concept to reality. The User Manual is a wealth of easily searchable knowledge and
the Inductive University has hundreds of short videos covering the basics of Ignition.
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2. Select the Download button for the platform you are running on: Windows, Mac, or Linux. This example demonstrates

the installation steps for a Windows operating system.

M Controller - Ignition Gateway X 4+

&« C @ localhost:8088/web/client-launchers?27

/

Ignition.

ﬁ # Home > Vision Client Launcher Download

Home

i . B

Status WAl Download the Vision Client Launcher & Download for Windows
.

o

Config We've detected you're on Windows. Download the Vision Client Launcher

for Windows and follow these steps below to install.

1. Run the Windows Vision Client Installer
Click Run or Save toinitialize the download.

Wihat do yeu want to do wih
VisionClientauncherSetupese (460 MEY X
From: 127081

Run
*If you chose Save, double-click the download to start installing.

Cancel

2. Follow Setup Instructions
Follow the instructions to get the Launcher installed on your computer.
After the installation is complete you will be asked if you want to launch

now.

3. Provide Firewall Access

0On the majority of windows machines you will need to allow access to
the firewall for the application to work properly. Windows Defender will
prompt you the first time you run the application. Click Allow Access.

2admin | Sign Out3>

Helr @

Alternative Vision Client
Launchers

3. Run the downloaded file (VisionClientLauncherSetup.exe) found on the lower-left of the window if using Chrome, or

go to your Downloads folder and double-click the file to run it.

The following feature is new in Ignition version 8.0.10
Click here to check out the other new features

4. If this is the first time installing the Vision Client Launcher, you will be prompted to select an install mode. Select either

"Install for me only," or "Install for all users."

Select Setup Install Mode >

Select install mode

Vision Client Launcher can be installed for you only, or
for all users (requires administrative privileges).

— Install for me only (recommended)

¥ Install for all users

Cancel
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5. The Install Wizard will select a default destination location folder for the Vision Client application files. If you are
"installing for me only", the destination folder will be different from the "all users" destination folder. You also have the
option to select a different folder. Click Next.

select Destination Location
Where should Vision Client Launcher be installed?

Setup will install Vision Client Launcher into the following folder.

To continue, dick Next, If you would like to select a different folder, dick Browse.,

zaro‘\AppDataiFoamingInductive Automation'Vision Client Launcher Browse...

At least 69,9 MBE of free disk space is required.

6. You'll notice that a desktop shortcut is checked and will be created so you don't have to run the Client Launcher each
time you want to open a client. Click Next.

Setup - Vision Client Launcher version 1.0 — x

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing Vision Client
Launcher, then dick Mext,

Additional shortouts:
Create a desktop shortout




7. The Ready to Install window will open. Click Install.

Setup - Vision Client Launcher version 1.0 — x

Ready to Install
Setup is now ready to begin installing Vision Client Launcher on your computer,

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location:
C:\Usersmipsaroapphata\RoamingInductive AutomationVision Client Laun:

Additional tasks:
Additional shortouts:
Create a desktop shortout

< Back Install Cancel

8. When the Vision Client Launcher completes the install, click Finish.

Setup - Vision Client Launcher version 1.0 —

Completing the Vision Client
Launcher Setup Wizard

Setup has finished installing Vision Client Launcher on your
computer. The application may be launched by selecting the
installed shortouts,

Click Finish to exit Setup,

Launch Vision Client Launcher




9. The Vision Client Launcher shortcut icon will be placed on your desktop and looks like the following.

(L4

Yizion Client
l'auncher

10. The Ignition Vision Client Launcher will open, but you most likely won't have any Applications (Vision Client
configurations). The next step is to add Applications. Click Add Vision Client or Add Application(s). Both buttons will
take you to the same window to browse for local and remote Gateways.

Ignition Vision Client Launcher - O x

Ignition Vision Client Launcher (D About LR Settings

iii My Applications Add Application(s)

Me Visien Applications Configured

When you have added Ignition Vision Clients they
will appear here for easy access.

Add Vision Client




11. The Vision Client Launcher window will refresh and show your local Gateway. It will also check for other Gateways on
your network. Select a Gateway and click the Add a Selected Gateway button.

Ignitien Visien Client Launcher

(D About XX Settings

Ignition Vision Client Launcher

i Select a Gateway Filter Gateways Manually Add Gateway

ON YOUR NETWORK (1)

Name URL |\'elsinn | 0s | System | Status |
Controller http://localhost:5088 8.0.0-betal - Independent RUNNING

Scanning local network for available gateways...

PREVIOUSLY USED GATEWAYS (2)
Name URL |\‘elsinn |OS System Status

Cancel Select a Gateway above, or manually input your Gateway address. Add Selected Gateway

12. If there is an issue automatically detecting your Ignition Gateway, you can manually add your Gateway. Click on the Ma

nually Add Gateway button in the upper right corner.
13. Enter the Gateway URL or IP address (i.e., localhost:8088), and click Add Gateway.

Add Gateway x

Gateway URL Host valid "

[ htip:/nocalnost 8084 |

Add Gateway




14. Once your Gateway is added, the Vision Client Launcher will automatically find all projects on the Gateway. However,
this list of Applications will only contain projects that contain one or more Vision resources (such as a Vision Window).
Additionally, projects configured as Inheritable will not appear (since Inheritable projects don't run as stand-alone
applications). Select the Applications you would like to add, and click Add Applications.

Ignitien Vision Client Launcher — [m} b

4 - - - - -
1/ Ignition Vision Client Launcher @ About £ Settings

Select Applications Cancel

NewProject v New Project 1 NewProject 2 v

y / Test |L

15. Back on the My Applications screen, you will see all of the Applications that have been added to the launcher, sorted
by Gateway.

Ignitien Vision Client Launcher — [m} b4

‘.h-"s Ignition Vision Client Launcher (© About ¥ Settings
i My Applications

v CONTROLLER

http:/

NewProject ; New Project 1 ; NewProject 2

Launch Windowed v Launch Windowed v Launch Windowed v

" ./ Test

Launch Windowed >
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16. The Vision Client Launcher is installed and opens the same way you open any program. Launch the client by clicking

the Launch Windowed button, or you can click the Expand ¥ icon and select Launch + Create Shortcut. The
project shortcut will be placed on your desktop so you don't have to run the Vision Client Launcher each time you want
to launch a project.

Ignition Vision Client Launcher - m} x

+/ Ignition Vision Client Launcher @ About K8 Settings
i My Applications

v CONTROLLER

http://localhost:8088
NewProject i New Project 1 i ‘/ NewProject 2

Launch Windowed - Launch Windowed - Launch Windowed -
Test

Launch Windowed -

Create Shortcut

I Launch + Create Shortcut I

(D The Vision Client Launcher will notify users if it detects that an updated version of the launcher is available
from either the app or a shortcut. For a major Client Launcher upgrade, the application will start and offer an
option to download a new version by providing a link to the Gateway. For a minor upgrade, it allows the user
to choose to upgrade at a later time and allows the application to start.

Windows Silent Installations

The Vision Client Launcher (and the Designer Launcher) can be installed on Windows systems from command line without any user prompts.

# Shows a sinplified user interface
C:\ User s\ user\ Downl oads\ Vi si onCl i ent Launcher Set up. exe / CURRENTUSER / SI LENT

# Shows no user interface at all.
C:\ User s\ user\ Downl oads\ Vi si onC i ent Launcher Set up. exe / CURRENTUSER / VERYSI LENT

Editor notes are only visible to logged in users
Commands above are taken from: https://jrsoftware.org/ishelp/index.php?topic=setupcmdline

The following feature is new in Ignition version 8.0.10
Click here to check out the other new features

Version 8.0.10 introduced launcher installations for all users. Note that using ALLUSERS may trigger a check from User Account Controls,
so you may need administrator access for the following command to offer a truly silent installation:


https://legacy-docs.inductiveautomation.com/display/DOC80/Designer+Launcher
https://jrsoftware.org/ishelp/index.php?topic=setupcmdline
https://docs.inductiveautomation.com/display/DOC80/New+in+this+Version#NewinthisVersion-Newin8.0.10

Related Topics ...

® Quick Start - Vision Client

In This Section ...


https://legacy-docs.inductiveautomation.com/display/DOC80/Quick+Start+-+Vision+Client

Vision Client Launcher Settings

You have the option of customizing the Vision Client Launcher Settings. This can be accomplished

with either the GUI or by modifying a file on the local file system. Regardless of method, both .
utilize the properties specified under the Vision Client Launcher Settings Reference Table. On this page
Launcher Settings
® Launcher Settings
You can find the Settings m button in the upper right corner of the Vision Client Launcher. ¢ I(_:?)l:]rf]ig;?;tion
Ignition Vision Client Launcher - [m] x . 33:3)?1 %Zsllfa)r’:lt
+/ Ignition Vision Client Launcher @ About | 2 Settings Launcher
i My Applications ;Z:‘grr]gr?ce Table
® Trusted
= Gl Certificates
http://localhost:8088 ® Delete a
NewProject : Certificate
W ® Export a
Certificate
Launch Windowed A ® | auncher
Application Settings
® Application
Property
Reference Table

You can choose to use the default settings or customize your client applications. There are three
different Action buttons in Settings in the Vision Client Launcher.

® Export Launcher Config - Exports a configuration of the the Vision Client Launcher, as a
JSON file (i.e., vi si on-cl i ent -1 auncher . j son). Taking an export is useful in cases
where you want multiple launcher instances to use the same settings. The content of the
export file is based on the last saved configurations settings of the launcher.

® Import Launcher Config - Imports your launcher configurations from a Vision Client
Launcher export file.

® Import Application Config - Creates a new client application configuration from an
export, adding a new application to the launcher. The import file is the same generated by
an application export.

When finished updating any of the client launcher settings, click the Save Changes button. Refer
to the list of additional launcher settings in the reference table below.



i Launcher Settings

GENERAL SETTINGS
Default Application
Multicast Address  231.1.1.1

Auto Exit on Launch

NEW APPLICATION SETTINGS

Timeout 30 Retries -1

JVM Arguments

Client Tag Cverrides

Tag Name

Export Launcher (

mport Launcher

)

Click '+ to add a Client Tag Override

TRUSTED CERTIFICATES

Expiration

Click "+ to add a trusted Certificate

Launcher Configuration Using JSON

In addition to using the GUI, these configurations changes can be made by modifying the vi si on- cl i ent -1 auncher . j son file (created

during installation of the launcher). The file is located at:

The preferred method of configuration is with the GUI, but JSON maodification is useful when attempting to load multiple application

configurations simultaneously.

A reference to the various properties that can be modified via JSON are listed in the Vision Client Launcher Settings Reference Table.
However, the JSON file has the following setting that isn't available from the GUI:

When set to true, the application list and individual application configurations cannot be modified. Effectively restricting the
ability to add applications and edit the launcher's configurations.

Vision Client Launcher Settings Reference Table

Launcher Settings - Configurations for the Launcher




Property
Setting

Default
Application

Logging
Level

Multicast
Address

Multicast
Ports

Auto Exit
on
Launch

Description

When set, the Launcher will attempt to automatically launch the specified Application when running. If left
blank/null, an Application will not automatically start
Level of logging that will be used for the launcher: INFO, TRACE, DEBUG, WARN, and ERROR.

The address that will be used to listen for multicast broadcasts from Gateways.

The port that will be used to listen for multicast broadcasts from Gateways.

Automatically close the launcher window when a client is started.

Application Defaults - Default Configurations for New Applications

Property
Setting

Timeout

Retries

Initial
Heap

Max
Heap

JVM

Client
Tag
Overrides

Description

Maximum number of seconds allowed for any Gateway communication. Any communication that exceeds
this amount will cause the client launcher to abort the communication and try again if configured.

The number of times a Client will to attempt to contact a gateway again if an error occurred during
communication. Available values are:

® -1: Retry indefinitely, or until the launcher is manually closed.
® 0: Zero retries, or abort after the first failure.
® 1 (or more): Determines the number of retries: i.e., a value of "5" means five retries.

Amount of memory to be allocated at startup.

Maximum amount of memory allocation for heap size.

Arguments to append to client startup. These should start with a -D' and be separated by semi-colons.

Client Tags and their values that are set when the client launches.

The following feature is new in Ignition version 8.0.13
Click here to check out the other new features

Trusted Certificates

JSON Name

defaul t.
application

| ogger .
| evel

mul ticast.
addr ess

mul ticast.
receive.
port

aut oexi t

JSON Name

ti meout

retries

init.heap

max. heap

jvm
argunent s

client.tag.
overrrides

As of release 8.0.13 you can add security certificates to the launcher. To use this feature, you must have installed a launcher from a version
8.0.13+ Gateway.

While attempting to launch an application, the launcher will check against the application's host Gateway, and attempt to automatically
download any required certificates. In addition, certificates can be manually added using the example below.

1. Access Vision Client Launcher Settings by clicking Settings on the top right of the Vision Client Launcher window.
2. In the Trusted Certificates section, click the Add

icon.


https://docs.inductiveautomation.com/display/DOC80/New+in+this+Version#NewinthisVersion-Newin8.0.13

./ Ignition Vision Client Launcher

£ Launcher Settings Cancel  [EEVCISQERES
GENERAL SETTINGS - ACTIONS

Default Application v Logginglevel INFO  ~ Export Launcher Config &
Multicast Address ~ 231.1.1.1 Multicast Port 4448 Import Launcher Config

Auto Exit on Launch

Import Application Config

NEW APPLICATION SETTINGS
Timeout 30 Retries -1 Init Heap Max Heap

JVM Arguments

Client Tag Overrides
Tag Name Tag Value +

Click '+' to add a Client Tag Override

TRUSTED CERTIFICATES

Common Name Expiration

Click '+ to add a trusted Certificate

3. Navigate to the location of the certificate on your system and choose Open.

4. Information about the certificate is displayed. To view complete details, click the Expand 4 icon next to Details. If everything looks
OK, click Trust Certificate.



Import Untrusted Certificate X

Carefully review the certificate details. Once finished, press the Trust Cenrificate

Subject Name
Country or Region
State or Province
Locality
Crganization
Organizational Unit
Common Mame

Issuer Name
Country or Region
State ar Province
Locality
Organization
Crganizational Unit
Common MName

button below.
Ignition Test Certificate Authority
— Self-Signed Certificate

Expires: Jul 24, 2020, 12:00:00 AM
Pacific Daylight Time

Ne S
ﬂ Certificate is valid

¥ Details

us

California

Folsom

Inductive Automation

Software Engineering

lgnition Test Cerificate Authaority

us

California

Folsom

Inductive Automation

Software Engineering

lgnition Test Cerificate Authority

Cancel

Trust Certificate

5. Once a certificate is imported, you can view its details by clicking the Information o icon.

Delete a Certificate

1. To delete an imported certificate, access Vision Client Launcher Settings by clicking Settings on the top right of any Vision Client La

uncher window.

2. In the Trusted Certificates section, select the certificate you want to delete.

r -5
3. Click the Delete |]Il icon.




4. You'll get a confirmation window. If the certificate is the correct one you want to delete, click the Delete button.

Delete Certificate? X

Are you sure you want to delete the trusted certificate?

Ignition Test Certificate Authority
— Self-Signed Certificate
@_ Expires: Jul 24, 2020, 12:00:00 AM
- Pacific Daylight Time
@ Cerificate is valid

X,

b Details

Export a Certificate

1. To export an imported certificate, access Vision Client Launcher Settings by clicking Settings on the top right of any Vision Client La
uncher window.
2. In the Trusted Certificates section, select the certificate you want to export.

. A
. Click the Exportmmm icon.
. Navigate to the location you want to save the certificate and click Save.

AW

Launcher Application Settings

-
For each project application, you can update the default settings by clicking the More % icon (three vertical dots) next to the project name,
and select Manage to open the Manage Project Settings window. The Export command exports the configuration settings to a . j son file.
The Delete command deletes the project application from the launcher.



Ignition Vision Client Launcher — O >

./ Ignition Vision Client Launcher @® About  &¥ Settings

My Applicatons

~ CONTROLLER

http://localhost:2088

Export

Launch Windowed Dielete

You can choose to use the default settings or customize your project client applications. There are three different Action buttons under Mana
ge Project Settings in the Vision Client Launcher.

® Launch Application - Launches the your application in the Vision Client Launcher.

® Export Config - Exports your updates to the Vision Client Launcher file (i.e., vi si on-cl i ent - | auncher . j son). The resulting
export file contains the last saved configuration of the application.

® Create Desktop Shortcut - Creates a shortcut to your application on your desktop, using the last saved application configuration.

When finished updating any of the launcher settings, click the Save Changes button.



Application Name

NewProject

Gateway Address
hitp:/flocalhost:8088

Description

NewProject

Image Path

Visionlcon

Window Mode

Screen Index

JVM Arguments

Ignition Vision Client Launcher

Vision Client Project

Fallback Application

window ~  Timeout 30 Init Heap 32m

0

Client Tag Overrides
Tag Name

/ Ignition Vision Client Launcher (@ About £ Settings
Manage ‘"NewProject’ Cance
ACTIONS
Launch Application &

Export Config

Create Desktop Shortcut A

Retries -1 Max Heap  256M

Tag Value -

Click '+ to add a Client Tag Override

Application Property Reference Table

Setting
Name

Applicat
ion
Name

Project

Descrip
tion

Window
Mode

Screen
Index

Image
Path

Description

The descriptive name of the application. This is independent of the project name that corresponds to a
project on the gateway. Instead, this is the name of the application as it is defined in the Launcher.

The Vision project that exists on the gateway that this application will load.

An optional brief note about the application. The description will appear in the Launcher. If left blank, a
description will not appear.

Controls the client mode. Available options are:
® wi ndow: Launches the client in Windowed Mode
® full screen : Launches the client in Fullscreen Mode

The screen index indicates which monitor to use.

This will allow the icon of the application to be set within the designer and it will be downloaded and

displayed as the icon for the application as well as the shortcuts. If no path is set the default icon is used.

If this is set to a different icon path, that icon will be used.

JSON
Name

appl i
cation

proje
ct

descr
i ption

wi ndo
W.
node

screen

i mage
.path



Fallbac = The name of the application to use if the number of retries has been exceeded. The fallback is only fallb

k utilized if the Retries setting is greater than 0. ack.

Applicat appl i

ion cation

Timeout The maximum number of seconds to allow for any gateway communication. Any communication that timeo
exceeds this amount will cause the Vision client launcher to abort the communication and try again if ut
configured.

Retries = How many times to attempt to contact a gateway again if an error occurred during communication. retri
Available values are: €s

® -1: Retry indefinitely, or until the launcher is manually closed.

® 0: Zero retries, or abort after the first failure.

® 1 (or more): Determines the number of retries: i.e., a value of "5" means five retries. If the number of
retries is exceeded, then the launcher will attempt to launch the Fallback Application.

If the number of retries is exceeded, then the Launcher will attempt to launch the Fallback Application.

Init The initial heap size (memory) for the client. init.
Heap heap
Max The maximum heap size (memory) for the client max.
Heap heap
Client Allows client tags to be overridden on the Vision Client. These are set using the table on the application clien
Tag configuration screen by adding rows with the names of the tags and the corresponding values. t.
Overrid tag.
es When applying the overrides from command line, the tags must first be defined as launch parameters, overr
then a value can be set on the parameters. i des

The following feature is new in Ignition version 8.0.7
Click here to check out the other new features

Added support for Vision Client Tag overrides within folders and passing client tag overrides with spaces
by using a '+' icon as an escape character. This happens automatically if you are configuring overrides in
the Client Launcher. To learn more about how to configure Client Tag Overrides, refer to Overriding
Vision Client Tags.

Related Topics ...

® Vision Client Tags


https://docs.inductiveautomation.com/display/DOC80/New+in+this+Version#NewinthisVersion-Newin8.0.7
https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+Client+Tags#VisionClientTags-OverridingVisionClientTags
https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+Client+Tags#VisionClientTags-OverridingVisionClientTags

Deploying Vision Client Launchers

Deploying Launchers _
On this page
In some cases, it may be desirable to deploy a pre-configured Launcher to remote clients. Doing
so bypasses the installation process on the remote machine. The process to do so is outlined
below. The steps in this example are operating system dependent, as the launchers were
designed to run on a single operating system.

® Deploying
. . Launchers
Three Key Pieces to a Configured Launcher * Three Key
Pieces to a
® The launcher itself. Configured
® The JRE for the launcher. The "jre" directory should be in the same directory as the '—aU”Chef_
launcher. ® Pre-Configure a
® The configuration JSON file. The launcher always expects this file to be located at a Launcher
certain directory, otherwise the launcher will create a new, blank, file. * Create a ZIP
® Deploying the
The steps below demonstrate how to configure a launcher, and then migrate each piece to a new Launcher
file system into an appropriate location. * Redundancy
® Command Line
/Terminal
® Command Line
Arguments

® |aunchers and SSL
® Certificates
Signed by a CA
® Self-Signed
Certificates
® Troubleshooting

Pre-Configure a Launcher

1. Install a Vision Client Launcher somewhere on network. Take note of the Installation directory you use, as a later step will involve
finding this directory.

2. Configure each application. Be mindful of the Gateway Address setting: the deployed launcher will need to be able find the Gateway
based on the address you enter.

At this point, we should have a single launcher configured with one or more applications. Next we can zip up the the launcher and its
configuration files.

Create a ZIP

In these steps, we will create a single ZIP, containing all of the required files.

1. Navigate to the Launcher's installation directory. It should look similar to the image below:

Marne Date modified Type Size

jre '6/2019 3:49 PM File folder

[&f clientlauncher.log 019 349 PM  LOG File 1KB
[ ] unins000.dat 4/26/2019 349 PM  DAT File 20KB
unins000.exe 472

2019 3:48 PM Application 820 KB

ViSiDnclientlauncher.ae Application 21,043 KB

2. Copy all of the files shown in Step 1, and paste them into the Client Launcher Data directory. This is the same directory that the
configuration JSON file is located. The path differs by operating system, but should generally look like the following:



After pasting, the directory should look something like the following:

o
Mame

certificates

jre
IQ{P clientlauncher.log
Ié{’ designer-launcher.json
IQ{P designerlauncher.log
| launchclient.jar
|J launchclient.jar.chk
|J unins000.dat
unins000.exe
visionclientlauncher.ae
I:{’vision-client-launcher.jsnn
E{rvisionclientlauncher.log
ﬂ‘u’isinnlcon.ico

Date modified

3/4/201912:28 PM
4/26/2019 2:39 PM
4/26/2019 3:49 PM
4/26/201911:11 AM
4/26/201911:11 AM
4724720191017 AM
4/24/201910:17 AM
4/26/2019 3:49 PM
4/26/2019 3:43 PM
4/22/2019 2:36 AM
4/26/2019 3:53 PM
4/26/2019 2:30 PM

4/25/2019 2:54 PM

Type

File folder
File folder
LOG File
JSON File
LOG File

Executable Jar File

Recovered File Fra...

DAT File
Application
Application
JSOM File
LOG File

lcon

Size

1KB
KB

26 KB
3,565 KB
1KB

20 KB
820 KB
21,043 KB
4KB
35KB
306 KB

We now have a single folder containing the launcher, a JRE, and the application configurations.

3. Navigate up a directory to the ".ignition" folder. You will see the folder we were just in: "clientlauncher-data"

E ¥ » .ignition
Mame

cache

clientlauncher-data
|:] .designer.prefs.bak
Qf’ clientlauncher.log
|:] designer.prefs

Ll

v O

Date modified

4/23/201% 241
4/26/2019 4:21
428/
4/26/2019 3:30

4/26/2019 2:21

209 2:21

Search

4. In this directory (the .ignition directory), create a new folder called .ignition. Note the leading period. In some operating systems
you may have to attempt to rename with a trailing period as well.

io.ignition.
SEFS # ¥ dgnition
Py
e Mame
JAgniticn
cache
clientlauncher-data
| .designer.orefs.bak

5. Copy the clientlauncher-data folder into the new .ignition folder. Note that you want to copy, not move. Moving would make prior
application configurations on the local system unavailable.

6. Zip up the newer .ignition directory.



-
5 » » .ignition
Marme
JAgniticn
cache
clientlauncher-data
| | .designer.prefs.bak
Jdgnition.zip
Efr clientlauncher.log

We now have a ZIP we can deploy to a new system.

Deploying the Launcher

1. Take the ZIP, and move it to another computer.
2. Unzip the file at the user directory. The location of the directory is based on the local operating system.

i C\Users\userNanme

/ home/ user/

4. Run the Launcher. It should contain all of the configured applications.
5. At this point, consider creating a shortcut to the launcher, and placing the shortcut at a more accessible location. Alternatively, the
launcher can be accessed via command line/terminal, so you could automate client launchers in a number of ways.

Redundancy

The client launcher can take advantage of a redundant Gateway setup. Whenever a connection is established with a master Gateway, the
backup Gateway IP address is automatically stored in the client launcher configuration file. If the master Gateway cannot be contacted the
next time the client launcher is run, an attempt is made to contact the backup Gateway. If the backup cannot be contacted, the client
launcher switches between contacting the primary Gateway and the backup Gateway until one responds or the user closes the launcher.

Command Line/Terminal

Clients can be launched from the Client Launcher via command/terminal. When called in this way, many of the application properties may be
overridden for the one call. The overrides use the same property names as noted in the Application Property Reference Table, under the
"JSON name" column.

"C:\ dientlLauncher\visionclientlauncher.exe" application=nyproject w ndow. node=wi ndow

Li nux:
.lvisionclientlauncher.sh application=nyterm nal w ndow. node=fullscreen screen=0

There are a few important notes when using the Command Line/Terminal to launch a project from the Vision Client Launcher.

® The Vision Client Launcher must be installed and have an application added for the Command Line/Terminal commands to work.
® The application argument requires the application name in the Launcher, not the project name. You can open the launcher to
determine what the application name is. Adding new applications in the launcher uses the Project title by default.



® Applications may contain spaces in their name. However, when launching from command/terminal, spaces should be escaped with
%20. For example, if our application was named my project, then we could all it with the following:

"C:\dientLauncher\visionclientlauncher.exe" applicati on=ny%0pr oj ect

Command Line Arguments

Argument Description

applica  The name of the application to launch.
tion

wi ndow.  Controls the client mode. Available options are:
node
® w ndow: Launches the client in Windowed Mode
® full screen : Launches the client in Fullscreen Mode

screen The screen index indicates which monitor to use.

fall bac = The name of the application to use if the number of retries has been exceeded. The fallback is only utilized if the
k. ) Retries setting is greater than 0.

applica

tion

ti meout The maximum number of seconds to allow for any gateway communication. Any communication that exceeds
this amount will cause the Vision client launcher to abort the communication and try again if configured.

retries How many times to attempt to contact a gateway again if an error occurred during communication. Available
values are:

® -1: Retry indefinitely, or until the launcher is manually closed.

® 0: Zero retries, or abort after the first failure.

® 1 (or more): Determines the number of retries: i.e., a value of "5" means five retries. If the number of retries
is exceeded, then the launcher will attempt to launch the Fallback Application.

If the number of retries is exceeded, then the Launcher will attempt to launch the Fallback Application

init. The initial heap size (memory) for the client.
heap

max. The maximum heap size (memory) for the client
heap

- Defines client tags that can be overwritten upon launch. The use of this argument alone only defines the client
Dy avaws  tags that will be overwritten. Setting a value on the tags can be done by an additional argument that utilizes the

: tag names delimited by a semicolon:
| aunchp

ar ans /] Establishes the tag nanes
- D avaws. | aunchpar ans="Tag1l; Tag2"

Il Sets values on the tags
- D avaws. | aunchpar ans. Tagl=10
- Dj avaws. | aunchpar ans. Tag2=20

/1 An actual call would ook I|ike:
"C:\dientLauncher\visionclientlauncher.exe" application=nyproject -D avaws.
I aunchpar anms="Tag1; Tag2" - Dj avaws. | aunchparam Tagl=10 - Dj avaws. | aunchpar am
Tag2=20

config.

json The following feature is new in Ignition version 8.0.15
Click here to check out the other new features


https://docs.inductiveautomation.com/display/DOC80/New+in+this+Version#NewinthisVersion-Newin8.0.15

Allows you to point the launcher to a launcher configuration file command line. Doing so will start running an
instance of the launcher using the configurations in the file as temporary overrides. The argument expects a
path to a JSON export file, specifically the same file that created by the that's created by the Export Launcher
Config button under the launcher's Settings menu.

i "C\dientLauncher\visionclientlauncher.exe" config.json="C i
: \Users\ WUser\ Deskt op\ vi si on-cl i ent -l auncher.json" H

Launchers and SSL

When SSL is enabled on a Gateway, the Vision Client Launcher can take advantage of the enhanced security features associated with SSL.

Certificates Signed by a CA

When the Gateway's SSL certificates are signed by a recognized Certificate Authority, no additional configuration is required on the launcher.

Self-Signed Certificates

When using a self-signed SSL certificate, the certificates for the Gateway must be locally accessible to the client launcher in the following
directory:

When a certificate is placed in the directory above, the launcher will attempt to automatically add the certificate(s) to the local KeyStore upon
application launch.

Troubleshooting

If the Vision Client Launcher fails to launch a client for some reason, the log file can be found at:

This log contains any errors that occurred.

Related Topics ...

® Quick Start - Vision Client
® Vision Client Tags


https://legacy-docs.inductiveautomation.com/display/DOC80/Quick+Start+-+Vision+Client

Client Launchers Commands

Command Line/Terminal _
On this page
Clients can be launched from the Client Launcher via command/terminal. When called in this way,
many of the application properties may be overridden for the one call. The overrides use the same
property names as noted in the Application Property Reference Table, under the "JSON name"

column.
W ndows: . Command Line
"C:\dient Launcher\vi sionclient | auncher.exe" application=nyproj ect /.Termlnal )
wi ndow. mode=wi ndow Command Line
Arguments

Li nux:
./visionclientlauncher.sh application=nyterm nal w ndow.
nmode=f ul | screen screen=0

There are a few important notes when using the Command Line/Terminal to launch a project from
the Vision Client Launcher.

® The Vision Client Launcher must be installed and have an application added for the
Command Line/Terminal commands to work.

® The application argument requires the application name in the Launcher, not the project
name. You can open the launcher to determine what the application name is. Adding new
applications in the launcher uses the Project title by default.

® Applications may contain spaces in their name. However, when launching from command
/terminal, spaces should be escaped with %20. For example, if our application was named
my project, then we could all it with the following:

"C:\dientLauncher\visionclientlauncher.exe" applicati on=ny%
20pr oj ect

Command Line Arguments

Argument Description

applica The name of the application to launch.
tion

wi ndow.  Controls the client mode. Available options are:
node
® w ndow: Launches the client in Windowed Mode
® full screen: Launches the client in Fullscreen Mode

screen The screen index indicates which monitor to use.

fallbac  The name of the application to use if the number of retries has been exceeded. The fallback is only utilized if the
k. ) Retries setting is greater than 0.

applica

tion

ti meout The maximum number of seconds to allow for any gateway communication. Any communication that exceeds
this amount will cause the Vision client launcher to abort the communication and try again if configured.

retries How many times to attempt to contact a gateway again if an error occurred during communication. Available
values are:

® -1: Retry indefinitely, or until the launcher is manually closed.

® 0: Zero retries, or abort after the first failure.

® 1 (or more): Determines the number of retries: i.e., a value of "5" means five retries. If the number of retries
is exceeded, then the launcher will attempt to launch the Fallback Application.



If the number of retries is exceeded, then the Launcher will attempt to launch the Fallback Application

init. The initial heap size (memory) for the client.
heap

nax. The maximum heap size (memory) for the client
heap

- Defines client tags that can be overwritten upon launch. The use of this argument alone only defines the client
D avaws  tags that will be overwritten. Setting a value on the tags can be done by an additional argument that utilizes the

. tag names delimited by a semicolon:
launchp =~~~

ar ans "7 Establishes the tag nanes
- D avaws. | aunchpar ans="Tagl; Tag2"

Il Sets values on the tags
- Dj avaws. | aunchpar ans. Tag1=10
- D avaws. | aunchpar ans. Tag2=20

//An actual call would | ook |ike:
"C:\dientLauncher\visionclientlauncher.exe" application=nyproject -D avaws.
| aunchpar ams="Tag1l; Tag2" -Dj avaws. | aunchparam Tagl=10 - Dj avaws. | aunchparam
Tag2=20

config.

json The following feature is new in Ignition version 8.0.15
Click here to check out the other new features

Allows you to point the launcher to a launcher configuration file command line. Doing so will start running an
instance of the launcher using the configurations in the file as temporary overrides. The argument expects a
path to a JSON export file, specifically the same file that created by the that's created by the Export Launcher
Config button under the launcher's Settings menu.

i "C\dientLauncher\visionclientlauncher.exe" config.json="C [
i \Users\ MyUser\ Deskt op\ vi si on-cl i ent -l auncher.json" H

Related Topics ...

® Quick Start - Vision Client
® Vision Client Tags
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Local Client Fallback

Ignition Clients are fully dependent on being able to communicate with a Gateway. If Gateway
communication is lost, the Client suspends operation while it attempts to reconnect with the
Gateway. This can be a problem when you need the Client to monitor critical operations on a plant

floor. On this page
Ignition provides a local Vision client fallback mechanism that lets you use a Gateway running on
the machine where the client is running. In normal operation, your Client can connect to a central

Gateway located somewhere on the network. The central Gateway would be responsible for all
data aggregation, such as storing historical data in a database. But if communication to the central

Gateway is lost, the Client can automatically retarget to a project that you specify in the local Gatew ® Testing Local
ay. This project should contain the minimal realtime information that you need to keep your . Fallback_
operation running. Note, that in order to use local client fallback, port 6501 must be open on the loc Automatically

al machine. Transferring Back

To enable local Vision client fallback, do the following steps:

1. Goto Config > Gateway Settings in the local Gateway.

Scroll down to the Local Vision Client Fallback section and select the Enable Local Fallback.

Select a Fallback Project from the dropdown list.

Note, that the selected project must be published in the local Gateway, and it must have at least one main window.

4. Optionally, you can change the Seconds to Failover setting to a value other than 60 seconds.
This setting controls the number of seconds to wait before fallback automatically starts. During comm failure, you can also click a
button to load the local fallback project immediately.

wn

Enable Local 4| Enables a client to fall back to a project in a local Gateway if communication is lost to the central Gateway. Note that
nable Loca port 6501 must be open on the local machine.
Fallback . .
default: falze
Seconds Before &0
Failover The number of seconds to wait before switching to the local Gateway project after comm loss.
default: 60
Fallback Project = M
The local project to use during fallback.

When local Vision client fallback is enabled, the Client attempts to open port 6501 on the local machine. If the port can be opened
successfully, the Client reads fallback settings from the local Gateway and shows a Fallback Project button on the bottom of the Gateway
Connection Lost window. You can click this button at any time to load the fallback project, or simply wait for the fallback project to
automatically load. You may want to set the local Client to automatically log in to avoid typing in a username and password when the Client lo
ads. This can be set in the Login section of the project's properties.

Testing Local Fallback

Testing local Vision client fallback is highly recommended before you start to depend on it in a production setting. The easiest way to test
fallback is to simply unplug the network cable to the Client machine, or disable the network card on the machine. If the Fallback Project butto
n is not visible on the Gateway Connection Lost window, check your local Gateway console and verify that the message Started Fallback
Socket on port 6501 is present in the console. Any other error message related to the Fallback Socket Controller indicates that some
other problem has occurred (most likely the port cannot be reserved) and local fallback is not available to Clients.

Automatically Transferring Back

Local Vision Client Fallback will not automatically transfer back to the main Gateway when it is running again, as simplicity was key in this
system. You can, however, provide your own solution to automatically switch back. One example is to add a retarget script to your Timer
Client Event Scripts to silently try to reconnect.

Automatically Retarget Back

# add this to a dient Timer Script running every 30 seconds
# change the ipaddress and project nanes to match your system
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# allow the main copy of Ignition 10 seconds to give a response

status = systemutil.get Gat ewaySt at us("i paddress: 8088/ mai n",
# if it's running again, retarget
if status == "RUNNI NG":

systemutil.retarget("ny_project”, "ipaddress:8088")

10000)



Vision Designer Interface

Vision Designer Workspace

When looking at a Vision specific element in the Designer, such as a window or template, the On th|3 page
Designer is organized with some panels that are specific to the Vision Designer Interface, such as
the Property Editor and Component Palette. Other elements of the workspace that are shared
between spaces are discussed in the General Designer Interface.

Fle Edt View Proect Component Algnment Stape Took Help
Bo[ens[dssnasiorls-e0
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® Vision Designer
Workspace
® Component Palette
® Vision Property
Editor
® Filters
® Binding Icon
® Status Indication
® Dropdown Lists
in Properties
® Common
Properties
® Vision Menubar
File Menu
Edit Menu
View Menu
Project Menu
Component Menu
Alignment Menu
Shape Menu
® Tools Menu

Vision Designer Workspace

.| | © Welcome T Wamwindow. % (133

@ INDUCTIVI
UNIVERSI]

Using Designer
User Interface

Watch the Video

Component Palette

The Vision module comes with a host of useful components out of the box, such as buttons, text areas, dropdowns, and charts, many of
which are specialized for industrial controls use. The Component Palette is located on the right side of the Designer workspace. The basic
workflow is to drag a component from the component palette and drop it into a container on a window. From there, you can use the mouse to
drag and resize the component into the correct position. While the component is selected, you can use the Property Editor panel to alter the
component's properties, which changes the component's appearance and behavior.

Vision Property Editor

The Vision Property Editor is a dockable panel that appears in the Designer's central workspace, usually in the lower left corner. It displays
the properties of the selected component. If more than one component is selected, it will show all properties that the current selection set
have in common. Hovering your mouse over a property will display a tooltip that gives a description of the property, as well as its data type

and scripting name. Alternately, you can click on the Show/Hide Description Area B icon to bring up the description area which displays the
same information for the currently selected property.
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You can also change how the properties are sorted in the property editor. By default, they are sorted with the Categorized E: icon, with
similar components grouped under different categorical headers. However, they can also be sorted in alphabetical order by clicking on the

&
Alphabetic 2% jcon.

Filters

It is common for components to have many properties, so by default the Property Editor only shows the Basic properties. These are the
properties that you'll most commonly want to set or bind for a given component. However, the property filter can be changed to show different
sets of properties. The designer will remember your selection for future sessions.

® Basic: The Name property and any very commonly used properties. Most components only show two to four properties in Basic.

¢ Standard: Most of the common properties that a designer would want to use. Few or none of the Expert properties are in the
Standard list.

® Expert: The properties that are most commonly used with more advanced features of the component. Few or none of the Standard
properties are in the Expert list.

® All: All properties

@ Most users find it best to set the property filter to All, so they can see all of the properties available to them at all times.

Vision Property Editor
B 24 | = | = Rl |

= Common “® Basic
Name % Standard
Visible & Expert
Border % Al

Binding Icon

To the right of most properties is the Binding =2 jcon. Click this icon to modify the property binding that is driving that property. You can only
use this button when the window workspace is not in Preview mode. Some properties cannot be bound because their datatype is not
supported by the binding system. You can still use scripting to affect these properties.

Status Indication

The name of a property in the Property Editor conveys important information about that property:

® A blue name indicates that the property is a custom property.
®* A bold name with a Link éﬁl icon next to the property indicates that the property is bound using a property binding.
® A bold name with a Color Palette ﬂ icon indicates that the property is being affected by the component styles settings.

®* A red bold name with a Warning £*% icon indicates that the property is double-bound. This means that two things, a property
binding and the styles settings are both trying to drive the property value. This will result in errors as the two systems fight each other
to write to the property.

Dropdown Lists in Properties

Some of the properties you will encounter on components will have a dropdown list instead of a field to type into. The property description will
say it is an integer value, and in most of these cases you can still create a binding on that property. These dropdown lists are an
enumeration, meaning each element in the dropdown has an integer value. In all cases, the first value in the list is 0, the second is 1, the
third is 2, and so on. You can use this knowledge to create a dropdown list on-screen for your operators that matches the list. In this case,
you would just bind this property to the Selected Value of the dropdown.
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Common Properties

Every component has properties arranged into categories based on what it has available (i.e., Common, Behavior, Data, Appearance,
Layout, etc.). Each component has a different list of properties to effect how it behaves, but every component has the Common group of
properties located at the top of the list. These Common properties will behave the same for all components. Here's a list for each Common
property and when it might be used.

Function

Name

Enabled

Visible

Border

Mouseov
er Text

Cursor

Description

The name of the component. This string is used to identify your components in the Project Browser. This is especially
important for Bindings and Scripting. Binding is allowed on this property, but it is recommended to never bind this property. Bi
nding it can break your scripts, bindings, and cause errors.

This Boolean controls whether a component can be interacted with. Most commonly used with data entry components to allow
the user to see the value, but not change it.

This Boolean controls whether the component is shown on the window. You can bind this property to show/hide the
component based on any logic you want (i.e., security, process step, etc.).

The border that surrounds the component. There is a dropdown to select from a list of common borders, and a button to the
right to manually edit a border from several different options with a second tab that shows Titled Borders. When binding this
property, note that this is a complex data type. It is a Java Border data type, not a string or an enumeration. The common
ways to make this property dynamic are to bind it with an Expression binding type or to set it through a script, but using the
Expression binding is preferred. If you are using an Expression binding, you must use the toBorder() expression function to
return the correct data type. If you are using a script, you need to make sure you use the Java Border data type. See the Java
documentation for more information on setting a border through scripting.

The text that is displayed when a user moves the mouse over the component. This string is commonly used to provide your
operators more information about an object (i.e., showing the PLC address of an on-screen value, or telling the operator
exactly what will happen when a button is pressed). HTML is allowed in this property.

The mouse pointer image to use when the operator moves the mouse over the component. This int property corresponds to
one of the options in the list. Selecting 'default' means the operating system decides what pointer to use.

Value Cursor
0 Default
1 Crosshair
2 Text
3 Wait
4 SW Resize
5 SE Resize
6 NW Resize
7 NE Resize
8 N Resize
9 S Resize

10 W Resize

11 E Resize
12 Hand
13 Move

Vision Menubar
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There is a menubar at the top of the Designer Workspace that provides functionality that you can interact with when working in the Vision
workspace. Each menu has a host of functions as it relates to that menu. The other menus that are shared between Vision and Perspective
are discussed in the General Designer Interface.

File  Edit View Project Component  Alignment Shape  Tools  Help
B |« 4 Y 5§ & |8 /¢ 0-»|F- - 9| =
File Menu

See General Designer Interface.

Edit

Menu

The Edit Menu is also similar to other applications edit menus in that it provides much of the basic copy/paste functionality. You can also
right click on an item to access this menu.

i

Function Description

Undo
and
Redo

Cut
/Copy
/Paste

/Duplicate

Find

Undo
Redo

Cut

Copy

Duplicate

Find/Replace

Select All
Select Same Type

Select Same Type In Window
Group Rename

Delete

Can be used to revert to the previous state, essentially removing the last change, or redoing it again after having been
removed. This has a large queue that can be traversed, but does not include every change (i.e., Tag edits cannot be undone).

These functions much the same as they do everywhere else. Most things in the Designer can be copied and pasted
elsewhere, from individual components on the window to entire folders of windows. The difference is that when using Paste
with an object on a window, it will instead create a paste action, and allow you to move the mouse and select where you want

to paste it, clicking the mouse to confirm. Cancel Paste will cancel the paste action, while paste immediate will bypass the

paste action, and instead immediately paste the object from where it was cut or copied from.

Brings up the Find and Replace interface to allow you to find specific objects within the project. See also: Find and Replace

/Replace

Select

Selects All siblings in the same container as the currently selected component.
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All

Select Selects all components of the same type in the same container as the currently selected component.

Same

Type

Select Selects all components of the same type as the currently selected component, regardless of what container they are in.
Same

Typein

Window

Group Renames a group of components to a prefix with a number afterwords. For example, if your prefix is Button, it will rename all
Rename  selected components Button (1), incrementing the number each component.

Delete Deletes the currently selected component. This can also be done using the delete key.
View Menu

The View Menu allows you to manipulate how various objects look or act in the Designer.

<
o8 HHE

C.

(4 4|

Function
Emulate
Touchscr
een

Disable
Overlays

Reset
Panels

Panels

Emulate Touchscreen

Disable Overlays

Reset Panels
Panels »
Toolbars »

Welcome Screen

Grid Size: 5
Grid Size: 10
Show Grid
Snap to Grid
Show Guides

Snap to Guides

Mew Guide...

Spotlights b
Dependencies b
Description

Simulates Touchscreen mode in the Designer to be able to test it without having to open a client.

Disables the red or gray overlays on components because of a bad Tag or binding, but only in this Designer session.

Resets panels (Project Browser, Tag Browser, etc.) to the default panel configuration.

Allows you to enable or disable certain panels within the Designer.



Toolbars

Welcom
e Screen

Grid Size

Show
Grid

Snap to
Grid

Show
Guides

Snap to
Guides

New
Guide

Spotlights

Depende
ncies

Allows you to enable or disable certain toolbars within the Designer.

Takes you to the welcome screen in the Designer, or reopen it if it had been closed.

Allows you to select a grid size of 5 or 10.

Toggles the grid on and off.

Changes click-and-drag behavior to snap components to grid lines. This works even when Show Grid is off.

Shows any guide lines.

Changes click-and-drag behavior to snap components to any created guidelines.

Adds a guide line to the current window.

Puts a highlighted border around components that have the selected spotlight. Bound objects will get a green highlight, objects
with scripting will get a blue highlight, and invisible objects will get a pink highlight. If a component has multiple highlights, and
both are enabled, it will alternate the colors throughout the highlight.

Shows the binding dependencies (as arrows) based on the selected component or components. Show Supporters will show all
components that the currently selected component is bound to, Show Dependents will show all components that are bound to
the currently selected component, and Show All will show all of the bindings, regardless of the selected components.

Project Menu

The Project Menu is where many project specific settings can be changed.

Project

Function

Designer
Comms

Properties

Event
Scripts

Comm Off
Comm Read-Only

Comm Read/Write

Project Properties
Gateway Events
Session Events

Client Events

Preview Mode

Freview Language

Description

The Comm settings allow you to select the level of communication the Designer can have with the Gateway. By default, this is
set to Comm Read-Only, which will make any information coming from the Gateway read only, but this can be changed to
Comm Off which will prevent Gateway communication, or Comm Read/Write, which will allow both read and write
communications between the Gateway. The default that the Designer opens at can be changed in the Project Properties. See
also: Communication Modes

Opens up the Project Properties window, allowing project settings to be changed. See also: Project Properties

Opens up the appropriate event script window, either client or Gateway. These can also be accessed from the Project
Browser. See also: Client Event Scripts and Gateway Event Scripts.
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Preview  Puts the Designer into Preview Mode, allowing you to interact with it like a client. See also: Previewing the Project
Mode

Preview | Determines the language that the Designer will revert to when in Preview Mode. See also Localization in Vision
Language

Component Menu

The Component Menu offers many of the same selections for the selected component that right clicking on that component would contain.

#L  Size & Position...

/& Customizers
E¥ Scripting...
O Security

&

Translations

Function Description

Group Only available when multiple components are selected. Grouping will place the currently selected components into a group.
Ungroup will remove the grouping. See also: Working with Components

Ungroup Only available when a group is selected. This option removes the group (and any custom properties that are on the group)
and places all items from that group into the object the group was in.

Convert to Only available when a group is selected. Converts the selected group to a container. See also: Container
Container

Lock Locks or unlocks the selected component's size and position.
Layout Set layout constraints for the selected component.

Size and Change the size and position of the currently selected component.
Position

Customizers = Allows you to select any of the available customizers for the currently selected component.
Scripting Brings up the scripting window for the currently selected component.
Security Opens up the Security Settings Panel, allowing security to be placed on the selected components.

Translations = Brings up the Translatable Terms Panel, showing any translations for the selected component.

Alignment Menu

The Alignment Menu options allow you to adjust the alignment of components relative to other components.
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Alignment

M Move to Front

& Move to Back

M  Move Forward

L1 Move Backward

B Align Left

= Align Right

I° AlignTop

ko Align Bottom

B2 Align Centers Horizontal
& Align Centers Vertical

oan - Align as Row

oea - Align Row and Normalize

g Alignas Stack

& Align stack and Normalize

HH  Center Horizontally

o Center Vertically

Function

Move to
Front

Move to
Back

Move
Forward

Move
Backward

Align Left
Align Right
Align Top
Align Bottom
Align
Centers
Horizontal
Align
Centers
Vertical

Align Centers
Align as Row

Align as
Stack

Description

Move the selected components to the front of the z-order.

Move the selected components to the back of the z-order.

Move the selected components forward in the z-order relative to any overlapping components.

Move the selected components backward in the z-order relative to any overlapping components.

Align the left edges of a group of components.
Align the right edges of a group of components.
Align the top edges of a group of components.
Align the bottom edges of a group of components.

Aligns all of the selected components horizontally on their centers.

Aligns all of the selected components vertically on their centers.

Aligns all of the selected components either vertically or horizontally on their centers.

Aligns all of the components on their centers as a row, and will add padding between them that you can select.
Normalizing them will change the size of all of the components to the first selected component.

Aligns all of the components on their centers as a stack, and will add padding between them that you can select.
Normalizing them will change the size of all of the components to the first selected component.



Center Horiz ~ Centers the currently selected components horizontally.
ontally

Center Vertic = Centers the currently selected components vertically.
ally

Shape Menu

The Shape Menu allows for manipulation of shape or path objects.

")  Rotate Left
& Rotate Right
¥4 Mirror Horizontal

== Mirror Vertical

4 Union

& Difference
4oy Intersection
£y Exclusion
My Division
2% ToPath

&% Stroke To Path

Function Description

Rotate Rotates the currently selected shape 90 degrees either right or left.

Mirror Flips the component either vertically or horizontally.

Union Alters the first shape to be the combination of all selected shapes.

Difference Alters the first selected shapes by removing the last selected shape from them.
Intersection Alters the first shape to become a new shape consiting of the area they share.
Exclusion Alters the first shape to become a new shape consiting of the area they do not share.
Division Cuts the first shape into multiple shapes along the borders of other shapes.

To Path Converts a shape to a simple path object.

Stroke To Path = Converts the selected shape into a new shape defined by its stroke.

Tools Menu

The Designer comes with many tools that allow you to manage and test various resources within a project. Each of the tools have their own
interface and are accessed within the Tools menu on the menu bar of the Designer. For more information, see Designer Tools.
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Vision Windows

Windows are the key to your HMI/SCADA application. A window is the basic building block of any
Vision project, where each window can contain any number of components that can display Tag .
values, run scripts, write values to the database, accept user input and more. When you publish On this page
your project, these windows are loaded into the Vision Client where any number of windows can
be opened at one time.

Your windows are brought to life through the property bindings and event handlers on your
components. They can be designed to fit any need, from simple screens showing basic

information, to complex diagrams outlining an entire plant floor with various controls. Despite their * \iVi”dOW Anato_my

abilities, using windows is relatively simple so that even new users can get started creating . Root Container

windows right away. The possibilities are endless when designing windows for your project. W'gql_f?;’IV Name
and Title

In this Realtime Display example, you can see how windows can be used to display and interact ® Titlebar and

with data and Tags. Border

® Creating a Window
® Right Click in the
Project Browser
® Using the
Welcome Window
® From the
Menubar
® Organizing Windows
® Window Right-Click
Menu
® Exporting
Window Example
® Importing
Window Example
® Navigation Strategy

Heating Unit

Current

Window Anatomy

While there is only one type of window object, windows have various properties that determine @ IN DUC TIV]
how they behave within the client. When these settings are configured in specific ways, they

create certain categories or types of windows: Main Windows act like a typical HMI screen and U NIVE RS I']
take up all available space, Popup Windows are often opened by a component in a Main Window
and appear to float on top of the Main Window, and Docked Windows stick to one side of the
screen and are typically always open. These types of windows all provide different functionality to
a project which, when combined create the basis for a Vision project that displays relevant
information while remaining intuitive and user friendly.

Anatomy of a
Window

Root Container Watch the Video

Inside a window there is always a Root Container. The Root Container is where you place all
components in the window. It's a normal Container component except that it cannot be deleted or
resized, and is always set to fill the entire window. The root container will be the root of all
components that go onto the window.

Window Name and Title

Windows have both a Name and a Title. The name is used within the Project Browser to
differentiate the windows from each other and to form part of the path to the window. Windows can @ IN DUC TIV]
be renamed by right clicking on the window object and selecting rename or by pressing F2. Each U NIVE RS I']

window must have a unigue path, so windows can have the same name as long as they are not in
the same folder.

The Title property is a property within the property editor and works a little differently than the

name. By default, Ignition assigns the Title property the same name as the window type that is Locate All Opened
created (i.e., Main Window, Docked Window, or Popup Window). These window titles are used for Windows In Client
the titlebar of a window, but are also used when viewing currently opened windows. In the Client,

the Windows menubar command will display a list of all currently opened windows, as well as

allow you to switch between which one is in focus. The list of opened windows displays the title of
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the window, and not the window name or path, so it is also important to have good titles for your Waitch the Video
window.

Command m Help

Close Popup
M Close All — ——
Main Window

Navigation
90 ropup

Hand

Auto

Titlebar and Border

A window can display a Titlebar and/or a Border. A titlebar allows you to drag a window around the workspace, and contains the window's
close, maximize and restore buttons. The border of a window also lets you resize the window when it is floating or docked. Whether or not
the titlebar and border are displayed depends on the property values set for your Titlebar and Border properties. A window typically displays
both a titlebar and border when it is floating, but only a titlebar when maximized. It is often desirable to remove titlebars and borders on

maximized windows.

Creating a Window

Creating windows is easy. There are three ways to create a new window:

Right Click in the Project Browser

Probably the most common method is to right click within the Windows section of the Project Browser and select one of the window types to
create a window. While you can create each type of window, it is important to remember that the only difference is the configuration of the
window properties.

Project Browser a - X
Q, Project Properties /4
(& Vision -

[& Client Events

Ilwmﬁ

ain Window
b mm Fopup:
am Testz  [®]  Popup Window
[ Alarms ™ Docked Window

™ Classic
i MNewFolder
™ Compc

Export...

Using the Welcome Window
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The Welcome Window that is available when the project is first opened has a few quick start options available on it. One of these options is

the ability to add a new window.

= Getting Started

g New Main Window

From the Menubar

i Mew Popup Window

g New Docked Window

In the menubar of the Designer, the File menu has a New option that allows you to create a new window regardless of where you are in the

project.

m Edit View  Project Component  Alignment  Shape  Tools

|

New
= Open.
H  Save All
B  Save..
B  Save As..
[* Update Project
€ Ignition Exchange
A Import.
2 Export..
4  Exit

Organizing Windows

X

D

¥ NewProject
0 Main Window
m Popup Window
™ Docked Window
=C  MNewTemplate
E] MNewStandard Group
=] MNewBlock Group
I=]  Mew Historical Group
_ Mew Stored Procedure Group

MNew Report..
Mew View...

Mew Sequential Function Chart

You can create folders to organize your windows. A window's name must be unique among the
windows in its folder, but you can have the same window name in multiple folders. The window
name and folder path are very important, they are used as references by other windows. You can
create as many folders as you want and nest them as deep as you need for your project. To
rearrange a window, just click and drag the window where you want to place it.

@ INDUCTIV]I
s UNIVERSI]

i



Project Browser o - X

Q- Project Properties .{

s

b 4% Alarm Notification Pipelines
b & Sequential Function Charts
b B scripting
b @ Perspective
b g Transaction Groups
— G} Vision
& Client Events
- U Windows
m Alarms
F mm PopUps
= User Management
M About
~ [ Navigation
] Root Container
b [ MainWindow [+
» ™ overview Window

1 Ifyou have a security requirement to open a different startup window depending who is
logged in, you can create a client startup script to open a dynamic set of windows. To
learn more, refer to Open Dynamic Windows on Startup.

Window Right-Click Menu

Open Static Window
(s) on Startup

Watch the Video
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For a full list of properties that can be set on windows, refer to Vision - The Window Object. Windows also have right click menu of options
for additional functionality.

[ OpenWindow
[*] OpenonStartup
& About" Window
P MNotes..
Al Rename
Ei Duplicate
% Cut
& Copy
K CopyPath
m Delete
2 Export..
B Protect
Function Description
Open Opens the selected window.
Window
Close &  Commits any changes to your workspace and closes the window.
Commit
Close &  Reverts any changes that were made since the window was last opened or saved.
Revert
Openon  One of the most useful properties is the Open on Startup property, which when enabled will automatically open the window
Startup when the client first starts up. This makes it easy to open a static set of default windows that everyone can see after logging in
to the project. Multiple windows can be set to open on startup, though it is recommended that only a single main window is set
to open on start, as opening multiple at once will cause them to be hidden behind one main window.
All windows that Open on Startup have a little box with a Right Arrow [+] icon next to the window name.
About An "About" Window relays information to the user that may be important, such as instructions on how to use the project, or
Window  information about the projects creator. To specify a window as the About window, right click on the window in the Project

Browser. Then click the About Window checkbox. The window will have a Information Bubble i} icon displayed next to its
name.

In the client, the window will be displayed when a user selected Help > About This Application.
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Project_West_1 - Main Window

Command  Windows
A Diagnostics
@ About This Application
O  AboutIgnition Vision

Notes Windows can also have notes attached to them. The notes provide a way for a windows designer to provide some
documentation on what the window is doing and how the various components interact with one another.

Any windows that have notes will have a small Document I icon next to the window name.

Scripting = The Scripting option takes you to the Component Scripting for that window. For more information, refer to Component Events a
nd Script Builders in Vision.

Security = The Security options displays Security Settings for role-base security. For more information, refer to Security in Vision.
Rename  To rename a window, select this option then enter a new name.

Duplicate = Duplicates the selected window.

Cut Cuts the selected window onto the clipboard.

Copy Copies the selected window onto the clipboard.

Copy Copies the path of the selected window into the clipboard.
Path

Paste Pastes the content in the clipboard into the selected context.
Delete Deletes the current selection.

Protect Locks the individual project resource from inside the Designer.

Export Exports the window as a project resource file which can then be imported into other projects. See the following sections for
examples of Export and Import.

Exporting Window Example

In the Designer, you can export and import windows from one project to another project using external files or sending it directly to a project
on the same gateway.

1. You can export windows in two ways.

a. To export multiple windows, right click on the folder of windows and select the Export option or Send to Project option. The
window export works similarly to the project export, the difference being that it automatically highlights only that window to
export from the list of project resources.

b. To export one window, right click on an individual window and click Export, then choose the Export or Send to Project
option.

2. If you choose the Export option, the Save window is displayed. You can save the windows with the existing project name (not
recommended if you are only exporting part of a project), or type a new name in the File Name field.

3. Click Save to save the windows as a project export file.

Importing Window Example

Importing the individual windows can be done by right clicking on the Windows expandable object and selecting Import.
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Browse to the folder that contains the . zi p file you want to import, and click Open.
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Navigation Strategy

Setting up a navigation strategy allows you to navigate between different windows in the runtime Client. While we have a few examples of
the most common navigation strategies, it is certainly not an exhaustive list as most users tend to combine multiple strategies to create a
project that fits their needs.

A typical navigation strategy for a Vision project is as follows:

Have a Docked window or two, usually docked North and/or West.

Have a single Main window visible at a time.

Use swap navigation to swap between the Main windows. This ensures that only one main window is open at a time.
Use standard open navigation to open various Popup windows as necessary.

This style of project is so common, that the default operation of the Tab Strip component expects it. When it is in its default automatic
operation, it expects that each tab represents a main window, and will automatically swap from the current screen to the desired screen.
Additionally, the [ Systeni/ d i ent/ User/ Cur r ent W ndow Tag is calculated based on this strategy: its value is the name of the current
maximized window. This navigation strategy is used in the Ignition Online Demonstration that you can download from our website.

In This Section ...
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Window Types

There are three Vision window types: Main windows, Popup windows, and Docked

windows. You can create windows from the File > New menu or by right clicking on the Windows .
object in the Project Browser. By changing a window's properties, you can transform any window On thIS page
into various configurations, with each behaving differently based on those settings.

Docked

® Main Windows
® Popup Windows
® Docked Windows
® Docking Settings
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Window Types

Watch the Video

It is important to understand that just because a certain type of window was created does not mean that it must always be that type
of window. A windows type is determined by its settings, so changing its settings to match a different window type will change that
window to a new type.

Main Windows

A Main window is one that is set to start maximized, and has its Border and Titlebar display policies set to 'When Not Maximized' or 'Never.'
This will make the window take up all available space (minus space used by any "docked" windows). This makes the window act much like a
typical "HMI screen." There can be many main windows in a project, but only one should be open at any time since they would all overlap.

Popup Windows

A popup window is a window whose Dock Position is set to Floating and is not maximized. Its Border and Titlebar display policies are
typically set to 'When Not Maximized' or 'Always," so that they can be manipulated by the end-user. These windows are often opened

by components in a main window, and are meant to be on top of the screen. To this end, they should have their Layer property set to a
number higher than zero so they don't get lost behind the main window. Popups can be set to open at a specific position on the screen using
window's Location property. Popup windows can also be parameterized so they can be made once and used for multiple similar
applications, dynamically changing the content on the screen based on a parameter that gets passed in.

Docked Windows

A Docked window is one whose Dock Position is set to anything but Floating. Docked windows
are locked to the edges of the Client and fill all the space on that edge (i.e., West Docked fills the IN DUCTIV]
left side of the Client). It will also typically have its Border and Titlebar display policies set to Never. U NIVERS 171
This makes the "docked" window appear to be joined seamlessly with the current main window.

These screens are usually tall and skinny or short and wide, depending on the side they're
docked to. The purpose of a docked window is to make some information always available;
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typically navigation controls and overall status information. Using docked windows can help

eliminate repetitive design elements from being copied to each screen, making maintenance .
easier. Docked Windows -

Setting which side the window is docked on is done through the window's Dock Position property. Order Precedence
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E Layout

Location X0 Y:0
Size Width: 800 Height: 600
Minimum Size Width: 0 Height: 0

Docking Settings

Having multiple docked windows means you need to decide how you want them to appear in
relation to each other. For that, Ignition has several settings.

The Dock Index is a property on the window that determines the order of docked windows if
multiple windows are docked to the same side. The window with the lowest Dock Index will appear
closest to the edge on that side, whereas the highest Dock Index will appear closest to the middle
of the client.
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The remaining three settings are located in the Project Properties > Vision > User Interface section:

® Axis Precedence - Project wide property that determines which sides get to extend to the
edge of the window, North and South or East and West.

® Prevent Popup/Docking Overlap - When set to true, then floating (popup) windows will
not overlap with docked windows.

® Infinite Desktop - When set to true, then the desktop area will be expanded if windows
are dragged out of frame.
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u Permissions | Minimum Size

Cger | WM a0 (s
% Vision Height 600 %
B Design Client Background Color
m General - ®
B Launching

B Login Client Menu

B Permissions Dialog 12pt bold

M _Timing I v ——
L User Interface Hide Menu Bar
Perspective Hide Windows Menu

B General Touch Screen Keyboard Width
W Permissions 75%
W TagDrop

Docking

Axis Precedence | North/South -

Prevent Popup/Docking Overlap
Infinite Desktop

i

North Docked Window

South Docked Window




Related Topics ...

® Vision Project Properties



Popup Windows

A popup window is typically a window that “floats" on top of the main window. It can be resized
and moved around by the user, all while the main window is still open in the background. Popup
windows are great for displaying additional information about a selected item on the screen, for
example a details screen about one particular component. Popup windows are often opened by
components in a main window, and are meant to be on top of the screen. They are used to view
setpoints and zoom into a specific area.

The great thing about Popup windows is they can also be parameterized so they can be reused.
One popup window design can be reused for many components as long as the proper information
is passed to the popup window.

On this page

® Creating a Popup
Window

® Opening a Popup
Window

® Popup Window
Properties
® Layer
® Location

® Parameterized
Popup Windows

® Multiple Instances
of a Popup Window
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Window

Watch the Video
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Creating a Popup Window

Before you can open a popup window, you have to create it. Like main windows and docked windows, popup windows are simply windows
that have specific settings. In particular, popup windows are floating windows that are not set to start maximized. In the Designer, when
adding a new window, selecting the popup window option creates a window with these presets. Once you have your popup window created,
you can make it as big or small as you want. You can also set properties in the Property Editor to make it closeable, resizable, change the
title, and display the title bar and border in the window.

Vision Property Editor a _ X Test Project 5JP - Popup
4 | = | =Bl R - Command  Windows  Help
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Opening a Popup Window



In any window, you can add a script to any component to open your popup. This is easiest to do from a component like a button on the main
window using the Navigation Script Builder. Simply select the Open action and the window that you want to open. Clicking on the button will
then open the popup window that was selected. Alternately, you can use one of the many scripting functions that open a window.
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this is used with buttons, where the action is that |~ this event. hd

oK Apply Cancel

Popup Window Properties

There are a few properties of the Window that are useful to popups.

Layer

The Layer property of windows controls the z-order of the windows. Windows with a higher Layer will always be on top of windows with a
lower Layer, regardless of which window is in focus. This is useful for keeping popup windows at the forefront. By default, all windows have a
Layer of 0, but we can change this so that popups always remain on top. If popups have a layer that is the same as the main

window, clicking on your main window makes it look like the popup window disappears, but it's actually behind your main window. The Windo
ws Menu will show you all the open windows in your Client, with the popup still being open.
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The Layer property is located on the window object itself, in the Property Editor. Simply set it to a higher value so that the popup is always on
top.
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Location

Popup windows can also be given a specific location to open up at, when the not being automatically centered by the script. In the Vision
Property Editor, go to Layout > Location and provide a specific X and Y position (in pixels).
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1. When opening a popup window to a specific location, ensure the Open and Center option is unchecked so that it doesn't override

the location coordinates.
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Parameterized Popup Windows

A parameterized popup window lets you pass information from one window to another

window. You can make a single popup window, change what it does and what it points to from a
parameter(s) that gets passed into the receiving window using Custom properties. Parameters can
range from simple integers and strings, to properties on the window that is opening the popup, and
even entire UDT custom properties.
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Multiple Instances of a Popup Window

By default, the client only opens a single instance of a popup window, but you can change this

behavior. For example, suppose you have four different Tanks passing all the same parameters " p INDUCTIV]
with the only difference being the individual Tank number. In order to see all four instances of your v, i UNIVE RSI']
tanks, you need to configure component scripting to display Additional Instances. This is done by -

selecting the Additional Instance option when setting up the navigation scripting action.

Alternately, the system.nav.openWindowlnstance can be used within a more complex script
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Parameterized Popup Windows

A parameterized popup window lets you pass parameters from one window into a popup window,
where the receiving popup window could then use that parameter to display relevant information.
This also allows you to maintain a single window that can be used to display similar information.

For example, suppose you have two compressors: Compressor 1 and Compressor 2. Imagine
clicking on one of the compressors on the main window and a popup
displays the diagnostic information about that specific compressor. Instead
of creating a popup window for each compressor, you can create a single
popup and use indirection with the passed parameter to display a different
compressor's information depending on which was selected.

Passing Parameters to a Popup Window

To pass parameters from one window to a popup window, the receiving popup window must have c
ustom properties that receive the passed parameters. When the event on the parent window is
called, the parameters are passed to the receiving Popup Window's custom properties on its root
container. The component's properties on the receiving window can use the root container's
custom properties to address their bindings.

The following examples explain how to setup a main window and a popup window to pass

compressor numbers to the popup window in order to display relevant information about each
Compressor.

Setting up the Popup Window

1. Right click on a folder in the Project Browser and select Popup Window to create a new popup.
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. Drag a Compressor image from Symbol Factory.
. Drag a Label component from the component palette to your window.

. Create a custom property on your popup window that will receive the passed parameters. Right click on your window and select Cust
omizers > Custom Properties. The Custom Properties window is displayed.

. Click the Add + icon to add a property.
. Specify a Name for the Custom Property, such as compNum, and click OK.

Custom Properties -

Name Type Description =5

Ccomptum | imeger ||

=

oK Cancel

The custom property is created and displayed in blue at the bottom of the Property Editor.
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7. Let's use an expression on the Label to show what compressor number we are on.

a. Select the Label and click the binding @ icon for the Text property.
b. Select Expression for the binding type.

c. Click the Insert Property Value [E] icon in the Expression window and choose the compNum custom property on the root
container for the compressor popup window as shown in the image below. Click OK.
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8. Now, let's update the Expression using the script below to show the word "Compressor" before the number in the label. Update
the Expression as follows.

i Script to change the compressor number
i "Conpressor " + {Root Container.conmpNun}

9. The expression should look as follows in the Property Binding window. Click OK to save the property binding.
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Setting up the Main Window

1. In a Main Window (parent window) drag a Button from the component palette to your window. Type "Compressor 1" into the text
property.

Fle Edit View Project Component Alignment Shape Tools  Help

B M|« 4 (Y 5 & || 4 0-»|~F-2 Q|1 2 0 h|&
Project Browser a - X P B LU L P
Q, A : s ; _______ .!

[z ClientEvents ~ : ]

+ ™ windows 1 @ Compressor 1 e

& Main Windows ] \ !
« [™ Acme_Main Window L T &

521

+ [] Root Container

[ ||| TmButn

™ alarms
™ ca

2. Let's add a script to the button which opens the popup that we created earlier. We can then pass in a value to designate that this
button should be opening Compressor 1.

Right click on the Compressor 1 button and select Scripting.

Under Event Handlers, select actionPerformed.

Click the Open / Swap radio button.

Under Window, use the dropdown list to select the path to your Popup Window (i.e.,Popup_Param_Test).

Check the Pass Parameters check box, and click the Add icon to add a parameter.
Click the new row under Parameter Name and a dropdown list will appear. Select the custom property compNum.

-~® 2o0oT®

1 Ignition will automatically check the Root Container of the window selected in the Window dropdown. If you do
not see the compNum parameter, it may have been created on wrong component, so check the Root Container
of the Compressor Popup window.



g. Enter "1" in the Value column because the button will be for Compressor 1.
h. Click OK to save the script.
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3. Now, create a second compressor button. A quick way to do this is duplicate (Ctrl D) the Compressor 1 button so it inherits the
script. Update the Text property to Compressor 2.

4. Right click on the new Button component and select Scripting. Update the parameter Value being passed in from a "1" to a "2".
5. Click OK to save the script.
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6. Test it out by putting the Designer in Preview Mode. Click one of the Compressor buttons, then navigate back and click the other
Compressor button. While these buttons are opening the same popup, they display different information because they are using the
parameter that we passed in for indirection. In this example, we just used a label, but the parameters can be used in things like indire



ct Tag bindings or scripts to pull in various Tag bindings.

Compressor 2

Passing a UDT to a Popup

In addition to the basic types, parameters can be a complex UDT type. This works much the same

as passing in basic values, where the popup window has a custom property on the root container,
and a parameter is passed in when opening the window.

The difference is that the custom property on the popup window needs to be a UDT that has been
previously defined, and the value being passed in when opening the window needs to be an entire
UDT instance. This gives the popup access to every Tag within the UDT, which can be useful
when making popups that show all the details of a certain area which has a UDT.
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Navigation Strategies in Vision

Navigation Strategy

Setting up a navigation strategy allows you to navigate between different windows in the runtime
Client. Ignition provides several different types of runtime navigational strategies you can choose
from when designing your project. Before selecting the proper navigation strategy for your project,
there are several things to consider. These considerations will help you determine the best
navigation strategy to use for your project and your users. Once you address these
considerations, then you can choose the best navigation strategy from the types below.

Does your project have a lot of windows?

How complex is your project structure?

Is your project structure organized?

What types of things are you doing?

Do you want to use navigation windows or fill the screen?

Types of Navigation Strategies

To help you select the right strategy that fits your project structure, here is a brief description of
each navigation strategy that Ignition provides. Keep in mind your project structure, size,
organization, and types of things you are doing while you are reviewing these strategies so you
can select the best runtime strategy for your project.

® Tab Strip is a simple strategy used for small structures regardless of how organized your
project is. It lends itself perfectly to only having a few windows and showing all of them on
a navigation window. Having too many tabs does not work well with the Tab Strip
because of size limitations. You want your users too see all the navigation tabs
immediately on the first screen. The Tab Strip works by clicking to swap one main window
for another.

® 2 Tier is similar to the Tab Strip, but is good for small and regular size project structures
where windows are grouped. It contains a second level of tabs allowing you to navigate
around various areas of your project. This strategy has a docked window that contains
tabs that are always open to do navigation, and the main window which fills the rest of the
space.

® Tree View is excellent for large project structures. You can view the entire project
structure at a glance allowing you to navigate to any structure within the multi-tier Tree
View component.

® Back and Forward Buttons are perfect if you have a small process with ordered
steps. It is one big main window that has Back and Forward buttons to step through each
process step or operation one right after the other.

® Drill Down is ideal if you have different geographical locations, whether it's in a local
facility or facilities sprinkled around the world. The project opens with an overview that
has areas that correspond to specific locations/areas in your facility. With the Drill Down
strategy, you can select a specific area representing the facility, and the client swaps
windows to display details pertaining to that specific area.

® Menubar is ideal for maximizing the usable screen space, while still having the ability to
navigate to any window at any time by selecting from a list of windows.

® Retargeting enables navigation between multi-project operations: a simple script can
push the user between many different projects, even on different gateways.

Tab Strip Navigation

2-Tier Navigation

On this page

® Navigation Strategy
® Types of
Navigation
Strategies
® Tab Strip
Navigation
® 2-Tier Navigation
® Tree View
Navigation
® Back and
Forward Button
Navigation
® Drill Down
Navigation
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Navigation
® Navigation
Operations -
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Navigation Operations - Swapping vs. Opening

Any time you open a window, you have to use one of the two navigation operations: Swapping or
Opening. These operations can be performed on any type of window, but are usually reserved for
specific cases. Navigating between different windows typically involves some sort of scripting, but

the Navigation Script Builder makes this a simple task. Otherwise, you can use the specific

scripting functions to completely customize navigation.

Swapping vs.
Opening

Watch the Video

INDUCTIV]
UNIVERSIT


https://legacy-docs.inductiveautomation.com/display/DOC80/Script+Builders+in+Vision#ScriptBuildersinVision-NavigationScriptBuilder
https://www.inductiveuniversity.com/video/swapping-vs-opening/8.0

& ComponentSeripting Button]

% Event Handlers < ¥ SetTagValue [ SQLUpdate m SetProperty [ ScriptEditor

G action

No Action

Open/ Swap

Open Pass Parameters

& mosevoton and Center Parameter Name Value +*

G propertyChange and Close This Window ®
% Custom Methods Additional Instance D

5 d

Swap

UNIVERSIT

Forward /Back

Close

B security ®p Confirmation. E l' g a‘ 0
Functions
This event s fired when the 'action’ of the component occurs.
What this action is depends on the type of the component. . ’:‘"‘* ot fred th
Most commonly, this is used with buttons, where the action is ‘The component that fired this event.
that the button was pushed, via a mouse click or a key press.
See the component reference for details on what the action -
ars o oher comporens Watch the Video

oK || Apply || Cancel

Opening

Opening and by extension closing are the basic window navigation options. Opening a window
opens the window at the same size it was in the Designer, unless the Start Maximized property is t
rue or the Dock Position is not Floating. This is typically reserved for opening popup windows.
They have a scripting function that can open and a function that can close.

® system.nav.openWindow
® system.nav.closeWindow

Swapping

When Ignition swaps a window, it closes the current main window and then opens another window
in its place. This is typically reserved for moving between main windows, as it performs the close
action automatically. There are two different scripting functions that can be used to swap windows,
depending on what needs to be done.

® system.nav.swapWindow
® system.nav.swapTo

Common Navigation Mistakes

Multiple ‘Main' Windows

The most common mistake that will cause windows to stay open unintentionally is to implement a swapping navigation system using the syst
em.nav.openWindow() function on main windows instead of swapTo. When you do this, the next time the swapTo function is called, it may
swap from a window that is hidden behind the current 'Main' window and look like nothing happened. It is easy to check the client's Windows
menu to see what windows are currently open. If there are more windows listed there than you can currently see, there is a problem in your
navigation logic that is failing to close windows properly.

Swapping a Main Window with a Docked Window

Another common mistake that will cause windows to stay open unintentionally is to implement a swapping navigation system using the syste
m.nav.swapTo() function on windows that are docked. This will cause your docked windows to be 'swapped in' as a maximized window
instead of its usual size. When you do this, the client will not see it as a main window and next time the swapTo function is called, it may not
have space on screen to open the main window. Logging out and back in to the client (or restarting it) is the only solution to this. Identify the
offending button or script that is swapping the docked window and change it accordingly.

In This Section ...


https://legacy-docs.inductiveautomation.com/display/DOC80/system.nav.openWindow
https://legacy-docs.inductiveautomation.com/display/DOC80/system.nav.closeWindow
https://legacy-docs.inductiveautomation.com/display/DOC80/system.nav.swapWindow
https://legacy-docs.inductiveautomation.com/display/DOC80/system.nav.swapTo
https://inductiveuniversity.com/video/navigation-functions/8.0




Navigation - Tab Strip

The Tab Strip component provides a simple navigation strategy used for small project structures
having only a few windows. It allows users to see all the navigation tabs on the first screen of the
client. It is most commonly used in a docked window to provide automatic window navigation. The
Tab Strip works by clicking on a tab to swap one main window for another. The Tab Strip has two
navigation modes:

® Swap Windows - the Tab Strip automatically calls system.nav.swapTo() with the name of
the selected tab for easy navigation from one window to another.

® Disabled - the Tab Strip doesn't do anything when a tab is pressed. Users can customize
tabs using property bindings or by responding to the propertyChange scripting event.

A Tab Strip is an effective primary navigation strategy, particularly when you don't have many
items to choose from.

Tab Strip Navigation Example

On this page

® Tab Strip
Navigation Example
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Watch the Video

Tab Strip navigation is simple to setup. In the following example, we'll setup a small project that has a few windows which are visible on the

navigation tabs.

1. Add a Tab Strip component to a window, typically a docked window.
2. Right-click on the Tab Strip component, choose Customizers > Tab Strip Customizer.

3. In the Tab Strip Customizer you can specify which window to open with each tab. Notice the Navigation Mode property which is set

to Swap Windows as shown in the screenshot below.

4. To create a new tab, click Add Tab. If you have a tab already selected, clicking the Add Tab button creates a Tab with the same

colors and font as the selected tab.

@ Main Windows already created

This step assumes you already have your main windows created in your Project Browser.

a. Under Window Name dropdown list, select the window you want to open. Note, it is the full path from the window and not

just the name (i.e., Main Windows/Main Window 2).
b. Enter the Display Name for your new tab (i.e., Main Window 2).

c. With the Move Up, Move Down, and Remove Tab buttons you can move tabs up and down on the tab strip, and remove a

tab if it is no longer required.

d. You can also set the Background and Foreground colors when to show when a tab is selected and unselected.

e. When you're finished, press OK.


https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Tab+Strip
https://legacy-docs.inductiveautomation.com/display/DOC80/system.nav.swapTo
https://legacy-docs.inductiveautomation.com/display/DOC80/Component+Events#ComponentEvents-PropertyEventHandlers
https://www.inductiveuniversity.com/video/navigation-tab-strip/8.0
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5. Save your project.

6. Open your project in the Client, and see that each tab navigates to a different window. As you can see, the Tab Strip works by
clicking on a tab to swap one main window for another.
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Navigation - Two Tier

Two Tier Navigation is similar to the Tab Strip navigation strategy. It's good for small and regular
size project structures where windows are grouped, and lets you organize your main windows into
different sections making navigation easy for users. It uses two levels of tabs to navigate around
various areas of your project. Once you select a first tier tab, a different set of tabs appear in the
second tier to switch between different windows.

This works a bit differently than the default Tab Strip navigation, as the first tier Tab Strip will
actually not do any window swapping, which will instead be left up to the second tier of tabs. The
Two Tier approach has a docked window that contains multiple sets of tabs. One set is used as a
higher level of grouping of windows, and is used to conditionally swap out another set of tabs
based upon user selection.

In the image below, the top tier of tabs contains the HMI Screens and Administration tabs.
Clicking on HMI Screens makes a second tier of tabs appear (the set containing Overview, Alarms
, and Empty). Clicking on the Administration tab would make a different set of sub tier tabs
appear. Thus, the top tier of tabs isn't directly responsible for any sort of window navigation.

Rather, it's used to make other sets of tabs appear.

o

3 Overview

Two Tier Navigation Example

On this page

® Two Tier Navigation
Example
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Watch the Video

In this example, we are using the 2-Tier Tab Nav project template which is selectable upon project creation. By default, 2-Tier Tab navigation
comes with two tiers tab strips and several default tabs. We will add one tab on the first tier and two tabs on the second tier.

1. Right click on the First Tier Tabs in the Project Browser to add another tab. Select Customizers > Tab Strip Customizer.
2. To create a new tab, click Add Tab, and position it on the tab strip any where you like. Enter your Window Name and Display Name
. Make sure the Navigation Mode is set to Disabled since this first tab strip is not swapping to any windows.
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3. Now let's create a second tier category of tabs for the Reports tab. The easiest way to do this, is copy the second tier of tabs from

either the HMI Screens or Adminstration tabs in the root container of the Navigation folder of the Project Browser. Paste it in the root
container of the Navigation folder giving it a unigue name identifying what it is (i.e. Reports Tabs).


https://www.inductiveuniversity.com/videos/navigation-2-tier/8.0/8.0
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4. Right click on the Reporting Tabs Tab Strip of the Designer and select the Customizers > Tab Strip Customizer.
5. Add Tabs like you would for a normal Tab Strip, but only add tabs that fit that category of windows. In this step, we are adding two
tabs: Report 1 and Report 2. Click OK to create the new tabs.

Note: This example assumes you already have some main windows created in your Project Browser (i.e., Report 1 and Report 2).

6. The second tier tabs can be shown or hidden depending on what tab is selected in the first tier.
a. Select a second tier Tab Strip (i.e.,Reports).

b. Go to the Property Editor, select the Visible property and set it to true, and then select its binding &2 icon.
c. Select the Expression binding and set up an expression to be true when the appropriate first tier tab is selected, as shown
in the image below. Click OK.
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® No Binding

7. Save your project.
8. Open your project in the Client, click on the various tabs to see your first and second tier tabs switch between the different windows.

The following images show the first and second tier tabs for HMI Screens and Reports tabs.
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Navigation - Tree View

The Tree View navigation strategy is excellent for large project structures. It uses a typical
navigation strategy again with a docked west window that contains a Tree View to navigate around
to various areas. Users can double click on an item in the tree view and it will swap out one main
window for another. The list is fairly compact, and can contain folders, helping you to group similar
windows just like you would in the project browser.

Ignitio ‘./

by inductive automation

~ @ Administration
Settings

~ [ HMI Screens
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i) Empty
5 Overview
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Tree View Navigation Example

On this page

® Tree View
Navigation Example
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In this example, we are using the Tree View Nav project template which is set up when the project is created. By default, Tree View
navigation comes with several default folders to help get you started. This simple example adds one new main window.

1. Once you create your project and set the Tree View as your navigation strategy, open the Project Browser, and expand the Main
Windows folder. Click the Navigation folder to open the skeleton project, then select the Tree property.


https://www.inductiveuniversity.com/videos/navigation-tree-view/8.0/8.0
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2. From Property Editor, find the Items property and click on the Dataset Viewer B icon.
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3. This brings up a dataset editor. You will see a number of columns that identify how each tree view item is displayed. Each row
corresponds to a node in the tree view. The windowPath column is the window that we want to navigate to. The path is the folder
that the window will display in the Tree View.

Note: This example assumes you already have your new window created in your Project Browser.

4. Let's add a new main window under Administration. To add a new Main Window (i.e., Reports) we first need to add a row. Click the
ma
Add Row icon = and populate the fields manually using the data from the previous row, or you can also copy the entire dataset
into a notepad where you can manually manipulate the data to add a row, and then paste it back into the dataset editor. Click OK.

Note: Do not use the Tree View Customizer to edit any of your data. Use only the Dataset Editor, otherwise it will overwrite that
item's dataset.
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5. You can then add a script that will use the newly added windowPath to open the correct window when a user double clicks on a
node. Right click on the Tree View component and select Scripting.

6. Select the mouseClicked event handler, and add the following script to the Script Editor tab.

mouseClicked code

# 1f the user perforns a double click, open the appropriate w ndow
if event.clickCount == 2:
row = event.source. sel ectedl tem
data = event.source.data
if row!=-1:
# Grab the wi ndow path value out of the tree view s itens dataset
wi ndowPat h = dat a. get Val ueAt (row, "w ndowPat h")
syst em nav. swapTo(w ndowPat h)

@ Component Scripting [Tree] — m} X

~ [ mouse > —
| e L} e e
21if event.clickCount =

mouseEntered
mouseExited 4
mousePressed 5
mouseReleased 6
7

8
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2:
3 Tow = event.source.selectedItem A g
data = event.source.data
if row -1:

» i mouseMotion

» i propertyChange

@ Custom Methods
+

system.nav.swapTo(windowPath)

7. Save your project and launch the Vision Client and test out the Tree View navigation.
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Navigation - Forward and Back Buttons

Another navigation strategy in Vision is to set up Forward and Back Buttons to navigate between

different windows. This strategy is perfect for a small business process with ordered steps. It does .
not have a docked window, tree view, or tabs to navigate around. It is one big main window and On this page
has buttons to navigate forward and back from one Main Window to the next in the list.

Test Project
® Forward and Back

Buttons Example
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Forward and Back Buttons Example

In this example, we'll use the forward and back buttons on a main window to navigate between different windows in a project.

1. Inthe Project Browser, right click on the Main Windows folder and create a new Main Window. Enter a name for your window to
whatever best describes the window (i.e., Main Window 1). Add a label to the window for clarity (i.e., Main Window 1) so when you
navigate through different windows, you know precisely what window you're viewing. Repeat this step to create Main Window 2 and
Main Window 3.


https://www.inductiveuniversity.com/videos/navigation-back-and-forward-buttons/8.0/8.0
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From the Component Palette in Designer, drag a Button component to your Main Window 1. Label the button, Main Window 2.
Next we'll add a right green arrow to the Button component. With the Button component selected, click the folder to the right of the Im

age Path property . This opens the Image Management Tool.

Open the Built-inf/icons/24/ folder and select a right green arrow. Close the Image Management Tool.

T T R L I - [Ein n i n JE3

] |E Main Window 1

B ¢ -2
0«: Main Window 2 E> @
o g )

4.
5. Set the Horizontal Text Position property to Left in the Property Editor.

ﬂn Property Editor g - X

B4 = = el %
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Data
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Font Dialog, Bold, 12 - u:
Foreground Color 46,46,46 - ® = |
Background Color 250,250,251 - @ |
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Border Painted? [ true e "]
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Image Path = |5
Disabled Image Path G| 1
Icon-Text Spacing 46D 7
Styles <No Data> Eeo| | ]

= Layout
Margin Top: 0Left: 0Bottom: ORight: 0| |_7
Horizental Alignment Center - & ?r
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©Q Tip: You can drag images and folders into this window for easy uploadi...

6. Now you need to tell the Main Window 2 button what to do when a user clicks on it. Right click on the Main Window 2 button, select

Scripting. The component scripting dialog box will open.
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Security Cri+E

Translations Ctrl+T
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Run Diagnostics

7. Under the Event Handlers, open the action folder and select actionPerformed.
a. Click the Open / Swap and Swap radio buttons. The Swapping function builds a simple script to go back and forth between
different windows. The Swap function ensures only one main window will be open at a time.
b. From the Window dropdown box, select Main Windows/Main Window 2.

c. Click OK.
Qﬁ Component Scripting [Button 1] - m} X
@ Event Handlers ¢ [INavigation [ SetTagValue |[ESQLUpdate M SetProperty [ [ Script Editor
v action »
No Action
b focus © open/sSwap
r G key Open Pass Parameters
2 mouse
9 . Parameter Name Value +
b 753 mouseMotion
b 5 propertyChange ®
@ Custom Methods J
L
Window:
Main Window 2 v
Forward / Back
Close
B security... R Confirmation...
Event Description Event Object Properties
This event is fired when the action’ of the compenent |~ A
occurs. What this action is depends on the type of the |~ @ source _ =
Apply Cancel

8. Save and Publish your project.
9. Open your Client. Click on the Main Window 2 button and Main Window 1 will be swapped out with Main Window 2.
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|.‘; Main Window 1

Main Window 2 l::>

10. Repeat Steps 2 and 3 to create Main Windows 2 and 3, respectively. On Main Window 2 make sure you have a button for both Main
Window 1 and Main Window 3. Set your window path for the Main Window 1 button to Main Windows/Main Window 1 (refer to step
4). For the Main Window 3 button, set the window path to Main Windows/Main Window 3.

11. In this image, Main Window 2 is open. By clicking either button, it open the respective window. Click on the Main Window 1 button,
and Main Window 2 swaps out and opens Main Window 1. Click on the Main Window 3, and Main Window 2 swaps out and opens
with Main Window 3. You'll notice that you always have one main window open.

|& Main Window 2

<,1:I Main Window 1 Main Window 3 l:;>



Navigation - Drill Down

Another popular navigation strategy is to drill down into various areas of your project using a map.
The Drill Down navigation strategy is ideal if you have different geographical locations. A good .
example is to have a main window that has an image representing a plant or factory. The image On this page
can have any type of drawing tool component, such as an rectangle, circle, etc., that overlays the
image. When the user selects one of the overlay components, the Client swaps windows with a
window that displays information that pertains to the selected area of the plant.

It is a very simple navigation strategy to setup and is popular because it lets users select different
areas on an image and drill down to access specific information about that geographic location.

® Drill Down
Navigation Example

TRN_Version_ViionTest - Main Windows I

Command  Windows  Help
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Navigation - Drill
Down

Watch the Video

Drill Down Navigation Example

This example demonstrates how to use a US map and configure it to get information about different geographical facilities sprinkled across

the US.

1.
2.

3.
. Select the mousePressed event handler, and with the Navigation tab selected.

Drag an image on to a Main Window. It can be any type of image including a photo. This example uses an image of a US Map.
Add a Drawing Tool shape such as a rectangle, circle, polygon over an area on your image to identify the location. In the example,
we use different color circles.

Right click your drawing tool and select Scripting.

a. Select the Open/Swap radio button.
b. From the Window drop-down box, select the window that relates to the selected area on the map.
c. Click OK.
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5. In the Project Browser, select your US Map window and set it to Open on Startup.

Project Browser Bl
Q- Al

| | | ~-B usmap [ AT
b |:| Root _
» A9 BIZ

5 Cir (g Close & Commit
& Cir (@ Close & Revert
£5 Cir
£ Cir [l OpenonStartup
S m [ @ About Window

@ Area windows already created

This example assumes you already have your area windows created in your Project Browser.

6. On your area window, add a Button component so you can navigate back to the main window containing the overview map. (If you
have multiple area windows, copy and paste this button on to each window).
a. Open your area window.
b. Add a Button component.
c. Right click on the Button component and select Scripting.

Project Browser Ao X L L e, P LT L 399, L I
= ° 7 Folsom. cA i E
4 |
~ g Main Windows “11 3 olsom. ““ US Map
M alarms a2 3
~Mca 7 Gateway Name: Folsom
+ [ Root Container g‘* 1P Address: 10.10.1.10
- E = 1 support Contact: 800-800-000
swi Label 1 g
wwi | abel 2
ww | abel 3 |

7. Select the mousePressed event handler, and with the Navigation tab selected:
a. Select the Open/Swap radio button.
b. From the Window drop-down box, select the window that is your overview map.
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10.

c. Click OK.
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@ source

oK Apply

b X+

Cancel

In Preview Mode, test your window navigation by switching between windows.

. Save your project.

Now, try it out by opening your Client, and clicking on a shape to navigate to the area selected. A new window will open each time
you select a designated area on the map. You'll notice that in the following image, the Mouseover Text property was used to display
the location information when you hover over one of the circles.

TRM_Version_VisionTest - Main Window — m] x

Command  Windows  Help




11. Click on the US Map button to go back to the US Map.

Pl TRMN_Version_VisionTest - Main Window

Command  Windows  Help

Folsom, CA

Gateway Name: Folsom
IP Address: 10.10.1.10
Support Contact: 800-800-000

USs Map




Navigation - Menubar

You can set up a special menu within the Menubar that allows you to navigate throughout the

project using the scripting functions. They can be simple, like swapping to a window, or be more .
complex in how they navigate around the project. The benefit of using the Menubar for navigation On this page
is that it keeps navigation tucked away instead of using up valuable screen space.

Command PENMGENGGEN Windows  Help

W Overview

@ USMap ® Menubar Navigation
)

@ HMIMain Example

&

Switch User

Menubar Navigation Example

In this example, we'll setup a new menu option or sibbling on the menubar as well as a child option. This example assumes you have these
additional windows created.

1. In the menubar of the Designer, click on Project then select Client Events.

File  Edit View Component  Alignment

M N « 4 | it Comm Off
roject Browser ' O 1F  Comm Read-Only
Q 1 Comm Read/Write

i Main Wine Froject Properties

[ Alarms

[ || »Bca

A4
b ™ Empty & SessionEvents

Gateway Events

M HMI M Client Events

M HMIw

™ Main W P Preview Mode

B overvie &  Preview Language >

[ e RV R Y ETS

2. This opens the screen below in the Client Event Scripts space. Click on the Menubar under Client Event Scripts.

3. Select the Add Sibling E icon to add a Menu Item. Update the Name to a new menu option (i.e., Navigation). You can also add a
path to an icon if desired.
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4. Click the Apply button.

5. Click the Add Child icon to add a new option under the Navigation menu.
a. Give the menu item a name that is appropriate for the window it will be navigating to (i.e., Overview).
b. Add a script that will swap to the window.

Code Snippet - Menubar navigation

system nav. swapTo(" Overvi ew")

% Client Event Scripts - O *
p
Client Event Scripts Client Menu Bar
[ Startuy Configure the menu bar for the Client
P
(2 shutdown
a Shutdown-Intercept Menu Structure « - Item Properties
b Command E »| Name Icon
[E Keystroke + Navigation ) I . Q
) . Overview Builtinficons/6/clients.png |
& Timer
Toolti
[ Tag Change P
ot Message Accelerator Mnemonic Character
-None-| B @
Action Script
1system.nav.swapTo( "Overview") ~
< >
oK Apply Cancel

Repeat step 5 to add as many windows as needed. New groups of windows can even be nested within the parent Navigation Menu.
Click OK to save your new menu structure.

Save your project.

Now, open the Client to navigate from one window to another using the menubar structure. Notice that Navigation menu option is
located in the menubar because it was created as sibbling. All the other menu options were created as children under Navigation.

. By default, there are three commands under the Command menu option: Logout, Lock Screen, and Exit.

©cP~No
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Navigation - Retargeting

Retargeting is a special form of navigation which involves navigating to an entirely different project.
Retargeting is accomplished through scripting, usually as a response to a button press or .
other component event. The system.util.retarget() function allows you to 'retarget' the Client to a On this page
different project. You can have it switch to another project on the same Gateway, or another
Gateway entirely, even across a WAN. This feature makes the vision of a seamless, enterprise-
wide SCADA application a reality.

The retarget feature will attempt to transfer the current user credentials over to the new project /
Gateway. If the credentials fail on that project, the user will be prompted for a valid username and
password. Once valid authentication has been achieved, the currently running project is shut
down, and the new project is loaded.

® Retargeting
Navigation Example

You can pass any information to the other project through the parameters dictionary. All entries in
this dictionary will be set in the global scripting namespace in the other project. Even if you don't
specify any parameters, the system will set the variable _RETARGET_FROM_PROJECT to the
name of the current project and _RETARGET_FROM_Gateway to the address of the current

Gateway.
o @ INDUCTIV]I

Retargeting can be as simple as 1 line of code, just make sure you are using the project name (no
spaces allowed), and not the title. See the retarget function in the appendix for more information. U NIVE RS I']

A typical retargeting strategy actually combines this strategy with one or more other navigation

strategies. A simple landing project could be made that all users would have access to, which

would allow users to do some basic user management functions, as well as a screen with a button Retarg eti ng

that retargets out to other projects, with each project having a specific purpose, or targeting a

specific area of operations. The buttons that retarget to these projects can be hidden or shown

based on the user, allowing you to build in an extra layer of security to your projects. Additionally, Watch the Video
each of the other projects would utilize navigation strategies that best suit those areas.

Retargeting Navigation Example

In this example, we have two projects that we will setup to retarget to each other.

1. On ablank window, add a Button component, and either change the button text or add a label that informs the user that the button
retargets to a new project.

2. Right click on the Button and select the Scripting option. On the actionPerformed event, add this script to the script builder, and
click OK.

Python - Retargeting to Another Project

# Retarget to another project on the sane gateway.
# This script can be run fromany button in a project.
systemutil.retarget("M/_Q her_Project")
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The script below was added to the button in the Tank project. A similar script was also added to the Motor project.

&% Component Scripting [Button] - O X

& Event Handlers ¢ [] Mavigation % SetTagValue &= SQLUpdate [=] SetProperty [E Script Editor

- @ action 4 L
- 1# Retarget to another project on the same gateway. A=
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i focus 3 system.util.retarget("Tank Project")
key

L 2

mouse
mouseMotion
propertyChange
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3
2
»
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& Custom Methods

+toRBERE

< >
Advanced Settings

Event Description Event Object Properties

This event is fired when the 'action’ of the S e

oK Apply Cancel

3. This can be repeated with more buttons and scripts that lead to other projects. Save your projects.
4. Open the Client, and use the retargeting feature to navigate between two different projects. Press the Retarget buttons to navigate
between the Tank project and Motor project.

Tank Project - Main Window Motor Project - Main Window

command  Navigation  Windows  Help Command  Navigation ~ Windows  Help

Water Tank Project " | I . ﬁj

REtarneCLothe MotorBioicce b 1 Retarget to the Water Tank Project



Working with Vision Components

The Vision Module comes with a host of built-in components that you can select from for use in
your project. One thing that you'll find when working with components is there are a few different
ways to manipulate and layout components on a window when working in the Designer. Here is a
small sampling of the components available in Vision. See the Vision Components Appendix page
for a complete list of components.

A a0 0 g
30 70

20 80

&'Units 90
100

Radio Button
Radio Button

Button

Series3

Series2

Series1

Oct15 Oct16 Oct17 Oct18 Oct19 Oct20 Oct21 Oct22 Oct23 Oct24

This section introduces you to how to work with components so you can learn how to quickly
select, move, resize, duplicate, and group components during the design process.

Selecting Components

There are a number of different ways to select components within a window, each of which have
their own advantages.

Mouse Selection

Using the mouse is the most common way to select components. Click the Selection ‘_ icon,
then click on a component to select it. If the component you want to select is obscured by other
components, hold down Alt and keep clicking, the selection will step down through the z-order.

You can also select components using window-selection. Click-and-drag within a container to draw
a selection rectangle. If you drag the window left-to-right, it will select all components that are
completely contained within the rectangle. If you drag the window right-to-left, it will select all
components that the rectangle touches.

On this page

® Selecting
Components

Mouse Selection
Tree Selection

® Component
Properties

Data Types
Dataset Editor

® Manipulating
Components

Resizing

Moving
Duplicating
Rotating

Size and Position
Component
Grouping
Component
Layout

® Relative Layout
® Font Scaling
® Anchored Layout
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Lastly, you can start dragging a window selection and then hold down the Alt key to use touch
selection. This will draw a line as you drag, and any components that the line touches will
become selected. As you're using these techniques, components are given a yellow highlight
border.

Tank

¢ Units 80 ~J

L 10

Tree Selection

By selecting nodes in the Project Browser you can manipulate the current selection. This is

a handy way to select the current window itself, which is hard to click on since it is behind the
Root container. However, you can click to it, using Alt-click to step down through the z-order. It is
also the only way to select components that are invisible.

Project Browser o _ X
A
+ = Vision -
Ef, Client Events
v U Windows

™ main window [+

|| -0 overview window

+ [] Root Container
(=) Button

. Cylindrical Tank
& Meter

w4 Wulti-State Button

Component Properties

Each component has a unique set of properties that can be set and modified within the Property
Editor. A property is simply a named variable with a distinct type that affects something about the
component's behavior or appearance. You can also create your own custom properties on the
component, which act like variables that can store any information that you want on the

@ INDUCTIVI
UNIVERSI]

component.
Component

Data Types Properties

There are a wide variety of datatypes across all of the Vision Module's components. Each property Waitch the Video

has a distinct type, which dictate what values will be allowed. Below are the common data types.

Numeric Types
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Bool
ean

Short
Inte
ger
fint
Long
Float

Dou
ble

A true/false value. Modeled as 0/1 in Python. Technically, O is false and anything else is true.

A 16-bit signed integer. Can hold values between -32,768 to 32,767, inclusive.

A 32-bit signed integer. Can hold values between -2,147,483,648 to 2,147,483,647 inclusive.

A 64-bit signed integer. Can hold values between -9,223,372,036,854,775,808 to 9,223,372,036,854,775,807 inclusive.
A 32-bit signed floating point number in IEEE 754 format.

A 64-bit signed floating point number in IEEE 754 format.

Non-Numeric Types

String A string of characters. Uses UTF-16 format internally to represent the characters.

Color
Date
Data
set
Font

Bord
er

Dat

A color, in the RGBA color space. Colors can easily be made dynamic or animated using Property Bindings or Styles.

Represents a point it time with millisecond precision. Internally stored as the number of milliseconds that have passed since the
"epoch”, Jan 1st 1970, 00:00:00 UTC.

A complex data structure that closely mimics the structure of a database table. A Dataset is a two-dimensional matrix (also known
as a table) of data organized in columns and rows. Each column has a name and a datatype.

A typeface. Each typeface has a name, size, and style.

A component border is a visual decoration around the component's edges. You can make a border dynamic by using the Style
Customizer, the toBorder() expression function, or scripting with the Java border object.

aset Editor

The Dataset Editor icon B appears next to the binding icon for the Data property. Clicking the icon brings up the Dataset Editor window

where you can view and make changes to the raw data. Note, that any changes will be overwritten the next time your binding polls.
Vision Property Editor o - X
12| 1 = A (R
> Common
Mame Table & =
> Data
Data Dataset [6R x 3C]|BS je2

With the Dataset Editor you can add and delete columns and rows, delete all rows, and copy information to or from the clipboard. When
adding columns you have multiple formats to choose from: string, date, integer, double, float, etc.
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The Dataset Editor icons and their corresponding actions are shown in the table below.

Icon Action

=F  Addrow

'=' Delete selected rows
it Addacolumn

Iii Delete selected column
<  Delete all rows

£ Add to clipboard

@  Paste from clipboard

Manipulating Components

@ INDUCTIVI
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Manipulating components can be done with both the mouse and the keyboard. You can move
components around, resize them, and rotate them.

Resizing _ _
Manipulating

When you select the component you want to resize, they'll get eight resize-handles displayed Com pon ents

around the edge of the selection. These handles look like double-sided arrows around the

perimeter. Use the mouse to drag them to change the size of the components in the selection. To

maintain the selection's aspect ratio, hold down Ctrl as you resize. To resize around the center of Waitch the Video

the current selection, hold down Shift. These can be used at the same time.

You can also resize the current selection using the keyboard. To nudge the right or bottom edge of the selection in or out, use Shift combined
with the arrow keys, which resizes by the nudge distance, which defaults to one pixel at a time. To nudge the top or left edge of the selection,
use Ctrl-Shift combined with arrow keys. To resize faster, hold the Alt key as well, to move the component the alt nudge distance, which
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defaults to ten pixels at a time.|

Moving

To move the component, simply drag it anywhere within the container's bounds. You can also move whatever is currently selected by holding
down Alt while dragging, regardless of whether or not the mouse is over the current selection. This is important because it is the primary way
to move a Container component. (Normally, dragging in a container draws a selection rectangle inside that container).

While a component is selected, you may also use the keyboard's arrow keys to move a component around the nudge distance. Just like
resizing with the arrow keys, to move the alt nudge distance, use the Alt key.

Duplicating

Components can be easily duplicated by dragging them as if you were going to move them and holding down the Ctrl key. This will drop a
copy of the component at the desired drop location. It is often useful to also hold down Shift key as you do this to ensure exact alignment.
You may also use the Ctrl-D shortcut to quickly duplicate a component in place.

Rotating

Shapes can be rotated directly using the selection tool. Other components cannot be rotated in this manner. To rotate a shape, first select it
using the selection tool so that you see the resize handles around it. Then simply click on it once again and you'll see the rotation handles
appear. Clicking (but not double-clicking) on selected shapes toggles back and forth between the resize handles and the rotation handles.

Once you see the rotation handles, simply start dragging one to rotate the shape or shapes. Holding down the Ctrl key will snap your rotation
movements to 15° increments. When the rotation handles are present, there is also a small red crosshair handle that starts in the middle of
the selection. This is the rotation anchor: the point that the selection will rotate around. You can drag it anywhere you'd like to rotate around a
point other than the center of the shape.

Size and Position

Components can also be positioned and resized with the Size and Position window. This window allows you to type in an exact pixel size of
the component as well as x/y coordinates that the component will be at (with the upper left point of the component moving to that point). To
access the size and position window, right click on the component and select Size and Position.
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Component Grouping
Shapes and components can be grouped together so that they act like a single component in @ IN DUCTIV]

the Designer. Grouping components is very similar to putting them in a Container. In fact, it is the

same thing as cutting and pasting them into a perfectly-sized container and then putting that U NIVE RS I']
container into group mode, with one exception. If the group contains only shapes and no other
kinds of components, it will be a special shape-group that has the ability to be rotated and has
some other shape-like properties.

Component
When components or shapes are in a group, clicking on them in the Designer will select the Grou pmg
group instead of the shape. If you double-click on a group, it will become "super-selected”, which

will allow you to interact with its contents until you select something outside of that group.

Watch the Video

Groups can contain other groups, creating a nested structure. Groups themselves are
also components, meaning that you can add custom properties to groups, bind them, and so on.

Difference between a Container and a Group

It is helpful to use Groups and Containers to organize the components on your window. You can
select multiple components and right-click to convert them into a group, then right-click again
convert that group to a container.
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Layout works differently for groups. The layout setting for components and shapes inside a
group is ignored. All members of a group act as if they are in relative layout with no aspect ratio
restrictions. This special group-layout mode is also active when resizing a group inside of the
Designer, whereas traditional (container) layout doesn't take effect in the Designer.

Component Layout
Layout is the concept that a component's size and position, relative to its parent container's size @ IN DUC TIV]

and position, can be dynamic. This allows the creation of windows that resize gracefully using
either Anchored or Relative layouts and can optionally keep the original aspect ratio. U NIVE RS Il]

This is a very important concept because of the web-launched deployment of Vision clients - they

often end up being launched on many different monitors with many different resolutions.
Component Layout

This is also important for components that have user-adjustable windows like popup windows.

Imagine a popup window that is mostly displaying a large table or chart. If you're running on a .

large monitor, you may want to make the window bigger to see the table or chart easier. Of Watch the Video

course, this is only useful if the table or chart actually gets larger with the window.

Changing a component's layout is as simple as right-clicking on the component and opening
the Layout dialog box. You can also alter the default layout mode that gets assigned to new
components. See Designer/Window Editing Properties.

There are two layout modes, and they are set on a per-component basis. Both affect the
component's size and position relative to its parent container. The root container's size is dictated
by the window size. To edit the layout of a component, right-click on the component and select Lay
out from the menu. the Layout Constraints window displays showing all the default settings. These
default settings can be altered in the Project Properties.

Layout Constraints >

Layout Mode
Belative Anchored
Relative Layout Options

Maintain Aspect Ratio
Center Leading Trailing

Scale Font

| |‘ Cancel ‘

Layout Modes

® Relative
This mode makes a component's size and location relative to its parent's size and
location. When the parent changes size, the component changes accordingly. This
creates components that auto-scale.

® Anchored
This mode makes the edge of a component's two axes (horizontal and vertical) anchored
to the edge or edges of its parent.

Relative Layout

Relative Layout is the default mode. This is a simple and effective layout mode that simply keeps a component's size and position constant
relative to its parent container, even when the parent container grows or shrinks. More precisely, it remembers the component's position and
size as a percentage of its parent's bounds at the last time the window was saved. Relative Layout also has the option of scaling a
component's font appropriately.


https://legacy-docs.inductiveautomation.com/display/DOC80/Project+Properties#ProjectProperties-WindowEditingProperties
https://www.inductiveuniversity.com/videos/component-layout/8.0/8.0
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Note, that Relative Layout mode respects aspect ratio. So if the parent component is distorted, the contents will not be. The extra space is
distributed evenly on both sides of the contents.

Relative Layout Options

® Maintain Aspect Ratio
If selected, the component's original aspect ratio is preserved. Otherwise, it can stretch tall or wide.

* Center
When maintaining the aspect ratio, centers the component with respect to its parent.

® Leading
When maintaining the aspect ratio, aligns the component with the parent's leading edge.

® Trailing
When maintaining the aspect ratio, aligns the component with the parent's trailing edge.

® Scale Font

If selected, the component's font will scale along with its size as the relative layout adjusts the component. This will override other
font size settings. If this setting is applied to a Group, then all components in the group will use this setting.

Font Scaling

By default, font scaling is enabled on all components, but it can behave differently on some components so it's good to test it out before
putting it into production. You can change the default Component Layout settings in Project Properties under Vision > Design > Relative
Layout Options.

Font Scaling on Individual Components



When individual components are dragged into a window, the following default Layout settings for each component are applied. All
components on the window default to font scaling.
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Layout Constraints x

Layout Mode
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Cancel
- 1

Font Scaling on Groups

When individual components are grouped together, the default Layout settings are applied to the new group component, and to each
component in the group. All the components in the group default to font scaling.

. Tank !
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1 I
1 I

i e
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Layout Constraints >

Layout Mode
© Relative _ Anchored
Relative Layout Options

Maintain Aspect Ratio
© Center _ Leading ' Trailing

Scale Font
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Font scaling on individual components in a group can be disabled by selecting the group, and double clicking on a single component. You
will get a red outline around the group, then you can select the individual component(s), and disable font scaling. Note: The individual
component font scale setting takes precedence within a group.
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When you remove the group (right-click and select Ungroup), all the individual components within that group will get reset to the default
Layout settings including font scaling, even if font scaling was set differently.
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Font Scaling on Containers



You can convert a group to a container to change the way scaling works. Ignition remembers the last Layout Settings you made to each
individual component in that group prior to the conversion to a container (i.e., if any of the components had font scaling disabled, once the
group is converted to a container, those same components will still have font scaling disabled).

Anchored Layout

Anchored Layout lets you specify various "anchors" for the component. The anchors dictate how far each of the 4 edges of the component
stay from their corresponding edges in the parent container.

Anchored Layout Options

North/South
If one of these is selected, the distance between that edge of the component and that edge of the container is preserved. If both are

selected, the component will stretch its height to maintain both distances.

West/East
If one of these is selected, the distance between that edge of the component and that edge of the container is preserved. If both are

selected, the component will stretch its width to maintain both distances.

Center Vertically
When selected, both top and bottom buttons will be deselected. This option maintains the height of the component and centers it vert

ically in the container.

Center Horizontally
When selected, both left and right buttons will be deselected. This option maintains the width of the component and centers it horizo

ntally in the container.

Layout Constraints >

Layout Mode

Relative Anchored

Anchored Layout Options

b
P““ —+— +++ ++4
i

Cancel

For example, if you anchor top and left, then your component will stay a constant distance from top and left edges of its parent. Since you
didn't specify an anchor for the right or bottom sides, they won't be affected by the layout.

If you anchor bottom and right instead, the components will again stay the same size (since you didn't specify an anchor for their other
edges, but they will stay a constant distance from their parent's right and bottom edges.



Of course, you can mix and match the various modes for the different components in a given container. The following image shows the
following:

® The square uses a horizontal and vertical centering anchor. It is centered, and stays the same size.
® The triangle is anchored south and west.

® The circle is anchored north, west, south, and east. This means that its edges are all anchored and stay a fixed distance to each of
its parent's edges, so it grows.

=D
|

In This Section ...



Creating Vision Components

Adding Components to a Window

There are four primary methods for adding Vision components to a window:

Select the component in the palette, and then clicking and dragging on the window.
Drag a component's icon from a palette onto a container.

Drag one or more Tags onto a window.

Adding shapes using the drawing tools or SVGs.

PONPE

The Component Palette

There are two styles of component palette in Ignition Vision: the tabbed palette and the

collapsible palette. These palettes work in the same way, but the tabbed palette docks to the north
or south edge of the workspace, and the collapsible palette docks to the east or west edge. By
default, the collapsible palette is visible in the window workspace. To switch palettes, navigate to
the View > Panels menu, and select either Component Palette - Tabbed Palette or Component
Palette - Collapsible Palette.

Creating Components Using Click and Drag

Components can be created on the window by first selecting them in the component palette, and
then clicking and dragging on the window space. Draw a rectangle in the container to
specify where the component should be placed and what size it should be.
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Creating Components by Dragging from the Palette

On this page

® Adding Components
to a Window
® The Component

Palette

® Creating
Components Using
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® Creating
Components Using
Tags

® Creating
Components Using
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® Custom Palette
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Creating
Components

Watch the Video

Components can be created by dragging them from the component palette to the window. The component will be placed where they were

dropped at its default size. Once on the window, the component can be resized using its resize handles.


https://legacy-docs.inductiveautomation.com/display/DOC80/General+Designer+Interface
https://www.inductiveuniversity.com/video/creating-components/8.0
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Creating Components Using Tags

Components can also be created by simply dragging a Tag onto a container. Depending on

the datatype of the Tag, you will get a popup menu prompting you to select an appropriate type

of component for that Tag. This technique is great for rapid application design as it does two things
for you:

® The component is created at the position you dropped it.
® A variety of property bindings are created automatically.

Tags are used in windows to power property bindings on components. The easiest way to

make some components that are bound to Tags is to drag and drop some Tags onto

your window. If you don't have Tags yet, see the Browsing and Creating OPC Tags page for more
info.
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In the example above, we dragged the DayTank Memory Tag onto the window and were given the
option of Display, Control, or Templates. Within the display components, we were given the option
of displaying the tag in a Numeric Label, LED Display, Multistate Indicator, Progress Bar, or Tank
component.

The bindings depend on what kind of Tag was dropped and what kind of component was created.
For example, lets suppose you have a Float8 point that represents a setpoint, and you want to set
it. Drop the Tag onto a container and choose to control it with a Numeric Text Field. The following
bindings will be set up automatically:

® The text field's doubleValue property gets a bidirectional Tag binding to the Tag's Value p
roperty.

® The text field's minimum and maximum properties get Tag bindings to the Tag's EngLow
and EngHigh properties, respectively.

® The text field's decimalFormat property gets a Tag binding to the Tag's FormatString pro
perty.

® The text field's tool TipText property gets a Tag binding to the Tag's Tooltip property.

It is important to realize that multiple property bindings are created when creating components

this way. These bindings not only using the Tag's value, but much of the Tag's metadata as well.
Using the Tags metadata in this way can greatly improve a project's maintainability. For example,

if you decide that the setpoint needs 3 decimal places of precision, you can simply alter the Tag's F
ormatString to be #, ##0. 000, and anywhere you used that Tag will start displaying the correct
precision because of the metadata bindings.

@ INDUCTIV]
UNIVERSI]

Tag Binding - Drag
and Drop

Watch the Video


https://legacy-docs.inductiveautomation.com/display/DOC80/Understanding+Tags
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Creating Components Using Shapes

All of the shapes that you can draw using the shape tools are themselves components. As such, they have properties, event handlers,
names, layout constraints, and all of the other things that you'll find on other components.
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Custom Palette

Custom palettes are like expanded copy/paste clipboards. You can put customized components or groups of components into a palette for
quick access.

To create a custom palette, right-click on a tab in the tabbed palette or a header in the collapsible palette, and choose New Custom Palette.
Your custom palette will appear as the last palette. You can rename it by right clicking on the palette. Your custom palette has one special

. - [ . .
icon in it, the Capture - icon. To add components to your palette, select them and press the capture button. This effectively does a copy,
and stores the captured components as a new item in the clipboard. You can then use that item much like a normal component, and add
multiple copies of it to your windows.
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You can assign your custom component a name and it will appear under the Custom Palette. Note that these are simple copies, and are not
linked back to the custom palette. Re-capturing that palette item will not update all uses of that item across your windows.
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Vision Component Customizers

The Vision module provides a number of customizers to configure components in ways that are
more complex or detailed for basic properties.

The two main customizers are the Component Customizer and the Style Customizer. These
two customizers are used repeatedly for many different components. For special purpose
components like the Easy Chart, Table, Tab Strip, and Multi-State Button, they have their own
special customizers for you to create your own custom properties.

Component Customizers

To use a customizer, right-click on the component, choose Customizers, and select the
customizer for the the component you are working with. You can also select the component and

click the Customizer icon in the Vision Main Toolbar at the top of the window. The following
is an example of the customizer for the Multi-State Button Component.
|4 Multi-State Button Customizer X
Hand
Auto
$ e
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Border Border
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® Component
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® Configuring the
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® Example 1
® Example 2
® Value Conflict

Often, a Customizer works as a user-friendly user interface to one or more expert properties. For example, the Easy Chart Custom
izer modifies the contents of the pens, tagPens, calcPens, axes, and subplot dataset properties. This means you can also use
Property Bindings and scripting to modify the values of these expert properties at runtime, giving you the ability to dynamically

perform complex manipulations of components.

Custom Properties

In addition to the component's basic property settings, you can also create your own custom
properties to enhance and add functionality to a component. You can use the custom properties
like any other properties - with data binding, scripting, styles, and so on. Custom properties are
important for passing parameters from one window to another, especially with a popup window.
Properties on the window's Root Container are special in that they double as a window's
parameters. For example, when you click on a Button component to open a popup window, it can
pass a set of values into the window, which then get set to the custom property on the Root
Container for use on that window.

1. To configure a custom property, right click on the component, and select Customizers >
Custom Properties.

2. Click the plus + icon to add a row. Enter the Name (i.e., motorNum) of the custom
property and data Type. Click OK.

@ INDUCTIV]
UNIVERSI]

Custom Properties

Watch the Video


https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Easy+Chart+Customizer
https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Table+Customizer
https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Tab+Strip
https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Multi-State+Button
https://www.inductiveuniversity.com/video/custom-properties/8.0
https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Easy+Chart+Customizer
https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Easy+Chart+Customizer

3. In the Property Editor, scroll to the bottom of the panel to see your custom property in
blue.

|4 Custom Properties X

Name Type Description +
T
m

0K Cancel

Custom Properties can be any of the basic property types, but can also be a User Defined Type
(UDT) from a UDT that was created earlier. The UDT property contains values for each of the
Tags within the UDT, each of which can be bound to and used. The custom UDT property itself is
typically bound to a UDT instance to pull in the entire instance Tag.

Style Customizer

Many components support the Style Customizer which lets you define a set of visual styles that
change based on a single property. Typically, you'll have a property (often a custom property) on
your component that you want to use as a driving property, usually a discrete state, and you have
multiple visual properties, like the font, border, foreground color, visibility, and so on that you want
to change based on that one driving property. The Style Customizer enables you define these
relationships all at once, and lets you preview them as well. Without styles, you would have to go
to every property and bind them all individually.

Configuring the Style Customizer

@ INDUCTIVI
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Component Styles

Watch the Video

Some components have styles already setup and others do not. The following example involves a Cylindrical Tank component that already
has a styles defined. This example shows you how to change styles using the Style Customizer for the Cylindrical Tank.

1. Drag in a Cylindrical tank from the component palette on to your window.

2. Right click on the Cylindrical Tank component and scroll down to Customizers > Style Customizer. There are four driving

properties that can have styles configured: Capacity, Data Quality, Value, and Visible.

3. For this example, click on Capacity > Liquid Color and then the Add Property + icon. Repeat this step for the Show Value and T

ank Color Properties.


https://legacy-docs.inductiveautomation.com/display/DOC80/User+Defined+Types+-+UDTs
https://legacy-docs.inductiveautomation.com/display/DOC80/User+Defined+Types+-+UDTs
https://legacy-docs.inductiveautomation.com/display/DOC80/UDT+Instances
https://www.inductiveuniversity.com/video/component-styles/8.0
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4. Next under Styles, click the Add + icon.
5. Click the Expand W icon to see the color palette for the Liquid Color.
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6. Choose a color from the palette. Repeat this step for the Show Value and Tank Color Properties.

7. Then click the OK to save your updates.




Example 1

In this example, we have a Level Indicator component that is displaying the level in a tank. Let's say that you want to have its appearance
change based on the alarm state of the tank's temperature. We'll do this using a custom property.
1. In the Vision window, right click on the component and choose Custom Properties.

2. Click the Add + icon.
3. Name the new property Severity and set it to an Integer type. Click OK.

Customn Properties

Pt
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0OK Cancel

4. Right click on the component and choose Style Customizer.
5. Choose your Severity property as the driving property, and the Border and Filled Color properties as the styled properties.
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6. Under Styles, click the Add + icon three times

7. Now create three styles for the three alarm states you want to show. For the first style, enter a value of -1 (not an alarm) and don't
change anything else.

8. For the second, enter a value of 2 (medium alarm). Set the filled color to orange.


https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Level+Indicator
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9. For the third style, enter a Value of 4 (high alarm).
Click the Expand ™ icon.
Select the Animate checkbox.

m
Click the Add = icon.
Set the StepDuration to 500 for both frames.
For the first frame set the FilledColor to red.
For the second frame, set the FilledColor to yellow.

oo

-~ ® 20




Style for Level Indicator 1 X
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10. Click OK. Notice that the styled properties you chose are now bold and have the Styles o icon next to them. This is to help remind
you that those properties are being driven, so if you change their values directly, your changes will be overwritten.
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11. In the Property Editor, click on the Binding 2 icon for the Severity custom property. Bind it to the tank temperature tag's Alarms.
HighestActivePriority property.
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12. Now, when the alarm state for the tank's temperature changes, the color of the appearance of the indicator will change based on the
settings in the Style Customizer. In this image, the indicator flashes red and yellow because the high alarm was triggered.
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Example 2

Let's look at another example that uses the Custom Properties and the Styles feature together. For example, the Label component seems
pretty plain at first: it just displays a string. You can use its foreground color, background color, and border to make it look interesting.

1. Drag a Label component onto a window.


https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Label

2. Rght click on the Label component and choose Custom Properties.

3. Click the Add + icon.
4. Name the new property State and set it to an Integer type. Click OK.
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5. Bind that property to a discrete state Tag coming out of a PLC.

6. Next use the State property to drive its Styles configuration to make the component look different and display different text based on
the state being 0, 1, or 2 (maybe for a Hand/Off/Auto indicator).
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We could have used the Multi-State Indicator component from the very beginning, but understanding this example will let you create your
own types of components by combining the existing components in creative ways.

Some components like the Easy Chart, Table, Power Table, Tab Strip, Multi-State Button, and Multi-State Indicator have default styles

already setup, but you can modify them however you like. If you don't like the default styles, change them. They are there to simply help you
get started.

Value Conflict

You can bind a property that is already being used by a style, but a warning icon will appear on the property, and the property name turns red
in the In the Property Editor. This means there is a conflict between the binding on the property, and the style on the component. As a
general practice, only the style or binding should write to the property, not both.
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Drawing Tools

Drawing Tools Overview

Vision comes with its own set of drawing tools so you can draw your own vector graphics on a
window. Using the drawing tools you can create your own shapes such as lines, rectangles, and
circles. These shapes are components with their own set of properties. Shapes or graphics such
as lines, rectangles, and circles can be created using the 2D drawing tools in Vision. All SVG
(Scalable Vector Graphics) images are importable in Vision and are made up of these basic
shapes.

Using Drawing Tools

By default, the drawing toolbar is always located on the right side, but you can drag it to anywhere

on your window that you prefer. At the very top of the toolbar is a Selection ‘L tool that allows
you to select various components on a window. You can use the Selection tool to change the
component's size and position as well as to configure the component. Below the Selection tool are
all the tools that draw graphics. Click on the tool's icon to make it the active tool, then click in the
Designer and drag to place the tool in your workspace. Once you draw a graphic, and want to drag
a different graphic tool on to your window, click on the Selection tool. When a drawing tool is
active, a toolbar will appear in the top menubar that has specific settings and actions for that tool.

Types of Drawing Tools

There are multiple drawing tools that each fulfill a different purpose. Some, like the selection tool
simply allow you to select different components, while others like the rectangle tool allow you to
create shapes. When you create a shape it has a default Fill Paint color of white. After a shape is
created, you can change its Fill Paint color, Stroke color, and Stroke Style properties. All shapes
can be treated as paths and be used with composite geometry functions to alter or create other
shapes.

Selection Tool

On this page

® Drawing Tools
Overview

® Types of Drawing
Tools

® Shape Size,
Position, and Angle

Using Drawing
Tools

Selection Tool
Rectangle Tool
Circle Tool
Polygon Tool
Arrow Tool
Pencil Tool

Line Tool

Path Tool
Gradient Tool
Eyedropper Tool
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Drawing Tools
Overview

Watch the Video

The Selection ‘_ tool is active by default. When this tool is active, you can select shapes and components. Selected components can be
moved, resized, and rotated. For more on using the Selection tool to manipulate components and shapes, see Manipulating Components.


https://www.inductiveuniversity.com/video/drawing-tools-overview/8.0
https://legacy-docs.inductiveautomation.com/display/DOC80/Working+with+Vision+Components#WorkingwithVisionComponents-ManipulatingComponents
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Rectangle Tool

The Rectangle [;-] tool creates and edits rectangle shapes. To create a rectangle, select the tool and then click and drag inside a window to
create a new rectangle. Hold down Ctrl to make it a perfect square, and the Shift key to make it grow from the center point. Once

a rectangle is created, you can use the square handles to change the rectangle's height and width. This is important because it is the only
way to resize a rotated rectangle and let it remain a rectangle. If you resize a non-orthogonally rotated rectangle using the Selection tool, it
will skew and become a parallelogram. If you double-click on the rectangle so the tool is active, you can change the rectangle's width and
height using the tool-specific handles. From the toolbar, you can also change the rectangle's location (in pixels) on the window using the X
and Y axes.

There are also small circle handles on the rectangle that allow you to alter the rectangle's corner rounding radius. Simply drag the circle
down the side of the selected rectangle to make it a rounded rectangle. Hold down Ctrl to drag each rounding handle independently if you

want non-symmetric corner rounding. You can use the Make Straight button in the rectangle's toolbar (_I) to return a rounded rectangle to
be a standard, straight-corner rectangle.
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Circle Tool

The Circle Q tool creates and edits circles and ellipses. It is used in much the same way as the rectangle tool. While it is the active tool,
you can click and drag inside a window to create a new ellipse. Hold down Ctrl to make it a perfect circle, and the Shift key to make it grow
from the center point. When an ellipse is selected, use the width and height handles to alter the shape. You can also use the ellipse toolbar
at the top of the Designer to change the width and the height as well as the X and Y axes.

Polygon Tool



The Polygon é tool is used to create polygons and stars. Use the polygon toolbar at the top that becomes visible when this tool is active to
alter the settings of the shape that is created when you drag to create a polygon. This tool can be used to make any polygon with three
corners (a triangle) or more. On the Polygon menu you can specify the number of corners for the polygon. Once created, you can use the
center square handle to move the polygon around, and the diamond handles to alter the size and angle of the polygon. Hold down Ctrl to
keep the polygon's rotation an even multiple of 15°. For a star shape, specify the number of corners (points) and select the Star check box.

A second handle that is between each corner will appear on the polygon allowing you to make a star shape.

® O @ Corners:|7 —— Star
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Polygon Star (7 point)

Arrow Tool

The Arrow = tool is used to create single or double-sided arrow shapes. When it is active, simply drag to create a new arrow. Use the
checkbox on the arrow toolbar to choose a single or double-sided arrow. To alter the arrow, use the diamond handles to change the two
ends of the arrow, and the circle handles to change the size of the shaft and the arrow head. When changing the arrow's direction, you
may hold down Ctrl to snap the arrow to 15° increments.

Pencil Tool

&
The Pencil .&7 tool is used to draw freehand lines and shapes. When this tool is active, you can draw directly on a window by holding down
the mouse button. Release the mouse button to end the path. If you stop drawing inside the small square that is placed at the shape's origin,
then you will create a closed path, otherwise, you'll create an open path (line).

On the pencil toolbar, there are options for simplification and smoothing, as well as a toggle between creating straight line segments or
curved line segments. The simplification parameter is a size in pixels that will be used to decrease the number of points used when creating
the line. Points will be in general as far apart as this setting. If you find the line isn't accurate enough, decrease this setting. If you choose to
create curved segments, then the segments between points will be Bézier curves instead of straight lines. The smoothing function controls
how curvy these segments are allowed to get.

Line Tool

@ INDUCTIV]
UNIVERSIT

N
The Line ﬂ tool can be used to draw lines, arbitrary polygons, or curved paths. Unlike all of the
other tools, you don't drag to create new paths with the line tool. Instead, you click for each vertex
you'd like to add to your path.

To draw a straight line, simply click once where you want the line to start, and double-click where D . Li
you want the line to end. To make a multi-vertex path, click for each vertex and then double-click, rawing a Line
press enter, or make a vertex inside the origin box to end the path.

As you draw the line, "locked-in" sections are drawn in green and the next segment is drawn in Watch the Video
red. Hold down Ctrl at any time to snap the next segment to 15° increments.

On the line toolbar, you can choose between three different type of line settings:
® straight-line segments

® perpendicular-line segments
® curve-line segments


https://www.inductiveuniversity.com/video/drawing-a-line/8.0
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Perpendicular-line segment is just like a straight-line segment except that each segment
is restricted to either horizontal or vertical.

The curve-line segment will create a Bézier curve path by attempting to draw a smooth curve
between the previous two vertices and the new vertex.

Path Tool

<]

All shapes and paths can be edited directly by using the Path @” tool. This tool lets you directly
modify the nodes in the path, adding new nodes, removing nodes, and toggling segments between
straight or curved. For more information, see Shape Geometry.

Gradient Tool

The Gradient Etool is used to affect the orientation and length of any gradient paints. They work
hand-in-hand with the Fill Paint property. Gradients smoothly blend any number of colors that can
be positioned along a straight line or form an ellipse across the shape. A Linear gradient uses a
horizontal line drawn across the width of the shape by default. By switching to the gradient tool,
the horizontal line can be changed to move in any direction by dragging the handles. The Radial
gradient uses a 45° angle drawn over the shape which starts at the center and moves out. Just
like the Linear gradient, the Radial gradient can also be changed by dragging the handles around.

Eyedropper Tool

With the Eyedropper } tool you can set a selected shape(s) and/or component(s) foreground
/background or stroke/fill colors by pulling the colors from somewhere else in the window. Select
the component you want to change, and then activate the eyedropper tool. When this tool is
active, left-click to set the selection's fill or background color, and right-click to set the selection's
stroke or foreground color.

INDUCTIVI
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Editing Shape Paths

Watch the Video

INDUCTIVI
“ve#2> UNIVERSI]

Gradients

Watch the Video
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Eyedropper Tool


https://legacy-docs.inductiveautomation.com/display/DOC80/Shape+Geometry#ShapeGeometry-B�ziercurve
https://www.inductiveuniversity.com/videos/editing-shape-paths/8.0/8.0
https://www.inductiveuniversity.com/videos/gradients/8.0/8.0

Remember to turn off the Eyedropper tool when you're finished by clicking the Selection tool, Watch the Video
otherwise, you will continue to change colors on your component each time you do a mouse

click. Note that this tool works on most components as well as shapes. For example, right

clicking will set the font color on a Button component, or left-clicking will set the background color.

Shape Size, Position, and Angle

Shapes are different from other components in that they have properties that determine their size and position that can easily be bound.
These properties are called X, Y, Height, and Width. The values of these properties are always relative to the shape's parent container's
width and height, even in a running Client where that container may be a wildly different size due to the layout mechanism.

For example, let's say that you have a shape that is located at x=100, y=100, and was 125 by 125 inside a container that is 500 by 500. If
you want to animate that shape so that it moves back and forth across the screen, you'd set up a binding so that X changed from 0 to 375.
(You want X to max out at 375 so that the right-edge of the 125px wide shape aligns with the right edge of the 500px container). Now, at
runtime, that container might be 1000 by 1000 on a user's large monitor. By binding X to go between 0 and 375, the true X value of your
shape (whose width will now be 250px due to the relative layout system), will correctly move between 0 and 1750, giving you the same effect
that you planned for in the Designer.

Another ability unique to shapes is the ability to be rotated. Simply click on a selected shape and the resize controls become rotate controls.
There's even an Angle property that can be edited directly or bound to something dynamic like a Tag.

1 Use caution when binding the rotation. When you change a shape's rotation, its position also changes. The position of any shape
is the top-leftmost corner of the rectangle that completely encloses the shape. Because of this effect, if you wish to both
dynamically rotate and move a component, special care must be taken since rotation alters the position

If you want to both dynamically rotate and move a component, special care must be taken since rotation alters the position. You don't want
your position binding and the rotation binding both fighting over the position of the component. The way to both rotate and move a shape is
as follows:

Bind the rotation on your shape as you wish.

Create a shape (for example, a rectangle) that completely encloses (in other words, it's bigger than) your shape at any rotation angle.
Set that rectangle's visible property to false.

Select your shape and the rectangle and group them.

Bind the position on the resulting group.

ahunNPR

If you follow these steps, you can animate both the rotation and position of a shape.

In This Section ...


https://www.inductiveuniversity.com/videos/eyedropper-tool/8.0/8.0

Shape Geometry

Shape Paths

Once you draw shapes using the drawing tools in Vision, it's possible to alter and edit shapes after
they've been created. By default, all shapes gave a white fill color. Editing the paths of your vector

graphic shapes is done by using the Path @” tool. Simply select any shape or line while the Path
tool is active to start editing. If the shape is already a path, you can switch to the Path tool by
double-clicking on the shape.

You can convert any shape into a general path by selecting the To Path 3:3 function under the S
hape menu. Shapes will also implicitly turn into paths if they are altered in a way not supported by
the underlying shape. For example, if you stretch a rotated rectangle, thereby skewing it into a
parallelogram, it will become a path automatically.

Editing a Shape Path

Each point on the path is represented by a diamond-shaped handle when the path editor is
active. These handles can be dragged to move them around. They can also be selected by
clicking on them or dragging a selection rectangle to select multiple points. This allows groups of
points to be altered simultaneously.

-]
To change a line segment between open, straight, and curved, select the Path @” tool and use
the toolbar functions that become visible. Points can also be added and removed using
the functions on the Path Editor toolbar.
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Filling a Shape

Filled shapes have two fill settings that control whether or not holes in the shape should be filled.
To remove the fill entirely, simply set the Fill Paint property in the Property Editor to No Paint 1 .

On this page

® Shape Paths
® Editing a Shape
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® Filling a Shape
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Shape Geometry

Watch the Video


https://www.inductiveuniversity.com/videos/shape-geometry/8.0/8.0
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When editing paths directly, it is often useful to be zoomed in on the path. Don't forget that you can zoom in on a location by
holding down Ctrl and using your mouse wheel to zoom in on a particular area without having to zoom in and then scroll. Also, if
you press your mouse wheel in, you can pan around your window.

Bézier Curve

graphics that connects two points, allowing you to create smooth vector graphic shapes. A Bézier IN DUC TIV]
curve is configured using four points: the two end-points and two control points. The curve starts UNIVE RS 171
along the line between the an endpoint and the first control point, and then curves to smoothly

meet the line between the second control point and the next endpoint.

A Bézier curve, also sometimes called a quadratic curve, is a type of curved line used in vector @

Bezier Curves

Watch the Video

Making Bézier Curves

Curves are made using the Line tool.


https://www.inductiveuniversity.com/videos/bezier-curves/8.0/8.0
https://legacy-docs.inductiveautomation.com/display/DOC80/Drawing+Tools#DrawingTools-LineTool

N
1. In the Designer, select the Line 0 tool icon on the toolbar on the right side of your window. When the Line tool is active, a toolbar
will appear in the top menubar. There are three different type of line settings: straight-line segments, perpendicular-line segments,

and curved-line segments.
2. Select the curve-line segment on the menubar. Click on the window to begin drawing your image. Each time you want to make a
curve, click on the screen. The curve-line segment will draw a smooth curve between points creating a smooth vector graphic

shape.
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3. The line tool can make lines as well as shapes. To complete the line, simply click a second time on your final location. To make the
line into a shape, click on the starting point as your final location.

=]
4. Using the Path g” tool in the drawing toolbar, you can see a vector graphic shape showing where the points meet and the smooth
curves between each point. If you want to edit or alter the shape after you create it, use the Path tool and drag the circles or
diamonds to change the shape.

Creating and Editing Shapes Using
Constructive Area Geometry

Editing paths directly can be a bit awkward. Using Constrictive Area Geometry is usually a @ IN DUC TIV]

much easier and more intuitive way to get the shape that you want. These functions are accessed
from the Shape menu and operate when two (or more) shapes are selected. U N’IVE RS I']

Editing Shape Paths

Watch the Video


https://www.inductiveuniversity.com/videos/editing-shape-paths/8.0/8.0
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@ Selection Order Matters

The order that you select the shapes is important for many of these functions. Typically,
the first shape you select is the shape you want to retain, and the second shape is the
shape that you want to use as an "operator" on that first shape.

Union

The Union bfunction combines two or more paths into one. The resulting shape will cover the area that any of the shapes covered initially.
The example shows how the union of a circle, rectangle, and triangle can be unioned together to create a basic pump symbol. Creating the
symbol using this method took a few seconds, whereas attempting to draw this shape by hand using paths would be quite frustrating.

Difference

The Difference b function can be thought of as using one shape as a "hole-punch" to remove a section of another shape. The example
shows how a zigzag shape drawn with the line tool can be used to punch a cutaway out of a basic tank shape. The level indicator is added
behind the resulting shape to show how the area where the zigzag shape was is no longer part of the tank shape.




Intersection

The result of an Intersection tbfunction will be the area only where where two shapes overlap. The example shows how the "top" of the
tank in the difference example was easily made using two ellipses.
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Exclusion

The Exclusion b function, sometimes called X-OR, creates a shape that occupies the area covered by exactly one of the source shapes,

but not both.

N

Division

The Division !9 function divides or cuts one shape up along the outline of another shape. This works the same as an intersection for the
first shape selected, and a difference for the second.

-




Fill and Stroke

All shapes have three properties that affect how they look: Fill Paint, Stroke Paint, and Stroke

Style. .
On this page
® Fill Paint: Determines the interior color of the shape.
® Stroke Paint: Represents the color of the shape's outline.
® Stroke Style: Determines the thickness, corners, and dash properties of the shape's
outline.
® Fill Paint
® Editing Paints
1 1 ® Paint Types
FI I l Pal nt ® Gradients
® Gradient Paint
Bounds
Editi ng Paints ® Gradient Cycles
® Setting a
. . . . . . ) Gradient
Both the Fill and Stroke paints can be a variety of different types of paints. To edit a shape's fill or * Stroke Style
stroke paint, you can either use the paint dropdown in the Property Editor table by clicking on the E

dit “ icon or open up the dedicated Fill and Stroke panel from the View menu.

Paint Types @ %Nhﬁg%'fr{lsxg

The top of the paint editor is a selection area that allows you to choose between the five different
types of paints.

Fill and Stroke
NAAA AL
1 2 3 4 5

1. No Paint % when used as a fill paint, then the interior of the shape will be transparent. If
used as the stroke paint, then the paint's outline will not be drawn.

2. Solid Color Paint = is equivalent to the Color type used elsewhere throughout the
component library. A solid color is any color, including an alpha (transparency) level.

3. Linear gradient (4 smoothly blends any number of colors along a straight line across
the shape. Each color is called a Stop. Each stop is represented as a drag-able control on
a horizontal preview of the gradient in the gradient editor. You can click on a stop to select
it and change its color or drag it to reposition it. You can right-click on it to remove it. You
can right-click on the preview strip to add new stops and change the gradient's cycle
mode.

4. Radial gradient a are similar to linear paints except that the colors emanate from a
point creating an ellipse of each hue. Radial paints are configured in the same way as
linear paints.

5. Pattern paint Euses a repeating pixel-pattern with two different colors. You can pick a
pattern from the dropdown or create your own using the built-in pattern editor.

Gradients
@ INDUCTIV]I

Gradient Paint Bounds UNIVERSI]

The two gradient paints, Linear and Radial, are more than a list of colored stops, they also need
to be placed relative to the shape. The same gradient may look wildly different depending on how .
it is placed against the shape. By default, a Linear gradient will run horizontally across the width of Gradients


https://www.inductiveuniversity.com/video/fill-and-stroke/8.0

the entire shape, but this is readily changed. By switching to the Gradient ETON located on the
drawing tools toolbar, you can drag handles around to change the orientation of the gradient. You
can even make the gradient larger or smaller depending on how big you want it to be.

™
P

Gradient Cycles

The two gradient paints (Linear and Radial) both have a cycle mode that you can change by right-
clicking within the preview strip.

The cycle modes are illustrated below: No Cycle, Reflect, and Repeat.

B 8 BEEE

1 2 3

1. No Cycle - The first and last stops are repeated forever after the edge of the gradient
bounds.

2. Reflect - Beyond the bounds of the gradient, it will be reflected and drawn in reverse, and
then reflected again, creating a smooth repetition.

3. Repeat - Beyond the bounds of the gradient, it will be repeated forever.

Setting a Gradient

. In the Designer, select your component.

. Inthe Property Editor under Appearance, click the Edit # icon.

. Select either the Linear or Radial gradient.

. You will see two stops: white and black. Click on each Stop and choose a different color.

. If you want to add an additional stop, right click on the color bar and select Add stop. You
can also add / remove Stops, and select your desired cycle: No Cycle, Reflect or Repeat.

OhWDN =

Watch the Video


https://www.inductiveuniversity.com/video/gradients/8.0
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6. Close the Color Selector by clicking the X in the upper right corner.

7. With your component still selected on your window, and click the Gradient E tool in the
toolbar. You'll notice a line on your component. Now, you can drag the line's handles to
change the orientation and lengthen or shorten the gradient.

8. Here are a few examples of what you can do with gradients:

Radial - No cycle
Linear - Reflective
Linear - with a 3rd Stop
Linear - Repeat

eoop

Stroke Style

A shape's stroke paint is only half the story. The Stroke Style is also an important component of how an outline is drawn. Primarily the style
controls the thickness of the line drawn, but it also can be used to create a dashed line. The setting for thickness is specified in pixels, and
creating a dashed line is as easy as picking the style from the list. The effect of the thickness and dash pattern settings is fairly self-
explanatory, but the other stroke settings are a bit more subtle. You can notice their effect more readily on thick lines.

You can access the Stroke Style in the Property Editor under Appearance.


https://legacy-docs.inductiveautomation.com/display/DOC80/Color+Selector+Reference
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Cap style is a setting that controls what happens at the end of a line segment. You can either have the line simply be terminated with no
decoration (#1), round-off the end with a semi-circle (#2), or cap the end with a square (#3).

ZEEXEEE 1
CGEEEEXD 2
EEEEXEEN 3

Join style is a setting that affects how a line is drawn where two segments meet (a corner). The default setting is called a miter join (#1),
where the stroke is extended into a point to make 90-degree angle. The other options are rounded corners (#2) or beveled edge corners (#3).

=171 7

Miter Limit style joins can become a problem for very sharp angles. With a sufficiently sharp angle, the miter decoration can become
extremely long. To control this, there is a miter length setting to limit the length of a miter decoration. The illustration below shows the same
miter join with two different miter length settings. The first drawing illustrates the length of the miter join.






Images and SVGs in Vision

Using SVGs

Ignition can import SVGs (Scalable Vector Graphic) into a Vision window. Once imported, SVGs
can be modified and styled. To use an SVG in your project, simply drag the SVG file directly onto
the window you want the SVG to appear on. The SVG becomes a new polygon component on the
window.

Sometimes the way the SVG imports may result in the SVG appearing very small, in which case
you can manually expand the SVG to your desired size.

1 Some elements, attributes, and properties in an SVG are not supported.

The Vision module uses the Apache Batik library to handle SVGs, so a list of supported
elements, attributes, and properties can be found on Apache Batik's website.

SVGs as Grouped Components

All SVG images are made up of a group or groups of several (and often many!) paths. These
paths are Ignition's Drawing Tools, and are the basic building blocks of all SVGs in Ignition. You
can select each path individually from the Project Browser, or by double-clicking on an SVG then
single clicking on an object inside it.
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Coloring an SVG

With SVGs, one useful HMI technique is to color the SVG (Scalable Vector Graphic) to show the
state of whatever the SVG represents. Whether you are bringing in a vector graphic from the
Symbol Factory or importing an SVG from your computer, you can easily color the SVG to suit
your needs. There are two ways of coloring an SVG: coloring an individual piece of the SVG, or
placing a tint over the whole SVG.

Coloring SVG Parts

Individual pieces of the SVG can be pulled out and colored, by finding the path that corresponds
with the part of the SVG that you want colored and applying a color to it. This can be done for a
single piece of the SVG, or multiple different pieces. These colors can even be made dynamic by

setting up a binding on the Fill Color. Since the property is expecting a value with a data type of Col

or, you can either set up an expression binding which uses the color() function to create a color
object, or use Ignition's built in Number to Color Translator, which will automatically be made
available to you when selecting a binding that will typically return a value, such as a Tag or
Property binding.
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Coloring SVG Example

In this example, we selected an individual piece in a push button symbol and added a color to that area.

1. Place a push button image or any image from Symbol Factory onto the window.
2. Right click on the image and select Ungroup.
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3. Right click in the center of the image and select Ungroup again.
4. Click on the larger inner circle in the image, then select the Fill Paint color you want. We chose red #D90000.
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5. To get coloiin the "highlight" section of the graphic, click on the highlight. You'll see that the Fill Paint is a Radial Gradient. Click on

the Edit .’ icon to change the colors in the gradient.
6. Click on the left side stop and select white. Click on the right side stop and select red.
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7. To regroup all the parts of the SVG, drag a box around them with your mouse. Then right click and select Group.
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Alternately, you can create a style using the Style Customizer to change the color of an SVG path based on a driving property on that path.
This is typically done by setting up a custom property to use as the driving property, and then binding the custom property to the property or
Tag that will drive the color change.


https://legacy-docs.inductiveautomation.com/display/DOC80/Color+Animation+in+Vision#ColorAnimationinVision-StyleCustomizer

SVG Tinting

Because an SVG is typically composed of many smaller shapes, it is difficult to color the entire

object, as it would require changing the color on every shape within the SVG. So instead of @ IN DUC TIV]
changing the color of the entire SVG, we can make a new shape that is the same shape and size U NIVERS I']
as the SVG, and make it opaque, so that its color acts like a tint on top of the SVG. A clever way to

do this is to duplicate the SVG, union together the new SVG, so that all shapes combine into one

shape, and then change the color.

Tint SVG

Watch the Video

Tinting Example

Let's say you chose one of the many grayscale symbols, such as the 3-D Valve symbol from the Valves category, and you want to tint the
valve green when the valve is open, red when the valve has a fault, and keep it gray when the valve is closed. Suppose you have a Tag
called ValveStatus, that is O for closed, 1 for open, and 2 for faulted.

. Drag the symbol onto the screen.
. Duplicate the symbol by selecting it and choosing Duplicate from the Edit menu, or pressing CTRL-D.
Now, select the duplicate symbol, which will be above the original.

N N

. Click the Union icon in the toolbar or find the Union item under the Shape menu.
This will combine the duplicate SVG into a single shape.
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. Remove the outline by setting the Stroke Paint property to No Paint 1 .

. Click on the Binding @ icon next to the Fill Paint property.

. Select the Tag binding type.

. Navigate to the Tag you want to use. For this example, we used a Valve_Status Tag.

. In the Number-to-Color Translation, double click the color next to the Value 0 and select white.
. Click the Add New Translation icon. Set the Value 1 at 40% opaque green.

. Click the Add New Translation icon. Set the Value 2 at 40% opaque red.
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12. Click OK to save the binding.

13. On the window, place another copy of the original symbol.

14. Select the colored symbol and select Alignment > Move to Front.
15. Next place the colored symbol on top of the original.

16. Select them both, then select Component > Group.

-

In summary, what we did to tint the symbol was to make a flat shape that had the exact same outline as the symbol, and used semi-
transparent fills to achieve a tint effect for the underlying symbol.

Using Images
Images can be very useful for displaying important information, such as giving visual @ IN DUC TIV]

representations of real world objects. There are a few ways that images can be brought into a " p
Vision project. The first is by pulling images from The Image Management Tool, where the images Nyl U N’IVERS I']
are stored in the Gateway. The other way is to grab images using a filepath. -'s

Using the Image Management Tool Images (png, jpg,
Bringing in images using the Image Management Tool is easy. g If)
1. Place an Image component on the Window. a Watch the Video

2. In the Vision Property Editor, scroll down to Data and click on the Folder Search &% icon
next to the Image Path property. This will bring up the Image Management Tool.
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3. In the Image Management Tool, find the image you want, and double click to select it.
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The path to the image is now displayed in the components Image Path property. Images can be
displayed in the image component, but they can also be used in components like labels and
buttons.
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@ You can add any images you want to the Image Management Tool, which are stored on
the Gateway.

Using Local Images

Instead of using images in the Image Management Tool in Image Path properties of components,
you can use the file path to a local image. This is done by prefixing the file path withfile:///.
An example Image Path would look like this:

It is important to understand that this will only work if the image is accessible from where the client
is running. So if you access an image from the Designer on the local machine, clients that launch
elsewhere may not have the image stored in the same location. For this reason, we recommend
storing the images in a location that everyone can reach, such as a shared drive.

1 When working with images found online, make sure to follow all applicable copyright
laws.
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Comparison Charts

Overview
This page provides an overview of the various comparison charts in Ignition, or charts that allow On th|S page
you to compare difference sets of data. Comparison charts differ from trending charts in that they
tend to utilize a timestamp to visualize records over a period of time. Several types of comparison
charts and how they are used are described on this page.
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Using the Bar Chart

Typically, data is pulled into the chart from a database using either a Named Query or SQL Query binding on the Data property. This data is
typically category based, which typically means there is no timestamp. Generally, if values are split up by time, it is into large chunks of time,
like the different months as shown in the example above.

Initial Dataset

When a Bar Chart is first created, the component will contain a dataset that looks like the following:
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"#RONB", " 5"

"Jan", " 15", " 35"

"Feb","21"," 36"

"Mar", 17", " 23"

"Apr","11","39"
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Extract Order

The Extract Order property on the chart determines how data series are defined. By default, the property is set to By Row, which means
each row is a series, and each column (except the first) is a category. Based on the initial dataset, datapoints are grouped by area (column)
and then grouped by each month (row). If we set the Extract Order property to By Column, then we see that each data point is grouped by
the month (row), and then grouped by each area (column). Note that the underlying data has not changed, but rather how it is rendered as
shown in the images below.
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Chart

The Chart component, also known as the Classic Chart can be used to create many different types of charts by rendering the data in
different ways. This means that depending on the type of data you have, you may use the Chart component in very different ways.

By default the chart is setup to be used as a time series chart, with default data that shows this behavior. However with the right data, the
chart can also display an XY coordinate plot or a categorical plot.
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Using the Chart

The default settings on the Chart allow it to be used as a time series chart. Simply alter the dataset in the Data property with new time series
data to display it in the chart. You can also alter the renderer in the Dataset Properties to any of the XY renderers to change the way the data
is displayed.

To use the chart as an XY coordinate plot, data should be loaded with a two column dataset, where one column is the Y coordinate, and
another is the corresponding X coordinate. The chart will also need to be setup with a new X axis, since the default axis is a date axis.

To use the Chart as a categorical plot, a few things need to change from the defaults. The Data property will need to be loaded with some
categorical data. Categorical data will have one column of the dataset be categories of information in the form of a string. The chart will also
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need to be setup with a new categorical X axis, as well as a category renderer in the Chart Customizer. Lastly, the Chart Type will need to be
a Category Chart. When the chart is a Category Chart type, the Extract Order property can be changed to alter how the data is pulled out
and displayed in the chart. It works very similarly to the Bar Charts Extract Order seen above.

Initial Dataset

Each new Chart randomly generates a new dataset. This Data property will use the default timeseries behavior of the chart, with a t_stamp
column for the domain, and two other columns (Process Temp and Output Temp) as values at the specified times.

" #NAMVES"

"t_stanp", "Process Tenp","Qutput Tenp"
" #TYPES"

"date","I","I"

"#RONS", " 200

"2018-04-30 00:07:15", "64", "35"
"2018-04-30 01:07:15","60", "35"
"2018-04-30 02:07:15", "56", "36"
"2018-04-30 03:07:15","52", "31"
"2018- 04-30 04:07: 15", "53", "26"
"2018-04-30 05:07:15","57", " 28"
"2018-04-30 06:07:15", "60", "27"
"2018-04-30 07:07:15","57", " 26"
"2018-04-30 08:07:15", "59", "31"
"2018-04-30 09:07: 15", "57", "36"
"2018-04-30 10:07:15", "55", "39"
"2018-04-30 11:07:15","52","41"
"2018-04-30 12:07:15", "56", "40"
"2018-04-30 13:07:15","51","41"
"2018-04-30 14:07:15","52", "36"
"2018-04-30 15:07:15", "53", "32"
"2018-04-30 16:07:15","57","30"
"2018-04-30 17:07:15","52", "32"
"2018-04-30 18:07:15","57", "32"
"2018-04-30 19:07: 15", "55", "29"
"2018-04-30 20:07:15", "53", "30"
"2018-04-30 21:07:15","54","31"
"2018-04-30 22:07:15", "50", "29"
"2018-04-30 23:07:15", "54", " 25"
"2018-05-01 00:07: 15", "49", "21"
"2018-05-01 01:07:15","53", "21"
"2018-05-01 02:07:15","50","16"
"2018-05-01 03:07:15","51", "19"
"2018-05-01 04:07:15", "49", "23"
"2018-05-01 05:07:15", "48", " 25"
"2018-05-01 06:07:15","51", "20"
"2018-05-01 07:07:15","55","18"
"2018-05-01 08:07:15", "50", "22"
"2018-05-01 09:07:15", "49", "26"
"2018-05-01 10:07: 15", "53", "22"
"2018-05-01 11:07:15","50", "27"
"2018-05-01 12:07: 15", "46", "26"
"2018-05-01 13:07:15", "48", " 27"
"2018-05-01 14:07:15","52", "26"
"2018-05-01 15:07:15", "51", "24"
"2018-05-01 16:07:15", "55", "24"
"2018-05-01 17:07: 15", "58", "23"
"2018-05-01 18:07:15","61", "22"
"2018-05-01 19:07:15", "60", "27"
"2018-05-01 20:07: 15", "59", "32"
"2018-05-01 21:07:15","60", "33"
"2018-05-01 22:07: 15", "56", "38"
"2018-05-01 23:07:15","51", "35"
"2018-05-02 00: 07: 15", "47","34"
"2018-05-02 01:07:15", "45", "32"
"2018-05-02 02:07:15", "46", "27"
"2018-05-02 03:07: 15", "43", "31"
"2018-05-02 04:07:15","39", "33"
"2018-05-02 05:07:15","39","30"
"2018-05-02 06:07:15", "40", "26"
"2018-05-02 07:07:15", "41", " 27"
"2018-05-02 08:07: 15", "46", "29"
"2018-05-02 09:07:15", "43", "25"
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"2018- 05- 05 13:07: 15", " 62", " 44"
"2018-05-05 14:07:15","64","41"
"2018- 05- 05 15: 07: 15", " 62", " 45"
"2018- 05- 05 16:07: 15", " 66", " 42"
"2018-05-05 17: 07: 15", " 61", " 37"
"2018- 05- 05 18: 07: 15", " 63", " 38"
"2018-05-05 19: 07: 15", " 61", " 38"
"2018- 05- 05 20: 07: 15", " 64", " 40"
"2018-05-05 21:07:15","64","44"
"2018- 05- 05 22: 07: 15", " 60", " 40"
"2018-05-05 23:07: 15", " 64", " 44"
"2018-05- 06 00: 07: 15", " 63", " 45"
"2018- 05- 06 01:07: 15", " 61", " 47"
"2018- 05- 06 02: 07: 15", " 61", " 52"
"2018- 05- 06 03: 07: 15", " 61", " 48"
"2018-05- 06 04:07: 15", " 61", " 47"
"2018- 05- 06 05: 07: 15", " 60", " 46"
"2018- 05- 06 06: 07: 15", " 58", " 44"
"2018- 05- 06 07:07: 15", " 56", " 43"
"2018- 05- 06 08: 07: 15", " 61", " 45"
"2018- 05- 06 09: 07: 15", " 66", " 49"
"2018-05- 06 10: 07: 15", " 68", " 51"
"2018- 05- 06 11:07: 15", " 63", " 54"
"2018- 05- 06 12: 07: 15", " 66", " 58"
"2018- 05- 06 13: 07: 15", " 69", " 63"
"2018- 05- 06 14:07: 15", " 69", " 63"
"2018- 05- 06 15: 07: 15", " 67", " 58"
"2018- 05- 06 16:07: 15", " 71", " 54"
"2018-05-06 17:07:15","74","50"
"2018- 05- 06 18: 07: 15", " 79", " 49"
"2018- 05- 06 19: 07: 15", " 75", " 51"
"2018- 05- 06 20: 07: 15", " 80", " 49"
"2018- 05- 06 21:07: 15", " 79", " 50"
"2018-05- 06 22: 07: 15", " 82", " 50"
"2018- 05- 06 23: 07: 15", " 80", " 53"
" 2018- 05- 07 00: 07: 15", " 85", " 54"
"2018- 05- 07 01:07: 15", " 87", " 49"
"2018- 05- 07 02: 07: 15", " 87", " 51"
"2018- 05- 07 03: 07: 15", " 84", " 56"
"2018- 05- 07 04: 07: 15", " 82", " 60"
"2018- 05- 07 05: 07: 15", " 81", " 57"
"2018- 05- 07 06: 07: 15", " 83", " 55"
"2018- 05- 07 07:07: 15", " 83", " 55"
"2018-05- 07 08: 07: 15", " 81", " 52"
"2018- 05- 07 09: 07: 15", " 77", " 49"
"2018-05-07 10: 07: 15", " 75", " 46"
"2018- 05- 07 11:07: 15", " 79", " 45"
"2018-05-07 12:07:15","82","47"
"2018-05- 07 13:07: 15", " 81", " 48"
"2018- 05- 07 14:07: 15", " 82", " 53"
"2018-05-07 15: 07: 15", " 81", " 48"
"2018- 05- 07 16: 07: 15", " 81", " 43"
"2018-05-07 17:07:15","85", "40"
"2018- 05- 07 18: 07: 15", " 90", " 37"
"2018- 05- 07 19: 07: 15", " 94", " 34"
"2018- 05- 07 20: 07: 15", " 90", " 38"
"2018- 05- 07 21:07: 15", " 89", " 40"
"2018-05-07 22:07:15","85", "45"
"2018- 05- 07 23:07: 15", " 81", " 48"
"2018- 05- 08 00: 07: 15", " 83", " 43"
"2018-05- 08 01:07: 15", " 78", " 42"
"2018- 05- 08 02: 07: 15", " 73", " 40"
"2018-05- 08 03: 07: 15", " 72", " 44"
"2018- 05- 08 04: 07: 15", " 71", " 42"
"2018- 05- 08 05: 07: 15", " 75", " 44"
"2018-05- 08 06: 07: 15", " 71", " 46"
"2018- 05- 08 07: 07: 15", " 67", " 50"

Radar Chart



Radar Charts, also known as web charts, spider charts, and spider plots, are useful for displaying values that are out of spec, and several of
them at once. Each value is plotted on a separate axis with the middle of the axis representing the ideal value. The chart draws a line
between the different values, which create a shape that changes as those values change. Inside the chart, there is a polygon that represents
what the chart would look like if all of its values were in their ideal range. A good use of radar charts is to display realtime information in such
a way that outliers can be quickly identified. This can be an efficient way to convey if a process is running on-spec or off-spec at a glance. So
the Radar Chart lets you quickly see where the values are in comparison to where they should ideally be.

Using the Radar Chart

The Radar Chart can be used to show realtime values by dragging and dropping Tags from the Tag Browser on to the chart. Doing so will
create a Cell Update binding on the Data property that is tied to the Value, EngLow, and EngHigh properties on the Tag. Adding additional
Tags will add additional spokes to the chart. Alternatively, a Named Query or a SQL Query binding on the data property can be used to
display historical values, or aggregate previous historical values.

Initial Dataset

Each new Radar Chart randomly generates a new dataset. The Data property on the Radar Chart must have at least a Value, Min, and Max
column. Any additional columns are ignored.
To render properly, the dataset must have at least three rows. Datasets with only one or two rows will be drawn as a vertical line.

[0 Dataszet Viewer >
Value Min Max @

80,590 21 89,500
72.625 5 91 @

98.097 25 98.097
86.972 19 86.072 @

33.674 23 06
63.141 14 26 @

57.073 20 83
58.821 14 83 x
5

Column Mame: —-- Column Type: --—
E Cancel

Min and Max


https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Radar+Chart

The Min and Max column, aside from determining the limits on the the chart, are also used to determine the desired value. The Desired valu
e is drawn as the midpoint between the Min and Max for a single row in the Dataset. Each row of the dataset has a Min and Max column.
The values in these columns are used to determine the scale of the spoke for that variable with the midpoint representing the desired value.

Below we see the white polygon in the center of the chart. This represents the midpoint between Min and Max

" #NAMES"

"Val ue","Mn", " Max"

"#TYPES"

"D',"D',"D"

"#ROWS", " 8"
"41.51196715968135", "18. 0", "86. 0"
"72.21343683086239","2.0", "88. 0"
"98.91484924220774","16. 0", " 98. 91484924220774"
"23.189112936965692","1. 0", "78. 0"
"33.45468212322838", " 23. 0", "82. 0"
"77.17126241429432","7. 0", "100. 0"
"53.529302336166836", " 25. 0", "79.0"
"62.058120439146435","6.0", " 94. 0"

Pie Chart

A Pie Chart displays values from several categories, each category is a separate "wedge" of the chart. The total is the sum of all wedges.
The key to the Pie Chart component is the Data property, which contains the items that will be displayed as pie wedges.

® Apples ® Bananas © Kiwis ® Oranges

Grapefruit

% z
@ @
& i
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Using the Pie Chart

Typically, data is pulled into the chart from a database using either a Named Query or SQL Query binding on the Data property. The data
typically consists of a list of name-value pairs of things that are related.

Initial Dataset

The Pie Chart component contains an initial dataset with two columns, Label and Value. As the name implies, the Label column determines
the text associated with each wedge of the pie, while the value is the weight of the wedge.

EJ Dataset Viewer

Label Value

Apples 15
Eananas 36
Kiwis 19
Oranges 33
Grapefruit 7

T ) X B B«

Column Mame: —-- Column Type: --—

"Grapefruit","7"

CTWENANEST |
i "Label ", " Val ue" i
i "#TYPES'

Lotstrt,

H "H#RONS", " 5"

i "Apples","15"

{ "Bananas","56"

i "Kiws","19"

"(ranges", " 33"

Extract Order

When Extract Order is set to By Row, then the data must be formatted differently. This order expects each column to be a wedge. Note that
only the first row is utilized when extracting by row: subsequent rows are ignored.

"Grapefruit", " Appl es", "Bananas", "Ki wi s", "Oranges”
"H#TYPES"



Box and Whisker Chart

A Box and Whisker Chart displays pertinent statistical information about sets of data. Each 'Box and Whisker' item on the chart should
represent a large amount of data: The high, low, median, and where the middle 50% of the data falls. The dataset that is required for this
chart type will be all of your raw data, and it will calculate the box and whiskers for you.

Box Anatomy

The upper and lower bounds of each box (the colored in parts) represent the 1st and 3rd quartiles (quarters of a dataset range). This means
the space filled in by the box is 50% of your raw data.

The horizontal line inside of the box represents the median (middle) value.

The lines that stick out above and below the box (whiskers), represent the minimum and maximum values from the raw data.

W . ¢ . o
| Box & Whisker Chart :
1
1 1
| 1251 1
| 1
| 1
1 1
| 100 4 1
| 1
| 1
1 1
oa 75 1
= !

, B !
o = =
| 50 !
| 1
| 1
1 1
1 25 1 1
| 1
| 1
1 1
| 0 !

I Lot A Lot B :

1

1 1

I N Granite M Limestone :
o S -2

Using the Box and Whisker Chart

Typically, data is pulled into the chart from a database using either a Named Query or SQL Query binding on the Data property. The data
typically comes in categories separated by an optional key column, with each category containing multiple values.

Initial Dataset

The first column in the Box and Whisker Chart's dataset is the Key column. The Key column determines which series the data pertains to
(domain labels). Values in the Key column are case sensitive.

The second and additional columns denote categories (legend labels). The initial dataset contains two categories: Granite and Limestone.
Additional columns in the dataset would add additional boxes to the chart.


https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Box+and+Whisker+Chart

Dataset Viewer

Key Granite Limestone

Lot A 58
Lot A 43
Lot A 52
Lot A 86
Lot A 54
Lot A 3]
Lot A 63
Lot A 87
Lot A 31
Lot A 54
Lot A 25
Lot A 26

Column Name: — Column Type: —

127
110
81
113
111
126
101
65
100
04
70
74

0 ) X B x

€

" #NAMVES"
"Key","Ganite","Li mestone"
"#TYPES"

tstrt, ettt
"H#ROWNS", " 200"

"Lot A","28","108"
"Lot A","46","81"
"Lot A","103","57"
"Lot A","16","93"
"Lot A","41","91"
"Lot A","55","68"
"Lot A","23","93"
"Lot A","49", "97"
"Lot A","36","69"
"Lot A","47","106"
"Lot A","75","86"
"Lot A","14","115"
"Lot A","42","70"
"Lot A","100","129"
"Lot A","16","118"
"Lot A","62","125"
"Lot A","14", "51"
"Lot A","73","64"
"Lot A","35","55"
"Lot A","96","113"
"Lot A","50","93"
"Lot A"',"97","72"
"Lot A","7","80"
"Lot A","86","62"
"Lot A","87","78"
"Lot A","80","51"
"Lot A","100","94"
"Lot A","79","124"
"Lot A","39","107"
"Lot A","16","119"
"Lot A","20","60"
"Lot A","50","124"
"Lot A","37","50"
"Lot A","36","98"
"Lot A","46","77"
"Lot A","33","106"
"Lot A","49", "75"
"Lot A","84","60"




" Lot
"Lot
" Lot
" Lot
" Lot
" Lot
"Lot
" Lot
"Lot
" Lot
" Lot
"Lot
" Lot
"Lot
" Lot
" Lot
" Lot
" Lot
"Lot
" Lot
" Lot
" Lot
" Lot
" Lot
" Lot
" Lot
" Lot
" Lot
"Lot
" Lot
" Lot
" Lot
" Lot
"Lot
" Lot
" Lot
" Lot
" Lot
"Lot
" Lot
"Lot
" Lot
" Lot
"Lot
" Lot
"Lot
" Lot
" Lot
" Lot
" Lot
"Lot
" Lot
" Lot
" Lot
" Lot
"Lot
" Lot
" Lot
" Lot
" Lot
"Lot
" Lot
" Lot
" Lot
" Lot
"Lot
" Lot
"Lot
" Lot
" Lot
"Lot
" Lot
"Lot
" Lot
" Lot

A", "M1T7, 94"
A", " 44", " 93"
A", " T72", " 105"
A", "35","106"
A", "20","119"
A", "90","51"
A", "37","88"
A", "75","103"
A", "13","104"
A", "47", " 55"
A',"65","126"
A", "32","90"
A", "85","126"
A", "95", " TT"
A, T4, 123"
A',"104"," 68"
A", "90","109"
A", "63","66"
A", "60","90"
A", "28","65"
A',"64","69"
A", "55","62"
A", "98","64"
A", "69","100"
A", "35","110"
A", "31","115"
A", "51","106"
A", "16","76"
A", "91","93"
A", "90","TT"
A',"93","64"
A", "98","84"
A", "61","95"
A", "65","97"
A", "67","54"
A", "80","92"
A", " 104", " 123"
A", "104","112"
A", "20", " 71"
A", "95","99"
A", "37","98"
A", "91","51"
A',"101", " 106"
A", "68","94"
A", "9", " 96"
AL 14 T
A", "46"," 95"
A", "45", " 95"
A, T79", " 90"
A", "92"," 110"
A", "29","80"
A", 42", " 80"
A", "15","126"
A", "68"," 77"
A", "69","98"
A", "52", " 119"
A, 11, T2
A", 14", 122"
A", "36","115"
A", "41","66"
A',"98","73"
A", "46"," 116"
B","49"," 75"
B","33","46"
B","53","32"
B","51","58"
B","34","81"
B, " 44", " 73"
B, "71","43"
B","64"," 37"
B","58","77"
B","35","37"
B","76","88"
B","11","42"
B, " 11", " 64"



" Lot
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" Lot
" Lot
" Lot
" Lot
"Lot
" Lot
"Lot
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" Lot
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" Lot
" Lot
" Lot
"Lot
" Lot
" Lot
" Lot
" Lot
" Lot
" Lot
" Lot
" Lot
" Lot
"Lot
" Lot
" Lot
" Lot
" Lot
"Lot
" Lot
" Lot
" Lot
" Lot
"Lot
" Lot
"Lot
" Lot
" Lot
"Lot
" Lot
"Lot
" Lot
" Lot
" Lot
" Lot
"Lot
" Lot
" Lot
" Lot
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"Lot
" Lot
" Lot
" Lot
" Lot
"Lot
" Lot
" Lot
" Lot
" Lot
"Lot
" Lot
"Lot
" Lot
" Lot
"Lot
" Lot
"Lot
" Lot
" Lot

B","28","85"
B","26","58"
B","78","43"
B","43"," 69"
B","66","32"
B","7","42"

B, 17", " 71"
B","59","68"
B, " 7", "31"

B","53","48"
B*,"20","52"
B","71","58"
B","57","85"
B, "14","61"
B","34","47"
B, "59"," 74"
B","78","58"
B","64","81"
B, "19"," 31"
B","43","48"
B","58", " 38"
B","22","48"
B"," 20", " 83"
B","36","61"
B","40", " 69"
B","64","50"
B","67","70"
B","46", " 36"
B, "9","51"

B","10","41"
B","66", " 35"
B"," 46", " 44"
B"," 10", " 62"
B","13"," 35"
B","74"," 49"
B"," 69", " 64"
B","15"," 68"
B"," 56", " 38"
B","35","69"
B","61"," 37"
B"," 25", " 80"
B","38","89"
B","79","56"
B","6", " 64"

B","49"," 58"
B","5","54"

B","6", " 35"

B","38"," 75"
B, "6"," 77"

B","39","36"
B, "27","63"
B, "72","78"
B","55", " 38"
B","9", " 36"

B","40", " 65"
B","57","76"
B"," 65", " 55"
B, "74","81"
B","47"," 85"
B","66", " 84"
B"," 10", " 38"
B","23","53"
B","79","80"
B","27","58"
B","71","58"
B, "27","32"
B","73","43"
B","24","57"
B","27","59"
B"," 56", " 30"
B","32","55"
B","7","40"

B","20","63"
B","68"," 74"
B","64","57"



B","57","31"
B","54","61"
B","33","35"
B, "61"," 73"
B","36","61"
B", " 26", " 34"
B","9", " 59"

B","47"," 60"
B","61"," 86"
B","45"," 88"
B","5","87"

B","6", " 36"

Related Topics ...

Bar Chart
Classic Chart
Pie Chart
Radar Chart

Box and Whisker Chart
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HTML in Vision

HTML stands for HyperText Markup Language. It is commonly used to style text within web pages.

The features that HTML brings to style web pages can be applied to many components within
Ignition to style the text within components.

Using HTML in Components

Many Vision components display a text string. By default, a component's text is displayed in a
single font and color and will not wrap when its content exceeds the space the component has
made available to the text. However, you can use HTML if you want to mix fonts or colors within
the text or if you want formatting such as multiple lines. HTML formatting can be used in Vision
components such as buttons, labels, and tables. It can be used in common properties such as the
mouse over text property.

To specify that a component's text has HTML formatting, just put the <ht ml > element at the
beginning of the text, then use any valid HTML element in the remainder.

Closing the HTML element is optional. In other words, there is no need to place a <
/html> at the end of your stylized text. Also, the HTML elements are not case sensitive.

Common HTML Elements

HTML Tags are the special characters that instruct text to become stylized differently than other

text within the same text. The following table describes the most common HTML elements that you

can use within Ignition.

HTML Name Description
Element
<html>...</html> = HTML Initiates an html formatting. In most cases closing the html with

</html> is optional.

<b>...</b> Bold Applies a bold style to the contents of these elements.

<u>...</u> Underline = Underlines the text contained within the elements.

<s>..</s> Strikethro = Draws a line through the text contained within the elements.
ugh

<br> Break Applies a line break at this specific location.

<ol>...</ol> Ordered Places the text into an ordered list. Text inside list items are
List ordered by number.

<ul>...</ul> Unordere = Places the text into an unordered list. Text inside list items are
d List ordered by bullets.

<li>...</li> List ltem = Used to represent a list item. Should be contained in an order

list (<ol>) or unordered list (<ul>).

<center> Center Centers the contents of the text. Used directly after the HTML
Tag (that is, <html><center>...)

<font color="red" @ Font Colors the contents red. Works with standard color names, hex
>, .</font> numbers, or RGB numbers.

Applying HTML to Components

On this page

® Using HTML in
Components

® Common HTML
Elements

® Applying HTML to
Components
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HTML in Ignition

Watch the Video


https://inductiveuniversity.com/video/html-in-ignition/8.0

In Vision, you can add HTML to the text property of any component such as, a label, button, or
table. These examples aren't unique to their specific components, but can be used on any
component that has a Text or Mouseover Text property.

A good rule of thumb for what can be html formatted is text on components that is used
for display, not for input. So while the Label components have a Text property that
accepts html formatting, the Text Field component's Text property does not accept html
formatting, as a user may type into the component.

For example, individual words or phrases within the text can be made bold:

HTML in mouseover property

<htm >

These are the instructions:
<ol >

<li>Stop the process.</li>
<li>Check on this.</li>
<li>Renpve that.</li>

</ ol >

@ INDUCTIV]
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Multi-Line Labels
and Buttons

Watch the Video


https://inductiveuniversity.com/video/multi-line-labels-and-buttons/8.0

Localization in Vision

Overview

Localization in the Vision module utilizes the terms in the platform's Translation system. Once On this page
terms have been defined, translations can be enabled by either component or scripting.

Selecting a Language on Client Startup . Overview
® Selecting a
Once you create a second language, the Client Login Screen will automatically display a Language on Client
Language Selector where you can select your preferred language. There is Project Property Startup
setting that allows you to Show or Hide the Language Selector at login. By default, it is set to ® Language Selector

Automatic so you will see the Language Selector at login when two or more languages are created
unless you choose to hide it.

If a user that has a preferred language selected in their user profile settings, Ignition will login to
the Client with their preferred language automatically.

@ INDUCTIVI
UNIVERSI]

Username

Switching the
Current Language

Password

Language

- Watch the Video

espafiol

tgnition./ {3} Inductive

Language Selector

A single Language Selector on a window has the potential to trigger translations on all windows.
There is no binding involved in selecting a language because they are compared directly against
the Translation Manager database, so the component only needs to be placed onto a window after
a second language has been defined.

The component also offers an easy way to switch languages without forcing the user to log out
first. This way a single Language Selector component can exist on a navigation window and
provide language translations for all components on all windows.

More information on the Language Selector Component can be found in the Appendix.


https://legacy-docs.inductiveautomation.com/display/DOC80/Localization+and+Languages
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Overview
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User Management

Schedule
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@ LockScreen
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F Logout

Related Topics ...

® Localization and Languages
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Binding Types in Vision

Binding is perhaps the most important concept to understand when designing a project using the
Vision module. It is primarily through property bindings that you bring windows to life and have
them display useful things. A binding simply links one component's property to something else.

When you initially place a component on a screen, it doesn't really do anything. Changing
its properties in the Designer will make it look or act different, but it has no connection to the real
world and this is what bindings adds.

Binding, as its name suggests, lets you bind a property to something else, such as

A Tag

The results of a SQL query executed against a remote database
Another component's property

An expression involving any of these things

For example, bind the Value property of an LED Display to an OPC Tag, and voila - the

value property will always be the value of that Tag - creating a dynamic display. Bindings can also
work the other way, using a bidirectional binding. Bind the value of a numeric text box to a Tag,
and that Tag will be written to when someone edits the value in the text box.

The power of bindings comes from the variety of different binding types that exist, and the fact that
you can bind nearly any property of a component to anything else. Want its foreground to turn

red when an alarm is above a certain severity? Bind its LED Lit property color to a Tag's Alarms.
HighestActivePriority property. Want it to only appear if a supervisor is on shift? Bind its visible
property to the result of a SQL query that joins a personnel table with a shift table. The possibilities
are nearly endless.

Property Binding Types

A property can have one of many different types of bindings. Instead of setting a label statically,
the text might change based on a PLC value or on-screen selection. There are many ways to bind
your components to show values from PLCs, databases, other components, or user input. You can

even bind some or all of the properties on each component. You can bind component values using:

® Property simply binds one property to another. When that property changes, the new
value is pushed into the property that the binding is setup on.

® Tag binds a property directly to a Tag property (typically the value) which sets up a Tag
subscription for that Tag, and every time the chosen Tag property changes, the binding is
evaluated, and pushes the new value into the bound property.

® |ndirect Tag is similar to the standard Tag binding except that you can introduce any
number of indirect parameters to build a tag path dynamically in the runtime.

® Tag History is used for Dataset type properties. It runs a query against the Tag Historian.

® Expression uses the simple expression language to calculate a value which can involve
lots of dynamic data.

®* Named Query executes a Named Query that had been previously created.

® SQL Query is a polling binding type that runs a SQL Query against any of the database
connections configured in the your Gateway.

® Database Browse is equivalent to the SQL Query binding except that it helps write the
queries for you.

® Cell Update enables you to easily make one or more cells inside a dataset dynamic. This
is useful for components that store configuration information inside datasets like the Easy
Chart.

® Function is a generic binding type that lets you bind a dataset property to the results of a
function. It allows any of the function's parameters to be calculated dynamically via Tag
and property bindings.

® Style Customizer is not one of the standard bindings, but changes properties to create
cohesive styles based on different states.
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Setting Up Bindings

Every component that you put on the screen has various properties that change the component's appearance and behavior. To make
components do something useful, like display dynamic information or control a device register, you configure bindings on the component. It's
the bindings that brings your components to life and have them do useful things. Components can be configured to do just about anything

using bindings. To set up a binding on a property, simply click the Binding = icon to the right of the property in the Property Editor.

In this image, bindings were set to make these random components do something. You can quickly view dependencies to determine what is
linked to what by going to View > Dependencies > Show All. As shown below, a line is drawn from the Tank to the Slider letting you know
the Tank is bound to the Slider.
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Event-Based Bindings vs. Polling Bindings

While there are quite a few different binding types, they fall into two broad categories: event-based and polling. Some complex bindings can
span both categories.

Event-based bindings are evaluated when the object they are bound to changes. For example, when you bind a property to a Tag, that
binding listens to the Tag, and every time the Tag changes, it assigns the Tag's new value into the property that it is on. If you bind the value
of a Cylindrical Tank to the value of a Slider, every time the slider changes, it fires a propertyChangeEvent. The binding is listening for this
event, and when it is fired, the binding updates the tank's value. The following bindings are event-based:

® Tag and Indirect Tag bindings



® Property bindings
® Some Expression bindings
® Cell Update bindings

Polling bindings are evaluated when a window first opens, on a timer, or when they change. For example, if you bind the data property of a
Table to the results of a SQL query, that query will run on a timer, updating the Table every time it executes. The following bindings are
based on polling:

® Bindings that query a database, including Named Query bindings, DB Browse bindings, SQL Query bindings, and Tag History
bindings

® Some Expression bindings, like runScript() or now()

® Function bindings

Many bindings can combine elements of a polling binding and event-based binding. An expression binding may combine lots of other
bindings to calculate a final result. A query binding will often itself be dynamic, altering the query based on other bindings.

For example, you might have a dropdown on a window that lets the operator choose a type of product that is produced. Then you can use a
query binding like the following to calculate the defect rate for the given product:

SQL - Using a Component Property Reference

SELECT
SUM def ective) / COUNT(*) AS DefectRate
FROM
production_t abl e
WHERE
product Code = ' {Root Contai ner. Product Pi cker. sel ect edVal ue}"'

The blue code is a property binding inside of the query binding. Every time this (event-based) binding fires, the query will run again, but will
also run on a set timer based on its polling schedule. Using bindings like this, you can create highly dynamic and interactive screens with no
scripting whatsoever.

Polling Options
The following are the options you can choose from for bindings that poll:

® Polling Off
The query will run once when the window is opened, and again whenever a reference inside of the the binding changes.
® Relative Rate
The binding will poll at the project's Base Polling Rate, which is 5 seconds by default, plus or minus the given Polling Rate.
®* Absolute Rate
Using this option, you can specify an absolute rate for the binding to execute at, instead of one that is based off the relative rate.

Regardless of which option is selected, polling bindings always fire when the window the component is on opens. This allows the component
an opportunity to fetch an initial value.

Additionally, all three types will always update if the binding contains a reference to something else, such as a Tag or property value (noted
with the brace-notation "{}"), and the value of that reference changes. Typically this is seen in SQL query bindings: polling can be turned off,
and the query can reference a component value in a WHERE clause. When the referenced property value changes, the query will execute
and retrieve new results.

Copying Bindings

When you copy a component, all bindings, scripts, etc. are copied along with it, but you can also copy a property binding from one property
to another. Bindings can be copied from one property to another by right clicking on a property with a binding on it and selecting Copy
Binding. Then, on another property, right click and select Paste Binding to paste the binding onto the property. This can be on the same
component or a completely different component. The only prerequisite is that both property bindings must use a compatible property type.
(For example, a binding that resolves to a string will not work on an integer property.)
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Property Bindings in Vision

Property to Property Binding

A property binding is a simple type of binding. It binds one component's property to another. When
that property changes, the new value is pushed into the property that the binding is set up on.

@ Why aren't all properties listed?

You may notice that the list of properties available to bind to is smaller than the list of all
properties. While nearly all properties can be bound, only some properties can be bound

to. Only properties that fire a propertyChangeEvent may be bound to.

In the following example, we'll bind the value of a Numeric Text Field to a Slider component.

1. Place a Numeric Text Field component and a Slider component on window.
2. Select the Numeric Text Field.

3. Click the Binding L icon next to the Value (Integer) property.

Vision Property Editor 8- X ]
P H o= =l - 1
7

® Common il g,
& Behavior J
Sl Data ]
Number Type Integer v & ]
Maximum 1000 & 7]
Minimum 0.0 € 5
T o
Value (Double) 0.0 & 1
value (Long) 0e 3_
Value (Float) 00ed |0
Quality Good Ee 1

4. Select the Property Binding Type. Choose the Slider's Value property.
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sqQL
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® NoBinding
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x
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Options
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5. Click OK. Put the Designer in Preview Mode "
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6. Move the slider. You'll see that the value from the Slider component appears in the
Numeric Text field.

45

0 25 50 75 100

This can be useful to provide visual feedback to what a user is doing. The operator would input
something, and they would see another component adjust to match the setting they just changed.
Notice though, how if | were to change the value of the Numeric Text Field, the Slider will not
update. Bindings are one direction only by default.

Bidirectional Property Bindings

Property Bindings have the ability to become Bidirectional, meaning instead of having the binding
go one way only, it will work both ways, even with just the one binding. Take the previous example
with the Numeric Text Field and Slider again. When changing the value of the Slider, the Numeric
Text Field would update, but updating the value of the Numeric Text Field would not update the
Slider. If we reopen the binding on the Value (Integer) property of the Numeric Text Field, we can
see in the bottom left corner a checkbox for Bidirectional.

[ Property Binding: Root Container.Numeric Text Field 1 X
Tag Property
Tag Binds to another component's property in the same window
Indirect Tag
Property Choose Property
» @@ Numeric Text Field 1 )
Expression
- = Slider
= ame suing
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Named Query N
B Minimum Value (int)
DB Browse B Maximum Value (int)
sQLQuery  Styles (Dotoset)
u Data Quality (int)

m Quality (QualityCode) -
Root Container.slider.value -

Options

NoBind s, lay Opt-Out
© NoBinding Bidirectional| || Overlay Opt-Ou
E Cancel

Check the Bidirectional option and then save the binding. It will now be a bidirectional binding.
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Watch the Video
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Tag Bindings in Vision

Binding Properties to Tags

A Tag binding is a very straight-forward binding type. It simply binds a property directly to a Tag.
This sets up a subscription for that Tag, and every time the chosen Tag changes, the binding is
evaluated, pushing the new value into the bound property. If you choose a Tag in the tree, and not
a specific property of that Tag, the Value property is assumed.

Drag and Drop

There are several ways to drag and drop Tags onto a component allowing you to create screens
very quickly. You can quickly bind a Tag by dragging it from the Tag Browser into a component or
into the component property.

Binding to a Component

Ignition automatically creates the Tag bindings to several of the component properties when you
choose to bind a Tag to a component by dragging and dropping. This is true for both creating a
component by dragging and dropping a Tag onto empty space on a window at the same time
Ignition prompts you for what type of component you want to create, and by dragging and dropping
a Tag directly onto a component that already exists on a window. In both cases, Ignition
automatically creates the Tag bindings on the component.

In addition, some of the bindings will be bidirectional or they may be expression bindings. How
Ignition handles the binding depends on the disparity between the datatypes of the Tag and the
target component. For example, binding a numerical Tag to a label component will result in an
expression binding that formats the number to a string.

Binding to a Component Property

Ignition automatically creates a Tag binding to the property that you dropped the Tag into in the
Property Editor, resulting in the property binding to the value of the Tag. In addition, it is possible
to bind the Tag attributes to the component's property. For example, the Tag's Engineering High
Limit attribute could be bound to the capacity property of a cylindrical tank component.

Bidirectional Tag Bindings

Tag bindings can be made bidirectional simply by checking the Bidirectional checkbox at the
bottom of the Property Binding window. A Tag can be set as a bidirectional binding, if it has a
read/write permission and if the user has the security permission to write to the Tag. The Fallback
Delay is the amount of time that the value will remain at the written value, waiting for a Tag change
to come in. If no Tag change comes in within the allotted time (specified in seconds), the property
will fall-back to the value as it was before the write. This is needed, because sometimes even if a
write succeeds, another write or ladder logic in a PLC might have written something different, even
the old value, in which case no Tag change event will be generated. As a rule of thumb, the
fallback delay should be twice the Tag's scan class rate.
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Bindings to Tag Properties

Watch the Video

Aside from binding a property to a Tag's value, you can also bind to properties on a Tag, such as Tooltip, Quality, or AlarmActiveAckCount
. This is useful when you don't need the value of the Tag, but rather the state, or some other configuration on the Tag. Here we see a
boolean Memory Tag. It has a property indicating the Tag's quality. We can easily display that quality property on a component.

The simplest approach involves a Tag Binding. This can be achieved by dragging-and-dropping the Tag Property onto a Window,

component, or component property. This example uses a Label component.

Tag Browser a - X || ]
Q o ¥-a 0 906 H .
¢+ i Tanks_OPC Al ]
~ fw Test T
= % Alarm_Active_1 OPC Boo
¥ Enabled (] oolean -
B OpcltemPath ns=1;5=[Sim_SLC String .
B OpcServer iti AS... String J
Good string | | ]
B TagGroup default String 0
B Timestamp 2019-05-13 9:44..., DateTime i
B value Boolean ]
~ ® Alarms String ]

Display b | Label

Control >

Templates »

This is similar to creating a standard Tag Binding, except we're using a property on the Tag instead of the Tag's value. The resulting Tag
Binding would look like the image below. Note that the property name has been appended to the path.
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The Label component now displays the current value for the Tag's Quality property.
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Indirect Tag Bindings in Vision

Binding Properties to a Dynamic Set of Tags

An Indirect Tag binding is very much like a standard Tag bindi i

i St s i oo s e | (@) INDUCTIV]
parameters are numbered starting at one, and denoted by braces, for example, {1}. The binding UNIVERSIT
will be linked to the Tag represented by the Tag path after the indirection parameters have been

replaced by the literal values they are bound to. An indirection parameter may represent a property

on any component in the same window.

Indirect Tag Binding

For example, instead of binding straight to a Tag's path, like

[ [TagProvi der] M/Pl ant/ East Ar ea/ Val ves/ Val ve4/ Fl owRate Watch the Video

or

You can use other properties to make that path indirect. Suppose the "area" and "valve" number
that we were looking at was passed into our window via parameter passing. Then we might use
those parameters in the Tag path, like this:

[ TagProvi der] MyPl ant / { 1}/ Val ves/ Val ve{ 2}/ Fl owRat e
{1} =Root Cont ai ner . Ar eaNane
{2} =Root Cont ai ner. Val veNunber

Now our binding will change which Tag it is pointing to based on the values of those Root
Container properties.

Creating an Indirect Tag Binding

When setting up an Indirect Tag Binding, there are a few tools in the binding window that help make it easier.

First there is the Indirect Tag Path. This field is where the Tag Path with parameters needs to be entered. Indirect Tag Bindings use
numbered parameters at places in the Tag Path where indirection is going to occur. To the right of the Indirect Tag Path field are the Tag and
Property reference helper buttons. The Tag button will enter the full Tag Path of the selected Tag into the Indirect Tag Path, while the
Property button will add a new parameter reference to the Indirect Tag Path, and bind it to the selected property. The last area is the list of
references, where each row in the list corresponds to a {1} parameter reference, and each row can be bound to property on the window. To
bind a parameter reference to a property, simply select its corresponding row, and use the property selector to the right of the References list
to select a property from the window.

@ Putting some thought into your Tag structure will make using the Tags indirectly much easier!

Bidirectional Indirect Tag Binding

Indirect Tag Bindings can also be made Bidirectional by clicking the Bidirectional checkbox at the bottom of the binding window. This will
allow any input from a user on that property to be written back to the Tag. To work properly, the Tag needs to have the proper security to
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accept writes.

Property Binding: Root Container.Cylindrical Tank >
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Property . o : .

@ AnIndirect Tag Binding lets you bind to a tag dynamically, where parts of the tag's X
Expression path are defined by properties on your window. For instance, you could bind to
Property [source]tanks/tank{1}_SP, and then define that {1} refers to {Root

Container. TankNumber}
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Indirect Tag Binding Example

In this example, we have some different motors, where each motor is a folder of Tags. Each motor has an amps Tag that is within the folder,
so that our Tag paths look like the following:

Mot or 1/ Anps
Mot or 2/ Anps
Mot or 3/ Anps
Mot or 4/ Anps

Instead of creating four different displays for these four different Tags, we can create a single display and make it indirect. We need two
things for this example: a component to display the value in, and a component which allows the user to select which motor they are looking
at.

Drag an LED Display component onto the window.

Then drag a Spinner component onto the window. This we will use to enable the user to select which motor they are looking at.
There are four motor Tags, so change the Numeric Maximum property of the Spinner to 4, and the Numeric Minimum property to
1. You may also need to change the Value (Integer) to 1.

wh e
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4. Select the LED Display component. Click on the Binding e

5. Select the Indirect Tag type.

icon next to the Value property of the LED Display.

a. Click the Tag * icon and select the Motor 1/Amps Tag.
b. Delete the '1' in the Tag Path, and replace it with {1}.

=

c. In the References section, select the row, and click the Insert Property Value
of the Spinner.
d. Click OK to save the binding.

icon. Select the Value (Integer) property

Property Binding: Root Container,LED Display X
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Property could bind to [source] tanks/tank{1}_5P, and then define that {1} refers
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Options
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6. To test it out, put the Designer into Preview mode ’ Notice how the value represented in the LED Display depends on what value
is in the Spinner. Because the Spinner has the maximum value set to 4, users won't be able to set a motor number that does not
exist. Additionally, adding new motors simply means adjusting the maximum value on the Spinner.
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Tag History Bindings in Vision

Binding Properties to the Tag Historian

The Tag Historian binding type, which is only available for Dataset type properties, runs a query
against the Tag Historian.

Selected Historical Tags

For this type of query, you must select at least one Tag path from the Available Historical Tags
to query. The Dataset returned by the query will have a timestamp column, and then a column for
each path that you select here.

Date Range

Choose either a Historical or Realtime query. Historical queries use a date range that must
be bound in from other components on the screen, typically a Date Range or a pair of Popup
Calendars. Realtime queries always pull up a range that ends with the current time, so all
they need is a length.

This example uses a Historical query and two Popup Calendars for the start and end dates. The
history is presented in the Table below.

1. In the Designer, drag two Popup Calendar components and a Table component from the
Component Palette into your workspace.

2. Select the Table and right click on the Binding =2 icon for the Data property.

3. Drag a sine0, sinel, and sine2 under the Tag Path column under the Selected Historical
Tags area.

4. Under Date Range, select Historical.

5. Under Start Date Binding, click on the Property [Z] icon and under one of the Popup
Calenders, select Date.

6. Under the End Date Binding, click on the Property [Z] icon and under the second Popup
Calender, select Date.
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8. Now you can see the history of the three Sine tags along with a timestamp. You can scroll
through the information in the table to see the history that was logged. To change the

date range, click on dropdown buttons to bring up the popup calendars to change the date

range.
The tag history binding type allows you to bring back this history.
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Start Date End Date
06/25/2020 12:00 AM LI 06/26/2020 12:00 AM LI
t_stamp sined sinel sine2
Jun 25, 2020 5:56 AM -2213 169.82 83.14 "
Jun 25, 2020 5:56 AM -22.13 169.82 75.51
Jun 25, 2020 5:56 AM -30.98 169.82 75.51
Jun 25, 2020 5:56 AM -30.98 19243 75.51
Jun 25, 2020 5:56 AM -30.98 192.43 66.68
Jun 25, 2020 5:56 AM -38.47 102,43 66.68
Jun 25, 2020 5:56 AM -38.47 214.46 66.68|-

Sample Size and Aggregation Mode

In places where the Tag History system can be queried, a Sample Size and Aggregation Mode ca
n be selected that will determine how the results will be queried out and how the raw values will be

INDUCTIV]

aggregated.

UNIVERSI]
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Aggregation Mode

The Aggregation Mode dictates what happens when multiple raw values are encountered for a given sample window (the size of which is
determined by the number of requested rows, or the interval size).

Aggregation Description

Mode

Time- The values are averaged together, weighted for the amount of time they cover in the interval.

weighted

Average

Min/Max The minimum and maximum values will be returned for the window. In other words, two rows will be returned. If only one
value is seen in the interval, only one row will be returned.

Closest The value closest to the ending time of the interval will be returned.

Value

Basic The values are summed together and divided by the number of values.

Average

Sum The values in the interval are summed together.
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Maximum The maximum value in the interval.
Minimum The minimum value in the interval.
Duration On Returns the number of seconds that the value was recorded as non-zero.

Duration Off Returns the number of seconds that the value recorded as zero.

Count On Returns the number of times the Tag's value went from a zero value to non-zero.
Count Off Returns the number of times the Tag's value changed from a non-zero value to zero.
Count Returns the number of times a value was recorded

Percdent Time-weighted percentage of good values over the date range.

Goo

Percent Bad = Time-weighted percentage of bad values over the date range.

Range Returns the range between the highest and lowest value for the period.
Standard Standard Deviation - Returns the standard deviation of values, or how much spread is present in the data; low standard
Deviation deviation shows the values are close to the mean, and high standard deviation shows that the data points are spread out

over a large range of values. Only good quality values are used when calculating

Variance Returns the variance of values. Similar in concept to standard deviation. Only good quality values are used when
calculating.

Sample Size

The sample size determines how many data points will be returned from the query.

On Change

An On Change query will return points as they were logged, and can be thought of as a "raw" query mode. This means that the results may
not be evenly spaced. Also, it is important to note that every changed value will result in a row, and therefore if you are querying multiple tags
and once, you may end up with more rows than you anticipated. For example, if Tag A and Tag B both change, you would end up with [[Aj, B,

1A, Bgl. [A, Byl

If you want to essentially retrieve raw values, while coalescing them down into fewer rows, try using the Interval sample mode, with an
interval set to your largest acceptable time between rows, and select "prevent interpolation” from the advanced settings.

Natural

A Natural query will look up the logging rate for the queried tags (when possible), and return results spaced apart at that rate. This means
that the return size will vary with the date range.

Fixed

You can use the Sample Size and Aggregation Mode on the Tag History binding type to fix the number of records that are retrieved. The
Fixed sample size will cause the binding to retrieve all records from the date range, and aggregate them evenly between a fixed number of
points. This will ensure that the number of rows will remain the same without regard to the size of the dataset. In windows where users are

able to select a large range of data, Fixed is recommended as it will prevent the property from loading an excessive number of records.

In cases where the number of points can not evenly represent the data from the date range, an extra point will be added, making the final
size of the dataset the fixed value + 1.

Selecting the Min/Max aggregation mode returns two rows of data for every row requested. Each pair represents a minimum and a
maximum result from the underlying data. Therefore, a table with a fixed length, would return double the requested amount with Min/Max
aggregation mode selected. With Min/Max aggregation mode selected, and with a fixed row length of one, the data set returns the oldest tag
value of the time range

The following image shows a Tag History Binding pulling data from the last one day. The Sample Size is configured to Fixed with a value of 1
00, and the Aggregation Mode is set to Basic Average. This means that the binding will query for data from the last one day, regardless of
how many records there are, and create 100 time-slices that are evenly dispersed between the start and end periods of that range. Then, a



basic average of the tag values are calculated for each time-slice. The resulting values are then returned to the property.

Available Historical Tags ¢ Selected Historical Tags
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Note the Insert Property icon next to Sample Size. This allows a property binding to determine the number of data points, so you could
change the size to increase or reduce the amount data points on the chart from the client.

Interval

Where as the Fixed sample size will calculate time slices based on the date range, the Interval sample size allows you to determine the size
of the time slices. This sample size will divide the date range by the interval size to determine the size of each slice. Because of this, it is
recommended to use an interval that is evenly divisible by the date range. However, in the event that the date range is dynamic or user
driven, interpolation will handle any partially built slices. Even though the binding may attempt to evenly distribute the slices, there may be an
extra row that represents the current values as they are building an interval.

The image below shows a Realtime range of 60 minutes. The Aggregation Mode is set to Time-weighted Average, and the Sample Size i
s set to Interval for 5 minutes. This means that the binding will query for data ranging from 60 minutes ago to now (or whenever the binding
last executed, in the case that polling has been turned off). That 60 minute window will be divided as evenly as possible into 5 minute time-
slices, so there should around 12 time-slices. Each time slice will aggregate its value based on the time-weighted average of all values within
that slice.



The example uses a Realtime range, but a Historical range could easily be used instead.

Available Historical Tags ¢ Selected Historical Tags
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-l Indirection

Ref. # Property Path
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Note the Insert Property El icon next to Sample Size. This allows a property binding to determine the number of data points, so you could
change the size to increase or reduce the amount data points on the chart from the client.

Return Format

Return format dictates how the requested data will be returned. The options are "wide" (default), in which each Tag has its own column, and
"tall", in which the Tags are returned vertically in a "path, value, quality, timestamp" schema.

Advanced Options

These options affect the query results in more subtle ways.

® Ignore Bad Quality - Only data with "good" quality will be loaded from the data source.

® Prevent Interpolation - Requests that values not be interpolated, if the row would normally require it. Also instructs the system to
not write result rows that would only contain interpolated values. In other words, if the raw data does not provide any new values for
a certain window, that window will not be included in the result dataset.

® Avoid Scan Class Validation - "Scan class validation" is the mechanism by which the system determines when the Gateway was
not running, and returns bad quality data for these periods of time. By enabling this option, the scan class records will not be
consulted, which can improve performance, and will not write bad quality rows as a result of this check.

—llAdvanced

Ignore Bad Quality Prevent Interpolation Avoid Scanclass Validation

Tags Historian information is often easiest to work with in the Easy Chart component, which handles all of these options
automatically.
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Indirect Tag History Binding

The Tag History Binding can be made indirect but using indirection parameters in the Tag Paths of
the Selected Historical Tags. This works similarly to the Indirect Tag Binding, which uses " p INDUCTIV]
Indirection References within the Tag Paths to substitute something into the path. Valid Indirection -_:. :-‘1. UNIVE RSI']

references consist of a reference number within curly braces. Simply type the indirection
parameters (for example, {1}) into a selected Tag path by double-clicking in the list of selected
paths. All valid parameters will appear in the lower indirection table.

Indirect Tag History
Binding

In this example, the Tag Path points to the Spinner component for the indirection parameters.

Watch the Video
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Expression Binding in Vision

Binding Properties to the Outcome of an
Expression

An expression binding is one of the most powerful kinds of property bindings. It uses a simple expr
ession language to calculate a value. This expression can involve lots of dynamic data, such

as other properties, Tag values, results of Python scripts, queries, and so on. Any time

information needs to be massaged, manipulated, extracted, combined, split, and so on,
expressions can get the job done.

Event Based and Polling

Expression bindings fall into the unique category of having the possibility of using both Events and
Polling to update. How an expression updates depends on what is being done in the expression.
Expression bindings will always update immediately when the window they are in is opened. When
they update again depends on if they are driven by events or polling. Typically, expressions are
driven by events. If the expression was adding multiple values together, then when one of those
values changed the expression would update, regardless of whether those values came from other
properties or Tags. However, the expression function has some unique functions that can update
at a set rate such as the now() function. When these functions are used within the expression, the
expression binding will update based on the specified polling rate.

Using Expression Bindings

The expression language has lots of tools available that help calculate a specific value such as built
-in expression functions, multiple operators, and the ability to reference Tags. While all of these

can be manually typed into the expression, the expression binding window makes it easy to
reference these options.

Helper Icons

To the right of the expression binding window, there are four icons that can be used to reference
specific objects or functions easily.

. B Properties - Places a property reference into the expression at the cursor, pulling in
that property's value into the expression at the time of evaluation.

. Tags - Places a Tag reference into the expression at the cursor, pulling in that Tag's
value into the expression at the time of evaluation.
+

® = Operators - Places the operator into the expression at the cursor. Mostly used as a
reference to what operators are available for use.

. 2 Functions - Places the function into the expression at the cursor. Can be used as a
reference for what functions are available, as well as the parameters the function is
expecting.

On this page

® Binding Properties
to the Outcome of
an Expression
® Event Based and
Polling
® Using Expression
Bindings
® Helper Icons
® Expression
Binding Examples
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Expression Binding

Watch the Video
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Expression Binding Examples

Example 1

You have a button that starts a batch, but you only want to let it be pressed after the operator
entered a scale weight. An expression binding can be set up on the enabled property of the button:

Example 2

You want to display a process's current state, translating a code from the PLC to a human-
readable string. The examples below will yield the same results, but in different ways.

This first example uses nested "if" statements to produce the string. Notice that the false return for
the first "if" statement is another "if" function, and the same with the second "if" function. Since

the "if" function can only do simple if/than/else logic, this method allows us to do an if/than/else if
lelse.

if ({CurrentProcessState} = 0, "Not Running", i
if ({CurrentProcessState} = 1, "Warnmup phase - please wait", 1
if ({CurrentProcessState} = 2, "Running", "UNKNOMWN STATE")))

This example will yield the same result as the previous example, but works differently. Instead of
using multiple functions, this example uses a single switch function to decide which string to use.

i switch ({CurrentProcessState}, 1
i 0,1, 2, H
"Not Runni ng", i
i "Warmup phase - please wait", i
: " Runni ng", :
§ " UNKNOWN STATE") i

For more examples, see Expression Overview and Syntax.
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Named Query Bindings

Binding Properties to a Named Query

The Named Query binding is where you can configure a property to call a Named Query that you
had previously created in the project. Using Named Query binding instead of a SQL Query or DB
Browse binding helps to make your project more secure due to the built-in Security Zone and User
Role restrictions.

Polling Mode

Each Named Query binding type will use polling to determine when to update the results and run
the query again. The Polling Mode dictates how often the query will execute, and works in a similar
fashion to polling on other bindings.

Creating Named Queries

In order to use a Named Query, first one has to be created. You might already have some that
another developer created but if not, you will have to make one by going to the Named Query
section in the Designer or converting a SQL query.

Using Named Queries on Dataset Properties

The majority of your Named Query bindings will most likely be on a dataset type property. When placed on a Dataset type property, only a

On this page

Binding Properties
to a Named Query
Polling Mode
Creating Named
Queries

Using Named
Queries on Dataset
Properties

Using Named
Queries on Scalar
Properties

D

Named Query
Binding

Watch the Video

single Named Query needs to be specified. An explanation of the various fields on the binding are detailed below:

® Path: Here you can enter in the path to the Named Query. Click on the Search Os' icon to view a list of available Named Queries.

® Parameters: Here you can see a table of all defined Named Query parameters. You can pass in property or Tag values to the

parameters by first highlighting the parameter and then selecting either the Insert Property

icon or the Tag

2

icon

® Query: The Query section shows what Named Query looks like. Note that you can't modify the query on this page.
® Polling Mode: Here you can set the Polling Mode of the Named Query binding based on the Polling Rate.
® Retain Rows: If true, any rows that you have returned within the Designer will be saved along with the window. This may slow

window load times.

INDUCTIV]
UNIVERSI]
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Using Named Queries on Scalar Properties

When placed on a non-dataset type property (such as a String or Integer), then the Named Query binding allows for a second Named Query
to be specified in the case that the user can update the value on the property. This provides an opportunity to both return and update values
in the database from the same component.

The configuration is very similar to a Named Query binding on a dataset property. You need to specify a Named Query path, set up your
Parameters, and choose a Polling Mode. You can finish setup at this point, leaving the update query disabled so that the property will simply
pull the value from the database.

However, if you want the binding to be bidirectional, you need to specify an UPDATE query. This works similar to a SELECT query, in that
you need to select the path to the Named Query and set up any Parameters. However, it is important to make sure that the Named Query
chosen for the UPDATE query is in fact setup as an UPDATE query by setting the Query Type property on the Authoring section of the
Named Query.
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® Named Queries
® Named Query Parameters
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DB Browse Bindings

Binding Properties to Database Tables

The DB Browse binding is technically equivalent to the SQL Query binding, except that it helps On th|3 page
write the queries for you. Using the Database Browse binding type, you can pick the table from a
list of tables in each database that you want to pull content from. If you have a fixed range of data
you need to return, simply select it in the table, and watch the query get generated.

In the Browse Database tree, you can choose which columns in your table should act as your keys
(these columns get put in the WHERE clause based on your selection) and which columns should
be used to sort the data (these columns are put in the ORDER BY clause).

® Binding Properties
to Database Tables
® Configuring the

Binding

@ This binding type also serves as a convenient jumping-off point for the more flexible ¢ Key Column

SQL Query binding. Construct the basic outline of your query in the DB Browse section, * Sort Order

and then select the SQL Query radio button to convert to the new binding type. Your ¢ Dynamic Filters

query will be retained and can then be modified manually. ¢ Scalar Query Update
Property Binding: Rect Container.Table 2 X
Tag DB Browse
Tag Binds to data from a database, allowing you to browse for the data you want
Indirect Tag
INDUCTIVI
Property \;J[PrUJEE(DEFau\(] ® == Choose ATable -
Rl W ol UNIVERSI]
Property .
o 1
Named Query

e Key Columns . .
—— DB Browse Binding
cell Update G
Functions Polling Mode Polling Rate Retain Rows
ff _ Relative _ Absolute Rate=(BaseRate)+~ 0|3 sec | |false H
ey Watch the Video
© NoBinding :
B o

Configuring the Binding

After selecting a table in the Browse Database tree, you can customize which columns the query is selecting by selecting one or more
columns under the table to select just the highlighted columns, or selecting the table to use the * symbol to select all columns.

Key Column

The DB Browse binding has the ability to designate key columns within the query. A key column is used within the select query's where
clause, and can be given a value. A column is denoted as a key column when it has a key symbol next to it.

—
Clicking the Key ‘@g icon to the right of the Browse Database tree will designate a column as a key column. Alternately, if the highlighted

[©
column is already a key column, then clicking the Key & icon will remove that column as a key column.
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Lot ID
496
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Lot 3
534
550
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SELECT tank_overview_ndx FROM Tank_O\.reIuiewll\'HERE tank_overview_ndx = 1 I

Enable Database Writeback

UPDATE Tank_Overview SET tank_overview_ndx = {this} WHERE tank_overview_ndx

Notes
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Sort Order

In the DB Browse binding, you can also sort data in ascending or descending order. Select the column that you want to sort by and click the

Sort fE icon. Multiple columns can be used for sorting.

Dynamic Filters

DB Browse bindings also give the ability to bind a property to a key column to allow for dynamic
filtering of the returned data. Simply click the binding &2 icon next to the key column field. This
allows you to give the operators some control over the data they are seeing.

b

In the Designer, drag a Table component and a Text Field component on a window.

With the Table component selected, click the Binding
Chose DB Browse under Binding Types > Database.

=

icon next to the Data property.

.

@ INDUCTIVI
s UNIVERSI]

DB Browse Binding
- Dynamic Filters

Watch the Video

Let's pull all the data from this Table except for the id, and filter on state. Remove the Key éa from the id column and place it on the
state column.
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5. Select the Tank_Number, Lot_ID, Notes, and t_stamp columns. You can do this with Control+Click, or by clicking and dragging in
the results table in the upper right.

6. Instead of statically typing in a value like we in did in the above example, let's make it dynamic using the Text Field. Click the Insert

=

Property Value icon next to the value in the Key Columns section, and select the Text property of the Text Field.
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7. Notice there is now a property reference in the Key Column as well as the Generated SELECT Query.
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8. Click OK to confirm the binding.
9. Put the Designer into Preview mode.

10. Enter the Lot_ID that you want to view. You'll see the Table update to display just the data for that Lot ID.

296

Tank_Number Lot_ID
23 296
24 296

Tank_Number Lot_ID
16 b46
17 646
20 646

Scalar Query Update

Notes
300
300

Notes
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650

t_stamp
2019-03-20 12:36:00
2019-03-20 12:36:00

t_stamp
2019-03-20 12:326:00
2019-03-20 12:36:00
2019-03-20 12:36:00



Similar to the SQL Query Binding, the DB Browse Binding has the ability to become bidirectional IN DUCTIV]
by doing a database write back when the property being bound is a non-dataset type. In this case,
the select query should be configured to only return a single row from a single column. UNIVERSIT

For example, this option can provide a single value to the Text property of a Text Field component.

If you check the Enable Database Writeback checkbox, then any user input will write back to the

database. This will automatically generate an update query that will push the input value into the ; ;
database from the location where the original value was retrieved. SQL QU ery Bindin 9
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Generated SELECT Query
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SQL Query Bindings in Vision

Binding Properties to a SQL Query

The SQL Query binding is a polling binding type that will run a SQL Query against any of the
database connections configured in the Gateway. It is very similar to the DB Browse binding type
in that both query a database to return data. The difference is the SQL Query Binding can
manually be modified. This is useful for complex queries where you will use the more advanced
functions of the SQL language that can not be accomplished with the DB Browse binding.

@ Pro Tip!

The query that gets generated by the DB Browse will transfer over to the SQL Query
binding when you switch the binding type. It may be useful to build the basic query
structure with DB Browse first, then switch to SQL Query binding to modify the query to
fit your needs.

Dataset Binding

The majority of SQL Query bindings will return a dataset. These will return many rows with multiple
columns. For example, showing all customer details from a certain account, or all downtime events
in the facility. This type of SQL binding is used on properties of type dataset like the Data property
on a Table component.

On this page
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to a SQL Query
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SQL Query Binding
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Dynamic Filters

Using the curly brace {} notation, you can include the values of component properties (within the

same window) and Tag values inside your query. This is a very common technique to make your IN DUC TIV]
query dynamic. The values of the property or Tag represented are simply substituted into the U NIVE RS I']
guery where the braces are.

Note that because the substitution is direct, you'll often need to add quotes to literal strings and

dates to make your query valid. If you're getting errors running your query complaining about . .
syntax, it is important to realize that these errors are coming from the database, not from Ignition. SQL Query Bindi ng
Try copying and pasting your query into the Query Browser and replacing the braces with literal - Dyn amic Filters
values.

Watch the Video
Example

A common requirement is to have a query filter its results for a date range. You can use the Date Range component or a pair of Popup
Calendar components to let the user choose a range of dates. Then you can use these dates in your query like this:

SQL - SQL Query Binding with Parameter References

SELECT

t_stanp, flowrate, anps
FROM

val ve_hi story
WHERE

t_stanp >= '{Root Contai ner. Dat eRange. startDate}' AND
t_stanp <= '{Root Contai ner. Dat eRange. endDat e}'

Notice the single quotes around the braces. This is because when the query is run, the dates will be replaced with their literal evaluations.
For example, the actual query sent to the database might look like this:
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SQL - SQL Query Binding with the Values Replaced

SELECT

t_stanp, flowrate, anps
FROM

val ve_hi story
VWHERE

t_stanp >= '2010-03-20 08: 00: 00 AND
t_stamp <= '2010-03-20 13:00: 00

1 Itis important to use single quotes and not double quotes (t_stamp = "2010-03-20 08:00:00") because these mean something
different in certain databases like Microsoft SQL Server.

Scalar Query Update

You can bind a non dataset type property to a SQL query to allow a singular value to be returned @ IN DUC TIV]
from the database with a scalar query. Now instead of returning multiple rows and columns, the

query returns a single value from the first row of the first column. These types of SQL Query UNIVE RS 171
bindings can also be used to update the database on input components like a Text Field.

Essentially, we mimic the bidirectionality of Tag and property bindings by adding in an update

guery to run whenever a value gets entered into the property with the binding. In our update query,

we use the special parameter {this} to denote the new value from the bound property. If {this} is a : :

string, it needs single quotes around it. SQL QU ery Bindi ng

- Scalar Query and

[0 Property Binding: Root Container.Tet Field x

Ly Update
Tag Binds to data from a database, allowing you to write your own SQL query
Indirect Tag
oty ||| ST oy Watch the Video
Expression SELECT Name FROM area WHERE ID = 1 ~a
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sQL vl
Named Query
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> B %
SQL Query
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UPDATE Query L] Enabled
UPDATE area SET NAME = "{this}' WHERE ID = ‘lI ~ =
»
This
( :
® NoBinding = Convert to Named Query
[ o [

Take a Text Field with a simple query on it.

: SQL - Simple Select Query
i SELECT Nane FROM area WHERE ID = 1

This will return a single value that can populate our text field. We then enable the Update Query at
the bottom of the Property Binding window, and add in the update query.

: SQL - Using Ignition's 'this' Keyword
! UPDATE area SET Nane = '{this}' WHERE ID = 1

After confirming the binding, we can see that our text field contains the value from the database
and will update the database cell if we enter in a new value into the text field. This is a good way to
alter very specific cells in a database table.

Scalar Query Fallback

If the property that is being bound is a scalar datatype (that is, not a Dataset), the value in the

first column in the first row of the query results is used. If no rows were returned, the binding will IN DUC TIV]
cause an error unless the Use Fallback Value option is selected. The value entered in the fallback U N’IVE RS I']
value text box will be used when the query returns no rows.
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When binding a Dataset to a SQL Query, no fallback value is needed, because a Dataset will
contain zero rows.

SQL Query Binding

{7 Property Binding: Root Container.Text Field X SC al ar Q u ery an d
Tag SQL Query
o P T T, Fallback
Indirect Tag
R SELECT Query
SELECT columns ~ -
Expression W h
FROM tablename t t V
propersy st candiotan N ailc e viaeo
sqL |
< 5
Named Query
Database Connection Fallback Value 2 Enabled
DB Browse
Poling Mode Poling Rate
Off _ Relative _ Absolute Rate = (Base Rate) +- 0 |-=sec
UPDATE Query Enabled
UPDATE tablename Al =
SET colu = valu
WHERE condition *
< 5
© Nosinding & Convert to Nmed Query
o I

Stored Procedures

While queries can manually be written on a SQL Query binding, SQL Stored Procedures may also be called from a SQL Query Binding. Note
that the exact syntax is highly dependent on the type of database you are using.

For example, calling a Stored Procedure from MySQL would involve using the CALL command, while SQL Server utilizes the EXEC
command.

Named Query Conversions

You can convert the SQL Query created here to a Named Query. For more information, see Named Query Conversions.
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Cell Update Bindings

Binding a Dataset Property to Realtime Values

The Cell Update binding enables you to easily make one or more cells inside a dataset dynamic.

This is particularly useful for components such as the Table to easily display realtime Tag
information, or in the Linear Scale which stores configuration information in a dataset. The Cell
Update binding allows you to bind a cell inside of a dataset to a Tag or to a property.

Cell Update Bindings work really well with the Easy Chart component, allowing you to indirectly
show Tag history on the same Easy Chart. See Indirect Easy Chart for more details.

G} Cell Update Binding

The Cell Update binding type will only appear when setting up a binding on a dataset
property, otherwise, it won't be present.

The cell update binding has a few tools that help you make certain cells dynamic.
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Cell Update Binding

Watch the Video

The top table called Dataset displays the original dataset, while the bottom Cell Bindings table displays each of the cell updates that will be
occuring. Each Cell Update binding can have multiple cell updates happening on a single dataset. To the right of the Cell Bindings table are
four buttons that are used to create the Cell Bindings:

.+ Add Row - Adds a new empty row to the Cell Bindings table, which can be customized with a new Cell Binding. If a cell is
selected in the Dataset table, it will instead add a row with the Row and Column values already filled in with the appropriate values.

e [ pelete Row - Removes one of the rows in the Cell Bindings table.

o =l nsert Property - Inserts a property reference into the Value cell of the selected row.

e % Insert Tag - Inserts a Tag reference into the Value cell of the selected row.
o 3 Copy the current selection to the clipboard.
o B pastes the contents of the clipboard into the current context.

Adding Values to the Cell Bindings Rows

Each row in the Cell Bindings table needs three values to work properly: a Row identifier which is used to figure out which row the cell
binding is on, a Column identifier to determine the column of the cell, and a Value which will replace the original value of the cell. These
three values can pinpoint a specific cell, and replace its value with the dynamic Tag or property value specified. The examples in this section
use the dataset in the image above.

[ {Ty No two rows should specify the same cell, as this will throw an error.
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=

Row Column

The Cell Bindings Row column can be filled one of two ways.

Row Index

The easiest and most often used way is by specifying the row index of the cell that you want to target for an update. It is important to
remember that the row index is zero based, so the index of the first row is always 0. There can be multiple rows, each with the same row
index, as long as the Column is different. The order of the rows in this case does not matter, as in the image below, where it specifies a cell
with a row index of 0, then 5, then 0 again.

0 Boolean Column
5 string Column

Column Value

The other way to identify the row that the intended cell belongs to, is to use the value of a different column. This is done using the syntax:

Where the columnName is the name of the column and the value is the value that needs to match. The columnName and value are both
case sensitive, so you will need to use care when filling in these values.

0 Boolean Column
String Column

String Column = Test1 Boolean Column _

There are three things that make using the Column Value unique. The first is that there is the possibility for duplicates to happen. Take the
image above, with both a Row index of 0 and a Column Value of 'String Column=Test 1'. Looking at the original dataset, both of those point
to the same row, and with both of them pointing to the Boolean Column, they both refer to the same cell in the dataset. This instance of
duplicates will not throw an error, but instead will work. In this case, the updates happen from top to bottom, so the 'String Column=Test 1'
would be what writes to the cell last and what ultimately gets displayed.

The second is that there is the potential for multiple possible matches to that evaluation. For example, if | had this in the Row value:

This could potentially be true for multiple rows of my dataset, in which case, the binding will apply to all of them. This allows you to change
multiple cell values that should all be the same.

The final thing that makes the Column Value unique is that it itself is ultimately dynamic. The '‘Boolean Column=True' Column Value matches
the rows at index 1, 3, 4, 7, and 9 in the original dataset. However, if any of those were to change to False through another cell update, then

that row would no longer be updated as part of this cell update. Conversely, if any of the currently False values were to change to a True,
then those rows would fall under this cell update and the appropriate cell will be updated.

Column Column

The Cell Bindings column named Column, or Column column, expects the name of a column that will match in the "Dataset" table above.
These values are case sensitive, so care should be taken when entering them manually.

Value Column

The Value column is what will get pushed into the cell that is being updated. There are three possible types of values that can be placed in
here.



Static Value

A static value can be written in here. This will overwrite the existing value of the cell with whatever static value is in the cell update. This does
defeat the purpose of using the cell update though, since the static value could just be placed directly in the original dataset.

Tag or Property Reference

A Tag or Property reference can be used for the cell updates value, updating the value of the cell whenever the value of the Tag or Property
changes. The Tag or Property Selectors to the right of the Cell Bindings table can be used to add in the reference.

1 When adding a Tag or Property reference, be sure that the cell is only selected and that the cursor is not placed in the Value cell.
The cursor in the cell is used for typing in a static value, and trying to enter in a Tag or Property reference will not work.

This is used to enter in static text:

0 imcoum |

This accepts Tag and Property references:

Both Static Values and a Reference

The Value column can also accept a combination of a reference and static values. This allows you to build unique strings or numeric values
within the Value cell. The syntax used is:

..............................................................................................................................................................................

..............................................................................................................................................................................

and the IntegerTag had a value of 5, the updated cell value would be 5000. This method of combining both a reference and a static value is
great for updating Tag paths, such as in an Easy Chart's Tag Pens dataset.

..............................................................................................................................................................................

Here, the MotorNumber property on the root container is replacing the motor number inside of the Tag path. See Indirect Easy Chart for more
details.

Realtime Tag Values in a Table Example

The Cell Update binding allows you to place the value of a Tag into a dataset easily. With a dataset property like the one on the Table compo
nent, getting updating values into it requires either a SQL query, or some constantly running script. With the Cell Update binding, that isn't
necessary. The simple static table, as shown below, contains four rows for four different tags, and each having a value. As an alternative,
you could use four numeric text fields and labels, but the Table component looks much nicer compared to all of those labels and numeric text
fields.

Tag Name Value
Ramp0 8.58
Ramp1 120.88
Ramp2 13.14
Ramp3 6.39

Let's use the table above table to create a Cell Update binding to get the pressure readings into the table.
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1. Open the property binding &
a Cell Bindings area.

2. Select the first value, and click the Add icon in the Cell Bindings area to add a row. You'll notice it added a row number, column
name, and blank value cell because we selected a cell from above. What you place in the blank Value cell determines what the
value will be in the table.

icon on the Data property. Click the Cell Update binding type, and you'll see your dataset along with

Property Binding: Root Container. Table X
Tag Cell Update
Tag Binds specific cells inside an existing dataset
Indirect Tag
Tag History Q' Use the Cell Update binding to dynamically bind specific cellsinside a datasettotagor X
Property property values. Simply select the cell you want to bind, and hit the "Plus" button.
i Rows can be specified explicitly by their index (e.g. "15") or by referencing another
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sQL
Tag Name Value
Named Query | g
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o e |
=
%
® NoBinding [}
n Cancel

3. Select the first Row and first Value cell in the Cell Binding area. Use the Tag ‘ icon to the right to select the Tag reference (i.e.,
Ramp0). You can also manually type in your Tag reference, or place in a property reference instead. Click OK.

Property Binding: Root Container.Table x
Tag Cell Update
Tag Binds specific cells inside an existing dataset
Indirect Tag
Tag History Q  uUse the Cell Update binding to dynamically bind specific cellsinside a dataset totag or *
Property property values, Simply select the cell you want te bind, and hit the "Plus” button.
Rows can be specified explicitly by their index (e.g. "15") or by referencing another
Expression column (e.g. "Name=Compressor")
Property —
sQL
Tag Name Value
Nemed Query Ramp0
DE Browse Rampl 120.88
SQL Query Ramp2 13.14
Other Ramp3 6.39
Cell Update Cell Bindings
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(o vae  (defautRampy &
o » % Poll Time
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»
E r Ramp1
8 » % Ramp2
+ % Ramp3
® NoBinding C [default]Ramp®
n Cancel

4. Now, you have the value of that Tag to the Value column in row 0. Repeat Step 3 for the other three Tags so that the Cell Binding

area looks like the image below, then click OK.




Tag

Tag
Indirect Tag
Tag History
Property
Expression
Property
sqQL
Named Query
DB Browse
SQL Query
Other

Cell Update

Functions

® NoBinding

71 Property Binding: Root Container. Table

Cell Update

Binds specific cells inside an existing dataset

Q  Use the Cell Update binding to dynamically bind specific cellsinside a dataset to tag or
property values. Simply select the cell you want te bind, and hit the "Plus" button.
Rows can be specified explicitly by their index (e.g. "15") or by referencing another

column (e.g. "Name=Compressor”)

Dataset
Tag Name
Ramp0
Ramp1
Ramp2
Ramp3

Cell Bindings

Row

0
1
2
3

Value
Column Value
Value {[defaulf]Ramp0}
Value {[default]Ramp1}
Value {[defaulf]Ramp2}
Value {[default]Ramp3}

X

6.579
50.276
1316
-5.614

Cancel

5. You can see that the Table values are now updating with the value of their respective Tag.

Tag Name

Ramp0
Ramp1
Ramp2
Ramp3

Adding a Realtime Indicator to the Linear Scale Example

The Linear Scale is a component that has a special Scale Indicators customizer that allows you to configure setpoints. You can setup the
value, color, style, and more for each of the indicators. During runtime, these values are normally static, as there is no way to setup a binding
in the customizer. However, the customizer merely configures a dataset that the component uses to create the indicators. If you look at the
Indicators dataset property of the Linear Scale, it has all of the properties that are configurable in the customizer. Changing them from the
customizer will alter the dataset, and changing the dataset values will alter what you see in the customizer. Knowing this, we can setup a Cell
Update binding to manipulate the values during runtime.

2.59

23.44

1.52
5.06

Let's add another indicator to the Linear Scale component and configure it.

1. Select the Linear Scale and right click on the Customizers > Scale Indicators.
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2. Click on the Add + icon to add a new indicator.

3. Click the Arrow radio button and set the following properties for the Arrow.
a. Value: 65.0
b. Length: 50.0
c. Width: 4.0
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E T tne@lao + « Tomake anindicator value dynamic, use a 23
&' —— Line @85.0 ® Cell Update binding on the Linear Scale's
Indicators property.
Indicator Style
Arrow ' Line . Range . Wedge
Value Extent
65.0 5.0
Length Width
50.0 o |
Label
Label Angle
270.0
Color Label Color
I - I -
0K Cancel

4. Click OK. This new indicator will be whatever the current value is.

5. In addition to changing the value of the realtime Indicator, you can also change its color based on its value. If the value is above the
high indicator (i.e., 85), the Arrow will change to red, and if the value is below the green indicator (i.e., 15), it will change to green.
To accomplish this, setup a custom property on the Linear Scale of type color:

a. With the Linear Scale selected, right click on the Customizers > Custom Properties.

b. Click the Add + icon to add a property.

c. Enter "Color" as the Name of the property.

d. In the Type column, choose Color from the dropdown list.
e. Click OK to save the custom property.
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6. Next, we'll setup a Number-to-Color Tag binding on the custom Color property. Select the Linear Scale component, then click the
Binding e icon next to the Color property.
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7. The values shown in the image below are based on the static setpoints that were set in the Linear Scale customizer.
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8. Finally, setup a Cell Update binding on the Indicators dataset property of the Linear Scale. Notice below that both of the cell
bindings are for the same row, just different columns. This is fine, as long as there aren't duplicate bindings for the same cell.

a. Bind the Value cell to the same Tag used in the custom property Color binding to get the value. Click the Add + icon,
click the Tag » icon and select the Ramp1 tag, then click OK.

b. Bind the Color cell to the Color custom property we just created. Click the Add + icon, click the Property =l icon and
select the Color property, then click OK.

c. Click OK.
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Tag History ©Q  Use the Cell Update binding to dynamically bind specific cellsinside a dataset to tag or property x
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9. Now, the Linear Scale has an Indicator that moves to show a realtime value and changes color whenever it goes outside the
setpoints. The image below shows the indicator below the setpoint, within range, and then exceeding the setpoint.
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Function Bindings

Binding Properties to Prebuilt Functions

The Function Binding is a generic binding type that lets you bind a dataset property to the results
of a function. It allows any of the function's parameters to be calculated dynamically via Tag and
property bindings. The function that you choose determines the parameters that are available. The
most common functions are the Alarm Status, Alarm Journal, and Audit Log functions, but there
may be more depending on the modules you have installed.

Using Function Bindings to Customize

While there may already be an Alarm Status Table component, it may not be able to customize to
exactly fit your needs. The Table component has more customization options. When you use a
Function Binding on the alarm status, you can pull that same data into a Table component, and
then customize the table exactly how you need.

The following example shows the default settings for the Function binding. Notice how each field
has Tag and property binding buttons next to them. This allows you to make this entire function
dynamic by binding either Tag or property values to the different values of the function.

1. In the Designer, drag a Table component into your workspace.
2. Select the binding 3 icon for the Data property.
3. This opens the property binding window. Select the Functions binding.
4. Select a Binding Function from the dropdown. In this example, we used the Alarm
Status binding function and the default settings for alarm state.
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5. Now our Table component is pulling in similar information as the Alarm Status Table, but
we have the freedom to customize the table exactly how we need using any of its
available scripting or extension functions, or its customizer. We can also add our own
buttons to acknowledge or shelve alarms using our own scripting functions. This may be

more work in setting it up then the generic Alarm Status Table component, but it allows for

full control over what is being displayed and what can be done with that information.

Eventld Source DisplayPath EventTime 2 State Priority
8065defb-de16-4cc7-b79... |providefault/tagiSpe... Jun 22, 2020 9:08 AM 2 4%
bt d32-4290-bb9... pr Tan... Jun 22, 2020 9:08 AM 2 4
b4-4a3e-a3ch-... pr i Jun 22, 2020 9:08 AM 2 4
fea7dd77-c859-4db7-9e0.. prov.default/tag:Sine... Jun 29, 2020 2:45 PM 0 4
9bbbead4-96b9-4a33-89e... prov.default/tag:Sine... Jun 29, 2020 2:53 PM 0 4
5d417457-30e5-4eb4-96f... prov.default/agsSine... Jun 29, 2020 3:02 PM 0 4
85bf1 b AD4f-89cF-... providefaul X Jun 29, 2020 3:10 PM 0 4

On this page

® Binding Properties
to Prebuilt Functions
® Using Function
Bindings to
Customize

@ INDUCTIVI
UNIVERSI]

Function Binding

Watch the Video
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Active Time Display Path Current State Priority Event Id Label
6220, 500 0| Wreserrteslein | Acive, Unacnon. el | st |
o0, s an—[ronkio0 | nctve,unacknow_|igh [ brrsesa- |
[o2m0,558 0 [Tnkto0 | cie unacron. | igh _sezesc. |
6220, 508 | Turoine Namoer 291o-| Acive, Uncknon.| igh | sessezce-~ |

. [Wigh |

. [High |

[High |

a2
/]

Low Tank L...

6/22/20,9:08 AM | Turbine Number 100 lo. a6ef1ef0-4.
6/22/20,908AM | Turbine Number 150 lo. 6f69459a-

al
8 AM | High Temp/High Tem Active, Unacknowl...

Acknowledge || Shelve

o
&
&



Color Animation in Vision

Using Color on Components _
On this page
Using color on components is an important part of creating effective HMIs. While static colors can
help identify specific features on the screen, dynamic colors can help draw the users attention to
certain areas. Making color type properties such as Fill Paint dynamic works a little bit differently
than other properties with simple types. There typically aren't Tags of type color, so the way we set
up bindings on these types of properties works a little bit differently, and we have a few options .
available to us.

Using Color on

Components
® Using Expression
Bindings
H H H H ® The Number to
Using Expression Bindings Color Tranclator
® Style Customizer
You can use the expression language to calculate a color using the color() function. If you have a ® Style Customizer
color that depends on multiple properties, then using an express is recommended to evaluate Window
correctly. This first example returns a static color using the Fill Color property. ® Value Conflict
e . ® Style Customizer
Expression Example
/1 binding on the Fill Color property
i color(255,0,0) // static red color :

Expression

/1 binding on the Fill Color property :
i color (255, 255, 255- ({tag val ue}/100*255)) // fades fromwhite to blue when Tag val ue goes fromO to 100 % :

Custom Properties

i f({Tag1}>50,
if({Tag2},
3, /1 if tagl>50 and tag2 is true
1), // if tagl>50 and tag2 is fal se
i f({Tag3},
2, /Il if tagl<=50 and tag3 is true
0)) // if tagl<=50 and tag3 is false

Expression Referencing a Tag

/1 binding on the fill color property :
swi t ch({HOA tag}, f
0,1,2, // off, on, hand H
col or (255,0,0), color(0,255,0), color(255,255,0), // red, green, yellow :
color(0,0,0)) // black (fallback col or) H

The Number to Color Translator

The Number-to-Color Translation, commonly known as Color Mapping is where you map a value to a color within a binding. When selecting
a binding type where producing a color won't be possible, the Number-to-Color Translator will appear at the bottom of the binding window.
This includes Property Bindings, Tag Bindings, and Indirect Tag Bindings. The way the Number-to-Color Translator works is that for every
number range there is a set color. The binding then translates the numeric value into a color based on the mapping table. You can choose a
different color for each value, and even make it blink between two different colors. If you need to add or remove values, use the Add New

=

Translation + icon or Delete Selected Translation I icon on the right side of the Number-to-Color Translation table. There is a Low
Fallback Color option so when a value falls below your lowest value, a default color can be set.


https://legacy-docs.inductiveautomation.com/display/DOC80/color

Property Binding: Reot Container.Small weigh belt.Group_Weigh_Box.Path 2 >

Teg | Ta

Tag Binds to a tag
Indirect Tag
Property » % Rampd -
_ ~ % Ramp!

Expression B AlarmEvalEnabled
Property B Deadband
sqL B Documentation
Named Query [default]Rampl.Enabled
DE Browse

Number-to-Color Translation
SQL Query

Value >= Color
Reset to Default Low Fallback Color: _

Options

® No Binding Bidirectional Fallback Delay - Overlay Opt-Out

In this example, the fill color two parts of the conveyor symbol has been bound to the Ramp1 tag, enabled value. When the Ramp is enabled
(value = 1), the symbol displays parts in the normal, yellow color. When the Ramp is disabled (value = 0), the fill color on those two parts is
red, indicating the conveyor belt is not running. For more information on how this was applied to a symbol, see Images and SVGs in Vision.

~ [ Ramp T
» % Ramp0 OFC 636.06 Double o
~ % Rampl OFC 27.72 Double J
| = Enabled g ]
B OpcltemPath ns=1;s=... String ]

B OpcServer Ignition ... String 1 .# : - -
B Quality Good String G

® TagGroup default String vl —

B Timestamp 2019-0... DateTime ]
~ @ Ramp 3]
» % Ramp0 OPC 983.79 Double a
- % Ramp1 OPC disabled Double J
= Enabled ]
B OpcltemPath ns=1;5=... String b
B OpcServer Ignition ... String B
B Quality Bad_Dis... String 3
B TagGroup default string ]
B Timestamp 2019-0... DateTime ]
B value disabled Double i




Style Customizer
Many Vision components support the Style Customizer, which lets you define a set of @ IN DUC TIV]

visual styles that change based on a single Driving Property. Typically, you'll have a property on
your component that you want to use as a driving property (like a discrete state), which then drives UNIVE RS 11

multiple visual properties, like the font, border, and foreground color, to change to a specific style
that was setup per state beforehand. Style Customizer lets you define these relationships all at
once, and lets you preview them too! Without styles, you would have to go to every property and

bind them all individually. Component Styles

Watch the Video

Style Customizer Window

The Style Customizer window has multiple parts to it.

® Driving Property - The value of the selected property will be used to determine the style used. Only certain properties on the
component can be used as driving properties, but the most common are discrete state properties. Custom Properties can also be
used here.

® Styled Properties - Here you can select which properties will be used in the styles. Any properties that are in the left panel are
available to be used in the styles, while properties in the right panel are already being used in the style. Properties can be moved
between the panels by selecting it and clicking the appropriate arrow button.

® Styles - The list of styles that will be available for this component. Each style has a Value property on the left. When the value of the
Driving Property is greater than or equal to the value of a style, that style will be applied to the component. Each style gives a
preview of what it looks like, and can be expanded to by clicking the expand icon * to edit the properties within that style.

You will notice in the image below that the properties being used in the Styled Properties are the Background Color, Border,
Foreground Color, and Text, which corresponds to the properties we have available within each style in the Styles area. Each style
can also be animated by clicking the animation checkbox. This allows you to add different steps to the style, where each step of the
style can have its own unique style. Each step also gains a Step Duration (ms) property that is used to determine how long the step
is active for, as shown in the fourth row. This is typically used to create a flashing effect, where the component will flash between two
different colors such as red and gray.

|4 Style for Multi-State Indicator >
Data Quality Available Properties: Used Properties:
Image Path Cursor = Background Color
Data Quality Border
Text Disabled Image Path Foreground Color
Visible Enabled Text

Font
Horizontal Alignment
Herizontal Text Position v

Value Preview
0 Off v

2 Manual ~

<
Eh| Eh| Eh| Eb

Animate
Step Duration (ms) | Background Color | Border Foreground Color | Text =
so0. N .01 e Gorier ~ ~ o Faut
- o.Ounesocer - I . Fou
+ | 0 K| E
OK Cancel

Value Conflict
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You can bind a property that is already being used by a style, but a warning icon will appear on the property in the Property Editor. This
means there is a conflict between the binding on the property, and the style on the component. As a general practice, only the style or
binding should write to the property, not both.

Vision Property Editor g - X

12| I = =2 T

* Common
Name Multi-5tate Indicator  # €2
Enabled true G2
Visible true G2
Border & [1 Line Border v /G
Mouseover Text & G
Cursor Default v G2

> Data
State 0co
Text & Off & G2
Quality & G

¥ Appearance
Font Dialog, Bold, 12 -
Foreground Color & |m &, G
Background Color & 213,213,213 - &, D
Image Path ™ GO
Disabled Image Path e GO
Icon-Text Spacing 4 G2
Styles Dataset [SRx 7C] Bed

Style Customizer Example

The best example of the Style Customizer in action is the Multi-State Indicator, as this component uses the style customizer to work properly
and switch between different states, so it can be used as an example already built in. However, the many other components can use the
Style Customizer, so this example sets up styles for a Cylindrical Tank.

1. Add a Cylindrical Tank component to the window, and add a Tag to the Value property. (This example uses a Ramptl tag).

2. Right click on the Cylibdrical Tank and go to Customizers > Style Customizer.

3. Select a Driving Property. Here, the Value is a good choice as we can change the tank to flash when the contents get too high.
4. Inthe Styled Properties select the Border, Liquid Color, and Show Value.


https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Multi-State+Indicator

Style for Cylindrical Tank X

Available Properties: Used Properties:
Background Color = Border

Capacity Liguid Color

Cursor Show Value

Data Quality

Font b

Font Color

Foreground Color

5. Next, we need to set up the different styles. Click the Add + icon three times to add three styles.
6. Leave the first style set to Value 0.00, and don't change any of the other settings.
7. Set the second style to Value 45.
a. Click the Expand * icon.
b. In the Border Chooser, select the Line Border style, set the line width to 5px, and the line color to yellow. This way, it is
obvious the tank is filling up.
c. Setthe Liquid Color to blue or keep the default color.

Style for Cylindrical Tank *
Capacity Available Properties: Used Properties:
Data Quality Background Color ~ Border
Capacity Liquid Color
Visible Cursor Show Value
Data Quality
Font
Font Color

Foreground Color

Value Preview
0.00 o o
45.00 & ~ 1
Animate
Border Liquid Color Show Value
Line Border ~ ./ | N T——
90.00 ] v &
+ 0 KN

0K Cancel

8. For the third style, we're going to animate it and and create two steps to alert the user that the tank is almost full. Set the third style
to Value 90, then click the Expand * icon. Set the following options for the first step:
® Animate checkbox - checked
® Step Duration 500 ms.
® Border - Line Border Orange and set the Line Width to 5px, and the line color to Orange.
® Liquid Color - Orange
® Show Value checkbox - checked
9. Click the Add + icon to add another step. Set the following options for the second step:
® Step Duration 1000
® Border - Line Border Red and set the Line Width to 5px, and the line color to Red.
® Liquid Color - Red
® Show Value checkbox - checked



Style for Cylindrical Tank

Capacity Available Properties: Used Properties:
Data Quality Background Color - Border
Value Capacity Liquid Color
Visible Cursor Show Value
Data Quality
Font
Font Color
Foreground Color v
Value Preview
0.00 -
45.00 [ v @
80.00 n ~
3 Animate
Step Duration (ms) Border Liquid Color Show Value =
500 HLineBorder ~ [N &, [~
1000 M LineBorder  ~ ¢ || R 5. [~
+ |0 KW
0K Cancel

10. Click OK to save the style.
11. In the Vision Property Editor, when the Value changes to >/= 90, the Tank component and border will change to reflect the style

settings. The tank colors and border will flash between red and orange.

Vision Property Editor g - X | ]
[z | = —r | ¥ EN
12| 13 = =2 |- o]
* Common ==l
Name Cylindrical Tank s e .
Visible 2 true & ]
Border & B Line Border v # ed| I
Mouseover Text s D u:
Cursor Default v G2 d

v Data
| value & 80.500747826 &3 =
Capacity 1000 e | 7]
Quality Good £ :
¥ Appearance ]
Font Dialeg, Plain, 12 =
Foreground Color 46,46,46 - &, @ ]




Vision Templates

Templates are a simple but a very powerful feature in Ignition that you can use with the Vision
windows. The power comes from the ability to modify only the template in one location while .
affecting all of the instances used throughout the project. HMI and SCADA systems typically have On this page
a lot of repetitions in their screens. You might use a group of the same components over and over
within your project. The data driving each set of graphics is different, but the graphics themselves
are copies of each other. You can make a single template and use instances of the template over
and over again.

When using templates, you define the graphical display in one place, called the master template. ¢ Template Properties

You then use this master template many times in your project on multiple windows, thus making a ¢ Template
number of template instances. Any changes made to the master template are then reflected in Parameters and
all of the template instances. Using templates early in your project development for any repeating Internal'
displays can save a significant amount of time later on. Properties
® Indirection and UDT

Without templates, the only way to do this is to copy-and-paste the components then re-bind them Tags
each time you want another. This is simple, and it works, but it can cause major headaches and * IStg_”datr_d

ndirection

time consuming corrections later on because if you ever want to make a change to how they are

represented, you're stuck making the change to each copy of the group. ® UDT Parameter

® Changing Template

File  Edit Wiew Project Component Alignment Shape Tools  Help Path
BEenrvsu|nooo-r|ls@o|xxnna ¢ The Drop Target
Project Bromser S o o T Parameter
o A || 4 motor # ® Resizing Templates
[T Reporting 17 ® Nested Templates
~ a0 Templates 1 N .
=5 Alarm Count Label q ccessing .
T — | Components Inside
et L
o & ’ ) a Template Instance
et 7 Units
b 4w Motor 1 1
B Multi-State Indicator @
a Named Queries 1 \
» Reports E
@ web Dev ~
Tag Browser a - X
Qs ¥ 8oldc E INDUCTIV]
+ % Motor UDT 2| |2 L] ¢
q N ’
‘ : “no72” UNIVERSI]
Vision Property Editor a_ X -

Hlm = et -
El Common
Name Motor Template
Border No Border v Qe
Mouseover Text [
El Behavior
Enable Layout false (-]

About Templates

Watch the Video

Combine Repaints false (-]
= Appearance

Background Color 255,255,255,C - ®

Width 217

Height 227

Texture > G
= Template Parameters

motorData (]

Template Properties

Template Properties (called Template Parameters) allow each template instance to reference different data. Because the primary use of
templates are the ease of maintaining repeated user interface elements, correct use of Template Parameters is very important. This is very
similar to the concept of Parameterized Popup Windows. In that case, any Custom property on the Root Container of the window is used as
a parameter, and is passed into the window when it is opened. With Templates, you have a property in the root of the master template that is
exposed when you drop a Template Instance on a window.

Template Parameters and Internal Properties

When you open the Custom Properties window (right-click the checkered-box of the template and select Customizers > Custom
Properties), you'll notice it is different than the Custom Properties of all other components. There are two kinds of custom properties here, as
follows:

® Template Parameters
These parameters appear on each template instance, allowing each instance to be configured differently. Commonly, this is some


https://www.inductiveuniversity.com/video/about-templates/8.0

sort of indirection. For example, if you have a template representing motors, you might have MotorNumber as a parameter property.
Then you can use that property as an indirection variable in other bindings within the template. Parameter properties are not
bindable from within the template master design. When you use the template to create a template instance, the property becomes
bindable. This ensures that the property only has a single binding configured for it.

® Internal Properties
These properties cannot be used as parameters in your instances. They show up when designing the template master, but it does
not show up on the template instances. Internal properties are bindable from within the template master design. These properties
are intended to be used for the internal workings of the template.

Indirection and UDT Tags

There are two primary ways to achieve indirection when using templates. Let's continue to use the example of a motor. Your system has
many motors in it, and your template is used to display the status of the motors and control the motor's running mode. The goal is to be able
to drop instances of the template onto your windows, and configure them in a single step to point to the correct motor's Tags.

Standard Indirection

If the Tags representing the datapoints of each motor are arranged in an orderly way in folders or with a consistent naming convention, you
can use standard indirection to configure your template. You can add a parameter such as MotorNum to the template. Then you configure
the contents of the template using indirect Tag binding, where the value of MotorNum is used for the indirection.

UDT Parameter

If your motors are represented by a User Defined Type (UDT), you can save some effort and use a property of that type directly. Make

your indirection property the same type as your custom data type. Then inside your template, you can use simple property bindings to create
a link to the members of the UDT. When you create a template instance, you can simply bind that property directly to the correct Motor Tag,
and all of the sub-Tags of motor are correctly mapped through the property bindings.

Changing Template Path
An instance of a template on a window has a property called Template Path. You can change @ IN DUCTIV]

this property on a window dynamically, and it can be bound to anything that produces a valid UNIVE RS I1
template path. For example, if there are two tank templates in a folder called Tanks, one template
is called Tank A and the other is called Tank B. Each tank has a different look, but they have the
same Custom properties. Their respective template paths are Tanks/Tank A and Tanks/Tank B.
The template rendered on a window can swap between Tank A and Tank B by binding the .
instance's Template Path property to any string reference that says Tanks/Tank A or Tanks/Tank Chan ging Tem p late

B. Path

Watch the Video

The Drop Target Parameter

When you specify parameters in the Custom Properties window (right-click the checkered-box of the template and select Customizers >
Custom Properties), you can set one of the parameters as the Drop Target. This allows you to drop a Tag of that type onto your template
instances or onto a window to facilitate even quicker binding. For example, let's say that you have a parameter that is an integer and you've
made it the drop target. If you drop an integer Tag onto a window, your template appears in the menu dropdown list of components which is
displayed. Choosing your template creates a template instance and binds that parameter to the Tag.

This also works for UDT Tags. Let's say you have a custom data type called Motor and a template with a Motor-typed parameter set as the
drop target. If you drop a motor Tag onto a window, it creates an instance of your template automatically. If you have more than one template
configured with Motor drop targets, you have to choose which template to use.
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Resizing Templates

You can configure the layout of each template so it resizes properly. " @ p IN DUCTIV]
972 UNIVERSI]

By default, when you drag a template into the window from the Project Browser, the size of the -

instance is exactly the same size as the master template. You can make the size larger or smaller.
To go back to the same size as the master template, right-click on the instance and choose Revert
to Master size. P

Template - Resizing

and Enable Layout

Watch the Video

13

Modify Template Master

Revert to Master Size

cut Ctrl+X

Copy Ctrl+C

o Delete Delete

For every component or template instance you add to the window, you can pick a Layout option as
to how it is going to resize in the Client. Right-click on the instance, select Layout from the menu,
the Layout Constraints window displays showing all the default settings.


https://www.inductiveuniversity.com/video/template-resizing-and-enable-layout/8.0

To learn more about layout, see the Component Layout page.

P | avout Constraints W

Layout Mode
Relative Anchored

Relative Layout Options

Maintain Aspect Ratio
Center Leading Trailing

Scale Font

If your template instance resizes in the client, then it will stretch all of the components inside it in
the same way a Component Group works. That is: it will ignore any layout settings and stretch
without maintaining aspect ratio. If you want the template instances to respect your layout settings,
set the Enable Layout property to true in the template definition.

Vision Property Editor g - X ot non i Ui o0 .l
11 S |V
~ Common §
Name Tank2 s !
Border Other Border v # & ]
Mouseover Text -] é_
~ Behavior B
Enable Layout [Bree e
Combine Repaints false ]
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Nested Templates
@ UNIVERSI]

You can embed templates inside of other templates. The nested template behaves like a
component. This can be useful if the project can be broken down into many similar, small parts.
Instead of building a template for a tank with a gauge, a motor with a gauge, and a compressor
with a gauge, it might instead be better to first build a simple gauge template that can then be
added to each of three templates so that it already is setup correctly.

Simply drag the already made template into the new template, just like you would onto a window. | Tem plate

can easily use an indicator template that | made to display values from a motor template, or values Com position
from a tank template, as long as | setup the indicator template with the proper indirection. This

way, | only have to setup the indicator once and write in a few parameters, instead of having to

customize the indicator the same way for every template that it gets added to. Watch the Video
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Accessing Components Inside a Template Instance

When working with a Template Instance, the components inside that instance or normally hidden, and otherwise inaccessible. However, you
can access these components via scripting. It helps to think of Template Instances as multi-layer containers. In most cases, users interact
with only the Outer Layer, which contains the Template parameters, and the other default Template Instance properties. A Python script can

access the Inner Layer, which then provides access to the components within.



Outer Layer

Inner Layer

Component

Component

A script can traverse to the Inner Layer from the Outer Layer with a get Conponent call.

Pseudocode - Acessing the Inner Layer

nmyTenpl ate = event. source. parent. get Conponent (' MyTenpl ate')
# The '0' in the first getConponent call effectively refers to an index value of a conponent, which

happens to be the Inner Layer.
nmyTenpl at e. get Conponent (0)

From the Inner Layer, a script can then call get Conponent again to access any components within. Assuming a Template with a Label
component named “Label", we could access the Text property with the following:

Pseudocode - Accessing a Component From the Outer Layer

nyTenpl ate = event. source. parent. get Conponent (' MyTenpl ate')

print nyTenpl at e. get Conponent (0) . get Conponent (' Label ') . t ext

In This Section ...



Creating a Template

Templates are a simple but very powerful feature that you can use with your Vision windows.
Templates are a built once, in one place, which is called the master template. You then create .
template instances throughout your project. Each of these instances will have the same On this page
components and properties as the master template, and will automatically update as changes are
made to the master template.

Creating a template is easy. To start, right click on the Templates section of the Project Browser

and select New Template. )

® Basic Template

® Dynamic Templates

. ® Edita Template

Basic Template * Example - Send

a Template to a

Different Project

Template Custom

Properties

® Creating the
Template Instances

Here we create a basic template. After the template is configured, you can create multiple .
instances of it throughout your project.

1. In the Project Browser, right-click Templates and select New Template.

Project Browser al - X
Q. 4
™ User Management
I S s qemplates New Template @ INDUCTIV]
L) L]
% Named Queries L=< o2 UNIVERSI]
B Reports NewFolder v -
A Export. Basic Template
A checkered box is displayed in the design space where you design your template. The Watch the Video

checkered box means that the template is completely transparent. You can set a
background if you want.

2. Right-click on New Template and click Rename to change its name to something else, for
example "Tank".

3. Drag a Cylindrical Tank and a Label component onto the screen. Resize the components
to fill the area of the template.

4. Bind the Value of the tank to a Tag, and set up the label to be a name for the tank.

1199,

Tank # 1

El“ul

5. Now that we made a template, use that template on a window. Navigate to a window, and
then click and drag our tank component onto the window. The template can be dragged
onto the window multiple times to create multiple instances of the template, or even added
to other windows.
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Dynamic Templates

While the basic template is a good example of what a template is, the real power of the template is its ability to be dynamic. The template
can create parameters that can accept values from the instance, and use them throughout the template. This way, instead of always
displaying Tank 1 values, we can pass in a tank value for the cylindrical tank component to use.

1. In the Tank template, right click on the gray background and go to Customizers > Custom Properties.
2. Click the plus button to add a Template Parameter. Give it a name like tankValue, and click OK. There should now be a new
property on the Tank Template object called tankValue.

.I.I.Illl:!l:ll..I.I.lzl:!':I 400 400

= —

Custom Properties

Template Parameters

| I I

Mame Type Description = Drop Target

[=3 ;N]

tankValue Integer

q

Internal Properties

Mame Description

3. Now bind the Value property of the cylindrical tank to the tankValue property that we just made. Note that it will be O right now, but
we will pass in a value later.
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4. We also want to change the label, since this template won't always be pointing at Tank 1. So we can bind the Text property of the
label to Tank Template's Instance Name. This way, whatever we name the template instance is what the label will show.

Property Binding: Tank.Label X
Tag Property
Tag Binds to another compenent's property in the same
i window
Indirect Tag
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5. Back on our window, we want to change our two instances so that the first one is called Tank 1, and the second is called Tank 2.

Notice how the labels change when we change the name of the template. Select your second Tank, and change the Name property
to Tank 2.
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6. We also want to bind the tankValue property of each instance to separate Tags. In this example, you can do this simply by
selecting Tank 2 and clicking on the binding 2 icon for the tankValue property and selecting another Tag.
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7. We now have two instances of the same template, but they are displaying different information because we are passing different
values into each.
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Edit a Template



You can open a template for editing by double-clicking on it in the Project Browser, or by double-clicking any instance of that template within
a window. You design your template the same way you design windows: by adding components to it, and configuring those components
using property bindings and scripting.

There are a few differences between templates and windows from an editing perspective. Templates, unlike windows, have a transparent
background by default. This can be changed simply by editing the background color of the template. Templates also do not have the concept
of the "Root Container" - the template itself acts like a container.

Once you change the master template, all the instances of that template are updated.

Templates are a project resource. As such they can be copied, duplicated, protected and more. There are several actions available with a
right click menu.

Project Browser a - X

Q A

b Y& Transaction Groups -

+ =} Vision
[& Client Events
+ ™ wWindows
b [ Main Window [
™ Table test
[ Test easy
~ & o Templates

| i FankBosic oo

B Cylindric ¢ Use in Window

B LED Dis| B scripting..
Tag Browser | MNotes...
L - . 1 .
Q o = C Ei Duplicate
- Tag Al Rename
F m Tags
b System te Cut

F i Vision Client Tags A Copy

r im All Providers %  CopyPath
=+

@ Delete
B Protect
Send to...

G Export.
Action Description
Use in Places the selected template on the current window.
Window
Scripting

The following feature is new in Ignition version 8.0.11
Click here to check out the other new features

Opens the Component Scripting Window where you can set scripting on this template. For more information, see Script
Builders in Vision.

Notes Opens a popup window where you can make notes about the template.


https://docs.inductiveautomation.com/display/DOC80/New+in+this+Version#NewinthisVersion-Newin8.0.11

Duplicate = Duplicates the template in the Templates folder.

Rename  Renames the template.

Cut Cuts the template, but leaves it on the clipboard.

Copy Makes a copy of the template on the clipboard.

Copy Copies the path to the template and places it on the clipboard.
Path

Paste Pastes a template that's currently on the clipboard.

Delete Deletes the selected template.

Protect Once a project resource protected, it cannot be changed except by someone that has the permission to unprotect it, and
modify it. For more information, see Project Security in Designer.

Send To = Sends this template to another project on this Gateway.

Export Opens export Project Resources window. where you can export this template and other resources. For more information, see P
roject Export and Import.

Example - Send a Template to a Different Project

You can share Templates with other projects.

1 Ifa Template by the same name already exists in the target project, it will be overwritten.

1. To send a Template to a different project, right click on the template name and choose Send to.

- & Vision
[& Client Events
™ windows
~ & Templates
[ 0 New Ten iy
E Named Queries ¢ Use in Window
Reports | [5]  MNotes...
Tag Browser | Ei Duplicate
"3
Q o |v- 2 @ Rename F2
Tag | Je Cut Ctrl+X
b i Tags i
» i System @ Copy Ctrl+C
» i Vision Client Tag [4 copypath
+ i All Providers B
€9 Delete Delete
| & Protect
I Send to k| Project_East A
Vision PropertyEditr | O Export.. Project_West_1
B4l = | = oel R - Project_West_Bldg_1
B common ~ Project_West_Bldg_2
Name New Template Project_East_Testing_only
Border Other ~ [Jje2 Project_West_Templates
L) X
Mouseover All other projects

2. Alist of existing projects is displayed. Choose a specific project, or select All other projects if you want to send the template to all
projects.
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3. A confirmation message is displayed. Click Yes to confirm.

x

Confirm

If the selected resource(s) already exist in the target project(s), they will be overwritten.

Template Custom Properties

Templates have the capability to incorporate custom properties. In this way, they are the same as any other Ignition components. The main
difference between the custom properties for an Ignition component and a template is that the template has internal properties and template

parameters.

® Internal Properties - Internal properties help facilitate the bindings within a template in the same way that a window's root container
will help facilitate bindings between components that make up the template. When a template is deployed onto a window the internal

custom properties are not exposed to the world outside the template.
®* Template Parameters - The template parameters are the template's custom properties that are exposed to the outside world. In
other words, when a template is deployed onto the root container of a window, the template parameters are available for binding with

the objects on that window or to Tags.

Creating the Template Instances

Once you've made your template, you can use it on any of the windows in your project by doing any one of the following steps:

® You can drag the template from the Project Browser into an open window just like you can drag components into the window for

display.
® You can right-click on the template in the Project Browser and choose Use In Window, which will let you place the template inside a

window with another click.
® You can drag a Tag from the Tag Browser to a window and from the pop-up menu, which is displayed, you can choose a template.
This only works if the template has a configured Template Parameter that been enabled as a drop target.

The template instance can then be moved and resized like any other component.

Related Topics ...

® User Defined Types - UDTs
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Template Indirection

Indirection in Templates

You can create templates that point indirectly to a set of Tags based on a simple parameter. This
is very helpful when you have a large number of UDTs with the same type of Tags that only differ
in one parameter. For example, lets say you have 100 Tank UDTs that all have the same kind and
number of Tags. The only thing that is different is the Tank number.

If each Tag inside the UDT has a Tag path that looks like this:

You can create a Template Parameter on the Custom Properties that can help make the template
indirect. There are two main ways of doing this. The first method is to pass in an indirection value
so that Indirect Tag bindings can be set up within the template. In this case, we would want to
pass in a tank number, which can be substituted in for the tank number in the Tag Path. The
second method is to pass in a reference to the entire UDT, essentially turning that UDT reference
into a property that we can use within the template.

Indirect Binding

This example demonstrates, how to set up a parameter to be used as an Indirect Tag binding.

1. Create a new template, and call it Tank. Right click on the background of the template,
and select Customizers > Custom Properties, and add a Template Parameter called
tankNumber of type Integer.

|4 Custom Properties X

Template Parameters

Name Type Description Drop Target | <
tankNumber | Integer -
m

Internal Properties
Name Type Description +
[i]

oK Cancel

2. Next, add some components to our template, being sure to utilize the Template Parameter
tankNumber that we created earlier to make them indirect.

a. Add a Label component at the top with a simple expression binding to clearly
display what tank is being shown in the template using the tankNumber property.

: Expression - Indirect Label
i "Tank " + {Tank.tankNumber}

On this page
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Template - Indirect
Binding

Watch the Video
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b. Add a Cylindrical Tank component that has an Indirect Tag binding to the
Volume Tag using the tankNumber property for indirection.

Property Binding: Tank.Cylindrical Tank

Indirect Tag

Tag
Tag Binds to a tag dynamically using indirection (a.k.a parameterization)
Indirect Tag
Property .
Q  An Indirect Tag Binding lets you bind to a tag dynamically, X
Expression where parts of the tag's path are defined by properties on
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sqL to {Root Container.TankNumber}
Named Query
DB Browse Indirect Tag Path
SQL Query [default]Ramp/Ramp{1} % =
References
Ref. # Property Path
1 | Tank.tankNumber
Options
® NoBinding Bidirectional Fallback Delay Overlay Opt-Out

n Cancel

. The only thing left to do is drag a few instances of the Template onto a window. Then

enter a different value into our tankNumbe

r for each template and all of the templates will

now display different Tag values from one another. In addition, it is very easy to bind the

tankNumber property to something, allowin
is displaying in the client during runtime.

g you to easily change what tank the template
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UDTs in Templates



ser Defined Type (UDT). This creates a complex property with several child properties, where IN DUC TIV]
each sub property represents a tag in the UDT. These properties can be bound to within the

template. An instance of a UDT can be passed into a Template Instance just like any other Tag UNIVE RS I
would.

When adding custom parameters to a template definition, the type of the property can be setto a U @

When using a UDT as a parameter in a template, be mindful that the Template Canvas and Templa
te Repeaters components can not make use of UDT parameter types on embedded templates: Tem p|ate —uUDT
when using either component, Indirect Binding on standard data types is the preferred approach. Parameter

Watch the Video

. Create a new template, and call it Tank2.

. Right-click on the background of the template, and select Customizers > Custom Property.

. Add a Template Parameter called tankUDT, but this time, we want the type to be a UDT (named "Tank_UDT") that we have already
created.
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4. Next, add some components to our template: Label, Cylindrical Tank, and Slider. Be sure to utilize the Template Parameter tankUDT.

a. Add a Label component at the top of the template to show the name of the tank. Using a property binding, bind the label to
the Tag Name property of the UDT property tankUDT in the Meta folder. This will pull the name of the UDT instance in as
the title of the template. Don't worry if it makes your label blank, as there is nothing in that custom property yet.

b. Add a Slider component and bind it to the sliderValue property within the tankUDT property.
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c. Add a Cylindrical Tank component and bind it to the Slider component's Value property.
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5. Next, add an instance of the Tank2 template onto a window. In this example, we added three instances.

6. Bind the tankUDT property to each of the UDT instances. In the image below, we selected the Tank 3 instance and bound the
tankUDT template property to the Tank 3 Tag. The Tag bindings to the UDTs can even be made indirect to allow the passed UDT to
be changed at runtime.

You can see how easy it is to create these tanks using UDTSs.
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Related Topics ...

® Using the Template Repeater
® Using the Template Canvas



Using the Template Repeater

The Template Repeater component lets you easily create multiple instances of a master
template for display on the HMI. Each instance shown in the Template Repeater has the same
look, feel, and functionality of the master template. The instances can be arranged vertically,
horizontally, or in a "flow" layout, which can either be top-to-bottom or left-to-right. If there are too
many instances to fit, a scrollbar is added to the display. The Template Repeater also gives you
the ability to pass parameters to each instance of the template, making the templates dynamic.

The Template Repeater can create multiple template instances in two different ways, which will
also affect how it passes parameters to those instances. The first is Count mode, which will allow
you to specify how many times the Template Repeater will repeat a template. It will then use the
index number of each template as a parameter that it will pass into the template. The second
method is Dataset mode, where each row of a dataset will be a new template instance and each
column will be a parameter that will be passed into the template. This is useful if you have multiple
parameters that need to be passed into a template. See the Vision - Template Repeater page for a
more detailed description of this property and how it works. We will go over both methods of using
the repeater below.

Creating a Template

Before we use the Template Repeater, we need to first have a template that we need multiple
copies of. We used Ramp Tags in the Generic Simulator device built into Ignition. The template
will have a label at the top with the ramp name, and it will display the ramp number value. To do
this, our template needs to have two parameters. One called RampNumber, which will be used to
display the ramp number and also used for in an indirect Tag binding. The second parameter
called RampName, which is passed in a string name that is the name of the ramp that | made up.
The steps for making this template are listed below, or you can skip ahead to the next section if
you are familiar enough with making templates.

On this page
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1. In the Templates section of our Project Browser, create a new template. | named mine, Ramp_Example. See the Templates section

for a more detailed description on what templates are and how to use them.

2. We are going to want to pass in a value to the template, so we need to create a Template Parameter.
a. Right click on the Root Container, select Customizers > Custom Properties and add a Template Parameter called RampN

umber, and make it an Integer type.
b. Add a second Template Parameter called RampName, and make it a String type.

[0 Custom Properties

Template Parameters

RampMame String
RampMumber | Integer

Name Type Description Drop Target

Internal Properties

Name Type Description

0K Cancel

=[]

=[]
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3. Next, add some components to our Template.
a. Add two Numeric Labels and one Label. | also added two extra label components, and manually typed in some static text
into their Text property. In one label, | entered "Ramp Number" and in the other, "Ramp Value".
b. Resize the components so that they are easy enough to read. Place the blank Label component at the top of the Template,
and place each Label that we wrote text into next to a Numeric Label.
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4. Next, setup some bindings on our Template.
a. Using a property binding, bind the Text property of the blank Label component at the top of the Template to the RampName
Template Parameter.
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b. Using a property binding, bind the Value property of the Numeric Label next to the "Ramp Number" label to the RampNumb
er Template Parameter.
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c. Using an indirect Tag binding, bind the Value property of the Numeric Label next to the "Ramp Value" label. We bound it to
a Ramp Tag that is in our Tag Browser, using the RampNumber Template Parameter as the indirect reference for the
number in the name of the Tag. It should look similar to the image below.

1 Remember to remove the number portion of the tag name and replace it with {1}. For example, [defaultfRamp
/Ramp0 becomes [defaultjRamp/Ramp{1}.
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5. The template is now finished and ready to use. See the image below for an idea of what mine looks like. Yours should look similar.
Note the two Template Parameters, as well as the placement of the components. The label at the top that can't be seen because
there is no text in it.
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Using the Template Repeater with Count Mode

Now let's take a look at how to use the Template we just made in a Template Repeater.

1. On a new window, drag a Template Repeater component. Resize it so that it is taller than it is long.
2. With the Template Repeater selected, find the Template Path property, and find the name of the template that we just created in the
drop down menu.
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3. With the Template Repeater still selected, find the Index Parameter Name property. Enter in 'RampNumber’, which was the name
of one of our Template Parameters from our Template.

4. Ensure that the Repeat Behavior property of the Template Repeater is set to Count.

5. In the Repeat Count property of the Template Repeater, set the value to '5'.
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6. You should see your Template repeated five times within the Template Repeater. Notice that our Ramp Number value in the
Template corresponds to the index value of the Template, 0 through 4 because it is 0 based. You should also see that the value in
our Ramp Value component corresponds to the value of one of our Ramp Tags.
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Your Repeater is complete. You can modify the Repeat Count to change how many times the Template gets repeated.

Using the Template Repeater with Dataset Mode

In our previous example, although we were able to successfully pass in the index parameter into our Template, we were not passing
anything into the RampName Template Parameter and because of this, the blank label at the top of our Template remained blank. This is
because Count mode only allows a single index parameter to be passed in. However, since we want to pass in two parameters, we can
instead use Dataset mode. In addition, because we are going to be defining a dataset to pass in parameters, we don't have to use a 0
indexed parameter, and can instead use whatever values we want. We will use the same Template and Template Repeater from before.

1. Onthe Template Repeater, set the Repeat Behavior to Dataset. All of the Templates that were previously in will temporarily

disappear.
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2. Click the Dataset Viewer @ icon on the Template Parameters property of the Template Repeater. You should see a new popup
that allows you to build a dataset.
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3. First, we'll add two columns to our dataset.

o
a. Click the Add Column IB¥ jcon. Set the Name as ‘RampNumber' in Position '0', and enter 'Integer' as the Type. Click Ad
d Column.

b
b. Click the Add Column Bl jcon. Set the Name as 'RampName' in Position '1', and enter 'String' as the Type. Click Add
Colum.

1. Make sure the name of each column exactly matches the names of the Template Parameters (RampNumber and
RampName). They are case sensitive.

Dataset Editor >
RampNumber =
i
Name | RampMName © position 1
Type |Date
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m4
4. Next let's add some rows by clicking the Add Row = icon. Click it five times to add five rows.



5. Add in some values for the RampNumber column. Since we are defining all of the values, we don't have to start with a RampNumber
of '0". In fact, we don't even need to have them be in sequence! We do need to make sure that the numbers each correspond to one
of our Ramps, so enter in a value '0' through '9' for the RampNumber column for each row. In this example, we used 2, 5, 7, 3, 8 in
that order.

6. Next, add some values for the RampName. These can be whatever you want, since we are going to be giving unique names to
each of our Ramps. When finished, the dataset should look something like the image below. Click the OK button to save your

dataset.
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7. Notice how we now have our five templates back, and they are using the parameters that we are passing in from the dataset we just
created. The Templates are receiving the parameters in the order that you made them in the dataset. We can also see that each
Template instance corresponds to a specific ramp.
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Dataset mode is great when you need to pass in multiple parameters, or if you have a single parameter that is not zero based. In addition to
manually specifying values like we did in this example, you can instead setup a binding on the Template Parameters property to something
like a database table. This allows you to easily modify the templates that are being displayed in the window simply by modifying the database
table.

Related Topics ...

® Using the Template Canvas






Using the Template Canvas

The Template Canvas component works much like the Template Repeater in that it can easily

create multiple copies of a master template. What makes the Template Canvas unique is that it .
can display instances of multiple master templates, and set their layout in any way you want. The On this page
Template Canvas has a customizer that can help put the templates together within it, but the
customizer is just driven by a Templates dataset property on the Template Canvas. The Template
Canvas can be made dynamic by setting up a binding on the Templates property, such as a query
that pulls in an entirely new dataset of information, or even a cell update binding, which updates

individual cells of the dataset. With that, you can load new templates into the canvas at runtime, or

even move the templates around. ® Creating a Template

® Absolute Positioning

® Layout Positioning
(MiG Layout)

® Read User Input

The Template Canvas has two layout systems: Absolute Positioning, where each template
instance has an absolute position within the Template Canvas, and Layout Positioning, which
uses the MiG Layout system to place the instances within a grid like system.

Creating a Template

Before we get started with the Template Canvas, we first need to have a template. Here we are @ IN DUC TIV]

going to make a simple Form Input template, that consists of a Label and a Text Field. The
template will need two parameters. A Label_Text parameter which is what will get displayed in the
label, and a TextField_Text which we can use to pass user input outside of the template by
making it bidirectional. This template is a great way of quickly making user input forms, by using a
template for each piece of info that needs to be collected. The steps for making the template are
listed below, or you can skip ahead to using the Template Repeater in the next section. Tem plate Canvas

Watch the Video

UNIVERSI]

1. In the Templates section of our Project Browser, create a new template called Form Input. We are going to want to pass in values

to and from the template, so we need to create Template Parameters.

2. Right click in the Form Template workspace, and select Customizers > Custom Properties. Add a Template Parameter called Labe

|_Text, and make it a String type.

3. Add a second Template Parameter called TextField_Text, and make it a String type, and click OK to save your template
parameters.

4. Next, drag a Text Field component and a Label component onto the Template.

5. On the Label component, set the Horizontal Alignment property to Trailing.
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6. Finally, we want to setup some bindings on our Template.
a. Using a property binding, bind the Text property of the Label component to the Label_Text Template Parameter.

b. Using a property binding, bind the Text property of the Text Field component to the TextField_Text Template Parameter,

and make it Bidirectional.
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7. Set the Size and Position for the components by right clicking on each componet inside to 20 pixels. Next, set the height for the
Form Input template as shown in the image below.
Note, make sure to drag your two components to the top of the template before adjusting the size.

Size & Position et

[ 2wlx 2]
ﬂ Cancel

8. The template is now finished and ready to use. See the image below. Yours should look similar. Note the two Template Parameters,
as well as the placement of the components.
9. Once you have the properties added and components bound, type a value into each Template Parameter so we can easily tell that
our bindings are working.
a. Label_Text: Label
b. TextField_Text: Text
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Absolute Positioning

First, we can set up our Template Canvas using Absolute Positioning, which is a little simpler to understand as each template has a width
and height as well as an x and y position.

1. Drag a Template Canvas component to a window and open the Template Canvas Customizer. The customizer provides an easy
interface to setting up our templates.
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2. Enter in the following values for the first instance:
a. Name: First Name



b. Template: Form Input
c. Absolute Positioning: 0, 0, 200, 20
d. Parameters: Label_Text = First Name (leave TextField_Text blank)

3. Click the Add button to add the instance. The instance will then be visible in the preview section of the window. Note that values for
the components are still using the default values for the Label_Text and TextField_Text. This is intentional. The new values will
appear once you hit OK and close the canvas customizer.

The following feature is new in Ignition version 8.0.6
Click here to check out the other new features

Labels were added to the Absolute Positioning properties: X, Y, width, and height labels. A Z-index field was added indicating where
a given template instance should appear in the z-order within the template canvas (top or bottom).
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Take note of the yellow outline around the instance in the image, and how First Name is highlighted at the top of the
customizer. This means that the instance is selected, and the customizer is in edit mode. This allows you to make
changes to the selected instance. To exit edit mode and add a new instance, click on the Cancel button in the lower left of
the window. Clicking on the Cancel button in the lower right will cancel out of the customizer.

4. Let's add another instance. Click on the plus + icon in the Instance area to clear the Add/Edit Instance fields from the prior entry,
and enter the following:
a. Name: Last Name
b. Template: Form Input
c. Absolute Positioning: 0, 20, 200, 20


https://docs.inductiveautomation.com/display/DOC80/New+in+this+Version#NewinthisVersion-Newin8.0.6

d. Parameters: Label_Text = Last Name (leave TextField_Text blank)

5. Once entered, click the Add button again. You'll see that you have two instances visible in the preview section of the window. Once
both instances are configured, click the OK button.
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6. Now you will see both instances appear in the Template Canvas.
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7. If a new instance needs to be added, it can be added through the Template Canvas Customizer. However, the Template Canvas
also has a 'Templates' property. This property stores all of the data that was entered into the customizer into a dataset, so new
instances can be configured directly on the Templates property. View the dataset by clicking the Dataset Viewer button next to the T
emplates property. Furthermore, template instance configurations could be stored in a database table, and the Template Canvas

could fetch the data with a SQL Query binding on the Templates property.
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Layout Positioning (MiG Layout)

Instead of having to manually enter a size and position for each instance, we can make use of Layout Positioning to have the Template
Canvas determine the best position for each instance, while also making suggestions as to where each instance is placed in relation to
another. The layout positioning uses a grid-methodology to instance placement. Each instance, unless otherwise specified, is considered a

single "cell" in the grid.

Don't Mix Absolute and Layout Positioning

We recommend not using both Absolute and Layout Positioning for instances on the same Template Canvas. Select either
Absolute or Layout Positioning for your instances. Layout Positioning will determine the best position for each instance in your
canvas, where Absolute Positioning allows you to manually specify the width, height, x and y positions for each instance.

Continuing from the example above, the First Name and Last Name instances are using Absolute Positioning. Let's tell the First Name
instance to use Layout Positioning and enter the 'wrap' parameter. This means the next cell in the grid should be placed on the next row.

1. With the Template Canvas component selected, open the the Template Canvas Customizer again, and make the following

modification to the First Name instance.
a. Click the radio button for the Layout Positioning property and enter 'wrap' the field.



2. Click Apply, and the First Name instance will appear to overlap with the Last Name instance. This is because the grid only accounts
for instances using the Layout Positioning.
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3. Next, we can configure the Last Name with Layout Positioning as well. Make the following changes to the Last Name.
a. Click Layout Positioning radio button and enter ‘wrap' in the field below.



4. Once the changes have been applied, click OK. You'll notice in the preview section of the window that both instances are now in
line.

5. Open the Templates property by checking the Dataset View button. Notice that the X, y, width, and height columns are no longer

used, but the layout columns for First Name and Last Name now have a value of 'wrap'.
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6. Like the previous example, new rows can be added directly to this dataset. Furthermore, the 'wrap' value means the next template
instance will begin on a new line. Add three new instances for Street Address, City and Account Name. Use either the Template



Canvas Customizer or simply add two new rows in the dataset viewer with the values shown in the image below.
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Read User Input

The last step is to read the user input. Put the Designer into Preview Mode and add some values for each text field component. Once
finished, switch the Designer back to Design Mode, and add a Button component to the window (not the template canvas)

Add a script to the Button component using the Code Snippet below - Read User Input Example. Place the code on the actionPerformed
event of your component by double clicking on the Button component and opening the Script Editor tab.

# Reference the tenplate canvas conponent, and call the getAll Tenpl ates() nethod.
# This will return a list of every instance in the canvas
tenpl at eLi st = event. source. parent. get Conponent (' Tenpl ate Canvas').get Al l Tenpl at es()

# Initialize a list. User input fromeach text field will be stored in this variable
user |l nput =[]

# Iterate through each tenplate instance inside the canvas
for tenplate in tenplatelist:

# add the user inputted value to the userlnput list. The values are originally returned in Unicode.
# the Python str() function is casting the Unicode values as string val ues.
user | nput . append(str(tenpl ate. Text Fi el d_Text))

# Show the values in a nmessageBox. This could be replaced with an | NSERT query, or sone other action.
# str() is used again to case the list as a string. This only required to work with the nessageBox
function

# since the function requires a string argunment be passed in

system gui . nessageBox(str (userlnput))

When running the script, each value should appear in the message box. If you're not getting a value in the message box, make sure the Text
Field property is bound to the TextField_Text template parameter as mentioned in the Creating a Template section, Step 6b.

This example can easily be expanded to do something more meaningful with the input, like store to a database table.



First Name
Last Name
Street Address
City

Account

Tim
Smith
Dover 5t
Utah
123456

Information

X

o ['Tim', 'Smith', 'Dover 5t', 'Utah', '123456']




Security in Vision

Client Permissions _
On this page
Every project's clients are governed by a set of permissions to control what is allowed to originate
from the client. For example: access to construct queries against the database, or the ability to edit
Users and Roles in your authentication profile. To maintain a secure system, these are all set to
disabled by default, but you can enable them for everyone, for specific users, or even for specific
users that are logged into certain zones. See descriptions of these categories and how to change .
them on the Project Permissions page.

Client Permissions
® Client Login Security
® Role-Driven Client
Security
H H H ® Incorporating
Client Login Security Serinting into
Security

Projects are assigned a User Source to authenticate against. All roles that have been defined in
the User Source can be used to prevent users from logging in to the project.

A Project Properties - [m] x

Project Project / General
Permissions Tag Settings
Designer Default Provider default o
Vision Client Poll Rate 250 (4
Design Database Settings
General Default Database MysSQL |2
Launching Security Settings
Login Identity Provider Select one... s
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Enable Auditing

Permissions
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Tag Drop
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Role-Driven Client Security

On the simplest level, security settings can be applied to individual windows or components. Users with different roles can all view the same
project from the client, but the functionality and readability can change based on the roles assigned to each user. Generally, higher level
access provides full functionality to all contents of a project, and lower level access is restricted to generalized read-only privileges.

Below we see the Security Settings panel in action. This panel is the interface that applies Ignition's built-in security settings. Security
settings can be applied to a single component, multiple components simultaneously, or even a whole window. Users who should be allowed
full access can be selected, and restrictions can be applied for users that should not have full access.
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Incorporating Scripting into Security

The component-based security settings are fairly simplistic: the user either has the required roles, or a restriction is applied. In situations
where consideration for access should go beyond a simple role check, security-based scripting can provide a larger degree of granularity.
Information about the logged-in user, such as user-name or roles, can be detected by scripting, allowing for the creation of a robust security
system.
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In This Section ...



Login Security

Overview

In Gateways with multiple projects, sometimes client access should be limited on a per-user-basis.
The most common use-case is when users from one area of a facility should be able to launch
clients that are specific to their area, but should not be able to launch clients from other areas.
While there are several different ways to approach this, the easiest is to require different roles to

log into each project.

Every project in Ignition is going to have a user source associated with it. For Vision you can
change the User Source (Authentication profile) for a project as well as assign Required Client

Roles within the Project Properties.

1. In the Designer, click on Project tab on the menu bar at the top of the Designer, then

select Project Properties.
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2. Use the User Source dropdown list to choose a User Source for this project. The selected
User Source will only allow users from that User Source to access the project.

3. In the Required Client Roles field, enter the roles you want to grant access to this
project. The Required Client Roles field will show all matching roles as you start typing.
Multiple roles may be specified by separating them with a comma.

4. Click OK to save the changes.

1 Changing your security settings will not log users out of an open client, but it will

stop them from logging in again.

Login Issues

On this page

® Overview
® Login Issues

@ INDUCTIVI
UNIVERSI]

Project Security

Watch the Video

If a user is experiencing some issues logging into a project, there are a few things that may be causing the problem.

1. First, make sure the credentials they are using are valid. This is easily done by going to the Gateway Webpage and testing the login.
2. If the user's credentials were successfully tested against the user source, you can then verify if that user source is the one being

used by the project that the user is trying to log in to. (See Above)

3. If the user's credentials failed, they may have forgotten their password, and it may need to be reset.
4. Alternately, the user source may not be reachable. Depending on the type of user source, this can happen when there are network
problems. For example, a database user source will no longer work if the database connection is faulted.

Related Topics ...

® Security

® Project Security in Designer
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Component and Window Security

Role-based security inside of Ignition works on multiple levels: component, group, container, and
window levels. Each of these levels also have special categories of security that help with tuning
security to various design considerations.

Each window and component can define its own security settings. These settings determine who
can see and/or use the component. It's good business practice to have a well thought out security
policy for your project.

Changing Security Settings on a Component

By default, each component inherits the security that is on its parent which initially gives anyone
with access to the project the ability to use the components. This can be changed on a per
component basis by right clicking on the component and selecting Security. This brings up the
Security Settings panel.
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Inherit Permissions

Restrictions

Access Denied Overlay
Disable

Disable Events

Hide

Exempt Roles

Administrator
Driver
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® Changing Security
Settings on a
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Window Security

Watch the Video

The Inherit Permissions checkbox signifies that the component is inheriting the security settings of the parent.

In the Restrictions section on the right, choose the restrictions that will be placed on the component if the user does not have the selected

role. Multiple restrictions can be selected to combine their effects.

Restriction Used On  Description Image
Access Compone = Shows an overlay on top of the component when the user doesn't have security clearance. Access
Denied nts Denied
Overlay
Disable Compone = Sets the Enabled property to false on the component when the window opens up. Disabled
nts
Hand
If you choose to disable a component, make sure that it is a component that actually
does something different when it is disabled. For example, buttons and input boxes
can't be used when they are disabled, but disabling a Label component has no effect.
AUto
Disable Compone = Prevents event scripts from running when the user doesn't have security clearance. N/A
Events nts, Root

Container
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Hide Compone = Sets the Visible property to false on the component when the window opens up. Hidden

nts, Root

Container
Do Not The Only used on the window object itself, will prevent the window from opening if the user doesn't N/A
Open Window have one of the specified roles.

Object

Exempt Roles

Unchecking the Inherit Permissions checkbox enables the role checkboxes under Exempt Roles. Each role that is selected will have
access to the component. So if the Administrator role was checked, then all users with the Administrator role will be able to use the
component, while users without the role would have Restrictions to the component. A user only needs to have one of the selected roles to be
able to use the component, not all of them.

If the roles you created do not appear, it is probably because the Designer was open before those roles were created. To update the list of
roles, right-click in the Exempt Roles section and select Refresh .

Security Settings L1 X

Inherit Permissions

Restrictions

Access Denied Overlay
Disable

Disable Events

Hide

Exempt Roles

Administrator
Driver

® Refresh

1 Ifthe roles you created do not appear, it is probably because the Designer was open before those roles were created. To update
the list of roles, right-click in the Exempt Roles section and select Refresh.



Security in Scripting

While the Vision system has many options for securing individual components and clients, it is
possible to have requirements that go further than the options that are available. With scripting,

you can create any type of security that you may need. This is mainly done through the use of the s
ystem.security.getRoles function, as well as the other system.security functions. The getRoles
function gets a list of the users roles, which you can check for specific roles within your script. You
can then write code for what would happen if the user has the role and if they don't have the role.

Additionally, while the typical security set up only requires the user to have one of the required
roles, in scripting you can ensure that the user has any combination of roles.

Securing Event Handlers

Security can be added to any of the event handlers in Ignition. This works on both components as
well as on event handlers within the Scripting window. While the typical security settings for a
window only give you the option of not opening it if the user does not meet the required roles, you
can instead do something else like opening a different window.

Script Builder Security Example

On this page
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® Script Builder
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® Security in Client
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Each one of the script builders also has the ability to add security to them. The following is an example of setting up security on a Button

component.

1. Drag a Button component onto a window.
2. Right click on the component, and choose Scripting.
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Under the Navigation tab, click the Open/Swap radio button.
From the Window dropdown list, choose a window for this navigation.

Click the Security button in the Action Qualifiers section. Click the Required Roles checkbox.
Select the roles that are required for this navigation. Click Close.

ﬁﬁ Component Scripting [Button 2]

@ Event Handlers

~ @ action

- actionPerformed *

Ih m focus

b il key

b @ mouse

b mouseMotion

} @ propertyChange

@ Custom Methods
4=

- ] *
¢ [ Navigation W% SetTagValue 2= SQLUpdate [ SetProperty [l Script Editor
¥
No Action
~O Open/swap
[«] Open Pass Parameters
2 and Center Parameter Name Value
and Close This Window
Additional Instance
Swap
Window:
Main Windowll -
’, Forward / Back
’, Close
1 |
@ Ssecurity... € Confirmation...
PO Required Role(s):
Event Description Administrator Event Object Properties
This eventis fired wl| Operator onent |~
occurs. What this ac ; f the ® source
Supervisor i
component. Moste o The component that fired this
buttons, where the 3 Upper Management event.
pushed, via a mouse 3
component refereng Close tion |«
0K Apply Cancel




7. Next, click on the Script Editor tab. You'll see the script that is generated by the options you chose in the Navigation tab.

%% Component Scripting [Button 2] - O X
@ Event Handlers ¢ [] Navigation % SetTagValue == 5QLUpdate [S] SetProperty I [E Script Editor I
~ @ action >
| actionperformed* > ®
— 2#
b focus 3% %
b key 4%
b @ mouse 5
+ I mouseMotion 6if u'QA" in system.security.getRoles():
» @ propertyChange 7 window = system.nav.openWindow('Main Windowll')
@ Custom Methods 8 system.nav.centerWindow{window)
+ 9else:
10 system.gui.errorBox('Insufficient security privileges.')
< >
+ Advanced Settings
Event Description Event Object Properties
This event is fired when the 'action’ of the A A
comnonent occurs. What this action is depends > ® source >
oK Apply Cancel

8. Click OK to save the scripting. Now you added security to the Button component.

Security in Client Event Scripts

The Client Event Scripts can also be used to set up security within the project. While any of the

Client Events can be used for different security purposes, the most common is the Startup Script.

This allows you to create a customized, secure environment right as the Client is started. A Script
here can do certain things based on the roles of the user such as open certain windows, write to
client Tags to enable or disable certain things within a project, or even retarget to an entirely new
project.

Setting Client to Read Only

There are times when it is best to open a Client in a Read-Only mode to eliminate the possibility
that a Client will affect a device or database. The Client event startup script that sets the Client
mode to Read-Only is an easy way to accomplish this. Similar to the buttons in the Designer, this
function can be used to set Disconnected, Read-Only, and Read/Write modes in any script in
Ignition that runs in a Client. This function can be called in any Client scoped script, but is most
commonly used in the Startup script.

This example creates a Client event script that sets the Connection Mode to Read-Only.

1. From the Designer, go to Project Browser > Client Event Scripts.
The Client Event Scripts window is displayed.

2. In the Startup script area, enter the following: syst em uti | . set Connecti onivbde( 2)
where 2 means Read-Only.

@ INDUCTIVI
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Setting Client Read-
Only

Watch the Video
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[Z Client Event Scripts - ] X

Client Event Scripts Client Startup Script
Project startup script that runs in each Client
(= Shutdown
(& shutdown-Intercept 1 system.util.setConnectionMode(2) |

[E) keystroke
© Timer

[ Tag Change
[¥] Menubar
B2 Message

“ Apply Cancel

3. Click OK. The startup script will run the next time a user logs into the Client, resulting in
the Client being Read-Only.



Scripting in Vision

A lot of the scripting that happens in Vision is either located on components and windows, or it
manipulates component and window values. Many times, you can easily add the path to another
component or property from your script. It is important to understand how the component hierarchy
of a window works as well as how to properly access components and properties in a script
anywhere in a project

Component Hierarchy

Every window in a project has a hierarchy to it, with components and containers arranged in a tree
structure, with a single parent up at the top, and many children down at the bottom. While small
windows with only a few components can have a simple hierarchy, windows with many containers
can get more complex. Since the components are arranged like a tree, this means that we can
only move up and down through the tree structure and not sideways. To get from one component
to a sibling component, we must first navigate up towards the common parent, and then back
down to the desired child. Let's take a look at an example of how this works. Here we have a
simple window, with just a few components:

On this page

® Component
Hierarchy
® Accessing
Component
Properties
® Accessing a
Component
® From an Event
Handler
®* From an
Extension
Function
® From a Client
Event Script
® From a Project

Script
® Accessing
Components on
Other Windows
® Root Container
© Edit Table Container
" New Value Text Field
" Enter Data Button
© Alarm Label
© Data Table
© Header Label
We can flip the tree around to get a better understanding of exactly how the tree works:
Project Browser g - X e, 10 L 1200, Lo B 1220, L |ERLI Lo a8,
7 1 RootContainer H -
8 ] \ Edit Tables «— Headerlabel Data Table
¥ & Vision =
[Z Client Events ] Note Value Status
- U Windows 7] TestRow 12 74.24|ok Ll
i Alarms T] [TestRow 19 37.27 ok
b i Field Tanks & restrow1a 44.19)ok
" m PopUps 7 [TestRows 23.34|ok
B meinwindow 11 y TEEER:::G 94.62 :k
~ [] Root Container ] :
NN ENTET T || e oo To2do
(=] Enter Data Button 2] TestRow1 44.33|ok
O Text Field a: TestRow 18 2.12/ok
-+ Alarm Label ] Testrow7 20410k
Sy == e
[ overview Window [ T estRow el
B Test g» TestRow 15 29.88/ok v
b &0 Templates e w ]
» B Named Queries ] [ Text fi'etm """"" Enter Data |
» B Reports v i / / Button |
VT EomEa EET - Enter Data hud _
i |
|8 | = = el - ] ! L ~
7 [ E 1 S % Edit Table Container Alarm Label
| =l Common ”| ]

Here we can get a better idea of why we can only move up and down through the tree structure, and how getting to a component can be very

different depending on where you start. Let's say we want to go to the New Value Text Field so that we can grab its value.

Start From Path To New Value Text Field

Edit Table Container
1. Down to New Value Text Field




Enter Data Button

=

Up to Edit Table Container
2. Down to New Value Text Field

Data Table

Up to Root Container

Down to Edit Table Container
3. Down to New Value Text Field

N

To move up or down within the hierarchy, there are two special commands we can use on component objects: parent and getComponent().
The parent property allows us to grab a reference to whatever is directly above the component in the hierarchy, which in most cases is the
root container. We could then access any component on the root container by using getComponent(*Component Name") and then placing
the name of the component we want to access within the parenthesis.

Pseudocode - Component Hierarchy

# This pseudo code shows how to grab the parent of a conponent
conponent . par ent

# This pseudo code shows how to grab a child of a conponent
conponent . get Conponent (" Text Field")

Both parent and getComponent() can be used as many times as necessary to reach the desired component, drilling up or down through
layers of containers or or grouped components. Once you have a component reference, you can then access any one of that component's
attributes by using the name of the property, just like when accessing a property on the source component.

G} There is one exception to the pattern of using . par ent to go up the hierarchy and using . get Conponent ( nane) to go down.
The parent of a root container is not the window, and a reference to the window does not have a . get Conponent ( nane)
function. To get a reference to a window, simply use system.gui.getParentWindow with any component's event object as the
parameter. Once you have a reference to a window, you can use its . r oot Cont ai ner property to get to the root of
the component hierarchy, and from here you can follow the rules laid out above.

Accessing Component Properties
To access a property within the component, we simply need to use the scripting name of the @ IN DUCTIV]

property. The scripting name can be found in the description of each property, either by enabling U NIVERS I']
the description field or hovering over the property until the mouseover text appears. The scripting
names for every property on every component can also be found in the appendix. For a text field,
the scripting name of the text property is just text, so we would need to call that on the text field
which has the text property we want to access.

______________________________________________________________________________________________________________________ ) Accessing
Pseudocode - Component Properties Component

i # This pseudo code will access the text property of a conponent and PrOperties

i assign it to value. H

i value = conponent.text

Watch the Video

Accessing a Component

Now that we have an understanding of how the component hierarchy works, we can apply that knowledge to accessing a component from
anywhere within the project. While moving up and down within the hierarchy remains the same, accessing our initial component can differ
depending on where we start our script from.

From an Event Handler

Event Handlers get a special event object that has special properties depending on the type of event. Regardless of the event, all event
objects have a source property, which gives the component that fired the event. When accessing a component from an event handler, we
can first use event . sour ce to get a component on the window to start at. From there, we can use parent or getComponent() as needed to
get to the component we need to access.
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Python - Accessing a Component from an Event Handler

# This woul d access the text property of a Text Field conponent.
print event.source. parent. get Conponent (' Text Field').text

G} When accessing a component from an event on the window, there will be a different path to the component than normal. If you
already have a window object, you can use the function getComponentForPath(). This allows you to enter in the path to the
component as a string (similar to expression bindings), and will end up looking something like this:

Python - Accessing a Component from an Event on a Window

| system gui . get Par ent W ndow( event ) . get Conponent For Pat h(* Root Cont ai ner. Text Field').text

above:

Python - Accessing a Component from an Event on a Window

| system gui . get Parent Wndow( event) . get Root Cont ai ner () . get Conponent (' Text Field').text

From an Extension Function

Extension Functions get a special self object which is actually a direct reference to the component that the extension function is on. This
provides a direct reference point from which to access other components within the component hierarchy.

Python - Accessing a Property of a Component from an Extension Function

# This woul d access the text property of the conmponent running the extension function script.
print self.text

# This woul d access the text property of the conponent named 'Text Field if it is in the same container.
print self.parent.get Conponent (' Text Field').text

From a Client Event Script

Client Event Scripts are special because they don't start with a direct reference to anything on a particular window. So, we have to use
another means of finding a starting point on the window. The system.gui.getWindow() function allows us to get a reference to a window which
we can use to navigate to the root container with . get Root Cont ai ner (), and then to any component on that window. However, this will
only work if the window is currently opened. If the window is closed, it will throw an error, which can be handled with normal exception
handling.

Python - Accessing a Component from a Client Event Script

# Start the try block in case the windowis not open.

try:
# Grab the wi ndow reference and assign it to the variable w ndow.
wi ndow = system gui . get Wndow( " G her W ndow")

# Use the window reference to get the text property off of a text field.
print wi ndow. get Root Cont ai ner (). get Conponent (" Text Field").text

# Handl e the exception by opening an informative error.
except Val ueError:
system gui . errorBox("The wi ndow i s not open!", "Error")

From a Project Script

Project Library are unique in that how they access components can vary depending on where the Script Module is being called from and
what is being passed to it. If the script module is being called from an event handler or an extension function, it is possible to pass in the
event or self objects and use them within the script module.

Python - Accessing a Component from a Project Script

i # This code would go in a project script. W are defining our function that takes an event object
! # and uses it to find the value of the text property on the text field in the same contai ner.
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def func(event):
print event.source. parent.get Conponent (' Text Field').text

Python - Calling a Function from the actionPerformed Button

# On the action performed of a button on our w ndow, we could then use this to call our function.
nmyTest Scri pt. func(event)

Project Browser =L 4 . )
! project.myTestScript
Q. X
g 1def func(event):
v E,Scripting ~ 2 print event.source.parent.getComponent( ' Text Field').text

Ef, Gateway Events
~ & Project Library
~ w project

| D& myfestsripe |

[E] MewScript

However, this may not always be the case. In these instances, it is possible to instead use the same method that Client Event Scripts use
and grab the window object instead.

Accessing Components on Other Windows

You can also grab properties from components on other open windows from anywhere in the
project using the same method used in Client Event Scripts. This allows you to grab properties on
a main window from an event handler on a popup window.

@ INDUCTIV]I
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ety Components on
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Script Builders in Vision

When creating an Event Handler on a component, you can use one of the handy Script Builders i
nstead of writing your own script. In the Component Scripting window, the Script Builders are .
accessible as tabs along the top. Each tab represents a different kind of action that users can On this page
associate with an event. The last tab, Script Editor, lets you write your own event handler. You
can also use the Script Editor tab to view a script that was generated by one of the builders,
which is a good way to get started learning how to write your own event handlers. Each script

builder example on this page shows the actual script in the Script Editor, just simply click the link
under each example.

® Navigation Script
& Component Scripting [Button] - O x Builder

.
& EventHandlers O Navigation % setTagValue & SQLUpdate [=] SetProperyy G Scripteditor | Open / Swap
A 0 o cton * Forward / Back

= focus Open swap ¢ Closing Windows
= o * SetTag Value

s emanrine | e Script Builder
 Custom ethods ® SQL Update Script
. Builder
indons ® Set Property Script
Builder
Forward  Back ® Script Editor

® Advanced

Settings

® Action Qualifiers

® Security Qualifier
— ® Confirmation
e[ Qualifier
component occurs. What this action is depends

on the type of the compenent. Most commonly, ;:‘9 E“'"FED"E”UhatﬁrEd
this is used with buttons, where the actionis is even

Close

ok || Apply || Cancel
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Actions are Overwritten when Choosing another Script Builder
Only one Script Builder can be used at a time. If you previously picked another action using a different Script Builder, it will get

overwritten by enabling another Script Builder. If you need to do more than one action at a time, use the Script Editor to combine
scripts, or create your own script.

Navigation Script Builder

The Navigation Script Builder has various functions that deal with opening and closing windows.

Open / Swap

Opening is a very straight-forward operation, it simply opens the specified window at the same size it was in the Designer. Simply click on the
Open / Swap button, and select a Window from the dropdown list that you want to open. There are options to center that window within the
Client, and to close the window that the event was fired from. The opened window can also be opened as an additional instance, meaning
there can be multiple copies of the same window. This is useful when opening dynamic popups, so that a couple of popups can be opened,
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each with different values.

%% Component Scripting [Buttan] - O X
@ EventHandlers < W SetTagValue 2= SQLUpdate [S] SetProperty [E Script Editor
= @ action » .
b focus Open/Swap
b key Open Pass Parameters
b @ mouse
. Parameter Name | Value
F @ mouseMotion and Center
F @ propertyChange and Close This Window
@ Custom Methods Additional Instance
+
Swap
Window:
Popups/Tank -

Swapping is the practice of opening another window in the same size, location, and state as the current window, and closing the current
window. This gives the appearance of one window simply swapping into another, seamlessly. The Navigation Builder uses the swapWindow
version of swapping, but most "by hand" script authors will use the swapTo version. This last version relies on the fact that the windows
being swapped are both maximized windows. See the navigation strategy section for more information.

You can also pass parameters to the opened or swapped-to window. Check the Pass Parameters box, and click the Add + iconto add a
row, where each row is another passed parameter. The names of these parameters must match names of custom properties on the root
container of the target window. The values can either be literals or values of other properties from the source window. Use the Binding icon

3 4 navigate to the properties that you want to pass. It will construct the path to the property on the window. To pass parameters in a
navigation window, follow the steps below.

1. Check the Pass Parameters box, and click the Add + icon to add a row.

2. Choose a custom property from the "Parameter Name" dropdown list. This will be filled with custom properties on the root container
of the selected window. You can also type a name in directly.

3. Highlight the empty cell in the Value column of the parameter table, click the Binding icon c_:', select the component property you
want to enter the value and press OK.

4. Press OK to commit the change.

@Q:“::*E‘:S:"::'*;:'..'.'.:*: - O X
W Event Handlers < ¥ SetTagValue == SQLUpdate [ SetProperty (5 Script Editor

~ @ action >

| acoetomed

o

b focus Open / Swap
b ey Open Pass Parameters
b @ mouse
. Parameter Name Value
} i@ mouseMotion and Center +
} i@ propertyChange and Close This Window tankNum {S\.tankNum} &
@ Custom Methods Additional Instance =
+
Swap
Window:
Popups/Tank v

To learn more about passing parameters, refer to the parameterized windows section for more information.

The following Navigation builder script was generated by the Script Editor. If you compare the settings in the Navigation tab with the
documented code in the Script Editor, you'll notice the Tank popup window will be opened and centered in the window, and the
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value of the "tankNum" parameter passed.

&% Component Scripting [Button] - O X
L’i Event Handlers ¢ [J Navigation % SetTagValue 2= SQLUpdate (=] SetProperty
~ [ action »
1# This s N E
— 2# s t
i focus 3# L 2
b key 4z
» @ mouse 5
» @ mouseMotion 6 paraml = event.source.parent.tankNum
b i propertyChange 7
W Custom Methods 8window = system.nav.openWindow('Popups/Tank', {'tankNum' : parami})
+ 9 system.nav.centerWindow(window)

1@

Forward / Back

The Forward / Back actions give you a simple way of implementing browser-style forward/back buttons in your client. Note, that you must be
swapping between windows for this to work, because these functions rely on calls to syst em nav. swapTo in order to keep track of what
the sequence of recent windows has been.

Closing Windows

The Closing windows action allow for an easy way to have an event handler close the window that it is a part of, or any other window.

Set Tag Value Script Builder

The Set Tag Value Script Builder responds to an event by setting the value of a Tag. You can set the Tag to either a literal value directly
typed in, but we recommend using the chain link Tag ‘icon to have the event handler use the value of another property from the same
window.

Use the steps below to create a Set Tag Value.

1. Under the Set Tag Value tab, click the Set Tag Value radio button.
2. Click the Tag 2 icon and choose a Tag from the Tag browser list to write to (i.e., Writeablelntegerl).

3. Inthe To this Value field, enter a number (i.e., 100) or click the Property El icon to to browse for a component property to use as
the set-to value.

4. Press OK to commit the change.

%% Component Scripting [Button] - O X
W Event Handlers ¢ [ Navigation | % SetTagValue | = SQL Update [=] SetProperty [E Script Editor
~ @ action » )
I No Action
b i focus Set Tag Value
b key . . . . .
— Setthis tag: | [default]_Generic_/Writeable/WriteableInteger1
b @ mouse
b i@ mouseMotion To this value: | 100 =
b propertyChange
@ Custom Methods
+




The Set Tag Value script shown below was generated by the Script Editor. Compare the settings in the Set Tag Value tab with the
documented code in the Script Editor and you'll see the Tag is set to "Writeablelntegerl" and the Tag value is set to "100."

% Component Scripting [Button] - m] X
W Event Handlers ¢ [0 Navigation W% SetTagValue = SQLUpdate [ SetProperty | [ Script Editor |
~ @ action > - - —

- g 211y by - Al =

F @ focus

bl key

b mouse

b mouseMotion

b I propertyChange

W Custom Methods
+

SQL Update Script Builder

The SQL Update Script Builder helps you build an update query using a database browsing interface. Choose a database and table in your
target database, and the update query will be built for you. The key query will help identify a specific row to update, and can be made
dynamic using Update Query and Update Value text boxes.

1. Under the SQL Update tab, click the Update Query radio button.
2. Select a database and choose a table in your database. Select an event value in the table on the right.
3. This example has the id as the Key Column, so we entered 'id =2."
4. We selected the Humidity for 'id 2'.
5. To change the value in the database, we entered the new value in the Updated Value field to replace the previous value when the
action is executed.
6. Press OK to commit the change.
% Component Scripting [Button] — m} X
W Event Handlers < [ Navigation % SetTag Value = SetProperty & Script Editor
~ @ action >
| sctonveromeds P
b i focus Update Query
b key Browse Database
b @ mouse ~ H data A o |6 id Humidity Pressure Temperature
b @ mouseMotion id (INT) D= 3 2 80.0 100.0 154652 |~
» W properyChange | | 3 80,1492 100.0 20.1074
W Custom Methods Location (VARCHAR) 1 80,8002 100.0 33.0643
+ Pressure (FLOAT) s 100.0 100.0 41.966
£_stamp (DATETIME) v - prepp—
< > <
Key Columns
id=2 | @
UPDATE data SET Humidity = ? WHERE id = 2
Update value: | 95 I =

The following SQL Update script was generated by the Script Editor. If you compare the settings in the SQL Update tab with the
documented code in the Script Editor, you'll see your database, table, and column name, including the row id of the searched value.
You'll also see the new update value that will replace the existing value when the action is executed.

% Companent Seripting [Button]

[m] X
@ Event Handlers ¢ [J Navigation % SetTagValue &2 SQLUpdate [ SetProperty | & Script Editor
I~ '@ action >
| @
i focus %

W key

3
3
b i mouse
»
»

@ mouseMotion
i propertyChange

W Custom Methods
+

queryValue = '95'

system.db.runUpdateQuery("UPDATE data SET Humidity = %s WHERE id = 2" % (quexyValue),

1
2
3
4
5
6if system.gui.confirm(u'Are you sure?', 'Confirm'}):
7
8
9
]

‘MysqL')




Set Property Script Builder

The Set Property Script Builder will respond to an event by altering a property in the window. You must choose the property to alter and
choose the value that you wish to assign to it. The new value can be a literal value or the value of any other property on the window.

. Drag a Label component to your window to set the property to.
. Select the Button component and open the Scripting window, and select actionPerformed.

. On the Set this property click on the Property icon = to browse for the Label component's Text property, and click OK.

1
2
3. In the Set Property tab click the Set Component Property radio button.
4
5

. Type something into the To this value: field (i.e., Hello World!), or click the Property icon El

use as the set-to value.

6. Press OK to commit the change.

to browse for a component property to

\ﬁ Component Scripting [Button]

— O

2
»
2
»
2

i focus

W key

i mouse

W mouseMotion
i propertyChange

W Custom Methods

+

W Event Handlers ¢ [ Navigation W SetTagValue = SQLUpdate | = SetProperty | B Script Editor
~ @ action » .
Mo Action

Set Component Property
Setthis property: | {$\.Label.text}

To this value: Hello World!

x

This Set Property script was generated by the Script Editor. Compare the settings in the Set Property tab with the documented code
in the Script Editor and you'll see the value string "Hello World!" will be written to the Label component when the action executes.

bﬁ Component Scripting [Button]

2

2
»
2
2

W Event Handlers
~ @ action

m focus

= key

W mouse

i mouseMotion
i propertyChange

W Custom Methods

+

¢ [ Mavigation % SetTagValue == 5QLUpdate (= SetProperty | & Script Editor
»

6value = u'Hello World!"

7 event.source.parent.getComponent('Label’).text = value
8

9

Script Editor

The Script Editor allows you to add more complexity to existing scripts, combine scripts, and even write your own custom scripts. For
example, if you need to perform two or more actions at once, (i.e., set a Tag and navigate to another window), you can update the script by
combining the two actions in the Script Editor. The Script Editor even gives you the flexibility to create your own code for any action you want

to perform on an event handler.

As seen elsewhere on this page, the other builders ultimately generate a script that can be modified from the from the Script Editor Builder.

Advanced Settings

® Scoping Dropdown - Allows you to specify the scoping of the script. The scoping of event handlers in older versions of Ignition
work differently that modern versions. This settings was added as a way to provide backwards compatibility when upgrading. All new

scripts should ideally leave the scope set to Standard Scoping, as there is no reason for new scripts to use the Legacy Scoping
option.

this setting disabled, however if can be useful in some scenarios:

© Controlling the focus order in a window, since requesting focus from a component in the middle of an event being processed
can cause undesirable results.

© When writing a script on a window's visionWindowOpened event, you may wish to have your script run after processing.

Invoke Later - Provides an opportunity to allow the script to run after other events have finished processing. Most scripts will leave


https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+The+Window+Object

Action Qualifiers

All of the Script Builders allow you to put Security and/or Confirmation qualifiers onto an event handler. These Action Qualifiers are optional.

Security Qualifier

The Security Qualifier lets you restrict the event handler from running if the current user does not have one of the required roles highlighted
in the Security qualifier dialog box. The roles listed will be all of the roles within the project's default user source. To setup the required roles
for an event handler, select one or use CTRL+click to select multiple roles. Once the roles are selected, they will be highlighted. To deselect
roles, use CRTL+click again. The action will only be executed if the Required Roles checkbox is enabled. Click Close.

@ security... €y confirmation...
— Required Role(s):
Event Description Administrator Event Object Properties
Operator
Supervisor

Upper Management

Close

Confirmation Qualifier

The Confirmation Qualifier prompts the user with a popup dialog box confirming you want to perform the action. The action will only be
executed if the Require Confirmation checkbox is enabled. There is a default message, and if you prefer, you can delete it and enter your

own message. Click Close.

@ Security... €y Confirmation...
. Require Confirmation:
Event Description Are you sure?

Close

Related Topics ...

® Parameterized Popup Windows
® DB Browse Bindings



Component Events

Event Handlers :
On this page
When running a script on a component, we typically don't want it to be constantly running, but
instead want the script to trigger when the user does something on screen such as clicks with the
mouse. That something the user does is called an Event and can range from a mouse click or a
keypress to a window opening or a component property change. When certain events happen,
they trigger Event Handlers, which use a script to handle what happens when the event occurs. .

Event Handlers

. -
This page lists out all of the event handlers that are on Ignition's Vision module. Any third party Action Event

. . Handlers
modules may add new components which may potentially have new event handlers. * Property Event
Handlers
. ® Mouse Event
Event Object Handlers
* MouseMotion Event
Every Event Handler contains an event object, which allows you to interact with the component . Handlers
and the entire window hierarchy within your script. While each event object has different properties . Key Event Handlers
depending on what Event Handler it resides in, each event object contains a source property, Focus Event
which is a reference to the component that fired the event. Using event . sour ce not only gives Handlers

® VisionWindow
Event Handlers

® |nternalFrame Event
Handlers

® Cell Event Handlers

® |tem Event Handlers

® Paint Event

us access to all of the properties available on that particular component, such as the text property
of a text field,

Pseudocode - Event Handler Source Component Properties

# Here we start with the event object, then use source to go to the
conponent that fired the event,

# and then use the nane of the property to access its value. In this Handlers
case, we accessed the text property.
text = event.source.text
but it also provides us with a way to navigate to other components within the hierarchy. For
example, here we have a script on a button that references a text field. @ IN DUC TIV]
Pseudocode - Event Handler Other Components U NIVERS I']

# Here again we start with event.source to get to the conponent that
fired the event, but now we use :
# parent to go up to the root container, and then get Conponent to i
navi gate back down to a different conponent. i
text = event.source. parent.get Conponent (" Text Field") i

Vision Event
Scripts Overview

Watch the Video

G} Even when components are disabled, most scripting events can still occur. For example, a mouse click can still happen on a
disabled component, which is why we recommend using the action performed event when placing a script on a button.

Action Event Handlers

The Action category of event handlers pertains to components being "used" from the client, such as a button being pressed or a checkbox
component being selected. You can access Event Handlers through the Scripting option.

Events

Events Description

action = This event is fired when the 'action’ of the component occurs. What this action is depends on the type of the component. Most
Perfor '~ commonly, this is used with buttons, where the action is that the button was pushed, via a mouse click or a key press. See the
med component reference for details on what the action means for other components.


https://www.inductiveuniversity.com/videos/vision-event-scripts-overview/8.0/8.0/8.0

It is recommended to use this event over mouseClicked whenever possible.

Event Object Properties

Properties = Description

source The component that fired this event.

In this example, let's use a Button component to print "Hello World!" on the the console each time the Button is pressed.

1. Drag a Button component to the your Designer workspace.
2. Select your Button and right click on Scripting.
3. Copy the code in the code block and paste it in the Script Editor tab. Press OK.

Python - Button Action Performed

# On the actionPerformed of a button, this will print Hello Wrld! to the console each tine the
button is pressed.
print "Hello Wrld!"

m % @ | & ComponentScripting [Button] - o x
@ Button & _ . 5 -
N @ Event Handlers ¢ [] Navigation % SetTagValue =2 SQLUpdate [=] SetProperty | B Script Editor

~ @ action > n . n - i ; . .

1# On the action rmed o n, this will print Hello World! to the console|~ | &
p— 2print "Hello World!"

b I focus %

b key

b mouse

b @ mouseMotion

b I propertyChange

@ Custom Methods
+

4. Save your project, and put the Designer in Preview Mode.

5. From the top menubar click on Tools > Console. Press the button and you'll see "Hello World" printed each time the button is
pressed.

Output Console o 4
B

Hello World!
Hello World!
Hello World!
Hello World!

Property Event Handlers

Property event handlers typically trigger based on the property of a component.

Events

Events Description

propertyChange Fires whenever a bindable property of the source component changes. This works for standard and custom (dynamic)
properties.

Event Object Properties



Properties = Description
source The component that fired this event.
newValue The new value that this property changed to.

oldVvalue The value that this property was before it changed. Note that not all components include an accurate oldValue in their
events.

propertyNa = The name of the property that changed.
me

1 Remember to always filter out these events for the property that you are looking for!l Components often have
many properties that change.

Python - Printing the Changing Property

# On the propertyChange of a conponent, this script will print out the name of the property that is :
changi ng. :
print event. propertyNanme :

Python - Looking for a Specific Property

# 1t is common to use propertyNane to | ook for specific properties to change. This is a great way to :
i restrict how often your scripts execute
! if event.propertyNa == "text': :
i print 'The Text property changed' :

Mouse Event Handlers

The mouse events all correspond to the clicking and movement of the mouse. They are triggered in the client by an operator interacting with
a mouse. Touchscreen monitors will trigger these events when a user touches the screen, but not all touchscreens will fire the mouseEntered
and mouseExited events.

Events

Events Description

mouseCli = This event signifies a mouse click on the source component. A mouse click is the combination of a mouse press and a mouse
cked release, both of which must have occurred over the source component.

1 This event fires after the pressed and released events have fired.

mouseEn = This event fires when the mouse enters the space over the source component.
tered

mouseEx = This event fires when the mouse leaves the space over the source component.
ited

mousePr = This event fires when the mouse presses down on the source component.
essed

mouseRe = This event fires when a mouse button is released, if that mouse button's press happened over this component.
leased

Event Object Properties

Properties = Description

source The component that fired this event.



button The code for the button that caused this event to fire. Use the constants event . BUTTONL, event . BUTTONZ2, and event .
BUTTONS.

clickCount = The number of mouse clicks associated with this event.
X The x-coordinate (with respect to the source component) of this mouse event.
y The y-coordinate (with respect to the source component) of this mouse event.

popupTrig = Returns True (1) if this mouse event is a popup trigger. What constitutes a popup trigger is operating system dependent,
ger which is why this abstraction exists.

altDown True (1) if the Alt key was held down during this event, false (0) otherwise.

controlDo | True (1) if the Control key was held down during this event, false (0) otherwise.
wn

shiftDown = True (1) if the Shift key was held down during this event, false (0) otherwise.

Python - Printing on a Mouse Enter

# On the nouseEntered event of a conponent, this script will only fire if the nouse enters the bounds of
the conponent.
print "The nouse is inside the conponent space!"

MouseMotion Event Handlers

The mouseMotion events deal with the motion of the mouse over a component. Not all touchscreen monitors will fire these events.

mouseMotion events will not trigger when the project is viewed from a mobile project as these gestures are used by the browser
/device to zoom or pan.

Events

Events Description
mouseDragged = Fires when the mouse moves over a component while a mouse button is being held.

mouseMoved Fires when the mouse moves over a component, but no buttons are being held.

Event Object Properties

Properties = Descriptions

source The component that fired this event.
button The code for the button that caused this event to fire. Use the constants event . BUTTONL, event . BUTTON2, and event .
BUTTONS.

clickCount = The number of mouse clicks associated with this event.
X The x-coordinate (with respect to the source component) of this mouse event.
y The y-coordinate (with respect to the source component) of this mouse event.

popupTrig = Returns True (1) if this mouse event is a popup trigger. What constitutes a popup trigger is operating system dependent,
ger which is why this abstraction exists.

altDown True (1) if the Alt key was held down during this event, false (0) otherwise.

controlDo = True (1) if the Control key was held down during this event, false (0) otherwise.
wn

shiftbown | True (1) if the Shift key was held down during this event, false (0) otherwise



Python - Printing on a Mouse Movement

print

# Fromthe nouseMtion event on a conponent, this will print each tinme the nouse noves when it is over
the conponent.

"The nouse is noving over the conponent!"

Key Event Handlers

The key events all have to do with the user pressing a key on the keyboard.

Events

Events

keyPress
ed

keyRelea
sed

keyTyped

Description

Fires when a key is pressed and the source component has the input focus. Works for all characters, including non-printable
ones, such as SHIFT and F3.

Fires when a key is released and the source component has the input focus. Works for all characters, including non-printable
ones, such as SHIFT and F3.

Fires when a key is pressed and then released when source component has the input focus. Only works for characters that
can be printed on the screen.

Event Object Properties

Properties
source

keyCode

keyChar

keyLocation

altDown

controlDo
wn

shiftDown

Description
The component that fired this event.

The key code for this event. Used with the keyPressed and keyReleased events. Uses the standard Java key codes, see
below for more information.

The character that was typed. Used with the keyTyped event.

Returns the location of the key that originated this key event. Some keys occur more than once on a keyboard, e.g. the left
and right shift keys. Additionally, some keys occur on the numeric keypad. This provides a way of distinguishing such keys.
The keyTyped event always has a location of KEY_LOCATION_UNKNOWN. Uses the standard Java key locations, see
below for more information.

True (1) if the Alt key was held down during this event, false (0) otherwise.

True (1) if the Control key was held down during this event, false (0) otherwise.

True (1) if the Shift key was held down during this event, false (0) otherwise.

Python - Printing the Key Released

# On the keyRel eased event of a conponent, this will print out the key code of the key that was hit on
the keyboard,

# but only on rel ease of the key, and only when the conponent has focus.
print event.keyCode
Java Keys

The key Event Handlers use the Java KeyEvent class, which has unique identifiers for both keys and locations on the keyboard to help
differentiate which key is actually being pressed on the keyboard. The numeric codes for each unique location and character can be called
from the event object using a constant. For example, the letter "a" has the constant name VK_A. This can then be used to compare against
the keyCode value like this:

Python - Checking Specific Key Codes

if event.keyCode == event. VK_A

print "The key press was a"



We listed the locations and some common codes below, but the full list of codes can be accessed by going to https://docs.oracle.com/javase
/8/docs/api/java/awt/event/KeyEvent.html.

1 Some Operating Systems reserve certain keys for certain function, and will capture the key press or release before it gets sent to
the Client. For example, many Operating Systems use the TAB key to shift focus to the next field.

Key Code Constants Key Location Constants
VK_0-VK_9 VK_END VK_PAGE VK_DOWN VK_CONT KEY_LOCATION_L KEY_LOCATION_R ' KEY_LOCATION_
_UP ROL EFT IGHT NUMPAD
VK_A-VK_Z VK_ENT ' VK_RIGHT VK_PAGE_D VK_LEFT KEY_LOCATION_S | KEY_LOCATION_U
ER OWN TANDARD NKNOWN
VK_F1-VK VK _HO | VK_SHIFT VK _UP VK_TAB
_F24 ME

VK_ALT VK_INS | VK_SPACE VK_ESCAPE
ERT

Focus Event Handlers

Focus events deal with focus moving between different components on a window. Opening windows, using tab to move around the screen,
or clicking on components will trigger these events. Note that not all components can hold focus.

Events

Events  Description

focusG  This event occurs when a component that can receive input, such as a text box, receives the input focus. This usually occurs
ained when a user clicks on the component or tabs over to it.

focusLo = This event occurs when a component that had the input focus lost it to another component.
st

Event Object Properties

Properties Description
source The component that fired this event.

oppositeCompon = The other component involved in this focus change. That is, the component that lost focus in order for this one to gain
ent it, or vise versa.

Python - Printing on Focus Gained

# On the focusGained event of a few different conponents, this script can print out when the conponent
has gai ned focus.
print "The conponent nane now has focus!"

VisionWindow Event Handlers


https://docs.oracle.com/javase/8/docs/api/java/awt/event/KeyEvent.html
https://docs.oracle.com/javase/8/docs/api/java/awt/event/KeyEvent.html

The visionWindow events are specific to windows and not available elsewhere. Right click on the window name in the Project Browser and
select Scripting to get access to these events. These events are triggered by a window opening or closing.

Project Browser a - X L o Uil 11t O T T 1599, 1590, 1790,

A
- EI Windows &
¥ mm Popups
» [ Alarms
™ Dabatase Pens T
50%
M pata o
[™ Database Pens2

BRI 8 component Scriptim*[ﬁeld Tanks]l - m]

[ Root Containg

[ Main Window1 | | Event Handlers ¢ [ Navigation % SetTagValue = SQLUpdate [ SetProperty| & ScriptEditor
b il internalFrame

Tag Browser b propertyChange 1 system.gui.getParentWindow(event) .getComponentFoxPath( 'Root Container.Text Field').requestFocusInWindow()
Q < - a2 ~ @ visionWindow
Tag Pr—
b il Tags visionWindowClosed
Events Description

visionWindowOpened = This event is fired each time the window is opened and before any bindings are evaluated.

visionWindowClosed | This event is fired each time the window is closed.

Event Object Properties

Properties = Description
source The vision window that fired this event.

Python - Grabbing Focus on Window Opened in Two Different Ways

# From a vi si onW ndowOpened event on a wi ndow, you can request the focus of conponents in the w ndow, to
start the focus on a conponent other than the upper |eft npbst conponent.

# Here we grab the reference to the conponent using the property selector on the upper right side of the
script editor.
system gui . get Par ent W ndow( event ) . get Conponent For Pat h(' Root Cont ai ner. Text Field').requestFocusl nW ndow()

# Here we can manually enter in the path to the conponent using our know edge of the conponent hierarchy
and

# the get Root Contai ner function. Both of these functions work in the sane way.

syst em gui . get Par ent W ndow( event ) . get Root Cont ai ner () . get Conponent (" Text Fi el d").request Focusl nW ndow()

InternalFrame Event Handlers

The internalFrame events are fired by windows: windows are known as "internal frames" in the underlying Java windowing system that the
Vision component uses. Note that the source of these events is the window itself, just like the visionWindow events above.

Events

Events Descriptions

internalFrameAc = Fires whenever the window is shown or focused. If you want a script to fire every time a window is opened, use this
tivated event.

internalFrameCl = Fires when a window is closed.
osed

internalFrameCl = Fires right before a window is closed.
osing



internalFrameD = Fires when a window loses focus.
eactivated

internalFrameO  Fires the first time a window is opened. Note that when windows are closed and cached, next time they are opened this
pened event will not be fired. Use internalFrameActivated instead.

Event Object Properties

Properties = Description

source The window that fired this event. Use source.rootContainer to get the root container.

Python - Printing on Frame Activation

# Fromthe internal FrameActivated event on a window, this will fire each time the window is focused, so
clicking between two different windows will trigger it. :
print "This windowis nowin focus!" :

Cell Event Handlers

The cell event is unique in that it only appears on the Table component. It will trigger when something within a cell changes, and once for
each cell changed.

Events

Events Description

cellEdited = This event is fired when one of the cells in a table component has been modified.

Event Object Properties

Properties = Description

source The table component that fired this event.
oldvalue The old value in the cell that changed.
newValue = The new value in the cell that changed.

row The row of the dataset this cell represents.
column The column of the dataset this cell represents.

Pseudocode - Updating a Database Table

# Fromthe cell Edited event of a table conmponent, this script can update our database table with any new
data that is entered in the table

# Get the id of the row we edited and the headers
id = event.source. dat a. get Val ueAt (event.row, 'id")
headers = system dat aset . get Col unmHeader s(event. sour ce. dat a)

# Build our Update query.
query = "UPDATE User SET % = ? WHERE id = ?" % (headers[event. col um])
args = [event.newVal ue, id]

# Run the query with the specified argunents.
syst em db. runPrepUpdat e(query, args)

ltem Event Handlers


https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Table

The item event is unique in that it only appears on components that can be "on" or "off, such as with Radio Buttons, Check Boxes, and Toggle
Buttons.

Events

Events Description

itemStateChan  This event fires when the state of the component changed. This event is the best way to respond to the state of that
ged component changing.

Event Object Properties

Properties = Description
source The component that fired this event.

stateChan = An integer that indicates whether the state was changed to "Selected" (on) or "Deselected" (off). Compare this to the event
ge object's constants to determine what the new state is.

SELECTED The constant that the stateChange property will be equal to if this event represents a selection.

DESELEC @ The constant that the stateChange property will be equal to if this event represents a de-selection.
TED

Python - Printing on a Radio Button Selection
# On the itenttateChanged event of a radio button, this will print when this specific radio button is
sel ect ed.
if event.stateChange == event. SELECTED:
print "This radio button is selected!"

Paint Event Handlers

The paint event is only found on the Paintable Canvas component, and is used to customize how the component gets painted. This event

requires a heavy knowledge of programming using the Java 2D drawing tools, but there is code for a pump shape each time you add a new
Paintable Canvas to a window.

Events

Events Description
repaint  This event will fire whenever the component needs to repaint itself. It will repaint when any of its custom properties change, or

when . repai nt () is called on it. When a Paintable Canvas is first dragged onto the screen, the repaint Event Handler will be
filled with an example that draws out a pump.

Event Object Properties

Properties = Description
source The Paintable Canvas component that fired this event.

graphics An instance of java.awt.Graphics2D that can be used to paint this component. The point (0,0) is located at the upper left of
the component.

width The width of the paintable area of the component. This takes into account the component's border.

height The height of the paintable area of the component. This takes into account the component's border.

Python - Painting a Circle



https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Radio+Button
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# On the repaint event of a paintable canvas conponent, this will create a circle with a gradient
background col or of orange and white.

fromjava.awt inport Col or
fromjava.awt inport G adientPaint
fromjava. awt.geominport Ellipse2D

g = event.graphics

# Body
innerBody = Ellipse2D. Float(8,8,72,72)

#### Scal e graphics to actual conponent size
dX = (event.w dth-1)/100.0

dY = (event. hei ght-1)/100.0

g. scal e(dX dY)

Pai nt body
. set Pai nt (G adi ent Pai nt (0, 40, Col or. WHI TE, 0, 100, Col or. ORANGE, 1))
.fill(innerBody)

. set Col or ( Col or . ORANGE)
.draw(i nner Body)

Qe a e H#




Extension Functions

What Are Extension Functions

Extension Functions are found on the component scripting window of certain components, and
they allow for more advanced customization of the component using scripting. These functions are
generally more advanced and require a better understanding of Python. Unlike Event Handlers,
Extension Functions are not driven by a specific event, but are instead called by the component
itself for a specific purpose when appropriate. This may be when the component first loads in the
window, or whenever the function receives new input.

From an object-oriented point of view, Extension Functions create a custom "subclass" of the base
component type. Your subclass can then override and implement parts of the functionality of the
component itself, in Python. Following Python object-oriented methodology, each extension
function's first argument is called sel f . That is because these are methods that belong to the
component's class itself, instance methods. The value of sel f will always be the component itself.
Notice that this is different than Event Handler scripts where you are given an event object in your
scope and the component that fired the event is under event . sour ce. When you write an
Extension Function, there is no event object so the component is given to you as the sel f object
instead.

Each component Extension Function comes with its own documentation built-into the function's
default implementation using a standard Python "doc-string". You will find that you are unable to
edit the function's signature or docstring. Changing the method's signature (arguments or function
name) would prevent the component from calling it correctly. Changing the docstring could be
misleading or confusing as you'd lose the documentation for how your implementation of the
function should work.

Using Extension Functions

On this page

® \What Are Extension
Functions
® Using Extension
Functions
® Example - User
Management
Component
® Example - Table
Component
® Example - Power
Table Component
® Example - Ad
Hoc Charting

@ INDUCTIV]I
UNIVERSI]

Component
Extension
Functions

Watch the Video

Using an Extension Function works much like using an Event Handler. First select and Enable the Extension Function within the component

scripting window, and then add in a script. The script will then automatically run when called.

Example - User Management Component

The User Management component has many Extension Functions that provide a way to customize how the component works. Thefilter U
ser () extension function is useful for filtering out users you don't want to see in the user source, preventing users from editing that user in
the client. We can add a simple scriptto the fi |l t er User () Extension Function that will hide the user from the list if they have the

Administrator role.

1. Drag a User Management component in to your Designer workspace, and right click on Scripting.

2. Under the Extension Functions folder select filterUser and click Enabled.
3. Copy the code from the code block below and add it to bottom of the script and click OK.


https://inductiveuniversity.com/video/component-extension-functions/8.0
https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+User+Management

%3 Component Scripting [User Management] - [m} x

@ Event Handlers < [ Enabled
b mouse >
+ @ mouseMotion

I propertyChange Called for each user leaded intc the management table. Return false to
@ Extension Functions hide this user from the management table. This code is executed in a

def filterUser(self, user): ~
5

3

4
I_ 5 background thread.

6

7

8

f¥ filterRole
¥ filterSchedule Arguments: . . . .
f¢ onCreatelser self: A Ieferencelto the component that is inveking this function.
/¢ onDeleteliser 9 user: The user object itself. Call user.get('propertyName') to
10 inspect. Common properties: 'username’, 'schedule’, 'language
f+ onSaveUser 11 user.getRoles() for a list of rolenames.
/¥ onCreateRole 12 e
/v onDeleteRole 13 to see If the user has the

/¥ onSaveRole 14
@ Custom Methods 15
+ 16
17 else:
18 # in
19 return 1

Python - User Management Filter User

# Check to see if the user has the Administrator role.
if "Adm nistrator" in user.getRoles():

# Return 0 to hide themif they do.

return 0
el se:

# Otherwi se, show the user in the table.
return 1

4. By enabling this script, we now only see the users without the Administrator role in the list of users.

Username Name Roles Contact Info Schedule +
operator Greg Peters Operator, Supervisor email: operator@ai.com Always
|ane |ane Dobson Operator email: operator@induc... | Always
Sara Sara Jones Supervisor email: supervisor@ind... Always
Role name # of Members +
Administrator 4
Operator 5
Supervisor 5

Upper Management 1

Example - Table Component

The Table component exposes an Extension Function called get Backgr oundAt () . By implementing this function, you can control the
background color of each cell of the table component using scripting. Starting with a Table component with some test data, then then add the
following script to the get Backgr oundAt () Extension Function.

Here is our sample data. We want to have a clearer indication of what companies have fewer than 30 installations. So, we'll write a script to
make those rows have a light grey background color.
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Right click on the Table component and choose Scripting.
Choose the get Backgr oundAt * extension function.
Select the Enabled check box.
Copy the code from the code block below and add it to bottom of the script and click OK.
%% Component Scripting [Table] - m] x
@ Event Handlers Enabled
b cell def getBackgroundAt(self, row, col, isSelected, value, defaultColor): il i
+ m focus 2 e
b key 3 Called for each cell, returns the appropriate background color. Do not g
» il mouse 4 block, sleep, or execute any I/0; called on painting thread.
» i propertyChange 5
& Extension Functions 6 Arguments:
7 self: A reference to the component that is inveking this function.
J* getForegroundat 8 row: The row index of the cell
e . 9 col: The celumn index of the cell
. " getDisplayTextat 1e isSelected: A boolean representing if this cell is currently selected
& Custom Methods 11 value: The value in the table's dataset at index [row,col]
+ 12 defaultColor: The coler the table would have chosen if this function
13 was not implemented
14
15 # For each cell, we check the value of the cell in the same row but in Installations
16 if self.data.getValueAt(row, "Installations"”) < 3@:
17 # If the value 1s less than 3@, we return a light grey color.
18 return system.gui.color("lightgrey"”)
19 else:
20 # Otherwise, we return a white color.
21 return system.gui.color("white")
v
[+].4 Apply Cancel
Python - Table Row Color
# For each cell, we check the value of the cell in the sane row but in Installations.

el se:

if self.data.getValueAt(row, "Installations") < 30:
# If the value is less than 30, we return a light grey color.
return systemgui.color("lightgrey")

# Ctherwise, we return a white color.
return system gui.col or("white")

5. We should see the script run automatically, and the background color of the table will change.
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Example - Power Table Component

The Power Table component has several extension functions on it that change the way the table looks or behaves. One in particular, called o
nPopupTri gger (), makes it easy to implement a right click popup menu as it is called each time a user right clicks on a cell of the table. It
can be used in conjunction with the syst em gui . cr eat ePopupMenu function to create your own custom popup menu, as shown in the
following example.

1. Drag a Power Table component on to your Designer workspace and set the Test Data property to 'true’ so you have some data to
test on.

2. With the Power Table selected, click Scripting, and then click on the onPopupTrigger extension function.

3. Select the Enabled checkbox.

4. The onPopupTrigger extension function will have a pre-built example commented out in the extension function. Uncomment the
lines of code to see it in action.

&% Component Scripting [Power Table] - o X
<[ Enabled
[ — S — 2 8 :
{ IntColumn | FloatColumn | stringColu..  Boolean Col.. | Date Column | | def onPopupTrigger(self, rowIndex, collndex, coltame, value, event) "
b 3u UBT TUBIRAZT Jorrza, 2oty = 2.
| » @ propertychange 3 Called when the user right-clicks on a table cell. This would be the
| 7 03 | D62954%0 Jun24, 2019 . 1 @ Extension Functions a4 appropriate time to create and display a popup menu
1 29 0.65 AEB6189F Jun 24,2019 . 1 /5 configureCell 5
| " e 6 Arguments:
| 2% 026 | ASFOAFOR Jun 22,2019 ey : :z:gg:::‘:;;rsme 7 et A reference o the component that is invoking this function
| 43 06 S96BSEE7 Jun24,2019..  inftalise TonIndex: Index of the row, starting at @, relative to the underlying
| ] 9 dataset
| “ 08 | DD fn2a,2019.. |} S+ isCellecitable 10 collndex: Index of the column starting at @, relative to the
! 67 015  F74BEDFS Jun24,2019... | £+ onCellEdited " underlying dataset
| 3 065 EFSDTFE Jun24,2019... ! /¥ onMousePress 2 colliame: Name of the colum in the underlying dataset
f+ onMouseRelease 13 value: The value at the location clicked on
£+ onMouseClick 14 event: The MouseEvent object that caused this popup trigger event
/+ onDoubleClick 5
6 # g 3 e
7+ onowspropped 17 def sayello(evt, cellValue=value)
- 18 import system
& Custom Methods 19 system. qui.messageBox( Hello, you clicked on % '%cellvalue)
+ 20 menu = system.gui.createPopupMenu({'Hello" :sayHello})
21 menu.showfevent) .
< 5

oK || Apply || Cancel

Python - Power Table Popup Trigger

inmport system
def sayHel | o(evt, cell Val ue=val ue):
import system
system gui . messageBox(' Hel | o, you clicked on %' %el | Val ue)
menu = system gui.creat ePopupMenu({' Hel | o' : sayHel | o})
menu. show( event)

5. Right click on a cell in the table and a "Hello" menu option will have a message box appear that has the value of the cell that was
right clicked.
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Example - Ad Hoc Charting

The Easy Chart component has an Extension Function to allow scripting when a Tag is dropped onto it (see Ad Hoc Charting). There is a lot
of customization possible in the Designer, but any client side changes to the Tag Pens dataset must be done here. Generally, people want to
change what axis and subplot a pen goes into based on some other information. Below is a simple example that uses the Tag's name to

determine this. For this example to work, you need to have two subplots and a second axis named "HOA".
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Python - Drop Tags on Easy Chart

# Alter chart configuration when dropping pens
# sanple data for the Tag Pens property:

#"NAME", " TAG_PATH', " AGGREGATI ON_MODE", " AXI S", " SUBPLOT", " ENABLED", " COLOR", " DASH_PATTERN', " RENDER_STYLE", "
LI NE_VEI GHT", " SHAPE", " FI LL_SHAPE", " LABELS", " GROUP_NAME", " DI G TAL", " OVERRI DE_AUTOCOLOR', " HI DDEN', "

USER_SELECTABLE", " SORT_ORDER", " USER_REMOVABLE"

#"HOA", "[ ~] Mot ors/ Mbtor 1/ HOA", "M nMax", "HOA","2","true", "col or (85, 255, 85, 255) ", """, "1","

false","","false","fal se","fal se","true",,"true"

# get ol d pen data and append new info

1.0","0", "true","



ol dData = system dat aset .t oPyDat aSet (sel f.tagPens)
# get new info
for full TagPath in paths:

# get names for everything in the tag path

| ast Sl ashl ndex = full TagPath.rfind("/")

cl oseBracket I ndex = full TagPath.find("]")

tagName = full TagPat h[ | ast Sl ashl ndex+1:]

tagPath = full TagPat h[ cl oseBracket | ndex+1:]

groupNane = ful |l TagPat h[ cl oseBr acket | ndex+1: | ast Sl ashl ndex]

# find which tags are nanmed "hoa" and put themin the HOA subpl ot.

if tagName. | ower () == "hoa":
axis = "HOA"
subplot = 2
digital = "true"
el se:
axis = "Default Axis"
subplot =1
col or = "col or (85, 85, 255, 255) " #bl ue
digital = "fal se"

# append to the old pen data
newDat a = system dat aset. addRow ol dDat a, [tagNane,tagPath,"M nMax", axi s, subplot,"true",color,"","
1","1.0","0","true","fal se", groupNane, digital,"fal se","fal se","true","","true"])

# push new pens back to the tagPens property

col or = "col or (255, 85, 85,255)" #red
sel f.tagPens = newDat a



Custom Component Methods

Custom Methods

Custom Methods function much like Project Library in that you write a script and call it from
somewhere else. However, Custom Methods are written on a component instead of a separate
scripting section, and are also automatically passed the value of sel f , just like an Extension
Function. The sel f object provides the script with easy access to everything within the window. In
addition to sel f , Parameters can be added that you can use to pass in other objects into your
Custom Method.

On this page

® Custom Methods
® Sample Custom
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3 Component Scripting [Label] - o x
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oK || apply Cancel

Component
Custom Methods

Watch the Video

Custom Methods can then be called from the same component or from other components. Custom Methods are called just like any other
method on a component: . met hodNane() . So if | had a custom method on a text field, and | wanted to call it from the actionPerformed
event on a button in the same container, | would use:

Python - Custom Method

# The nane of the customnethod in this instance is nyCustom\et hod.
event . sour ce. par ent . get Conponent (" Text Fi el d"). myCust omVet hod()

Templates are another good use for custom methods. By addng a custom method directly to a template, all the components that make up
the template can call the custom method from the template itself. Another advantage of templates is, in the event you want to share your
template with another project, your custom methods (scripts) would not have to be exported separately like they would as if they were in a
Script Library. When you export the template, the custom methods are included in the export automatically.

Sample Custom Method

A great use for Custom Methods is checking for valid input on a form with a lot of text fields. Instead of checking every text field all within a
script on a button press, we can instead build a value check script on each text field that is unique to that Text Field's specific type of input.
This keeps each script organized on the appropriate Text Field component. Take this sample code that can go into a custom method on a
text field which checks for a valid email address using :

Python - Text Field Input Validation

# First, we need to inport the Regular Expression library
inmport re

# We need to grab the value of the text field.
text = self.text

val i dAddress = re.conpile(r"(~[a-zA-Z0-9_. +-]+@a-zA-Z0-9-]1+\.[a-zA-Z0-9-.]+%)")

# Here, we put together our regular expression for enmil addresses.
# Check the text against the regul ar expression. :
# |If the text does not fit in with the regular expression, it returns a value of None, which we use to i
i show an error box. :
! if validAddress. mtch(text) is None: !
i system gui . errorBox("Pl ease enter a vaild enmanil address!", "Enmmil Not Valid") i
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A similar script can be repeated for each Text Field component, but modified to fit the expected input. Then, the another script can be on a
button that simply calls each of the Text Field's Custom Methods.

Python - Validate Input on Button Press

i event.source. parent.get Conponent ("Emai | Field").validlnput Check()



Focus Manipulation

Focus Order _
On this page
How components are laid out on a window determines the focus order. When tabbing through
components on a window, the focus moves from left to right, then top to bottom. Focus will then
cycle back to the first component. When determining order, the top left corner of the component is
used. To see for yourself, drag several components into your window. Go to Preview Mode, and

tab through the components. ® Focus Order
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Requesting Focus in the Window

You can programmatically request that focus be given to a component by calling the function r equest Focus! nW ndow() on that function.
This function is called on a component and will pull the focus to that component so it is selected and ready to use. It is best used with an
input component, such as a Text Field, so the user can immediately begin typing into the component. You can use it on the i nt er nal Fr ane
Act i vat ed event to bring focus to the component right when the window opens.

@3 Companent Scripting [Test] - m} *®
W Event Handlers ¢ [] Navigation W% SetTagValue == SQLUpdate [= SetProperty | [ Script Editor
~ @ internalFrame > - - - - -
1 system.gui.getParentWindow(event) .getComponentFoxPath( 'Root Container. Text Field').requestFocusInWindow() |~ | &=
internalFrameClosed »

internalFrameClosing
internalFrameDeactivated
internalFrameOpened
b i propertyChange
b i visionWindow
W Custom Methods
+

The getComponetForPath Function

The example above references the function getComponentForPath. This function can be called from a window object, and allows you to
specify the full path to a component inside of the window as a single string, using the following format:

: Pseudocode - Get Component For Path
i get Conponent For Pat h(' Root Cont ai ner. Conponent Nare' )

When referencing a component from a window event handler, such as internalFrameActivated, clicking the Property Reference =l icon will
use the getComponentForPath function. While this function is useful, you never have to use the getComponentForPath function. Instead you
can use the component paths that are seen from event handlers on other components. Below is a comparison of using both
getComponentForPath, as well as the more traditional

Pseudocode - Component Hierarchy from a Window

# Both lines belowwll return a reference to the root container in the window that this script
originates from



print system gui.get Parent Wndow event) . get Conponent For Pat h(' Root Contai ner')
print system gui.getParent Wndow event). get Root Cont ai ner ()

# These lines will both reference the text property on a Label that is nested in a G oup on the w ndow.

print system gui.get Parent Wndow event) . get Conponent For Pat h(' Root Cont ai ner. G oup. Label ') . t ext
print system gui.get Parent Wndow event) . get Root Cont ai ner (). get Conponent (' Group' ). get Conponent (' Label ') .
text

Python - Requesting Focus on Frame Activation

. system gui . get Par ent W ndow( event ) . get Conponent For Pat h(' Root Cont ai ner. Text Field').requestFocusl nW ndow()

Controlling Focus Between Components in a Window

In some cases, you may wish to control which component gains focus when the user clicks on a different component, or tabs away, instead
of using the default focus order. You can call r equest Focus| nW ndow() from the focusLost event to control which component should
gain focus next.

%3 Component Scripting [Text Field] - O X

@ EventHandlers ¢ [ Navigation % SetTagValue &= SQLUpdate [ SetProperty | B Script Editor

7~ forus ’ 1 t t.getC t('Text Field' tF InWind
focusGained event.source.parent.getComponent( ' Tex ie ) . requestFocusInWindow() =
»
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mouseMotion
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ustom Methods

.-' - ow W v_
nInEE

+ n

However, calling r equest Focus| nW ndow() may cause some irregular behavior as shown below. Notice below how the "second" and
"third" Text Fields both have a text cursor in the component, but the "first" text field has focus. This is because r equest Focusl nW ndow() i
s being called on the focusLost event, which runs when one of our components loses focus. This means that while focus is being pulled to
one component (the "second" Text Field), our script changes focus again to a different component.
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The solution to the problem above is to have the r equest Focusl nW ndow( ) call occur as the last part of the event trigger. This can be
accomplished in one of two ways: using Invoke Later under Advanced Settings, or the invokeLater() system function.

About Invoke Later

The concept of invoking some code later leads to a broader discussion on event handling and timing, which deviates from the purpose of this
page: focus manipulation. The concept of "Invoke Later" simply means to wait for the current event to finish processing before running our
focusLost script. In the scenario above, clicking from one component to another (or tabbing to a different component) natively calls a focus
change event. A script on the focusLost event handler that uses requestFocusinWindow will also cause a focus change event, except it does
so mid-execution of the native focus change event.



The main issue then is that focus is being moved to two components simultaneously from within the same event stack. The solution then is to
have them occur in sequential order instead, with our custom focusLost script occuring last, hence using Invoke Later.

Running a script with one of the invoke later approaches mentioned here is not required on most scripts in Ignition, but it is common when
the script is attempting to set or interact with focus on a window. On a related matter, invoking a script later is not the same as adding a delay
mid execution.

To resolve the focus manipulation issue mentioned above, we can take one of two approaches:

Script Editor Advanced Settings

The simplest approach would be to use the Invoke Later option under Advanced Settings in the Script Editor.

%9 Component Scripting [Text Field] - O X
W Event Handlers ¢ [ Navigation % SetTagValue &= SQLUpdate [=] SetProperty | & Script Editor
- @ focus »

v : [ 1 [ e
focusGained 1 event.source.parent.getComponent('Text Field').requestFocusInWindow() =

 focuslest* >
b key
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@ Custom Methods
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had the input focus lost it to another v L v
0K Apply Cancel

Using the invokeLater System Function
Alternatively, we could address this by using system.util.invokeLater to request focus at the end of the event.

Python - Requesting Focus Later

# Create a function for invokeLater that requests focus.
def focus(): i
event. sour ce. parent . get Conponent (' Text Field').request Focusl nW ndow() :

# Call the function once the event has executed.
systemutil.invokeLater (focus)

Text Areas and Focus Requests

Text Area components are slightly more complex when it comes to focus requests. Calling r equest Focus| nW ndow( ) directly on the
component will not allow the user to immediately start typing into the component. However, we can accomplish this by calling get Vi ewport ()
, and then calling get Vi ew() first as shown in the code below.
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Python - Requesting Focus from a Text Area

# Create a reference to the Text Area. This step could be skipped and conbined with the line bel ow, but !
is segregated in this exanple for clarity. :
text Area = event.source. parent. get Conponent (' Text Area') :

# This line denpbnstrates how to request focus on a Text Area
t ext Area. get Vi ewport (). getView().request Focusl nW ndow( )



Client Event Scripts

Client Event Scripts Overview

Client Event Scripts execute in the running Client, which means that they may never execute if no
clients are running, or they may execute many times if multiple clients are running. Client Event
Scripts will also execute in the Designer, but only in Preview Mode. Because Clients are full-
fledged applications, Client Event Scripts run on the computer running the Client, not on the
Gateway's host server computer. This means that they don't have access to the Gateway's file
system, and so on.

Note: System functions are available for both Client Event Scripts and Gateway Event Scripts,
but some system functions are specific to either one or the other. When you're writing event
scripts, it's important to remember the scope of where you writing the script: Client or Gateway.
You can check Scripting Functions in the Appendix to see list of all system functions, their
descriptions, and what scope they run in.

[Z Client Event Scripts — [m] X
Client Event Scripts Client Startup Script
(& Startup Project startup script that runs in each Client
(& shutdown

(& Shutdown-Intercept 1 i
Keystroke

Timer

(& Tag Change

[1 Menubar

8 Message

E Apply Cancel

Startup Script

These trigger when the user logs into the client. These scripts trigger before any windows in the project are opened, so they are ideal to use

when you need to dynamically open certain windows based on which user logged on.

Configurations for Client Event Startup Scripts are similar to Gateway Event Startup scripts. See the Gateway Event Scripts page for more

information

Shutdown Script

These trigger when the user closes the client, or logs out.
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Configurations for Client Event Shutdown Scripts are similar to Gateway Event Shutdown scripts. See the Gateway Event Scripts page for
more information

Shutdown-Intercept Script

The Shutdown-Intercept Script is unique in that it runs when a user attempts to shutdown a client, but before actual shutdown occurs. The
main reason to use a Shutdown-Intercept script is to prevent the client from closing.

Preventing Client Shutdown

There is a special property on the event object inside the Shutdown-Intercept script that can be used to prevent the client from closing:
simply type "event.cancel = 1." somewhere in your code. Doing this will cancel the shutdown event and leave the client open. This allows you
to set special restrictions in regard to when the client is actually allowed to shut down, such as having a certain role, as seen in the example
below:

Python - Cancel Application Exit

# Check to see if the user has a certain role.

if "SuperUser" not in systemsecurity.getRoles():
# If the role is not present, it will warn the user and cancel the shutdown process.
system gui . war ni ngBox("Only administrators are allowed to shutdown the client.")
event.cancel =1

Keystroke Scripts
The Keystroke Scripts let you create different events that will activate on certain key combinations, @ IN DUC TIV]

allowing you to add keyboard shortcuts to your projects.

I UNIVERSI]
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Client Keystroke Script Interface

d +Add Script - Adds a new keystroke script.
. Delete Script - Deletes the currently selected keystroke script.

i Script Settings - Opens the Choose Keystroke window, allowing you to modify the
keystroke that will trigger the script.

Choose Keystroke Window

The following areas are available on the Choose Keystroke window:

® Modifiers - Additional keys or mouse buttons that must be held to trigger your script.
Modifiers are inclusive, so multiple modifiers must all be held down when the key is typed
to trigger the script.

® Action - Similar to the Key Event Handlers, determines what action must occur to the key
to trigger the script:
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© Pressed means the key was pressed,

© Released means the key was released. When used in conjunction with a
modifier, this action provides the user a means to prevent the script from
happening after the key has already been pressed: if the user releases the
modifier before releasing the key, then the script will not trigger.

© Typed means the user typed a specific character. Selecting this action enabled
the Char field under the key section. This provides an easier way to trigger the
script based on non-standard ascii characters.

® Key- Which key will trigger the script. A dropdown is available when the Action is set to Pr
essed or Released. A Text Field is available if the Action is set to Typed.

Special keys like the Function keys (F1) or ESC key are only available in the pressed and released
actions.

1 Some operating systems reserve certain keys for certain functions, and will capture the
key press or release before it gets sent to the Client. For example, many operating
systems use the TAB key to shift focus to the next field.

Timer Scripts

Run on a timer in the same fashion as their Gateway counterpart, except each instance of the project (i.e., client looking at the project
containing the timer script) has a separate instance of the timer script running. Timer scripts that insert records into a database, or write to a
Tag, are better suited as Gateway Event Scripts, since there will only ever be one running. If there are not any open clients, there will not be
an instances of this script running.

Configurations for Client Event Timer Scripts are similar to Gateway Event Timer scripts. See the Gateway Event Scripts page for more
information

Tag Change Scripts

Monitor one or more Tags, and trigger a script in each instance of the client on Tag change. Unlike the Gateway Tag Change Script, Client
Tag Change Scripts can monitor a Client Tag. Much like Timer Scripts, they only run in each instance of the client, so if there aren't any open
clients, then the script will never execute.

Configurations for Client Event Tag Change Scripts are similar to Gateway Event Tag Change scripts. See the Gateway Event Scripts page
for more information

Menubar Scripts

The Client Menubar Scripts create and control the options available in the menubar of the Client.
As such, these scripts are only available in the Client Scope. By default, a Client will have three
menus: Command, Windows, and Help. The Windows and Help Menu are separate, and
controlled through the project properties, but the Command menu is actually created in the Client
Menubar Scripts.
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Below we see a configured Menu Structure list.

= Client Event Scripts - O 4
p
Client Event Scripts Client Menu Bar
= Startup Configure the menu bar for the Client
[ Shutdown
a Shutdown-Intercept Menu Structure < - Item Properties
v Command E » Name Icon
[E) Keystroke N
) Logout Builtinficens/16/id_card_delete.png 3
& Timer 7 Lock Screen =
(& Tag Change W Exic Tooltip
:
Accelerator Mnemenic Character
$# Message il
-None-| [ @ L
Action Script
1|sy5tem.security.logout{) ~
< >
oK Apply Cancel

Next we see the results of the structure in the client.

bl Controller - Main Window
% Logout
7 LockScreen

o Exit

@ INDUCTIVE
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Menu Bar

Watch the Video

Menubar Script Interface

The user interface on the Menubar script is divided into two sections.

Menu Structure

A tree representing the layout of the menu bar. Items at the root of the tree will appear on the menu bar in the client, and nested items will
appear as subitems in the client. In the image of the Client Event Script above, notice that the Logout, Lock Screen, and Exit items are
children of the Command item. When looking at the image of the menubar in the Client, these three items appear under the Command ltem.
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Because the Menu Structure ultimately impacts the order, the following buttons are available to help sort each item.

Item

IE Add Sibling - Adds a new sibling, or peer item, to the selected item.
E Add Child - Adds a new child to the selected item.

t Move Up and 4 Move Down - Moves the selected item up or down in the list. The order in the list determines the order that
items appear in the menu, so these buttons can be used to group meaningful items together.

[ pelete - Deletes the selected item, removing it from the menu.

Properties

Name - The text on the item in the menu.

Icon - What image should appear next to the item, if any.

Tooltip - Optional property allowing you to specify a tooltip when the user hovers the mouse cursor on top of the item.

Accelerator - Allows you to define a keyboard shortcut that will quickly select the item. Please see the Accelerator section below for
more details.

Mnemonic Character - Allows you to define a character key that will trigger the option when the menu is open. Please see the
Mnemonics section below for more details.

Action Script - The script that will run when the user selects the item. Every item, even those at the root and branches may have a
script defined.

Note: It is uncommon to have a script defined on a branch, as they usually act as a means to list other items.

Accelerators

An accelerator is a key or key combination that can be pressed at any time in the client to initiate that menu item's event. If an accelerator
has been configured for an item, then it will be listed on the menu in the client. Below we see our initial menu bar has been modified with the
accelerator Shift+F1. Now the Lock Screen item may be called anywhere in the client by holding Shift and pressing the F1 key.

Controller - Main Window
Windows  Help

% Logout

ol Exit

1 Lock Screen

Mnemonics

The mnemonic character is a key that can be pressed when the menu is opened. This is functionally similar to an Accelerator, in that it allows
the user to select an item in the menu without clicking on it. However, mnemonics differ in that they only call an item when the menu is open,
and the item is visible on the screen.

Users can identify mnemonics by a character to the right of the comand in the menu. In the image below, we see that the Logout item has
an "L" character. This means the user can now press the "L" key to select the Logout item. However, this will not work unless the menu is
open, so if the user accidentally presses the L key while the menu is closed, the script will not trigger. Notice, how each command also has a
mnemonic character defined for each command.



Wision - Main Window
% Logout L
7 LockScreen

o Exit

Message Scripts

Client Message Handlers are created and called using the same mechanisms as Gateway Event
Scripts. There are two main differences that make Client Message Handlers stand out from
Gateway Message Handlers: they run in the Client, and they have different settings.

[Z Client Event Scripts — O X
client Event Scripts Client Message Handlers g
(& Startup Message handler scripts that run whenever the Client receives a script message
[2 Shutdown
(& shutdown-Intercept _ ¢ th handleMessage (payload): .
| 2 v
[ED Keystroke 3 This message handler will be called each time a message of this
& Timer 4 type is received.
5
Li» Tag Change 6 ATguments:
] Menubar 7 payload: A dictionary that holds the objects passed to this
8 message handler. Retrieve them with a subscript, e.g.
9 myObject = payload['argumentName’]
10
11
4G4 < 5
oK Apply Cancel
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Script Messaging

Watch the Video

Client Message Handler Settings
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Message Handler Settings et

Name

My Message Har‘dled

Threading Enabled
Shared - true
Cancel

Client Message Handlers have the following settings:

® Name - The name of the message handler. Each message handler must have a unique name per project.
®* Threading - Determines the threading for the message handler. Contains the following options:
© Shared - The default way of running a message handler. Will execute the handler on a shared pool of threads in the order
that they are invoked. If too many message handlers are called all at once and they take long periods of time to execute,
there may be delays before each message handler gets to execute.
© Dedicated - The message handler will run on its own dedicated thread. This is useful when a message handler will take a
long time to execute, so that it does not hinder the execution of other message handlers. Threads have a bit of overhead, so
this option uses more of the Gateway's resources, but is desirable if you want the message handler to not be impeded by
the execution of other message handlers.
© EDT - This will run the message handler on the Event Dispatch Thread (EDT) which also updates the GUI. If a message
handler were to take a long time to execute, it would block the GUI from running which may lock up your client. This is
helpful when your message handler will be interacting with the GUI in some way, as the GUI will not be able to update until
the message handler finishes.

For more information on Message Handlers, such as working with the Payload argument, or calling them, please see the Gateway Event
Scripts page.

Troubleshooting Client Scripts

The Console is very a important tool in Ignition for troubleshooting Client scripts. You can check to see if your script is working directly from
the Client window, or the Designer while in Preview Mode. Any client scripting errors along with printouts go to the Console. The Console will
identify the script name, error message, what line the script error is in, and a description of the problem.

To access the Console from a Client, go to the menubar and select Help > Diagnostics > Console. To access the Console from Preview
Mode in the Designer, go to the menubar Tools > Console.

Related Topics ...

® Gateway Event Scripts
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Read a Cell from a Table

After data has been populated in a Table or Power Table component, it may be useful to read or
extract a particular cell from the Table, especially if users can select rows in the Table. On this .
page, we'll take a look at how to retrieve information from a particular cell on a Table. On this page

The example on this page utilizes a simple Power Table and Button component. Users select a
row from the table to extract one of the cells from the highlighted row in the Power Table and press
the Sign-In button.

® Power Table
. Example
sign-In ® Selecting a
Single Cell
. . ® Selecting
Mechanic_ID Mechanic_Name Multiple Cells -
1 Waylon Same Column
® Test Your Script
3 Kurt
4 Lewis

Power Table Example

This example provides the code that you can use for selecting a single cell and multiple cells in a Table.

1 Datasets in Tables

Before we get started, it is important to understand that a cell in a Table is actually a cell in a dataset. Data in a Table is stored in a
property on the component (the Data property), and the script needs to interact with that property.

Selecting a Single Cell

Retrieve a single cell requires that we reference the Power Table a couple of times in the same script. Because of this, we can create a
variable that references the table, and use the variable later on. Be aware that a Button and Power Table can be in the same container or
separate containers. If your Button and Power Table are in separate containers your path may differ.

1. Drag a Button and Power Table components to your Designer workspace. Assuming the Power Table has not been renamed, we
can reference the Power Table component with the line of code below as shown in the image below.

%% Component Scripting [Button] - O *
W Event Handlers ¢ [ Navigation % SetTagValue 2= SQLUpdate [Z] SetProperty | B ScriptEditor
~ @ action »

1event.source.parent.getComponent('Power Table') ~ =

b i focus LS
bl key
b @ mouse
» @ mouseMotion
» @ propertyChange
W Custom Methods

Python - Reference the Power Table

# Grab a reference to the Power Table.
tabl e = event. source. parent. get Conponent (' Power Tabl e')




. As mentioned above, if the Button and Table are in separate containers, the path will be different. Double click the Button
component to open the Scripting window, select the action > actionPerformed event handler, and click the Property Reference ic
on El o generate the path to a property, but not the component.

. Next, select a property from the Power Table in the Choose Property window and click OK.

. Remove the ".propertyName" portion at the end of the script in the Script Editor, and click OK.

1 1 1 1 |1CICI 1 1 1 1 |ZCICI 1 1 1 1 |3cm 1 1 1 1 HGG 1 1 1 1 |5cm 1 1 1 1 |GCICI 1 1 1 1 P‘uu 1 1
1 om o $ @
1 e Button ‘@
1T oF# T § ’&
. & c e - O X
o
W Event Handlers ¢ [ Navigation % SetTagValue &= sSQLUpdate [Z] SetProperty I & Script Editorl
~ @ action »
i I 1event.source.parent.getComponent('Power Table') =
> m focus %% Choose Property * %
5_ b B key
iy b il mouse - Power Table -
7 b propertyChange B Enabled (boolean)
E @ Custom Methods W Visible (hoolean)
= + B Font (Font)
g— B Foreground Color (Color)
- B Background Celer (Color)
i B Cursor (int)
il B Data (Dotoset)
- B Selected Column (int)
o B Selected Row (int)
] B CellSpanData (Datoset)  ~
< >
Root Container.Power Table.name | =
= v
1 < “ Cancel >
[im| L — —— |
] + Advanced Settings
il Event Description Event Object Properties

. Next , we simply need to figure out which row contains the cell we want to read from. In our example, the user will select the row for
us, so we simply need to know which row is selected when the Button is pressed. Fortunately, the Power Table contains a Selected

Row property that can be used to determine the row that is selected. Furthermore, we can use the getValueAt() function that is built
into datasets.

Python - Reference the Name of the Column

# Here the "Mechani c_Nanme" argunent

references the name of the col um.

tabl e. dat a. get Val ue(t abl e. sel ect edRow, "Mechani c_Nane")

Python - Reference the Index of the Column

# Here the '1' references the index of the colum in the Power Table's raw dataset (Data
property).

# Renmenber, indexes are zero-based, so this would retrieve the second colum fromthe left.
mechani cName = tabl e. dat a. get Val ueAt (t abl e. sel ect edRow, 1)

. Lastly, we will need to account for scenarios where the user did not selected a row, otherwise, this will throw an exception. An if-
statement can be used here to check for a -1 value on the Power Table's Selected Row property, and an else-clause can be used
to notify the user that a row needs to be selected. Note that there is a property on the Power Table named Selection Mode that
allows users to select multiple rows. By default it is set to only allow a single row to be selected. Change it to test your button.

Here is all the code that you'll need to read a single cell from a Power Table in the same container.

Python - Putting it all Together

# Grab a reference to the table.
tabl e = event. source. parent. get Conponent (' Power Tabl e')

# Make sure the user selected sonething before doing the rest of the work.
if table.selectedRow != -1:

mechani cNarme = tabl e. dat a. get Val ueAt (t abl e. sel ect edRow, "Mechani c_Nane")
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# Do sonething with the nmechani cNanme vari abl e.

i print mechani cName

i else

i print "Please Select a Row "

1 P L T I S T [ n _n [EUEn P I I L P [in

B & &2

b I
Je Sign-In hod

|
AN ]
- Mechanic_ID Mechanic_Name
(IT 1 Waylon
o 2 Monty
] 43 Component Scripting [Button 1] - O *
] W Event Handlers ¢ [ Navigation % SetTagvalue
é_ ~ @ action >
] | E
7 r i focus »
b b key
B b I mouse
= b mouseMotion
ol » i propertyChange
g W Custom Methods
4 +
] EL he user d
ry 12if table.selectedRow -1:
# 13
i 14 mechanicName = table.data.getValueAt(table.selectedRow, "Mechanic_Name"}
H
i
[
] < ?

+ Advanced Settings

8. To test your script, follow the steps in the Test Your Script section.

Selecting Multiple Cells - Same Column

By default, the Power Table allows for multiple rows to be selected. However, the Selected Row property only shows the row index for the
first row selected. Fortunately, the Power Table also has a built-in getSelectedRows() function that can be used to return all of the indices.
We simply need to iterate over each index. Note, we can still use the Power Table's Selected Row property to test if any rows are selected,
but we could instead check the length of the object returned by getSelectedRows():

Here is all the code you'll need to read multiple cells from a Table in the same container. Copy the code in the code block below and replace
the code in previous example to allow for multiple rows to be selected.

Python - Reading Multiple Cells

tabl e

if

for

print

# Grab a reference to the table.
event . sour ce. parent . get Conponent (' Power Tabl e')

index in selectedl ndices:

"Pl ease Select a Row "

sel ect edl ndi ces = tabl e. get Sel ect edRows()

# 1f the length of selectedlndices is greater than O,
I en(sel ectedl ndi ces) > O:

nechani cNane = tabl e. dat a. get Val ueAt (i ndex,

# W can do sonething with the value as we iterate,
# do sonmething with the entire list after the for-loop conpletes.
print nechani cName

then at |east one row is selected.

"Mechani c_Nane")

or append to a list and
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Test Your Script

Now you're ready to test your script whether you are selecting one row or multiple rows.

1. Open the Output Console and select Tools > Console in the menubar.

2. In Preview Mode, select a row in the Power Table, and click the Sign-In button. You will see the selected Mechanic_Name
displayed in the console.

3. To test selecting multiple rows, shift click a couple of rows and press the Sign-In button, and you'll see the selected
Mechanic_Names displayed in the console.

Output Console B X

Mechanic_ID Mechanic_Name * e
1 Waylon Lewis
2 Monty
3 Kurt

E— T

Related Topics ...

® Vision - Table
® Vision - Power Table
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Historian in Vision

The Tag Historian is a powerful system that can easily be set up to store Tag data to a database to
be accessed at a later time. The Vision system has many components that are designed to easily
pull the information out of the database and display it, most commonly in chart format.

The Easy Chart

The most popular Vision component that trends historical data would be the Easy Chart. This
component is simple to initially configure and contains many ways to customize the look and
behavior of the chart. The Easy Chart also features a customizer that enables you to change the
many different settings of the component.

On this page

The Easy Chart
The Classic Chart
The Sparkline Chart
The Status Chart
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The Classic Chart

The Classic Chart pulls in data from the Tag History system and can display it in a variety of ways. While not as simple to get started with as
the Easy Chart, the Classic Chart provides the unique ability to trend data that isn't based on a timestamp, but instead something like a
category.
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The Sparkline Chart

The Sparkline Chart is a simple chart that strives for minimalism rather than many fancy settings. Even with its simplicity, it remains a
powerful tool. For example, the Sparkline Chart works great when used in High Performance HMI environments, where muted colors and
lines are used to help draw the users attention to the places that matter.

h o,

The Status Chart

The Status Chart displays discrete data over a period of time. This provides a great way of displaying status information for various
machines. It can also accept data in both wide and tall format, making it easy to use with any type of stored historical data.

Series3

Series2

Oct15 Oct16 Oct17 Oct18 Oct19 Oct20 Oct21 Oct22 Oct23  Oct 24
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In This Section ...



Using the Vision Easy Chart

Trends Made Easy

The Easy Chart was developed with the Tag Historian system in mind. Once an Easy Chart is INDUCTIV]
created, you can drag and drop historical Tags onto the chart. The chart will immediately retrieve " p
the results and trend the history. Data that is not set up with Tag Historian can also be displayed =4 fe

y p with Tag play 197> UNIVERSI]

on the chart, as long as the data has timestamps associated with the values. For this type of data,
database pens are created and displayed.

Basic Easy Chart

Watch the Video
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Chart Modes

The Easy Chart has a Chart Modes property that changes the behavior of the chart in several ways. The mode is set in the Vision Property
Editor in the Chart Mode Property.

Vision Property Editor o - X
- :
PE 8 | = | = B W -
Common ~
= Behavior
Chart Mode |Hi5torica| v D
Pen Control? Manual &
Pen Control Mode Historical &
Realtime
Auto Apply - G

Historical
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This mode places a Date Range Selector component at the bottom of the chart. This mode allows users to select a start and end date for the
trends. The data density is shown at the bottom of the chart: the more vibrant the color, the higher the density. This the default mode, and
commonly used in situations where users need to look at specific date ranges. It is important to remember that the chart does not poll in this
mode. New values are only added to the chart when the selection box is moved or re-sized.
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Realtime

Displays the most recent data for each pen. Users are able determine how far back in time the trend should display with the Spinner and Drop
down components at the bottom of the chart. In this mode, the chart polls for data at the rate specified by the Poll Rate property.

In some cases, you may notice that the most recent values on tag pens tend to flat-line, and then 'snap' to a different value. This is generally
due to how often the chart polls versus how often history is being generated. If the chart polls at a 1,000ms rate, but history is only recorded
at a 10,000ms rate, then the chart will extrapolate the last recorded value for 9,000ms. After a new value is recorded, the next poll will return

the latest value, and the flat-line will change position.
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Manual

Similar to the Historical mode in that trends range from two points in time. However, there is not a built-in method for users to change the
data range. Instead, some sort of binding can be applied to the chart's Start Date and End Date property. This mode is generally used in
situations where only certain date ranges should be shown, such as values recorded during the previous day, or shift.
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Pens

Pens on the chart, or each series of data points on the chart, can be customized to take on a number of different styles and colors. There are
three types of pens, and each pen functions in a similar manner. What makes them different is how their data is collected.

® Tag Pens - These pens are driven by the Tag history system. Data from any historical provider can be used, and Tag history from
different databases can be shown on the same chart. These are the type of pens that are created when Tags are dragged onto the
chart. Since the Tag History system is being used, an Aggregation Mode must be selected, and the Tag Path needs to be specified
for each pen.

® Database Pens - These pens are driven by a SQL query, so they are ideal to use when trending Transaction Group data. However,
they can query for data in any connected SQL database, so it is possible to show historical data recorded by other systems on the
Easy Chart.

® Calculated Pens - Pens that derive their data from calculations performed on other pens. Data for calculated pens is not stored
directly into a database, but rather calculated in the runtime based on data from another pen. These type of pens are great for
display running totals, control limits, or specification limits.

") Easy Chart Customizer >
L, Axes Subplots  Dynamic Groups
Name Tag Path Color Preview P
Sine0 [~]Sine/Sine0 s e : '_
Sine [Isine/Sine1 e 0+
Sine2 [~]5ine/Sine2 * & |
e W
Name Y Column Table Color Preview p
RV Tank_Mumber Tank_History _ & T &
e W
Name Function Pen Parameter Color Preview *
sinel Sum RunningSum Sined - @ T
oK Cancel

Pens can be added manually to the chart with the Easy Chart Customizer or added dynamically by modifying the various pens properties
listed under Chart Configuration in the Vision Property Editor. These properties contain the configuration of each type of pen and can make
use of the binding system. Because of this, pen preferences can be saved to a database table and then queried in the runtime with a SQL
binding. Additional adjustments can be made with Cell Update bindings or scripting to create a dynamic-yet-robust chart.
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with a white X next to their name. This exists for creating an a
d hoc chart used with the Tag Browse Tree component. To
remove the ability to delete pens, you must edit the Tag

Pens dataset property. Click on the dataset viewer icon, then
in the last column "User Removable", deselect the checkbox
and click OK.
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Easy Chart Customizer

Aside from the properties on the component, the Easy Chart Customizer allows modifications to be made to the chart. Along with configuring
pens, the customizer can be used to create subplots, new axes, and dynamic groups. Once created, each pen can be assigned to any
available axes or subplots. This way different values can be shown on different plots with an axis that is specific to data at hand.
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Related Topics ...

® Easy Chart Customizer

In This Section ...
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Easy Chart - Axes

Configuring Multiple Axes on an Easy Chart

The Easy Chart supports the use of multiple axes for displaying data from the Tag Historian.

@ This section assumes that Tags and Tag History have been configured

To learn more, go to the Tag and Configuring Tag History pages.
The examples below use OPC Tags from the Programmable Device Simulator driver,
but Memory, Expression, and Query Tags can be used instead.

Now, let’s configure multiple axes on an Easy Chart component.

1. From the Component palette, drag an Easy Chart component to your workspace.

2. Next, drag your Tags over from the Tag Browser onto your Easy Chart. For the example, we used Sine 1 and Sine 4. Sine 1 and
Sine 4 have completely different value ranges. Sine 1 values range between -10 and 10. Sine 4 values range between -100 and 100.
Since both sines are on the same axis, it is hard to see the details of Sine 1 values because Sine 4 is throwing off the axis due to its

wide range of values.
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On this page

® Configuring Multiple
Axes on an Easy
Chart

® Hiding Pens

® Configuring an Easy
Chart using the
Symbol Axis

@ INDUCTIV]

UNIVERSIT

Easy Chart - Axes

Watch the Video

3. You have the option of putting Tags into different axes. You can do that in the Customizer of the Easy Chart component. Right click
on the Easy Chart component and choose Customizers > Easy Chart Customizer.
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Customizers » / EasyChart Customizer
Scripting...
Security

Translations
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Run Diagnostics

Click on the Axes tab. You'll notice that there is already one axis showing called Default Axis, which both Tags are sharing.

|4| Easy Chart Customizer X
~ Pens | Axes [ Subplots [ Dynamic Groups =2
Name Label AutoRange Lower Bound Upper Bound +
Default Axis Value 0.0 100.0 )

,

[

< >
0K Cancel

To add an axis, click on the Add + icon.

. The Edit Axis window is displayed. Assign the Axis a name. In this example, it's the name of the Tag that is being used.
. Enter a Label name, which is a name that you want users to see on your chart.

. Select the Type of axis from the dropdown: Numeric, Logarithmic or Symbol. This example uses the default, Numeric.
. If desired, select the Label, Tick Label and Tick Color that you want to set for your axis.

The Position property determines which side of the chart the Axis should be drawn on. By default, this property is disabled because
the Easy Chart automatically attempts to position each Axis. To manually determine the position of an Axis, locate the Auto Axis
Positioning property in the Property Editor of the Easy Chart component, and set it to 'False'.

By default, the Auto Range is set to 'true' and will apply padding so the pens do not draw at the top and bottom of the axis. Instead
of having the Easy Chart automatically determine the range, Auto Range could be set to ‘false’, in which case the Lower Bound and
Upper Bound properties will determine the full range of the axis.



Edit Axis X
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Auto Range 2 True
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10. Now, you have two axes: Default Axis and Sine 4 axis.

Easy Chart Customizer X

~ Pens | Axes £ Subplots B Dynamic Groups
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Default Axis Value v} 0.0 100.0
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0K Cancel

11. Once a new axis has been created, you need to assign a pen to the axis. Select the Pens tab, select the pen row you want to

change, and click the Edit 4 icon . This example uses the 'Sine 4' pen. In the Axis field, select the ‘Sine 4’ axis from the
dropdown menu, and click OK to save the pen.
12. Click OK again to close the Easy Chart Customizer.
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13. You'll notice that each pen is now in a different axis: Sine 1 is in the Default Axis, and Sine 4 is in the Sine 4 axis. On the right side,
you can see Sine 4 axis and its values. On the left side, you can see the Default Axis (Sine 1) axis and its values. Now, you are
using a different axes for each pen, and one pen is not going to throw off the values for the other pen.
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Hiding Pens

You can also hide or turn off pens so they are not displayed on the Easy Chart. To only see values for the Sine 1 axis, go to Preview Mode, u
ncheck the Sine 4 pen, and click Apply. To see the values for only the Sine 4 axis, check the Sine 4 pen, uncheck the Sine 1 pen, and click
Apply. Also important to note, auto positioning on the Easy Chart will automatically move the axis should pens assigned to an axis be
removed.
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Configuring an Easy Chart using the Symbol Axis

Another feature of the Easy Chart is the use of the Symbol Axis type. Instead of showing numerical values on the axis, the Symbol Axis
type can show plain text on the axis.

The second subplot in this Easy Chart uses a Multi-State Button component to demonstrate the use of the Symbol Axis type. The Multi-
State Button component is bound to an OPC Tag, and the value of the Tag is stored in the Tag History system. Instead of showing the
numerical values '0,' '1,' and '2," you can use plain text such as 'Hand,' 'Off," and 'Auto." This is helpful to an operator who immediately
knows the state of the equipment instead of having to learn what the numeric values mean.
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1. Click on your Easy Chart component, and select Customizers > Easy Chart Customizer.
2. Click on the Axes tab, then click the Add + icon to add an axis.
3. Enter a Name, we chose 'Axis 2'. Enter a Label, we called 'State'.
4. In the Type field, select 'Symbol' from the dropdown.
5. In the Symbols/Grid Bands field enter '‘Auto,' 'Off,' and 'Hand' separated by commas, and no spaces. (Note: The order of the

symbols when you type them in, will be ascending order on the axis).
. Click OK two times.

o
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Position -
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7. Put the Designer in Preview Mode P
8. Toggle the Multi-State buttons to begin logging data to your Easy Chart. Data for the Multi-State Button component is collected in the
second subplot which is using the Symbol Axis type. The first subplot is data for another Tag using the Numeric Axis type.
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This Easy Chart example above shows the subplot feature of the Easy Chart component and how easy it is to break up the chart plot
area into multiple distinct subplots sharing the same X axis. It is a good way to display lots of data from different Tags in one Easy

Chart.

Related Topics ...

® Easy Chart Customizer
® Easy Chart - Subplots


https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Easy+Chart+Customizer

Easy Chart - Subplots

@ This section assumes that Tags and Tag History have been configured

Subplot Overview

To learn more, go to the Tag and Configuring Tag History pages.
The examples below use OPC PC Tags from the Programmable Device Simulator
driver, but Memory, Expression, and Query Tags can be used instead.
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D

Easy Chart -
Subplots

The subplot feature of the Easy Chart component allows you to break up the chart plot area into

multiple distinct subplots sharing the X' axis, but they each have their own "Y' axis.
way to display lots of data from different Tags in one Easy Chart.

Itis a good

Watch the Video

By default, the Easy Chart has one subplot which is the main white area. In this example, there are
three Tags inside the chart, yet it's difficult to see the details of the data. It's possible to break up
your Tags into multiple subplots which is often useful for discrete data.
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Configuring Easy Chart Subplots

For each Tag in the Easy Chart example above, let's create its own subplot so the data is easier to view and analyze.

1. Drag an Easy Chart component onto your window.
2.
3. Right click on the Easy Chart component and choose Customizers > Easy Chart Customizer.

Drag three Tags onto the chart. We used Ramp0, Ramp2, and Sinel from Programmable Device Simulator.

The Easy Chart Customizer
window opens displaying four tabs.

. Click on the Subplots tab.

. The Subplots tab lets you add one or more subplots to the Easy Chart. Create two more subplots by clicking the Add + icon two
more times.

The size of each subplot corresponds to the ratio between their "Relative Weight" settings. By default, each subplot is assigned a
weight of 1, meaning each subplot will share an equal percentage of space on the chart. In this example, we set Subplot 1 has a
weight of '2', and Subplots 2 and 3 have a weight of '1'. Subplot 1 is going to be 2 times larger than Subplots 2 and 3.


https://inductiveuniversity.com/video/easy-chart-subplots/8.0
https://legacy-docs.inductiveautomation.com/display/DOC80/Programmable+Device+Simulator
https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Easy+Chart+Customizer
https://legacy-docs.inductiveautomation.com/display/DOC80/Creating+Tags
https://legacy-docs.inductiveautomation.com/display/DOC80/Configuring+Tag+History
https://legacy-docs.inductiveautomation.com/display/DOC80/Creating+Tags
https://legacy-docs.inductiveautomation.com/display/DOC80/Programmable+Device+Simulator
https://legacy-docs.inductiveautomation.com/display/DOC80/Creating+Tags

Easy Chart Customizer X

~ Pens [, Axes | B Subplots | B Dynamic Groups =
Q  subplots allow you to break your chart up into separate plots stacked vertically, each with its own X

set of Y-axes. Their sizes will correspond to the ratio between their "Relative Weight" settings.

Plot # Relative Weight Custom Background? | Background +
2/ 8 | ~ 8
Plot 2 1 > ol "
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7. Now that we have subplots, we'll put each of the different pens into a different subplot. Click on the Pens tab, select the row for the
Ramp0 Pen, and click the Edit s icon. For this example, we chose the following settings:

a. Chose Subplot 1.

b. Set the color to pink.
c. Set the style to Area.
d

. Click OK.
Edit Pen X
- General - Style
e [0 o [ ©
Enabled B true Style Area .
Hidden false
Dash Pattern
User Selectable [ true
Axis Default Axis - Line Weight b
A Shape L] v
Subplot 1~ _
Fill Shape?
Group Name -
Labels
Digital Offset false ,
- Data
Tag Path [~151im_Generic/Ramp/Ramp@ G
Aggregation Mode | Min/Max v

ﬂ Cancel

8. For the Ramp2 pen, we selected the following:

® Subplot: 2
® Color: Blue
® Style: Line w/Gaps

9. For the Sinel pen, we selected the following:

® Subplot: 3
® Color: Red
® Style: Digital



Easy Chart Customizer X

~ Pens [ Axes B Subplots B Dynamic Groups =
MName Tag Path Color Preview Q
Ramp0 [-JRamp/Ramp0 - B
Ramp2 Cramprary: [ >. —— — — | *
psmesnet |
Fa -
Name ¥ Column Table Color Preview
+
F .
Name Function Pen Parameter Color Preview +
7 .
o >
oK Cancel

10. Click OK.
11. Now, you have three distinct subplots on one Easy Chart. You are not limited to the number of subplots on one Easy Chart.
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12. You can be selective about what subplots you want to view. Go to Preview Mode, uncheck the Pens you don't want to see, and
click Apply.



13. Notice how the Ramp2 pen is unchecked and is no longer displayed on the Easy Chart. To add the Ramp2 pen back to the Easy
Chart, check the Ramp2 pen, and click Apply. The Easy Chart only displays subplots that have active Tags.
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Related Topics ...

® Easy Chart Customizer
® Easy Chart - Pen Names and Groups
® Easy Chart - Pen Renderer
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Easy Chart - Pen Names and Groups

G} This section assumes that Tags and Tag History have been configured

To learn more, go to the Tag and Configuring Tag History pages. @
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The examples below use OPC Tags from the Programmable Device Simulator driver,
but Memory, Expression, and Query Tags can be used instead.

Pen Names and Group Overview Easy Chart - Pen

. . Names and Groups
You can organize pens on the Easy Chart by creating custom names and groups for each pen. By

default, when you drag Tags from the Tag Browser on to the Easy Chart component, the pen

name is the same as the Tag name and organized into a single group called ‘Pens.' One of the Watch the Video
great things about pens is you can change pen names and organize pens into different groups

making it easier for the operator to quickly analyze the data.
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Configuring Pen Names and Groups

For each Tag on the Easy Chart, let's create unigue pen names and organize each pen into a group using the Easy Chart Customizer.

1. Right click on the Easy Chart component, and choose Customizers > Easy Chart Customizer.
2. On the Pens tab, we'll edit each of the individual pens and give them a different name as well as put them inside a different group.

a. Select the first pen row, click the Edit s icon, and rename the first Tag from ‘Ramp0’ to ‘R0’ as shown in the following
example.
b. At the bottom of the Edit Pen window, next to Group Name, create a new group called ‘Ramps.’
c. If other groups exist, you can select one from the dropdown list or enter your own. In this example, this is the first group to
be created, so simply type ‘Ramps,’ and press OK.
3. Repeat this step for each Ramp pen assigning each pen a new name.
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. Select the Sine0 pen row, and click the .

. Enter a new group name called 'Sines’.

. Click OK.

. Repeat this steps a and c. to add each Sine pen to the Sines group.

o0 T

4. Next, let's keep the Sine pen names the same as the Tag name, but add them to a group.
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5. Once you have all your pens configured, click OK. Operators will see the Pen and Group names organized into two legends on the
Easy Chart. You can update the pen and group names on this view by double clicking on any of the fields. It's a faster way to edit
this information then having to go to the Edit icon for each pen.
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@ Tip for Viewing Specific Pen Values

To see specific Pen values on the Easy Chart, uncheck the Pen and click the Apply button. To see all Pen values, make
sure all Pens are checked, and hit the Apply button.



Related Topics ...

® Easy Chart Customizer
® Easy Chart - Pen Renderer
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Easy Chart - Pen Renderer

Customizing the Pen Renderer

You can customize the renderer of each pen on the Easy Chart to change its style, shape, weight
and color. When adding Tags to an Easy Chart component, the default renderer or style of each
pen is a simple line, but it can be customized for each pen.
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Easy Chart - Pen
Renderer

Watch the Video

In this example, we will use the Pen Renderer to customize several pens. What's nice is the Easy Chart Customizer allows you to

previewthe style, shape, weight and color. If you don't like it, you can easily change it.

1. Click on the Easy Chart component, and scroll down to Customizers > Easy Chart Customizer.

t

2. From the Pens tab, select the pen row, and click the Edit # icon. Onthe right side of the Edit Pen window under Style, you can
change the line color, style, weight, and shape. The line style, by default, is ‘Line with Gaps,’ which means that if you lose
communication to the PLC or don’t have data for a particular time period, you will see a gap. You can change the Style from ‘Line w/

Gaps' to any other style type listed in the dropdown that fits your needs and preferences.

like. When you're finished, press OK.

Edit each style property. If you don't like the result in the Preview window, select another style. You can edit it as many times as you
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“ Cancel
| R |

4. Repeat steps 2 and 3 to customize the style for all the pens you want to change. When you're finished, press OK.

5. The pens on the Easy Chart now reflect your style changes.
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Related Topics ...

® Easy Chart Customizer


https://legacy-docs.inductiveautomation.com/display/DOC79/Easy+Chart+Customizer

® Easy Chart - Digital Offset



Easy Chart - Digital Offset

Digital pens often share the same subplot on the Easy Chart component. When you have multiple
digital pens on the same Easy Chart subplot, it's hard to see what the values are of each pen .
because they may overlap each other. There is a digital offset pen setting that can be set which On this page
prevents the values from overlapping and enables them to be seen better in the subplot.

The following example shows two digital pens on the same subplot: Statel and State2. The
values are a little difficult to see because they are on top of each other.

® Adding a Digital

Pens

=

300

I 2 Ramp3 53 st 2 Offset
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Watch the Video

Adding a Digital Offset

In this example, we will apply a digital offset on the pen renderer so you can see the values better.

Right click on the Easy Chart component and choose Customizers > Easy Chart Customizer.

On the Pens tab, select the Statel row pen, and click the Edit “ icon.
Set the Style is set to 'Digital’.
Set the Digital Offset to 'true’. Click OK to save the changes to the pen.

PN P
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Easy Chart Customizer X
~ Pens [ Axes B Subplots B Dynamic Groups =
MName Tag Path Color Preview Q

Ramp3 [~]JRamp/Ramp3 v &,
Ploenericandoms | g
I
State2
Edit Pen x | £
- w - General - Style N
1 e[S o [
Name =
Enabled [ true Style I Digital v I
Hidden false Dash Pattern +
- User Selectable £ true ) . =
) - Line Weight 1.5 -5
Name Axis Default Axis -
=~ Shape L] -
Subplot 2= )
: Fill Shape? # 5 v
Group Mame _ - Labels
|Digita| Offset [ true | Preview wm_] peel
- Data
Tag Path [~]1_Generic_/Random/RandomDoublel &
Aggregation Mode | Min/Max -

n Cancel
5. Repeat steps 2-4 for the State2 pen.

6. When you're finished editing your pens, click OK to return to the Easy Chart. You will see a little offset in the values between the
State pens in the 2nd subplot so they don’t overlap each other, making it a lot easier for the operator to read the digital values.
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Related Topics ...

® Easy Chart Customizer
® Easy Chart - Calculated Pens
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Easy Chart - Calculated Pens

Calculated Pens ,
On thispage

@ This section assumes that Tags and Tag History have been configured

To learn more, go to the Tag and Configuring Tag History pages.
The examples below use OPC Tags, but Memory, Expression, and Query Tags could be

used instead. ® Calculated Pens
® Calculated Pen
Functions
Calculated pens display a value that is dynamically calculated based on another pen. This can be ® Configuring
used to calculate certain values for a pen and graph them alongside the original pen values, Calculated Pens
allowing you to gain valuable insight into your data. There are many unique calculations that can ® Hide Driving Pens

be used, with some of them containing unique customization. Almost all of the Calculated pens
require a driving pen, which is a tag or database pen that you have already setup.

@ Note
You cannot bind the Calculated Pen values inside the Easy Chart Customizer. To bind @ INDUCTIV]
the function values, use the Cell Update Binding.
UNIVERSIT

Easy Chart -
Calculated Pens

Watch the Video

Calculated Pen Functions
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There are a variety of functions that can be used to calculate the pen value. The pen functions are located on the Edit Pen screen in the
Function dropdown list. The table below defines the available functions.

7)) Edit Pen ot
General Style
Enabled true Style Line w/ Gaps v
Hidden false Dash Pattern
User Selectable £4 true _ _ -
_ : Line Weight (=
Axis Default Axis -
- Shape v
Subplot 1 .
Fill Shape?
Group Name - Labels
Digital Offset false T I‘“\,/-J- R
Data
| Function v | Driving Pen v
Constant Parameter -
UCL
UwL u Cancel
Avg
LWL
LCL
MovingAvg
Multiply ~
Function Display Description Extra Properties
Name
Constant = Constant A constant value on the chart. Constant Value - The constant value of the pen
Upper UCL The upper control limit of the driving pen, which is three
Control standard deviations above the mean of the Driving Pen.
Limit
Upper UwL The upper warning limit of the driving pen, which is two
Warning standard deviations above the mean of the Driving Pen.
Limit
Average  Avg The average of the driving pen.
Lower LWL The lower warning limit of the driving pen, which is two
Warning standard deviations below the mean of the Driving Pen.
Limit
Lower LCL The lower control limit of the driving pen, which is three
Control standard deviations below the mean of the Driving Pen.
Limit
Moving Moving A series of averages based on subsets of the driving pen. = Window Size - The size of the moving average
Average | Avg The subsets are determined by the window size. window, specified as a multiplier of the chart's date

Multiply

Multiply  Multiply each data point of the driving pen by a factor.

range.

Factor - The factor that each data point of the driving



Pen pen is multiplied by.

Minimum = Min The minimum value of the driving pen.
Value
Maximum = Max The maximum value of the driving pen.
Value

Running  Running | A running sum or running total of the driving pen.
Sum Sum

Sum Sum The sum of two different driving pens.

Difference Differen = The difference of two separate driving pens.

ce
Linear LinearR = Will create a linear regression line for the driving pen.
Regressi = egression

on

Configuring Calculated Pens

In this example, we will configure the following calculated pens on our Easy Chart: Constant, Moving Average, Upper Control Limit (UCL),

and Lower Control Limit (UCL).

. Drag an Easy Chart component onto your Designer window.

. Drag a Tag onto the chart. In this example, we are using a 'Realistic1' tag from Programmable Device Simulator.

1

2

3. Right click on the Easy Chart component and choose Customizers > Easy Chart Customizer.
4

. The Pens tab will open and you'll notice a Calculated Pens Table at the bottom of the screen. Click the Add + icon.

Secondary Pen - The second driving pen.

Secondary Pen - The second driving pen.

|4| Easy Chart Customizer

I L. Axes B Subplots B Dynamic Groups

0K

Mame Tag Path Color Preview

Realistict [~]Realistic/Realisticl _ &, T

F .
Name ¥ Column Table Color Preview
.
Name Function Pen Parameter Color Preview

*

=[]

Cancel

-~

G} Pens

Calculated pens are just like other pens, so you can specify the style, color, axis and subplot in the Edit Pen window.

5. This will open the Edit Pen window. Set the calculated pen options as follows:

® Name: High SP

® Driving Pen: Realisticl (Since we only have one tag on our Easy Chart, the Realisticl tag is the default).

® Function field: Constant
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® Constant Value: 25

6. Click OK.
71 Edit Pen X
- General - Style
wme [Fighs? coor N >
Enabled 2 true Style Line w/ Gaps v
Hidden false Dash Pattern
User Selectable [ true _ _ —
Line Weight 1~
Axis Default Axis *
Shape m -
Subplot 1 : _
Fill Shape?
Group Name - Labels
Digital Offset false B I\ \/\_\/\_/I
- Data
Function | Constant + | Driving Pen v
Constant Value 25 :
ﬂ Cancel

7. Click OK again to save your pen options. Now, view your High SP pen on your Easy Chart. The High SP value of 25 is represented
on your Easy Chart by a blue horizontal line.
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8. Next, let's add a second calculated pen. Double click on the Easy Chart to open the Style Customizer. On the Calculated Pens

Table at the bottom of the screen. Click the Add + icon.

9. On the Edit Pen window, set the calculated pen options as follows:
® Name: MovingAvg



® Function field: MovingAvg
® Driving Pen: Realisticl
®* Window Size: .2

1 If you have more Tags that you dragged on to your Easy Chart from the Tag Browser, you'll have more pens to
choose from in the Driving Pen dropdown list.

Edit Pen *
- General - Style
Mame MovingAvg Color _ -
Enabled B true Style Line w/ Gaps v
Hidden false

Dash Pattern
User Selectable [ true

_ : Line Weight 1 :
Axis Default Axis -
Shape L v
Subplot 1 : _
Fill Shape?
Group Name - Labels
Digital Offset false T W
- Data
Function | MovingAvg + | Driving Pen | Realisticl v
Window Size 0.2 :

ﬂ Cancel

10. Click OK. The chart now displays a running average.

Pens 50
B 3 High sP H
W [ MovingAvg “1 ! ['l I ﬁl
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11. Lets add two more calculated pens: one for Upper Control Limit (UCL) and another for Lower Control Limit (LCL), and set the

Driving Property to 'Realisticl." Select a pen color to change the default color.

Edit Pen ® Edit Pen x
General Style General Style
Name ucL Color Name LCL Color
Enabled [ true Style Line w/ Gaps v Enabled true Style Line w/ Gaps v
Hidden — false Dash Pattern Hidden — false Dash Pattern
User Selectable 3 true . X =~ User Selectable £ true =
Line Weight 1 Line Weight =
Axis Default Axis - Axis Default Axis A
Shape L] - Shape L] v
Subplot = Subplot =
¥ Fill shape? Fill Shape?
Group Name - Labels Group Name - Labels
Digital Offset false e .'. Digital Offset false o= .-
Data Data
FunctionIUCL v I Driving Pen IRea\isticI - I Function | LCL v I Driving PenIReallstm > I
“ Cancel m Cancel

12. Once you add all your calculated pens, you'll see all your pens in the Calculated Pens section at bottom of the window. Press OK.

Easy Chart Customizer X
L. Axes B Subplots F Dynamic Groups =2
Name Tag Path Color Preview Q
Realisticl [~]Realistic/Realisticl _ &
+
F .
Name ¥ Column Table Color Preview Q
+
F
Name Function Pen Parameter Color Preview +
High 5P Constant 25 =
MovingAvg MovingAvg Realisticl 0.2 e 4
UcL ucL Realistic1 = =
LCL LCL Realistic1 =
o >
oK Cancel

13. Now, all your calculations are displayed on your Easy Chart. The blue pen is the Constant, the pink pen is the Moving Average, and

UCL and LCL are brown and green respectively.
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Hide Driving Pens

Once you have your Calculated Pens created, you'll notice that they disappear if you disable the pen driving them. If you want to remove the
Driving Pen but leave the Calculated Pens, set the Hidden property of the Driving Pen to ‘true'.

Edit Pen e
General Style
Name [uey coor | <
Enabled £ true Style Line w/ Gaps v
Hidden t_‘ frue Dash Pattern
User Selectable [ true _ _ -
Line Weight 1~
Axis Default Axis v
Shape m r
Subplot 1 : _
Fill Shape?
Group Name v Labels
Digital Offset false Preview I\M
Data
Function | UCL + | Driving Pen | Realisticl A




Related Topics ...

® Easy Chart Customizer
® Ad Hoc Charting
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Ad Hoc Charting

Using Ad Hoc Charting

In Designer, you can use a special built-in component called the Tag Browse Tree to create Ad
Hoc Charts where you can pick and choose which pens you want to put on an Easy Chart. This
same functionality is also available for an operator in the Runtime.

1.

oo r

In Designer, drag a Tag Browse Tree component and Easy Chart component from the

component palette to your workspace.

. Put the Designer in Preview Mode .
. Expand the Tag folders to see the Tags in your system. By default, the Tag Browser Tree

component shows you all Tags even those Tags that are not logged in Historian.
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Put the Designer back in Design mode .

Select the Tag Browse Tree component.

In the Property Editor, set the following properties:

a. SetInclude Realtime Tags to false.
b. Set Include Historical Tags to true.
c. Setthe Selection Mode to Multiple - Discontiguous.

@ INDUCTIV]I
UNIVERSI]

Ad Hoc Charting

Watch the Video
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Vision Property Editor a - X
=] ==t el %
Border Other Border * Qe
Data Quality 600 &2
Font Dialog, Plain, 12 -
Include Historical Tags (=]
Include Realtime Tags (=}
Mouseover Text e
Name Tag Browse Tree L]
Quality e
Root Node Path (-]
Selected Paths Dataset [1Rx 1C] [E e
Multiple - Discontiguous ~ + &3
Show Root Handles Single Selection G
Show Root Node Multiple - Contiguous oy
Tag Tree Mode IMuItipIe-Discontiguous Ic—:)
Visible 2 true (==

7. Save your project.

©

Launch a Vision Project or put the Designer in Preview Mode .’
Drag some tags over onto the chart. We chose Sine0, Sine2, Sine4, and Sine6. Note that

because we previously set selection mode to Multiple - Discontiguous, we can choose
several Tags using Shift-Click. The Tags don't have to be contiguous within the Tag

browser.
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10. You can click the Delete P icon to the right of any of the pens to remove a Tag from the
chart. You can also remove all pens and go back to an empty chart, and pick and choose



which of the Tags you want to drag on to the chart.
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(D Notes: Things to keep in mind when working with Ad Hoc Charting

® When working in the Designer, whatever pens you have on your Easy Chart
when you saved your project, the same pens will also be displayed on the chart
when the client is opened.

® You may have multiple axes set up for your Easy Chart, but when dragging
Tags from the Tag Browse Tree component to an Easy Chart, there is no way
for the user to set which axis to use. Because of this limitation, any Tag that is
added in this way will attempt to match their Engineering Units property to an
axis on the chart. If no match is found, the default axis will be used.

Related Topics ...

® |ndirect Easy Chart



Indirect Easy Chart

Configuring an Indirect Easy Chart

@ This section assumes that Tags and Tag History have been configured

To learn more, go to the Tag and Configuring Tag History pages.
The examples below use OPC Tags, but Memory, Expression, and Query Tags can be
used instead.

It is possible for the Easy Chart component to be indirect and point to a set of Historical Tags
based on any parameter using the Cell Update Binding type. In this example, suppose you have a
small tank farm consisting of Tank 101 through Tank 109. Every tank is identical and uses the
same Tags. Each tank has a Level Tag and Temperature Tag which are set to log to the
Historian.

Tag Browser o - X
Q o ¥-8 06| 006 B
* % Tank 101 Tank UDT Tank_... ~

» W Parameters Docu...

» % Alarm_Status OPC 0 Short | &

» % Batch_ID Me String | D

» % Date_1 M y DateT...

» % Date _2 Memory DateT...

» % Enable_Cooling OPC Boole...

» % Enable_Heating OFC Boole...

b % HC_Allowed OFC 3 Short
58.0 Float |

b % Mode OFC 1 Integer D

b % Notes Memory String

» % Number OPC 1 Short

» % Pump_Hand_Speed OPC 0.0 Short (%%

b % Pump_HOA OFC 2 Short | D

» % Pump_Speed OPC 1.0 Short

b % Pump_Status OFC 1 Integer D

» % Setpoint OPC 50.0 Float |® 5%
4956 Float | D &#

On this page

® Configuring an
Indirect Easy Chart

Editor notes are only
visible to logged in users
Put this link in when the
easy chart video is actually
made.

@ INDU
UNIV
Indirect Easy

Chart

Watch the
Video

Using an Indirect Easy Chart is a good way to see the history of these Tags for each tank in the tank farm. An convenient way to set this up
is using a Dropdown List component where an operator can select various tanks to see a Tank's Tag history. This example will show you

how to configure a cell update binding on an Easy Chart to be indirect and point to a set of Historical Tags.

1. In the Designer, drag a Tag Browser Tree and an Easy Chart component into your workspace.

N

Put the Designer in Preview Mode ¥ .

3. Navigate to the Tank Tags in the Tag Browser Tree. Under Tank 101, drag the 'Level' and ‘Temperature' Tags from the Tag

Browse tree onto the Easy Chart.
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4. Put the Designer back in Design Mode .
5. Drag a Dropdown component to your workspace. Using a Dropdown list will make it convenient for the operator to select a Tank
and see the history of the Level and Temperature Tags for that tank.

o
. With the Dropdown component selected, click on the Dataset Viewer E:] icon to the right of the Data property in the Property Editor.

6
=+
7. Click the Add Row == icon for as many Tanks that you have in your Tank Farm. Then enter the Value and Label for each of the
Tanks.
8. Click OK.
Project Browser [= " T T T L T T T T LI
Q- Al
~ g Datasets A1
+ [ Easy Chart ]
+ [] Root Container 7
T[T = Dropdown |
) Easy Chart Y
T= Tag Browse Tree o 14
Vision Property Editor o1 . $_ o
| = I 4 & <SelectOne> | v &
P28 | = | =) Bl % - B o § Dy
E Common u Dataset Editor X
Name Dropdown || 4
s val Label =
Enabled [ true (-] alue abe =
. — - 101 Tank 101
Visible [ true [ L 102 | Tank102 .
Border Other Border ~ [Jjea| 3 103 | Tank103 L
]
Mouseover Text || ] 104 | Tank 104
105 | Tank105 a
Cursor Default v G| | 4 106 | Tank 106 -
& Behavior 1 106 | Tank 107 S
El Data 107 | Tank 108 &
Selected Value -1 €2
S T hd Column Name: — Column Type: —
Selected Label <Select One> G|
Quality i Kl cre
& Appearance

9. Put the Designer in Preview Mode ’
10. Click the Dropdown list to see the complete list of Tanks in your Tank Farm that you just entered.



Tank 104 -

Tank10l
Tank 102
Tank 103
Tank 104
Tank 105
Tank 106
Tank 107
Tank 108 -

11. Put the Designer back in Design Mode .
12. Right click on your Easy Chart and choose to Customizers > Easy Chart Customizer.

You'll notice that the Tag Paths are pointing directly to Tank 101. The only difference between Tank 101 and all the Tanks in the
Tank Farm is the Tank number (i.e., 101, 102, 103, etc.). You can manually point to a different Tag Path by replacing ‘101’ in the
Tag Path with a different Tank number such as ‘102, but we'd rather have the Tag Paths change dynamically when the user selects
a Tank. Press OK.

Easy Chart Custernizer s
~ Pens | Axes B Subplots F Dynamic Groups =
Name Tag Path Color Preview Q
Level [~]Tank/Tank 101/Level _ &,
Temperature [~1Tank/Tank 101/Temperature _ &, N +
g
F . -
Name ¥ Column Table Color Preview Q
+
e
F -
< >
0K Cancel

13. The Easy Chart component has a property called Tag Pens which stores all the configuration information that you have configured

0
in the Easy Chart about your pens. With the Easy Chart selected, click on the Dataset Ba icon in the Property Editor to view all the
information for your Tag Pens.

Vision Property Editor a - X

IERNE: = =S| T~

* Chart Configuration

DB Pens Dataset [OR x 23C] B &
Calculated Pens Dataset [0Rx 21C] BY &

Axes Dataset [1Rx 22C] B &

Fa
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14. The dataset is displayed. It contains one row for each Tag. The second column is the Tag Path that you will want to change
dynamically. Press OK to close the Dataset Viewer.

[T Dataset Editor X
NAME TAG_PATH AGGREGATI..  AXIS SUBPLOT ENABLED COLOR E‘
Level [~1Tank/Tank 101/Level MinMax Default Axis 1 -
Temperature [~]Tank/Tank 101/ Temperature MinMax Default Axis 1 _ e

L]
@
]
< >
Column Name: — Column Type: -
n Cancel

15. Next we'll use a Cell Update Binding in order to change an individual cell of a dataset. With a Cell Update Binding, you can select
one or more cells and dynamically bind them to a property or to a Tag that you have in your system. Click on the Binding == icon
next to Tag Pens property to open the Property Binding window.

16. Select the Cell Update binding type.

17. Select Tag Path cell for Level, and click the Add + icon under the Cell Bindings table.

B Property B X
Tag Cell Update
Tag Binds specific cells inside an existing dataset
Indirect Tag
Tag History @ Use the Cell Update binding to dynamically bind specific cellsinside a dataset to tag or property values. Simply select the X
Property cell you want to bind, and hit the "Plus” button. Rows can be specified explicitly by their index (e.g. "15") or by referencing
another column (e.g. "Name=Compressor")
Expression
Dataset
Property
| soL NAME TAG_PATH A. | A. S. | E. | .
| ~TTank/Tank 101/Level
| Named Query Level AN [EEEEERE
| Tempera.. | [~ITank/Tank 101/Temperat... 1 - 1 1 0
DE Browse
SQL Query
Cell Bindings
| | Other
Row Column Value .
| 0 TAG_PATH
Functions
\
® NoBinding L]

n S

18. Select the first row you just added in the Cell Bindings Table, and click the Insert Property Value @ icon.
19. From the Property Window under the Dropdown folder, click the Selected String Value. This will grab the Tank number the

operator selected from the dropdown list.



20.
. Repeat steps 17 through 20 for the Temperature Tag Path.
22.

23.

24.
25.

B Quality (QualityCode)

= = Dropdown
B Name (String)
W Visible fhoolean)
B Data (Dataser)
W Selected Index (int)
W Selected Value (Integer

Root Container.Dropdown.selectedStringValue

W Selected Label (String)

-

Property Binding: Root Container.Easy Chart *
Tag Cell Update
Tag Binds specific cells inside an existing dataset
Indirect Tag
Tag History Q  use the cell Update binding to dynamically bind specific cellsinside a dataset to tag or property values. Simply select the X
Property cell you want to bind, and hit the "Plus" button. Rows can be specified explicitly by their index (e.g. "15") or by referencing
another column (e.g. "Name=Compressor”)
Expression
Dataset
Property
sqL NAME TAG_PATH A. | A. | 5. | E. | 274 e
o~ - o
Named Query Leve| [~]Tank/Tank 101/Level 1 ] - = =
Temperature [~TTank/Tank 101/Temperature 1| E - | =
DB Browse
SQL Query
Cell Bindings
Other
Row Column Value +
Cell Update
Functions
Choose Property X
~ [] Main Window 9 Indirect A %
=[] Root Container ¥
B Name (String)
@ NoBinding B Visible (boolean) []
B Background Color (Color)
W Styles (Dataset)
W Data Quality (int) Cancel

Click OK. Ignition fills in the Cell Binding value.

Next, expand the Value fields to make the Tag Path dynamic. Update the fields as follows.

Cell Binding to make Tag Path Dynamic

[ ~] Tank/ { Root Cont ai ner. Dropdown. sel ect edStri ngVal ue}/ Tenper ature
[ ~] Tank/ { Root Cont ai ner. Dr opdown. sel ect edStri ngVal ue}/ Level

Click OK to save the bindings.
Now you have an Indirect Easy Chart. To test it, put the Designer in Preview Mode b

Select a Tank from the Dropdown List. The Level and Temperature values will change in the chart. Next select a different Tank from

your Dropdown List to see how the history changes on the Easy Chart.




b % Enable_Heating OFC
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b % Level OFC

¥ % Mode OFC

b % Notes Memory

b % Number OFC

¢ % Pump_Hand_Speed OFC

b % Pump_HOA OFC

b % Pump_Speed OFC

b % Pump_Status OFC

b % Serpoimt OPC

[ 3-8 Temperaure orc |
b % Valve_Cooling Expressior
b % Valve_Heating Expressio
b % Valve_Status OFC

Pens
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B & Temperature 33

Value
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Tank 104 *
Apply
b % Enable_Heating OPC |- — — E
» % HC_Allowed 0PC W (3 Level 32 : &
b % Leval OBC B £ Temperature 332 &5 g
b % Mode OPC v
b % Notes Memory
b % Number OFC &0
» % Pump_Hand Speed OPC g 515
b % Pump HOA OFC = o
» % Pump_Speed OFC
b % Pump_Status OPC 525
b % Setpoint OFC
)-8 Temperaure 07C =
b % Valve_Cooling Expressior 475
b % Valve_Heating Expressio . /

b % Valve_Status OFC
[ »

£*

Tank 107 -

Apply

*
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[Jun 14, 2019]
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Charting - Right Click Menu

When viewed from the client (or the Designer's Preview Mode P’) many
chart components, such as the Easy Chart or Bar Chart, enable users to On this page
right-click and access a menu with additional features. Explanations of
these features are listed below.

(s 1,000 | i [
RO . .

Ao o I | ‘ /& ® Right Click Menu

800 / f .
mE® 3 o /| H Functions
Sines 0 /
EGsine0 33 Lol / f ‘ f ‘
O Esinet 32 2 | [ /
W Esine2 33 | - / / L L |

300 f | Mode »| O zoom / f

a3 / [, | sackground » Pan [ /

100 . i {ale oAb {

o YDA s2veos- wark WA Ww.n
P R VR VRV il VARV R VARV
9:59 AM 10:011 Zoom In 4 10:05 AM 10:07 AM
Zoomout  » 120191
4 ] 614 AutoRange * 4/1910:08 AM e b

=
Reset Axes
900AM  9M5AM  9:30AM  OESAWTTOOUAM  10:15AM  1030AM 1045 AM

Right Click Menu Functions

Note that many of the behaviors listed below may be overridden by a property on the parent component. For example, the Easy Chart
provides a way to define the plot background color with the Easy Chart Customizer, so the Background options on the right-click menu would
not modify the behavior on the component when the user selects them.

Item Description
Name

Mode @ Specifies the functionality of a left-click on the chart. The following modes are available:

Z | Zoom in: Users can left-click and drag on the chart to zoom in or @
o  out. Dragging to the right creates a hollow rectangle. When the user =~ = 5001 F
om releases the mouse button, the viewable space in the chart will E f
zoom in to a rectangle. 400 5 T
300 4
Zoom out: Left-click and dragging to the left will not create a 200 5
rectangle, but releasing the mouse button will zoom back out. 100
14 AN iy ;V A
| | 1A | |
o MM{{ Vil
10:50 AM 10:51 AM 10:52 AM
P | Allows users to Pan the chart horizontally or vertically by left-click
an | and dragging. The Pan mode may be used after using the Zoom
mode: doing so allows panning within the zoomed in view-space.
M | While in Mark mode, a left click will target the closest point on the 700 -
ark nearest pen, and return the value and timestamp of that point.
600 -
500 -
400 A

X- | Similar to Mark, X-Trace will instead show the values of all pens at
Tr | the selected point in time.

ce
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600
500 { :--"'“I--'-l- RO: 55¢
a0l [
300{ /
: Ramps/R1:19.99
200 -
100 ’
ﬂ_//p’ ¥ iflun 14, 2010/} ¥ )/
10:50:40 AM
10:50 AM 10:51 AM 10:52 AM

Back | Allows the user to change the background color. Available options include Black and White.
ground

Save  Provides a Save window that allows the user to save a PNG of the chart locally.
as...

Print... Provides a Print dialog that allows the user to print an image of the chart. This will send the chart to a physical printer. Note: a
printer must be installed on the client computer.

Zoom  Allows the user to Zoom in on the chart. There are three possible options:
In
® All axes: Zooms in on both the Range and Domain.
® Domain axis: Zooms in on just the Domain, or X- axis. Reduces the range of viewable values on the domain (typically a
datetime), while leaving the Range axis untouched.
® Range axis: Zooms in on just the Range, or Y-axis. Reduces the range of viewable values (typically numeric), while leaving
the Domain axis unmodified. This is helpful when a trend shows very little change over a period of time, as this allows the
user to view the trend with increased granularity.

Zoom  Allows the user to Zoom out on the chart. There are three possible options:
Out

® All axes: Zooms out on both the Range and Domain.

® Domain axis: Zooms out on just the Domain, or X- axis.

® Range axis: Zooms out on just the Range, or Y-axis

Auto = Automatically updates the range, or viewable space, on the chart to incorporate all data points. As mentioned above, many
Range components have properties/customizations that restrict the capability of these (such as the date range on on the Easy Chart).

® All axes: Adjusts the viewable space on both axes.
® Domain axis: Adjusts the viewable space on just the Domain, or X-axis.
® Range axis: Adjusts the viewable space on just the Range, or Y-axis.

Reset = Adjusts the Axes back to their initial state.
Axes

Related Topics ...

® Easy Chart Customizer
® Easy Chart - Subplots
® Easy Chart
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Easy Chart - Database Pens

Database Pens _
On this page
Database Pens are driven by a SQL query, so they are ideal to use when trending Transaction
Group data. However, they can query for data in any connected SQL database, so it is possible to
show historical data recorded by other systems on the Easy Chart.

® Database Pens
® Configuring

@ The following example assumes that Tags and Tag History are configured Database Pens

To learn more, go to the Tag and Configuring Tag History pages.
The example below use OPC Tags, but any types of tags can be used instead such as M
emory, Expression, and Query Tags.

Configuring Database Pens

In this example, we'll configure a database pen driven by a SQL query to show historical data and display it on the Easy Chart.

1. Drag an Easy Chart component onto your Vision window.
2. Right click on the Easy Chart component and choose Customizers > Easy Chart Customizer.

3. In the Database Pens section, we'll create a database pen to trend data stored in our database. Click the Add + icon to create the
Database Pen.

| ~ Pens | Axes & Subplots [ Dynamic Groups

Name Tag Path Color Preview Q
f’.
- -
I
| Name ¥ Column Table Color Preview Q

[+

B

=[]

OK Cancel

4. The Edit Pen window will open. Here is where you enter your database pen data. In the very least, we'll need values for the following
properties:

We entered the following settings:

a. Name - The name of the pen on the chart. Works the same as the name on any other pen.

b. Datasource - The name of the database connection (as configured on the gateway) that contains the table we want to
extract values from.

c. Table Name - The name of the database table that contains the values that we want to represent on the chart.This
dropdown will automatically populate with available table names once the Datasource property has a valid database
selected.
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d. Value Column - The name of the column in the database table that contains the values we want to show, representing the
value of the datapoint at a particular time. This column is ultimately responsible for the determining where each point lies on
the chart's Y-axis. This dropdown will automatically populate with column names once a value for the Table Name property
has been set.

e. Time Column - The name of the column in the database table that contains a timestamp, representing the time of the
datapoint. This column is ultimately responsible for determining where each point lies on the chart's X-axis. This dropdown
will automatically populate with column names once a value for the Table Name property has been set.

f. Axis - All pens require an axis. We can use the default here.

Click OK to save your database pen settings.

Edit Pen *
General Style
Enabled [ true Style Line w/ Gaps -
Hidden — false Dash Pattern
User Selectable £ true _ _ N
_ : Line Weight 4

Axis Default Axis v

Shape [ -
Subplot 1 : )

Fill Shape?
Group Mame A Labels
Data
Value Column | Sined » | Table Name | group_table A
Time Column | t_stamp + | Datasource | MySQL - | -~

Where Clause

M. Run Diagnostics

5. In the Database Pens area, you will see your database pen that you created. Click OK to exit the customizer and view your Easy
Chart.

Easy Chart Customizer X
L. Axes B Subplots F Dynamic Groups =
Name Tag Path Color Preview Q

+
s
F -
Name ¥ Column Table Color Preview Q
High Temp Sinel group_table _ 3. N T
+
s
F B b
< >
0K Cancel




6. The High Temp database pen is now trending data for the High Temp values we want to show at a selected time.

Pens
W [ High Temp

50

g
D K

Value

B:10 AM B12 AM B:14 AM B:16 AM B:18 AM
[Apr28, 2020 ]

N 4/28/20 8:09 AM - 4/28/20 8:19 AM| a [y

L v o Ve
7:00 AM 7:30 AM £:00 AM 8:30 AM T
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Using the Classic Chart

Chart

The Chart, sometimes referred to as the Classic Chart, is capable of rendering time series, XY,
and Bar charts.

On this page

Configuration * Chart
® Configuration
The basic idea behind configuring the classic chart is simple: add datasets, and fill them in with * Datasets
data in a format that the chart understands. You add datasets to the chart using the chart's * Binding
customizer. You then use a bindings to populate each dataset. Commonly you'll use a SQL Query Techniques
Binding. Since these datasets are just normal dynamic properties, you can also access them via ¢ Chart Type: XY
scripting. vs Category
® Populating a Chart
The Customizer also lets you add additional X and Y axes. There are various types of axes and with Data
each works slightly differently. Lastly, you can configure additional properties for each dataset, ° E>_<ample - Tag
such as which axis it maps to, its visual style, subplot, etc. History o
® Customizing a
Chart

® Adding a Second
Dataset to a
Chart

Datasets

Each dataset should define one or more "series" (a.k.a "pens"). The expected anatomy of a
dataset for the Classic Chart depends on several settings: namely the Extract Order property on
the chart, as well as the type of renderer specified in the Chart Customizer's Dataset Properties
tab.

Binding Techniques

The Classic Chart can be used to make almost any kind of chart, with some effort. Historical,
realtime, dynamic pen selection, etc., is all possible. Your job is just to fill the datasets with the
pertinent data, and the chart will display it. The most common idea is to make the chart dynamic
by varying the date range that the dataset's SQL Query bindings run. This is easy to do by adding a
Date Range component and using Indirect Bindings.

Chart Type: XY vs Category

The Classic Chart is typically in XY Plot mode. This means that the X-axis is either date or numeric, and the Y-axes are numeric. If your X-
axis is categorical (names, not numbers), you can switch the Chart Type property to Category Chart in the Property Editor. Don't be surprised
when you get a few errors - you'll need to go and switch your X-axis to be a Category Axis, and fill your dataset in with valid category data,
that is, String-based X-values. This is most often used with the Bar Renderer (see the Chart Customizer).
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Vision Property Editor g - X I R L T PO T . T PO TR O .. H1
|ERE S =T 1 % 3 & ____. &
1
- I
¥ Common o | 70 :
- I
Name Chart s i & !
. 7 . &0 r\ ]
Visible true (=1 (I - = W ”|| :
1
Border Other Border v # €2 | |0] | 50 m {\ i
) I
Mouseover Text s - I 45 J ]
4 : w 40 1
Cursor Default ¥ GO 1 % - :
— > 1
~ Behavior ! 30 NJ I
71 @ o
Chart Type XY Plot v & ] ! 25 I
T !
Extract Order By Col v GD i I - :
) I
Subplot Mode Shared Domain v & T 10 :
— 1
Show Tooltips? true &> | 2 :
— 1 0 1
Show Popup? true e 3 ! Jul16  Jul17 Jul18 Jul19 Jul20 Jul21 Jul22  Jul23  Jul 24 I
iy 1
Selection Enabled? false (=] ] i Date :
I
¥ Data 4 ! — Process Temp — Output Temp |
|\ —
Quality s ||| F 3 L’'E
» Appearance % ]

Populating a Chart with Data

Populating the Classic Chart involves using Custom Properties to collect data. New Custom Properties are added to the component via the C
hart Customizer. Multiple dataset properties may be configured on the component, and each additional dataset will show as a new subplot.
Populating the Chart with historical data involves populating one of these Custom Properties.

The default configuration of the component expects a dataset where the first column is a timestamp (the first column always acts as the
domain for the chart), and sequential columns are pens that should be drawn on the chart. The default dataset contains at_stamp column
with values for the domain, and two columns (Process Temp and Output Temp) with values that will be drawn against the range.

(")) Dataset Editor *
t_stamp Process Temp Output Temp =
1046419, 3:15:00... 53 45 |~
10/6/19, 4:15:00... 48 48 +
10/6/19, 5:15:00... 48 53 |l 1
10/6/19, 6:15:00... a0 a0
10/6/19, 7:15:00... 46 46 a
10/6/19, 8:15:00... 49 44 o
1046419, 9:15:00... 52 46 ¥
10/6/19, 10:15:0... 57 48 &
1046419, 11:15%:0.. 59 46
10/6/19,12:15:0... 56 46
10/6/19, 1:15:00... 53 43
10/6/19, 2:15:00... 56 39
1046419, 3:15:00... 61 36 =

Column Name: -— Column Type: —
Lo

Example - Tag History
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The Classic Chart is initially configured in a manner that easily displays Tag History with a Tag History Binding.

1. Drag a Chart component onto a window.

2. In the Vision Property Browser, scroll down to the Data property. It should be located at the bottom of the Property Editor when
sorted by section. Click the Binding 2 icon.

3. Select Tag History from the Tag section of the Binding window.

4. Browse the Available Historical Tags. For this example, we chose some ramp Tags. Drag the Tags over to the Selected
Historical Tags table on the right of the window.

5. Change the Date Range to Realtime with a Most Recent set to 10 minutes.

Property Binding: Root Container.Chart x
Tag Tag History
Tag Queries the tag history system for time-series tag history data
Indirect Tag
Tag History ©Q  Drag and drop historical tags into the selected tag list. You can edit the selected tag paths X
Property and insert indirection parameters like "{1}"
Expression Available Historical Tags < Selected Historical Tags
Property - @ ramp A2 > | tagPath Column Name 1+
s5QL [~]1ramp/ramp@ Tamp@ :
[~]ramp/Tampl Tampl
Named Query > ) ramp/
p/ramp2 Tamp2 +
DE Browse
[~]ramp/ramp3 Tamp3
SQL Query W ramps [~]1ramp/Tampd Tampd Ll
Other W% rampé 5
Cell Update ¥ ramp7
. ]
Functions _ * r..arr?ps
b i realistic Sl Indirection
b il sine
Ref. # Property Path
b i station1 perty
b il station 2 ~
Use fully-qualified paths
Date Range Most Recent
Rea 10 © E | min -
Aggregation Mode Return Format Sample Size
Min/Max v Wide Natural v
Advanced
Polling Mode Polling Rate Retain Rows
@ No Binding O off _ Relative  Absolute Rate = (Base Rate) +/- 0 -3sec false
n Cancel




6. Click the OK button. The Chart will now show Tag History from the Tags you selected.
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80O
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Value
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Date [May 29, 2019]

—ramp0 —rampl —ramp2  ramp3 — ramp4

Note that the timestamp has automatically been included as the first column, so the domain has been automatically configured for you. If you
wish to change the orientation of the axes, use the Chart Orientation property in the Property Editor to swap the position of the Domain and
Range axes.

Customizing a Chart

Once trends are present on the chart, additional customization can be achieved through the Chart Customizer. When you open the
customizer, you'll notice five tabs at the top: Datasets, X-Axes, Y-Axes, Dataset Properties, and Plot Properties. Each tab has its own set of
properties and defaults.

P Chart Customizer *

Datasets  X-Axes Y-Axes  DatasetProperties Plot Properties

<

Axis Visible? true
Axis Label Date
Axis Label Angle

0.0
Axis Label Color 0,00 - &

Axis Label Font SansSerif v |12 | - A A

Tick Labels Visible? true

Tick Label Color 0,00 - @

Tick Label Font Sansserif * |10 |~ AA i
Tick Marks Visible? true

Tick Mark Color 0,00 - @
0

Tick Mark Inside L... .0 v

oK Cancel
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An overview of each section in the Chart Customizer is listed below:

® Datasets: Allows additional datasets to be added to the component. Each dataset will appear as a separate custom property on the
component. Data from multiple charts can be drawn on the same chart.

® X-Axes and Y-Axes: Allows for the creation of new X and Y Axes on the chart. There are six types of axes to choose from when
configuring a chart, each having its own list of properties: Number Axis, Date Axis, Category Axis, Logarithmic Axis, Elapsed Axis,
and Symbols Axis. Most of the X and Y axes properties are used in the customizer, and some properties are specific to the axis type
and have their own unique properties. See the Chart Customizer page for more information on types of axis, associated properties,
and examples.

® Dataset Properties: Specify which axes should a be used with each dataset. Also allows you to specify which subplot each dataset
should be shown on.

® Plot Properties: Configure the look of each plot.

This example walks you through adding a new dataset to a chart, and modifying the existing chart properties using the Chart Customizer.
When you first drag a chart to your window, you'll notice that it will display some data, that's because it's using the default dataset provided.
For this example, you can add a new dataset by either copying and pasting the one below or adding your own.

1. Let's add a new dataset (i.e., SnowPackData) that measures the Snow Pack Level for the month of February. Double click on the
chart to open the Chart Customizer.

2. Go to the Datasets tab and click the Add + icon to add a new dataset.
3. Enter the Dataset name and then click OK.

[ Chart Customizer et

Datasets |X—Mes ¥-Axes  Dataset Properties  Plot Properties

Name Type Description

Data Dataset Default DataSet

Snowpackpas o

o
4. In the Vision Property Editor, click on the Dataset Viewer Bs icon.
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Vision Property Editor o _ XX
BE | % | = | = B | R -

=l Commeon
Name Chart 1 (5]
Visible true G2
Border Other Border » ] D
Mouseover Text (5]
Cursor Default - G

+ Behavior

+ Data

+ Appearance
+| Deprecated
=1 Custom Properties
Data Dataset [200R x 3C] g e

SnowPackData Dataset [0R x 0C] o] 2]

5. Highlight and copy the dataset below, then click the Paste Dataset from Clipboard | icon.

Classic Chart - SnowPack Dataset

" #NAMES' Z
"Date","Current Snow Pack","Normal Snow Pack"
"#TYPES" :
“date","F","F" i
"HRONS', " 4" :
"2018-02-02 10:41:22","2.25","3.75" :
"2018-02-10 10:42:19","3.15","4.5" :
"2018-02-15 10:43:27","2.15","5. 25" |
"2018-02-25 10: 44:02","3.75","6. 35"

6. The data will appear in the Dataset Viewer. Click OK to save the dataset.

(7] Dataset Editor >
Date Current Snow Pack MNormal Snow Pack E"
2/2M8, 10:41:22 AM 2.25 3.75
21018, 10:42:19 AM 315 4.5 o
2518, 10:43:27 AM 215 5.25 I
225M8, 10:44:02 AM 3.75 6.35

e
]
Column Name: —- Column Type: -
oK Cancel

7. The Chart component is now displaying both the default dataset and SnowPackData dataset. Let's disable the default database.
Open the Chart Customizer and go to the Dataset Properties tab.



8. Select the default dataset (i.e., Data) and uncheck the Enabled? box.

Chart Customizer x

Datasets X-Axes Y-Axes | DatasetProperties | Plot Properties -

<

>
¥ Axis | DefaultX Axis «
SnowPackData

Y Axis | DefaultY Axis «

Subplot Number 1 :
Enabled?
Renderer | XY Line/Shape Renderer -
< >
oK Cancel

9. Click OK. You'll notice the chart is now only displaying the values for the new dataset (i.e., SnowPackData).
10. This step uses the default Number Axis type, but if you want to add a new Axis Type, go the X and Y Axes tabs and select a new
Axis type.
11. Next, let's change a few visual properties on our chart. Go to the Y-Axes tab and select Default Y Axis, and change the Axis Label
(i.e, Snow Pack Level (Feet)).

Chart Customizer >
Datasets  X-Axes Dataset Properties  Plot Properties =
L
Default Y Axis * | Property Value
Axis Visible? B3 true
Axis Label |Snow Pack Level (Feet) £
Axis Label Angle 0.0
Axis Label Color 0,0,0 _ .
Axis Label Font SansSerif v ||12| ¥ A A Sans§
Tick Labels Visible? B true
Tick Label Color 0,0,0 _ &, .
0K Cancel

12. Lastly, let's make the plot lines thicker on the chart. Go to the Dataset Properties tab, and change the Line Size renderer property
from 1.0 to 3. 0.



EJ Chart Customizer .
Datasets  X-Axes  Y-Axes I Dataset Proper‘ciesl Plot Properties =
L8
>
bata KAxis | Default X Axis  «
SnowPackData
Y Axis DefaultY Axis
Subplot Number =
Enabled?
Renderer | XY Line/Shape Renderer -
Property Value
Series Colors AVEVEr a 5 V7T 8 I
Type Lines Only A
]
Dash Pattern b
Fill Shapes true
Shape Offsat 0
oK Cancel

13. Here is the chart with the new dataset and updated properties. As you can see, you can easily configure additional properties for a
dataset, as well as choose from a host of visual style properties to design your charts using the Chart Customizer.

Snow Pack Level (Feet)

Feb2 Feb4 Feb6 FebB& Feb10 Feb12 Feb14 Feb 16 Feb 18 Feb20 Feb22 Feb24 Feb 26
Date

|—Currer'|t Snow Pack ==Mormal Snow Pack

Adding a Second Dataset to a Chart

In this example, we'll add an additional dataset to the chart.

1. Double click on the Chart component to open the Chart Customizer (or right-click and select Customizers > Chart Customizer).

2. Once the Chart Customizer is open, make sure the Datasets tab is selected, and click the Add + icon to add a new dataset.
3. A new row will appear. Give the new dataset a name by typing into the cell under the Name column. We'll call it NewData.
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H-Axes  Y-Axes  Dataset Properties  Plot Properties &
Name Type Description
Data Dataset Default DataSet

[}
CNewosta | pammser

oK | Cancel

4. Click the OK button.
5. Check the bottom of the Property Editor. The newly created dataset will appear and may now be populated with data.

Vision Property Editor o - X
12| 1 = S (T
} Appearance
b Deprecated

* Custom Properties
Data & Dataset [42R x 6C]

MewData Dataset [OR x 0C]

B &
B &

6. Now that we have a new dataset, you can add data however you like and it will show up in a second subplot.



Other Vision Trending Charts

Along with the Easy Chart and Classic Chart, there are several other types of charts contained in
the Vision Module that can also visualize a trend and track a change in condition, output, or
process through a single data point or multiple data points over time. This page describes the
Sparkline and Status Charts and how they can be used.

Sparkline Chart

AN

The Sparkline Chart is a minimalistic chart that displays a line-chart history for a single data point
that fits well with High Performance HMI screens. It's a great way to show a lot of contextual
information in a very small amount of space. It provides a fast way to display the recent history of a
single data point so the viewer can quickly discern the most recent trend.

Note, the Sparkline Chart can not show multiple trends, however, multiple Sparkline Charts can be
stacked. This chart is often laid over an image or level display to show a simple trend with the
current value.

Usage

On this page

® Sparkline Chart
® Usage

® Status Chart
® Series Data
® Color Mapping

D

INDUCTIV]
UNIVERSIT

Sparkline Chart

Watch the Video

The trend on the Sparkline Chart is determined by the Data property located in the Property Editor. Bind the Data property to either a Tag
Historian realtime query, or to a database query. The dataset should contain two columns: the first being a date, and the second a number

/value.

Any additional columns in the dataset are ignored. Thus, the Sparkline Chart will only show a single pen per instance of the component. The

data should be sorted by date in ascending order.

The red dot on the Sparkline Chart represents the most recent value. The Sparkline Chart can display a band of color across the back of the
chart which indicates the desired operating range of the datapoint. Setpoints can be displayed on the chart by setting a value for the Desired
High and Desired Low properties. This allows an easy way to view when the value fell out of bounds. Note that both properties must have a

value for the Desired Range Color to appear.

Vision Property Editor o - X P T L I . R

12| 1} = =2 | T - T

~ Common ~1R
Name Sparkline Chart £ e ]
Visible true = __ ‘. ““““““““ - .F
Border No Border v /D é- E M ,/\‘Ljr:
Mouseover Text ] 5 ' )/ L/VJ’VV_/‘\ r\j’\/) :
Cursor Default v €D ] ”E \'\/ E“

> Data __ :\/\ A :
Data Dataset[60Rx2C] B§Gd| 3 : \/ :
Range High &2 a: L . 2 L
Range Low e .
Desired High 65.0 €2 ]

Cocsredion | soa 1

Quality Good & = 0:
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Status Chart

The Status Chart allows you to visualize the status of one or more discrete data points over a time range. The X-axis is always a time series
axis, and the Y-axis is a category axis, with one entry per data series. The Status Chart is populated with the Series Data property in the Pro
perty Editor. This chart is good for showing machine states or HOA values over time. It is recommended to include some sort of Legend
when using this chart.

Oct15 Oct16 Oct17 Oct18 Oct19 Oct20 Oct21 Oct22 Oct23 Oct 24

Series Data

The first column of the Series Data property must contain datetime values. Each additional column should be numeric (the default columns
are doubles). The order of the columns (left-to-right) determines the order of the entries on the chart (bottom-to-top). Because of this, re-
ordering the entries would involve changing the order of the columns as they appear in the Series dataset by modifying the mechanism that
is populating the dataset (i.e., changing the order of columns in a query).

In Wide format, all of the columns but the first must be numeric. These "series" columns' headers will be used as the names on the y-axis. In
Tall format, there should be exactly three columns. The first is the timestamp, the second is the series name, and the third is the value. For
example:

Wide Format
t_stamp Valvel Valve2
2010-01-13 8:00:00 0 2
2010-01-13 8:02:00 0 2
2010-01-13 8:04:00 1 2
2010-01-13 8:06:00 1 1
2010-01-13 8:08:00 0 1
Tall Format
t_stamp Name Value

2010-01-13 8:00:00 = Valvel 0
2010-01-13 8:00:00 = Valve2 2
2010-01-13 8:02:00 = Valvel 0
2010-01-13 8:02:00 = Valve2 2
2010-01-13 8:04:00 Valvel 1
2010-01-13 8:04:00 Valve2 2

2010-01-13 8:06:00 Valvel 1


https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Status+Chart

2010-01-13 8:06:00 Valve2 1
2010-01-13 8:08:00 = Valvel 0

2010-01-13 8:08:00 = Valve2 1

Color Mapping

Apart from getting the data into the series chart, the only other commonly configured option is the mapping of discrete values to colors. This
is done in the Status Chart Customizer. Each named series can have its own mapping of colors, if desired. These mappings are stored in the
expert-level dataset property Series Properties Data so they can be altered at runtime.

Status Chart Customizer K

T - x

seress o [
2.0 | v 3

o Apply Toall

oK Cancel




Alarming in Vision

The Vision visualization system has a few components that allow you to view alarming information
within the client. The Alarm Status Table allows you to view the current alarms in the system,
providing an easy way to inspect the alarm details, shelve the alarm, and acknowledge it. The Alar
m Journal Table allows you to view a history of alarms by reading from an Alarm Journal's
database tables. Note, that a valid database connection and an Alarm Journal Profile are required
to use the Alarm Journal Table.

Alarm Status Table

The Alarm Status Table is a built-in component in Ignition that displays the current status of all
alarms in the system into one view. Each alarm is color coded so you can quickly identify the state
of the alarm. The Alarm Status Table is highly customizable and can be configured to show active,
unacknowledged, cleared, and acknowledged alarms. Once alarms have been configured, most
users will want to view the status of alarms from within a client. Alarm acknowledged and shelving
are built directly into the Alarm Status Table making it easy for operators to respond quickly to
alarms.

Alarms can be visualized in several ways. By far the most popular way to visualize alarm status is
with the Alarm Status Table component. This component immediately displays the status of all
alarms in the system from all Tag providers. In addition, the Alarm Status Table has an extensive
list of filtering options where you can filter down to specific alarm criteria. For example, the
component can filter by source path which means a single Tag provider, folder in a Tag path, or
even UDT instances can be focused on by the component.

On this page

® Alarm Status Table

® Configuring the
Alarm Status Table
® Filtering Alarms
® Viewing Alarm

Information

® Alarm Journal Table
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Alarm Status
Component

Watch the Video
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& Appearance =
FIII o Motors/Motor 5/Amps/Low Amps | prov:default/tag:Motors/Motor 5/Amps:/alm:Low Amps. 6/11/'19,9:17AM Cleared,unackn...
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i
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play 5 A BB
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Configuring the Alarm Status Table

The Alarm Status Table component can be configured to view alarms, and monitor and respond to alarms, but there are a host of properties
for this component to become familiar with. The Alarm Status Table properties are configured in the Designer. When configuring the Alarm
Status Table, you will have to toggle between both the Designer and Preview Modes in order to configure the Alarm Status Table properties

and organize the alarm data in the table.

1 Alarms

Alarms must be set up on Tags for them to show up in the Alarm Status Table.
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When you drag the Alarm Status Table component to your Designer, there are some default properties already configured. Some of the
defaults may work for your client users, but you always have the option to change them. For example, the table shows all the "Active and
Unacknowledged", "Active and Acknowledged", and "Cleared and Unacknowledged" alarms. It also displays the time the alarm went Active
as well as the current State and Priority of the alarm, but you may want to narrow the scope of your alarm state entries and only display
Active and Unacknowledged alarms with a priority of Medium and higher. You can update these property settings in the Property Editor of
the Designer under the Filters group.

Filtering Alarms

The Property Editor has a dedicated Filtering group where you can configure filtering properties for displaying alarm data in your Alarm
Status Table: alarm state, priority, source path, display path, and Tag provider. Once you configure your properties, the alarm table will
refresh with new alarm data based on your filter property settings. When displaying alarms on the Alarm Status Table component, it is
common to filter on either the 'Display Path' or the 'Source Path.’

The Display Path can be customized on each alarm. The default value for an alarm's Display Path is a Tag path that leads to the name of
the alarm. The Integer Tag example below has an alarm named 'Alarm’, and is located on a Tag path of 'Alarming Example/Integer Tag', thus
the Display path will resolve to 'Alarming Example/Integer Tag/Alarm'. However, the Display Path can be customized when configuring the
alarm. This is generally utilized to display readable messages as to what the issue is: i.e., "Tank 105 High Temp Alarm".

The Source Path is also a path to the alarm, but also notes the Tag provider the alarm is located in. Again using the Tag below, if the name
of the Tag provider is 'default’, then the source path would resolve to 'prov:default:/Tag:Alarming example/Integer Tag:/alm:Alarm’'. Unlike
the Display Path, the Source Path on an alarm can never be overridden.

Understanding the functionality of Display Paths and Source Paths allows for much flexibility when filtering alarms by Tag path.

Display Path

Source Path

| O 00O

Viewing Alarm Information

In Preview Mode and the Vision Client, you can customize how you want to see the alarm data. You can right click in the header to hide or
show columns, and move columns by clicking them and dragging them around to organzied the alarm data. You can also sort by column by
simply left clicking, or sort by multiple columns by holding the Ctrl key while clicking the column headers. You will see small numbers next to
the column header to indicate the sort order and direction (ascending vs descending). Client users can customize the alarm data in the Alarm
Status Table to however they wish to view the data.

Active Time Display Path Source Path

Priority Current State

-] crical | ctive, unacinow. [

Active, Unacknow...

Auto Resize This Column
Auto Resize All Columns

Hide This Column "Priority"
Show All Hidden Columns

o[ Crécal [ Clesred, Unadne..
6/7/19, 4:15 PM Motors/Motor 6/Amps/Low Amps provdefault:ftag AckTime g
6/7/19, 4:22 PM Motor Plant/Motor 3/Amps/Low Amps provdefault:ftag

Ack'ed By

6/7/19, 4:23 PM

Motor Plant/Motor 3/Amps/Low Amps providefault:ftag
6/7/19, 4:23 PM Motor Plant/Motor 3/Amps/Low Amps providefault:ftag

Active Pipeline

CerPyein
6/7/19, 4:23 PM Ack Pipeline
Deadband A2 B B

Display Path

Alarm Journal Table Component

There is a pre-built component in Ignition called the Alarm Journal Table that allows the database
to see alarm history. It provides a built-in view to explore alarm history that has been stored in your
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database. Before viewing alarm history, you must first tell Ignition to log alarms in your database

by creating your Alarm Journal Profile. By default, the Alarm Journal Table does not filter out any INDUCTIV]
of the alarms, it simply shows you all the alarms stored in the table for the time range set. When
you add an Alarm Journal component to a window and have no start and end dates selected, it U NIVE RS I']

defaults to show the previous 8 hours of alarms and will not refresh itself until the start or end date
properties change. You can use the Start Date and End Date properties to filter on alarms, or you
can use the Date Range component to filter alarms during a specific time period.

Alarm Journal
Component

Refreshing Alarm Journal Table Data

Watch the Video

Alarm data in the journal does not refresh automatically. Toggle one of the filters in the
Property Editor, or on the Calendar component you are using. You can also choose to
make the journal table data refresh automatically by setting an expression binding on
the journal's End Date property to now( ) .

Event Time Display Path EventState  EventvValue Priority Current state
6/10/19,2:46 PM Motors/Motor 3/Amps/Low Amps. Active 8 Critical Active, Unacknowledged |~
6/10119, 2:45 PM Motors/Motor 3/Amps/Low Amps Ack Critical Cleared, Acknowledged
6/10119, 2:45 PM Motors/Motor 3/Amps/Low Amps Clear 53 critical Cleared, Unacknowledged
6/10119, 2:45 PM Sine/sine3/High Setpoint Clear 30.9582 Low Cleared, Unacknowledged
6/10119, 2:45 PM Motors/Motor 3/Amps/Low Amps Active 48 critical Active, Unacknowledged
6/10/19,2:46 PM Motors/Motor 3/Amps/Low Amps. Ack Critical Cleared, Acknowledged
6/10119, 2:45 PM Ramp/Ramps/OPC Alarm Clear 157.52 Critical Cleared, Unacknowledged .,
28300 events * L P

The alarms are color coded so you know what each of the states represent. In Preview Mode, you can right click in the header to hide or
show columns, and move columns by clicking them and dragging them around. You can sort by column by simply left clicking, or sort by
multiple columns by holding the Ctrl key while clicking the column headers. You will see small numbers next to the column header to indicate
the sort order and direction (ascending vs descending).

Event Time Display Path Event State Event Value Priority Current State
6/10/19, 2:46 PM Motors/Motor 3/Amps/Low Amps Active 4 Auto Resize This Column Unacknowledged =
6/10/19, 2:46 PM Motors/Motor 3/Amps/Low Amps Ack Auto Resize All Columns d, Acknowledged
6/10/19, 2:46 PM Meotors/Motor 3/Amps/Low Amps Clear q . . d, Unacknowledged

- - - - Hide This Column "Event Value"
6/10/19, 2:46 PM Sine/Sine3/High Setpoint Clear 3 ) d, Unacknowledged
6/10/19, 2:46 PM Motors/Motor 3/Amps/Low Amps Active 4 Show All Hidden Columns Unacknowledged
6/10/19, 2:46 PM Motors/Motor 3/Amps/Low Amps Ack Event Id d, Acknowledged
6/10/19, 2:46 PM Ramp/RampB8/OPC Alarm Clear 1 Source Path d, Unacknowledged
6/10/19, 2:46 PM Sine/Sine3/High Setpoint Active 5 3 Display Path Unacknowledged
6/10/19, 2:46 PM Sine/Sine3/High Setpoint Ack Name d, Acknowledged
6/10/19, 2:45 PM Motors/Motor 2/Amps/Low Amps Clear 5 ) d, Unacknowledged
) Ld  EventTime
6/10/19, 2:45 PM Motors/Motor 2/Amps/Low Amps Active 5 Unacknowledged
6/10/19, 2:45 PM Motors/Motor 2/Amps/Low Amps Ack &4 Event State 4, Acknowledged
6/10/19, 2:45 PM Motors/Motor 2/Amps/Low Amps Clear 5 kd  EventValue d, Unacknowledged .
B Priority

28,300 events

® Lo P

System Event

v
To view an alarm's Details and Notes, select an individual alarm, then click the Search# icon in the lower right corner of the table to see
all the information that is associated with the individual alarm.

-

= . . . .
To close the Details and Notes tabs, click the Search #  icon again or click the Expand ™ icon.
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Event Time Display Path Event State Event Value Priority Current State
|6f10!1 9, 2:46 PM Motors/Motor 3/Amps/Low Amps Active 48 Critical Active, Unacknowledged I -
6/10/19, 2:46 PM Motors/Motor 3/Amps/Low Amps Ack Critical Cleared, Acknowledged
Details | Notes ¥
El Config Properties A
Source Path prov:default:/tag:Moters/Motor 3/Amps:/alm:Low Amps
Display Path
Label
Name Low Amps
Mode Equal
Priority Critical
Current State Active, Unacknowledged
Ack'ed By
Active Pipeline
Clear Pipeline
Deadband 0
Active delay (seconds) 0
Clear delay (seconds) 0
Timestamp Source System
Ack Mode Manual
Notes
Is Shelved? False
Shelf Expiration
Event Id 202c5887-c1fb-4844-9ef9-dce31ecdbcbe
= On Active
Event Value 48
Event Time 6/10/19, 2:46 PM e
28,300 events @ ’;‘ »

Related Topics ...

® Configuring Alarms
® Alarm Journal

In This Section ...
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Vision Alarm Status Table - Common Tasks

The Alarm Status Table has a lot of configuration options that can be used to do things like filter
the list of alarms being displayed, to changing how the component displays them. Each of the
pages in this section goes over setting up various aspects of the Alarm Status Table.

On this page

Vision Alarm Status - General Filtering

The Alarm Status table component has a lot of properties that allow you to filter on various parts of e \Vision Alarm Status
alarms. Learn about all of the different built-in ways that the Alarm Status Table can filter alarms. - General Filtering
® Vision Alarm Status
- Filter on
.. . . Associated Data
Vision Alarm Status - Filter on Associated Data * Vision Alarm Status
- Row Styles
Sometimes, the built in filters of the Alarm Status Table are not enough. The Alarm Status Table ¢ Vision Alarm Status
component allows you to filter alarms through scripting and filter on any of the alarms properties, - Marquee Mode
including user created associated data properties. ¢ Vision Alarm Status
- Acknowledgment
® Vision Alarm Status
- Shelving

® Vision Alarm Status
- Tag History and
Alarm History

® Using Alarm Status
Tags in Vision

Vision Alarm Status - Row Styles

The Alarm Status Table uses different styled rows to differentiate between alarms in different states. These Row Styles can be completely
customized using whatever colors and fonts you want. You can even add a blinking style, allowing you to really draw attention to critical
alarms!

Vision Alarm Status - Marquee Mode

Sometimes, the alarms displayed in the table can build up and it can be a pain to scroll through the list. The Alarm Status Table can be put
into a Marquee Mode, where it will slowly scroll through the list of alarms at a pace that you specify. Learn how to set that up and how to use
it.

Vision Alarm Status - Acknowledgment

Typically, the first step in fixing an alarm is acknowledging that the alarm is happening. Acknowledgement can play an important part in any
alarm system which is why the ability to acknowledge alarms is built right into the Alarm Status Table component. Learn how to acknowledge
alarms and what the different options are.

Vision Alarm Status - Shelving

Shelving alarms allows you to hit the snooze button on an alarm event, postponing the alarm until later. This can be useful when doing
maintenance if Tags are constantly going in and out of alarm.

Vision Alarm Status - Tag History and Alarm History



The Alarm Status Table allows you to view Tag History for Tags that are currently in alarm. As long as history is being stored for that Tag,
you can view the history right in the component to get an idea of what the value was prior to going into alarm. Was it a slow rise to the
setpoint, or was it a large spike?

Using Alarm Status Tags in Vision

While not part of the Alarm Status Table, these system Tags provide the number of Tags in specific states of alarm. Thes can be used to
easily create a small notice of how many alarms are in the system without having to show the entire Alarm Status Table.

In This Section ...



Vision Alarm Status - General Filtering

Filtering in the Designer

There are several different filtering properties on the Alarm Status Table component. Once you
drag the Alarm Status Table component on to a window, by default it shows you all the alarms that
are currently 'Active and Unacknowledged,' 'Active and Acknowledged,' and 'Cleared and
Unacknowledged,' with a priority ranging from Diagnostic to Critical. Some users want to do some
more targeted filtering like only seeing the 'Active and Unacknowledged' alarms for a specific area
or piece of equipment. This is easily accomplished by configuring a few alarm properties in the
Property Editor.

The Alarm Status Table below is similar to what you'll see when you first drag in an Alarm Status T
able to your Designer window. You can filter the alarm list in the table to be a shorter list using the
Filter properties in the Property Editor instead of scrolling through every single alarm in your
system. In the Property Editor, there is a group called Filters that you can configure to focus on

only those alarms you want to see. You can filter on Priority, State, Source Path, Display Path, a

nd Tag Provider.

You'll find, as you continue reading this page, that it is really easy to do some basic filtering using
the alarm filter properties on the Alarm Status Table component in both the Designer and Vision
Client.
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Filtering on Priority

On this page

® Filtering in the
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® Filtering in the
Vision Client
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Display Path
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Watch the Video

You can filter on any Priority by changing the Min Priority field in the Property Editor. You will only then see alarms displayed in the Alarm
Status Table for the priority you set in the Property Editor and higher alarms. This example sets the Min Priority to 'High' priority, and the
table displays only High, and Critical alarms. The number of alarms operators have to view can be narrowed down by using the Min Priority

filter.
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» Common ] Active Time Display Path Current State Priority EventId Label
» Behavior 1 7/8/20,12:20 PM | Tank Level 2/Low SP2 mm 0cc3183b-cebe-4f ,, ~
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} Deprecated ] 8/5/20, 9:28 AM Speed/High Speed Cleared, Unackno... 282ae2fe-1abb-4... |High Speed v
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Filtering on Alarm State

There are four alarm states that an alarm can be in; 'Active and Unacknowledged', 'Active and Acknowledged', 'Clear and Unacknowledged',
and 'Clear and Acknowledged'. Each of the four alarm states has a different color so you can quickly identify and respond to the most critical
alarms. To enable and disable filtering for any of the alarm states, go to the Filters group in the Property Editor.

This example shows only alarms for Active and Unacked, and Clear and Acked. A good business practice is to show only the Active
alarms that are either Unacknowledged or Acknowledged. It also reduces the number of alarms an operator has to scroll through.
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I Show Active and Unacked [ true c—:l | — — —
z 7/8/20,1220 PM | Turbine Number 100 located at Folsom, CA bae20ae5-a49f-4... | High Wind Speed
Show Active and Acked false @ g 7/8/20,1220PM | Turbine Number 150 located at Folsom, CA f8b105c2-6F7a-4a. i
show Clear and Unacked false e 7/8/20,1220PM | Turbine Number 300 located at Fresno 269a4h07-209f-4...
[ Show Clear and Acked B e e | ] 7/27/20,935AM | Tank 100 5116cf11-chd0-4...

- 7/27/20,935AM | Tank 100 35ae2cc6-Fbf7-40.
Source Filter £ e 5] = = 8
[ 8/5/20,309PM | Sine/Sine1/High Level | Active, Unackno... | ch58d6e7-62c9:
Display Path Filter £ el 7/8/20, 1220 PM | Low Temp/Low Alarm Cleared, Acknowl... | Critical Tccf2a53-0r54-44..
Provider Filter se | ] 7/8/20,12:20 PM | Tank Level 2/High 5P2 Cleared, Acknowl... | Critical 7575fa6-bb5c-40... | High 5P2
} Deprecated Bl 71/8/20,12:20 PM Temp/High Temp Cleared, Acknowl... |High b7a320d8-e511-4... [ High Temp v

H A 8B

Filtering on Source Path and Display Path

The Alarm Status Table has the capability to filter alarms based on the Source Path or Display Path.

Source Path

The Source is the actual Tag path which means you can also use Tag folders in Ignition to filter for specific alarms. For example, you may
want to filter for all Motor alarms in the Motors folder. You can enter *Tank* (using * as a wildcard) to look for all alarms with the Motor Tag
Path. The Source and Display properties allow you to restrict the results of the query to one or more paths. Multiple paths may be specified
with a comma. Additionally, these properties all use the asterisk (*) as wildcard character to denote any number of leading or trailing
characters, depending on placement.

You can see in this example, all the alarms have 'Tank' in the Source Path.



File  Edit View Project Component Alignment Shape Tools Help

IR woalel O-ms-@ | - § -
Vision Property Editor a8 - X TR L T T S O S T O T . T . T L I T . P
1)1 == T 1

* Common 1 O Active Time Source Path Current State Priority Label

» Behavior ] ), 12: prov:default/tag:Tank Level 2:/alm:Low SP2 Active, Unacknowl...

} Data o ), 10 prov:default/tag:Writeable/WriteableInteger1:/alm:Low Tank Level Low Tank L..
» Appearance aL ), 9: prov:default/tag.Tank Level:/alm:Low SP
~ Filters 4 prov:default/tag:Tank Level:/alm:High SP

Min Priority High ves |1 prov.default:/tag:Writeable/WriteableInteger1:/alm:Low Tank Level

T 7 prov:default:/tag:Tank Level:/alm:High SP Cleared, Unackno _
rue
7 /20, prov.default:tag:Tank Level:/alm:Low SP Cleared, Unacknow
ol
Show Active and Acked e | ¢ 7/9/20, 9 provdefault/tag-Tank Level/alm:Low SP Cleared, Unacknow.

Show Active and Unacked

Show Clear and Unacked & true (-] prov:default/tagTank Level:/alm:High SP Cleared, Unackno

" | prov:default/tag:Tank Level:/alm:Low SP Cleared, Unacknow...| High
Source Filter *Tank* 7| 5
éL 7/24420,10:59 AM prov.default:/tag:Tank Level:/alm:High SP Cleared, Unacknow...| High

Display Path Filter -1

cl , Unacks igh
Show Clear and Acked false e | ] prov.default:tag:Tank Level:/alm:High SP Cleared, Unackno igh

Provider Filter s ]

} Deprecated

g‘i A2 8
Source Path Examples
Example Filter Result
prov:tagProvider:/tag: | nputs Retrieve alarm information from the alarm at precisely the specified path:
/PS_1:/al m WAl arm prov:tagProvider:/tag: | nputs/PS_1:/al m WA arm
*PS_1:/al m VAl arm Retrieves alarm information from any path that ends with PS_1: / al m MyAl ar m Thus the

following paths would be returned:
prov:tagProvider:/tag: | nputs/PS _1:/al m MAl arm

prov:tagProvider:/tag: anot her Fol der/di fferent _Path/PS_1:/alm
M/Al ar m

prov:tagProvider:/tag: PS_* Retrieves alarm information from any source path starting with pr ov: t agPr ovi der:
/tag: PS_

prov:tagProvider:/tag: PS_1/ M\yAlarm /al m MyAl arm
prov:tagProvider:/tag: PS_2/ MyAl arm /al m MyAl arm

* WAl ar nt Retrieves any alarm information that has MyAl ar m somewhere in the path.

Display Path

The Display Path is the Tag path that leads to the Name of the alarm which can be customized when you configure your alarm. In this
example, ‘High Speed’ is the Name that was setup in the Alarm Configuration, and the Display Path is set to the Name you want the
operator to see. The Alarm Status Table below is filtered by Display Path with a value of 'High Speed'.

File  Edit View Project Component Alignment Shape Tools Help

; | il Tal
B e | lw o[s]fo-[a]s- e o | | | | -
Vision Property Editor 8 - X P T T L T O T T T O T T O T . T L O O I T I
1B 1 S =E |- 9
* Common 1 [ ActiveTime Display Path Name Current State Priority Label Event Value

» Behavior

A Speed/High Speed High Speed Active, Unacknowledged mm 17
» Data & 8/4/20,454PM | Speed/HighSpeed | High Speed Cleared, Unacknowledged High Speed
» Appearance % 8/4/20, 4:54 PM Speed/High Speed High Speed Cleared, Unacknowledged High Speed

) 5 99
Show Active and Unacked [ true [==] z;
Show Active and Acked [ true e |4
Show Clear and Unacked [ true e | ]
Show Clear and Acked false (-] :
Source Filter s e 7]
by

Display Path Filter

High Speed* =

Provider Filter se| ]
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Filtering in the Vision Client

In the Vision Client, the Alarm Status Table provides a host of built-in filtering options that are immediately available and easy to modify to
help you get started. You can choose to filter on any of the filter properties by right clicking in the Alarm Status header and selecting any of
the available properties.

Fuant Id
Auto Resize This Column

(=] Active Time Prinritu
7/8/20, 1220 PM
7/8/20,12:20 PM
7/24/20, 10:59 AM
7/28/20, 433 PM
7/8/20,12:20 PM

7/8/20,12:20 PM

Display Path Current State

Label

Speed/High Speed Active, Unacknowle
Tank Level 2/Low SP2 Active, Unacknowl¢
Writeable/WriteableInteg... | Active, Unacknowl¢

Auto Resize All Columns

Hide This Column "Display Path"

Sine/Sine0/High level Active, Unacknowl¢
Turbine Number 200 locat... | Active, Unacknowl
Turbine Number 100 locat... | Active, Unacknowlg

Show All Hidden Columns

778120, 12:20 PM Turbine Number 150 locht... | Active, Unacknowld Ack Notes
7/8/20,12:20 PM Turbine Number 300 locat... | Active, Unacknowlg Ack Time
7/27/20,9:35 AM Tank 100 Active, Unacknowld Acked By

7/27/20,9:35 AM
7/28/20, 431 PM
12:20 FM

Tank 100 Active, Unacknowl¢

Sine/Sine1/High Level Active, Unacknowl¢
High Temp/High Temp

Active Pipeline

Active, Unacknowlec Clear Pipeline gh Temp

12:20 PM FTemp/alarm Active, Unacknowlec Ack Pipeline
7/8/20,12:20 PM Writeable/WriteableInteger1... | Cleared, Unacknowl bw Tank Level
- - o Active Time
20, 3:56 PM Sine/Sine2/Low Level Cleared, Unacknow! ) bw Level
N5 Bad h na 241 A d 1in arar Clear Time =
Acknowledge Shelve Event Value P M B
Deadband

Display Path
Acked?

Active?

You can even arrange the columns in any order you want by simply right clicking on the individual column header and dragging it to the right
or left within the table. You can also sort in ascending or descending order by clicking in the column header.

il

Active Time
7/8/20,12:20 PM
7/8/20,12:20 PM
7/24/20, 10:59 AM
7/28/20, 438 PM
T/28/20, 438 PM
7/8/20,12:20 PM
7/8/20,12:20 PM
7/8/20,12:20 PM

Current State Display Path

k Level 2/Low SP2
teable/WriteableInteg...
/Sine2/Low Level
/Sine0/High level
bine Number 200 locat...

Event Id
Taleaa71-c69..

Highspeed |
el [octasbecbe [omsrz_|
il [3bicdbasboe- [ Low Tank cove|
[l [edeeraar[Lowievel |
il [7b70110952.[righlevel |
Figh ——[basoactss2b.. Highwind 5. |
Figh —[baezoaes 9. [Figh wind 5. |
Hish [ abtosczetra [ High wind . |

Priority Label

»

Active, Unacknowled... | bine Number 150 locat...

7/8/20,12:20 PM
7/27/20,9:35 AM
7/27/20,9:35 AM
7/28/20, 439 PM
12:20 PM

/20, 12:20 PM
7/8/20,12:20 PM

W fS Eh

Acknowledge

Shelve

Active, Unacknowled... |k 100
Active, Unacknowled... | k 100
Active, Unacknowled... |2/Sine1/High Level

Active, Unacknowled... (bine Number 100 locat...
Active, Unacknowled... (bine Number 300 locat...

Figh —[zesedbor09- [righ wind .|
Hgh ——[sttedodo.[Lowse |
Figh —[ssszcceorr [righsr |
Wsh —[sroaase ot [pigh Level |

g rm
a9dfs3ea-frab-... Tank Level




Related Topics ...

® Vision - Alarm Status Table
® Configuring Alarms
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Vision Alarm Status - Filter on Associated Data

Filtering on Associated Data _
On this page
Another way to filter alarms in the Alarm Status Table is using associated data that was added to
an alarm. You can easily and quickly search, filter, and display on specific alarms based on
associated data configured in an alarm.

® Filtering on

Using a Script to Filter on Associated Data Associated Data
® Using a Script to
It's a common design practice to associate alarm groupings on associated data of an alarm. Filter on

Associated Data

Scripting gives you the ability to filter on associated data, but also gives you the freedom to filter
on anything that you want. In the following example, we used a script to filter on associated data,
but first we need to add associated data and setup an alarm group.

Here we have a Memory Tag called 'Speed' with a configured alarm called 'High Speed.' To add
associated data, click the Add + icon at the top of the Tag Editor, scroll down the list of alarm @

INDUCTIV]
UNIVERSIT

properties to Associated Data, rename 'New Data' to 'Group' and add a static value called ‘Produ
ction.” Click Commit and save your Tag.

Tag Editor X

Speed > Alarms

L T—— Alarm Status -

;
3[4 =] =t ei[¥] ® il
Filter on
El Alarm Mode Settings H
. Associated Data
Setpoint 100 &3]
Inclusive true v &3
Any Change false v G| .
 Deadbands and Time Delays Watch the Video
& Notification

& Email Notification Properties
= SMS Notification Properties

El Associated Data
Group Production [

Email Notification Properties

Commit Revert

Next, create a script to filter for all alarms in the Alarm Status Table that have the associated data called ‘Production.’ Scripting allows you
to use the 'filterAlarm' extension function specifically for filtering on associated data.

Right click on your Alarm Status Table component, and scroll down and select Scripting.

In the Component Scripting window, under Extension Functions, select ‘filterAlarm.’'

Click the Enabled checkbox.

Enter the code below into the ‘filterAlarm' script. You can filter on anything you want here, but in this example, we are going to filter
on 'Production.’

el N =

Extension Function - filterAlarm for 'Production’

group = al arnEvent. get (" G oup")

if group == "Production":
return True

return Fal se

Your script will look like the image below. This script will only display alarms matching the associated data for 'Production.' For
every alarm matching ‘Production,’ it will return ‘True’ and show alarm results in the Alarm Status Table. If the associated data
does not match ‘Production,’ it will return ‘False,” and the Alarm Status Table will be empty. Note, when you're finished filtering on
associated data, don't forget to disable your script.
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% Component Scripting [Alarm Status Table] - m] *

W Event Handlers < £ Enabled I

==
» 4 propertyChange ’ def filterAlarm(self, alarmEvent): I
@ Extension Functions W

2
2 createPopupMenu 3 Called for each event loaded into the alarm status table. Return false to
I 4 hide this event from the table. This code is executed in a background
2 isAcknowledgeEnabled 5 thread.
7 isShelveEnabled 6
2 onDoubleClicked ;

Z onAcknowledge

ATguments:
self: A reference to the component that is invoking this function.

. 9 alarmEvent: The alarm event itself. Call
& Custom Methods 1e alarmEvent.get{'pTopertyName') to inspect. Common properties: 'name’,
+ 11 'source’, ‘priority’.
12
13 group = alarmEvent.get("Group”)
14 if group == "Production”:
15 return True
16 return False

< >

0K Apply Cancel

5. Click OK.

6. Now the Alarm Status Table below shows all the alarms in the '‘Production’ group. Select an alarm and click the Search p icon to
see all the Details about the alarm.

= Active Time Display Path Label Event Value Priority Current State

Details Notes ¥

+ Config Properties |

=l On Active
mode Above Setpoint
setpointA 100
Event Value 130
name High Speed
Event Time 6/13/19,7:19 AM
priority Critical
Group Production

Acknowledge Shelve H B

1 Checking Alarm Results

® |f you see alarms that do not match your associated data, check your filter settings in the Property Editor of the
Alarm Status Table. You may need to uncheck the 'Show Clear and Unacked' and 'Show Clear and Acked'
settings depending on what you want your operators to see.

® |f you have an error in this filtering script, it will return 'true’ for every alarm instance (and show all alarms) instead
of displaying many errors to your users. You can find more information about the error from the Output Console
under the Tools Menu in the Designer, and from the Vision Client under Help > Diagnostics and selecting the Co
nsole tab.

Related Topics ...

® Alarm Associated Data
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Vision Alarm Status - Row Styles

The Alarm Status Table comes with a particular set of colors associated with each of the alarm
states. You can change these colors for each of the states by going to the Alarms Row Styles .
Customizer that the Alarm Status Table component provides. On this page

By default, the Active and Unacknowledged alarms are at the very top of the table and are red and
blinking, and Cleared and Unacknowledged alarms are teal and at the bottom of the table, as
shown in the image below.

® Customizing Alarm
Active Time Display Path Priority

oz, 1900 | spesavigh spes [ghspees |10 |cmca | e unscino [ Row Styles
131,779 0| umidtyigh umidty | igh mity [s6[ctcn [ Acive,unacino e Creating a Row
oo, 779 me[ronk vl znowsrs—JumseeJo —citea [aciveonecno | 9

v, 158 0| rorsvoor ampriowamps | uomamps a6 Jcica [ cive,onacno | Style

Label Event Value Current State

6/14/19, 1127 AM | Motors/Motor 6/Amps/Low Amps Cleared, Unackn.
6/14/19,11:17AM | Motors/Motor 4/Amps/Low Amps Cleared, Unackn.
6/14/19, 1148 AM | Motors/Motor 3/Amps/Low Amps Cleared, Unackn.

A EB

@ INDUCTIVI
UNIVERSI]

Alarm Status - Row
Styles

Watch the Video

Customizing Alarm Row Styles

In the Alarm Row Styles Customizer is where you can modify an existing row style, add more styles, or delete a style. Each style has an
expression, a color and the option if you want it to blink. The expression allows you to do any evaluation you want using any filter properties
of the alarm such as Priority, State, Display Path, Active Time, and Clear Time.

In the Designer, right click on the Alarm Status Table component, go to Customizers > Alarm Row Styles to see the default row styles.
Alarm Row Styles is an ordered list and each style has an expression. How it works is, the first style that returns ‘True’ for a given alarm is
the one that is going to be used. So you want to make sure the order is the correct order that you want. If you want to change the order,


https://www.inductiveuniversity.com/videos/alarm-status-row-styles/8.0/8.0

select a row and click on the up or down arrow ﬁ \l} icons. Click on each of the row styles to view the expression and row style.

|
| Alarm Row Styles >

Row Styles

{priority}='Diagnostic'
{state}="ActiveUnacked' && {priority}>=3

{state}="ActiveUnacked'

X + @a=

{state}='ClearUnacked'

{state}='ClearAcked'

[
|
[
|
[
|
[
|
| r - .
W {state}="ActiveAcked
[
|
[
|
[
|
[
|
[
|
[
|

Expression Standard 7 Blink
1 {state}='Activelnacked’ ~| | Foreground Sl
v &, v o
Background Background
. B
Font Font
< » - v
OK Cancel

Creating a Row Style

Let's create another state alarm with a new row style. Call this new alarm state 'ActiveUnacked' and make it 'Critical.'

. With the Alarm Row Styles customizer open, click on the Add + icon, and call this new alarm 'ActiveUnacked' and make it 'Critica

. Copy and paste the expression from the code block below into the Expression block of the Alarm Row Styles window. Notice that we

are making this alarm state a priority 4.

....................................................................................................................................................................

@ Alarm State Priority Numbers

Priorities are numbered behind the scenes, but named when you are creating them. 0 = Diagnostic, 1 = Low, 2 = Medium,
3 = High, and 4 = Critical. This allows you to use operations like '>=' (greater than or equal) when filtering on priority.

. The new alarm state by default is added to the bottom of the list. Style order is very important. If you keep this style at the bottom of

the list, the alarm will never be visible in the Alarm Status Table. Move ActiveUnacked with a Priority >= 4 to the top of the row
styles list so it is evaluated before the other styles.

. Since this is a critical alarm, you want it to catch the operator’s attention, so it's a good idea to make the style standout. Make the

Foreground color 'Black' and the background color 'Red." Check the Blink Box and make the foreground color 'Black' and
background color 'Yellow.'

. Press OK.



*

Alarm Row Styles

Row Styles |

{state}="ActiveUnacked'&&{priority}>=4

{priority}='Diagnostic’
{state}="ActiveUnacked’ && {priority}>=3
- .

X+ aew

ked'
{state}='ClearUnacked'
{state}="ClearAcked'

Expression Standard 7 Blink

1 {state}='Activelnacked &&{priority}>=4 || Foreground Foreground

s - I

Background Background
B "o
3
Font Font
< » = -
0K Cancel
6. The critical alarms will now blink red and yellow and will definitely catch the operator’s attention.

(] Active Time Display Path Label EventValue  Priority Current State
6/13/19, 7:19 AM Speed/High Speed High Speed 130 Critical Active, Unacknow... ~
6/13/19,7:19 AM Humidity/High Humidity High Humidity 86 Critical Active, Unacknow...
6/13/19, 7:19 AM Tank Level 2/Low SP2 Low SP2 0 Critical Active, Unacknow...
6/14/19, 2:31 PM Motors/Motor 2/Amps/Low Amps Low Amps 50 Critical Active, Unacknow...
6/14/19, 2:43 PM Motors/Motor 4/Amps/Low Amps Low Amps 46 Critical Active, Unacknow...
6/14/19, 2:44 PM Motors/Motor 3/Amps/Low Amps Low Amps 45 Critical Active, Unacknow...

6/14/19, 2:45 PM Motors/Motor 1/Amps/Low Amps Low Amps 46 Critical Active, Unacknow...

6/14/19,245PM | Ramp/Ramp8/OPC Alarm OPC Alarm 3437333
6/14/19, 230 PM Motors/Motor 2/Amps/Low Amps Cleared, Unackn...
6/14/19, 2:30 PM Motors/Motor 2/Amps/Low Amps E Cleared, Unackn... |

A2 A B

To learn more about states and priorities including all the alarm configuration properties, refer to the sections on Alarm Event Properties
Reference.
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Vision Alarm Status - Marquee Mode

The Alarm Status Table can take up a lot of space on your Ignition client window as shown

below. In many production environments, a small Alarm Status Table is often displayed at the very .
bottom of the Client window taking up very little space. The problem is when an operator has quite On this page
a few Active alarms, they have to manually scroll through the list of alarms to see them all. This
can be a little tedious for operators. If you want to minimize the size of your Alarm Status Table,

and not miss any alarms, you can turn on the Marquee Mode option.

Command  Windows

Help

Ignition

&8 Roster
[ Schedules

Current Time:
06/14/2019 03:14 PM

20 Alarms
Logged In
admin
@ Lockscreen
B8 Switch User

¥ Logout

/1 Alarms

Active Time Display Path Priority EventVal.. Label  CurrentState
131,710~ [speeamignspees——Jcrscn |1 Jgns. |
131,770 mumiaypigh homidty[crticar [35—[mghi| e bnc |
631,775 [rank veaon sz [crtica [0 frowsra e orc |
11,240 worortorsamptow | rticar |46 [Lowamp] e |
171,305 ottt sampatow-|ricar |35 [Lowamp] e |
179 512t o[t [ |towhmps e |

6114119, .| Motors/Motor G/AmpsiLow A 54

119,255 .. Matorshtor GAmps/iowAm.. | Crical |51

torsitor a/mpsfion Am..| Criical |53

Active, Unac...[d

Setting Up Marquee Mode

® Setting Up Marquee
Mode
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Alarm Status-
Margquee Mode

Watch the Video

The nice feature with Marquee Mode, is it automatically scrolls through all the alarms when there is not enough vertical space on the client
window to show them all at once.

1. Select the Alarm Status Table. In the Property Editor of the Alarm Status Table, set the Marquee Mode to ‘true.’

Vision Property Editor - X

BE 24 | = | = 'l @ -

+ Common -

-1 Behavior
Refresh Rate 2,500 &
Sort Order State_Priority_Time * GO
Sort Oldest First true G
Multi Select true G

| Marquee Mode true c2|

Touchscreen Mode Single-Click v D
Scroll Delay 50 €2

2. This client screen shows you a typical Alarm Status Table using the Marquee Mode located at the bottom of the window. The Alarm
Status Table automatically scrolls through all alarms that are currently visible. Marquee Mode makes it very easy for operators to

see what's going on without having to manually scroll through the entire list of alarms to identify all the alarms that are Active or that
need attention.
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Command  Windows  Help

/ /1 Alarms
Ignition'
g by induct ,
ens
~ @ Administration W (3 Motor3 3¢ M\'H\ &
Settings B 5 Motor 4 3% SN 2
~ @ HMI Screens B & Motor 5 52 H
= Motor 6
1/ Empry U &
&) Overview
& Roster
(™ schedules
ol \ P HANl | L‘J'" P [LAYY)
4:23PM 424 PM 4:25PM 4:26PM 4:27 PM 428PM 4:29 PM 4:30 PM 431 PM 432PM 4:33 PM
[Jun14,2019]
4 9 6/14/19 4:23 PM - 6/14/19 4:33 PM @ |
[ I 1
P o e R o L T T
3:00 PM 315 PM 3:30 PM 3:45 PM 2:00 PM 415 PM 4:30 P 4:45 PM
Current Time:
06/14/2019 04:34 PM -] Active Time Display Path Priority Event Value Label Current State

6/13/19,7:13 AM Tank Level 2/Low SP2 m_m
6/13/19,9:23 AM Writeable/WriteableInteger1/Low Tank.., [15° [LowTankLe.

20 Alarms.

Logged In
admin

6/14/19, 418 PM Motors/Motor 4/Amps/Low Amps
6/14/19,4:30 PM___| Motors/Motor 6/Amps/Low Amps |critical |

A8 switch User Acknowledge Shelve p l,?z| @
+F Logout

@ Lock Screen

{D Set filters and inform operators that Marquee Mode is a scrolling list of alarms

When using Marquee Mode, it is even more important to pay attention to the filters configured on the Alarm Status Table since
there is limited room. Make sure your operators know that even though the Alarm Status Table may be small, when Marquee Mode
is enabled it becomes a scrolling list.



Vision Alarm Status - Acknowledgement

Using Alarm Acknowledgement

One of the most important things an operator is going to do in the client is acknowledge alarms. On thIS page
Alarm acknowledgement is built-in to the Alarm Status Table component. As soon as the operator
selects and presses the Acknowledge button, the current state of the alarm will change, and the

operator's credentials and the time the alarm was acknowledged will be recorded in the Alarm
Status Table.

® Using Alarm
Acknowledgement

® Security for Alarm
Acknowledgement

The Alarm Status Table component allows you to select an individual alarm or multiple alarms.

You can also use the Shift+Click multi select feature to select a range of alarms, or the Select All
checkbox in the header bar. Check all the alarms you want to acknowledge, and press the Acknow
ledged button. In this example, two alarms were checked, and two alarms were Acknowledged at
the same time. The Alarm Status Table will record the time the alarm was acknowledged and the
user that acknowledged the alarm.

Command  Windows _ Help.

/2, Alarms

a Active Time. Display Path Priority _ Event Value Ack'ed B) Ack Time Current State.
rv5922 0|ttt smpsnowmps e [s0 | 3
175928 vttt smmpow g e (3| | [newe,

o930 0 st nmpsnowmps el _[19 | 3

ster . AM ur y
7 Scheduies Ll -
6713715,5:18 AM_|Witeablenrceablinegert Lon Tank Lew | a

:
Alarm Status

Acknowledgement

ity

ey

Watch the Video

If you don't have the Ack'ed By or Ack Time column in the header of the Alarm Status Table, you
can simply add them in the Designer in Preview Mode as well as in the Client. Right click on the
header bar, and from the dropdown list check Ack'ed By and Act Time, and any other information
you want to display or remove from the Alarm Status Table.

Active Time Display Path Eventialie Priorine ack'ad By AckTime Current State

L e R el Auto Resize This Column Active, Unack... [8
P L e L IRy AutoResize All Columns 5
6/17/19,9:22 AM | Motors/Motor 3/Ar s/Low Ar

e Hide This Column "Bisplay Patt
6/17/19,9:30 AM | Motors/Motor 2/Amps/Low Arf

Show Al Hidden Columns
6/17/19,9:31 AM | Motor Plant/Motor 3/Amps/Ld
6/17/19,9:33 AM | Motors/Motor 5/Amps/Low Alf Ack Notes
6/17/19,9:34 AM | Motors/Motor 1/Amps/Low Arl [+ JRFYS S i
h B AckedBy

Active Pipeline

AM
6/17/19,8:43 AM_| Motors/Mator 6/Amps/Low Am|
Ack Pipeline

6/17/19,8:43 AM_| Motors/Motor 6/Amps/Low Am
L ] (4 Active Time

Clear Time

Clear Pipeline

@ Eventvalue

If any of the selected alarms require Acknowledgement Notes, a small window will appear in
which the operator will be required to add notes, otherwise, the alarm cannot be acknowledged. If
the operator wants to cancel the Acknowledgement Notes and close the window, click on the Searc

h 'O icon or Expand icon to close the Acknowledgement Notes window.

Acknowledgement Notes are setup on the alarm's configuration settings. To setup
Acknowledgement Notes, go to your alarm configuration settings and set 'Ack Notes Required’


https://inductiveuniversity.com/video/alarm-status-acknowledgement/8.0

to 'true.' For more information refer to Configuring Alarms.
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‘Acknowledgement

Engine recalibrated. Issue resolved|

Acknowledge Shelve iz = |

Security for Alarm Acknowledgement

If you want to restrict who can use the Acknowledge button, there is the Show Ack Button in the Property Editor that can be set to 'False." B
y setting the Show Ack Button to 'false,’ this hides the Acknowledge button on the Alarm Status Table.

In order for operators to acknowledge alarms, the correct permission must be assigned. This example shows how to set permissions to
acknowledge alarms for users in the Operator role. You can setup permissions for any role, user and user source in your system.

1. Select the Alarm Status Table component, and click the Show Ack Button binding = icon to open the Property Binding window.
2. Under Property Binding Type, select Expression.

3. Click the Function 2 icon and scroll down to Users, and select 'hasRole.' This enters the function name.

4. Edit the expression to read: hasRole("Operator")

5. Click OK.

If you currently have the "Operator" role you will notice that the Show Ack Button property is now 'true,' otherwise, it will be 'false.’
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Show Details Burton true B Browse Advanced > i
Show Chart Button e SQL Query Aggregates > |
Show Manage Shelf Butt.. true Alarming » |
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Vision Alarm Status - Shelving

Another important feature of the Alarm Status Table is the capability to shelve alarms. Shelving
alarms allows you to temporarily silence an alarm for a fixed period of time. This feature is .
extremely handy when an alarm is already active and you want to temporarily surpress the alarm On this page
while you're working on the issue. The Alarm Status Table component will not send any
notifications while the alarm is shelved, and will be temporarily dropped from the Alarm Status list

so operators don't get confused and think it's active. When the shelved time period is up and if the
alarm is still active, it will return into the Alarm Status list.

® How to Shelve an

Alarm
{:D Active Alarms ® Custom Shelving
Duration
Active alarms must be present in the Alarm Status Table before you can shelve an
alarm.

How to Shelve an Alarm @ INDUCTIV]

To shelve an alarm, select one alarm or multiple alarms, then press the Shelve button. The Shelvi
ng tab will automatically open so you can set a duration to silence an alarm You can set a

duration from 5 minutes to 4 hours in which to shelve selected alarms. Choose the duration and
click Apply.

Alarm Status -
a Active Time Display Path

Priority __Event Value Label Ack'edBy  Current State g

6/17/19,3:11PM  Tank100 High 0 Low SP

o e I T R Watch the Video
[or719,511 74| orosaiowr sampson - [crocal [ [towames | | clearequn |

6/17/19,3:11PM___| Motors/MMotor 6/Amps/low .. |Criical |53 [towAmps | |Cleared Un..

Shelving
Shelve the selected alarm(s) for:

5 minutes

Shelve

-
- 15 minutes ¢0 ’-I @

1 hours
2 hours
4 hours

To view all the alarms that are currently shelved, go to the bottom right of the Alarm Status Table and click on the Shelved Alarms @ icon
A Shelved Alarm tab will open and show all of the shelved alarms, as well as when the shelved time period expires. To close the Shelved

bt
Alarm tab, click either the Shelved Alarm @ icon or the Expand button ™ icon.

After the amount of time expires on a shelved alarm it will be evaluated, and if it is still active, it will automatically return to the Alarm Status

list. If the alarm transitions to a cleared state during the time shelved period, the alarm will show up as 'Cleared' in the Alarm Status list
instead of 'Active.'
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Active Time Display Path Priority Event Value Label Ack'ed By  Current State

6/18/19,9:23AM | Motors/Motor 2/Amps/Low... a6 [LowAmps |  [Active, Una.. |8
6/18/19,9:25AM | Motors/Motor 3/Amps/Low... a8
,9:2 ...| Criti 23

[cowamps | [active,una_

6/18/19, 9:26 AM Ramp/Ramp8/OPC Alarm High 384.48 OPC Alarm Active, Unac...

6/18/19, 9:14 AM Motors/Motor 4/Amps/low... |Critical |53  |lowAmps | | cleared, Un..

Shelved Alarms I ¥

6/18/19,9:26 AM | Motor Plant/Motor 2/Amps

Path Shelved By | Expires ®
providefaulti/tag:Tank Level:/alm:Low SP | admin 3 minutes, 9 seconds
prov:default/tag:Speed:/alm:High Speed admin 4 minutes, 52 seconds

» u[5]

To unshelve an alarm, select one or more alarms under the Shelved Alarms tab, click the Unshelved link, and the alarm will return back to
the Alarm Status list.

Active Time Display Path Priority Event Value Label Ack'ed By  Current State

6/18/19, 9:52 AM Ramp/Ramp8/OPC Alarm High 393.2 OPC Alarm Active, Unac...
6/18/19,9:36 AM___| Motors/Motor 6/Amps/Low ... | Critical |51 [towAmps | [Cleared Un.. |
Shelved Alarms ¥
Path Shelved By = Expires -

providefault/tagTank Level/alm:Low SP | admin 3 minutes, 26 seconds

providefault/tag:Speed:/alm:High Speed m

I Unshelve I

A 8B

Go to Preview Mode and test out shelving some of your alarms.

Custom Shelving Duration

The shelving duration values on the Alarm Status Table component can be customized. By default, the component has several shelving
preset times, but you can add or remove times based on your requirements. One thing to note when modifying the shelving times, is that
there is no option to set a shelving time indefinitely. Shelving times are meant to be temporary, not long term.

In the Property Editor, there is a property called Shelving Times. This is where you can add, remove, or change the shelving times for
alarms. In the following example, 90 minutes was added to the list of shelving times.

2]
1. Select the Alarm Status Table component, and click on the DatasetViewer B icon next to the Shelving Times property to open
the Dataset Viewer.

-

m
2. Select a row and click the green Add Row = icon to insert a new row. Enter the amount of time and unit of time (i.e., 90 minutes).
3. Click OK.



Vision Property Editor a - X
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¥ Data
Selected Alarms <No Data> B e
Dataset Editor D X
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. = -
Quality Good # co || amount unit =
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15 | minute w
30 | minute b
| 90 | minute |
1 hour '
2 | hour -
4 | hour L
]
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4. To verify your new time was entered correctly, select the alarms you want to shelve and click the Shelve button.
5. Choose 90 minute shelve time from the dropdown list. Click Apply to temporarily silence your alarms. Note, you may need to close
and reopen your window to see the new shelve time duration.

-] Active Time Display Path Priority  Event Value Label Current State
[nctive, unece

= Speed/High Speed High m High Speed
6/18/19, 12:42 PM Critical Low Alarm Cleared, Unac...

“Shelving v

Shelve the selected alarmi(s) for:
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© 5 minutes

15 minutes Shelve P H
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Vision Alarm Status - Tag History and Alarm

The Alarm Status Table component has a unique feature built into it that lets you view the actual
trend of a Tag's value and an alarm's history for any alarm that is currently active. It shows you
exactly where the alarms occurred, when it was cleared, and when it was acknowledged.

For the trend feature to work, you must have your Tag history setup so it's logging to the Tag
Historian as well as an Alarm Journal Profile configured so that the log history gets logged to a
database. As long as both the Tag Historian and Alarm Journal are configured, you will see the
trend for any given alarm that is currently active or in the Alarm Status Table list.

The Tag Browser will display the Tag History‘E]I icon when alarm history is enabled.

Tag Browser o - X
Q o ¥- A K906 B

» % Pressure Memor 125 Integer A& ~

» % Speed Memory 109 Integer l.

» % Tank Capacity Memory Integer

» % TankLevel OFC 12 Float &

» % TankLevel 2 OFC 55 Float (&

b % Temp Memory 32 Integer & .

Alarm Journal Property

If you have more than one alarm journal configured, the Journal Name property field is
blank. Make sure you enter the name of the Alarm Journal you intend to use, otherwise
your alarm log history will not get logged to the database.

B

In the Alarm Status Table, select any alarm and click on the Trend 'le icon located on the bottom
right of the table. The Trend Chart shows you the trend of the selected alarm's value over time.
You can look at the last 5 minutes, 30 minutes, 1 hour, 8 hours or up to 24 hours to view the exact
history of that Tag's value, as well as all the alarms that occurred over time.

The yellow triangles denote when the alarm was active, the green circles identify when the alarm
was cleared, and a vertical black bar shows when the alarm was acknowledged. It's all built into
the Alarm Status Table component and you don’t have to go to a separate window to view an
alarm trend or alarm history.
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Related Topics ...

® Configuring Alarms
¢ Alarm Journal
® Configuring Tag History

History

@ INDUCTIV]I
UNIVERSI]

Alarm Status - Tag
History and Alarm
History

Watch the Video
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Using Alarm Status Tags in Vision

Ignition displays four Gateway System Tags that give you the number of alarms that are Active
and Acknowledged, Active and Unacknowledged, Cleared and Acknowledged, and Cleared and
Unacknowledged. A quick way to see if any alarms are active, and to get an active alarm count is

to add a Label component on a Vision navigation window.

Add a Label with Alarm Status

Let's setup an Active Alarm on a Navigation window using a Label component for the Active and UnAcked Tag showing how many alarms
are currently active and unacknowledged.

@ INDUCTIV]I
UNIVERSI]

Alarm Status Tags

Watch the Video

1. Inthe Project Browser open your Navigation window, and drag in a Label component and name it "Active Alarms." This
example uses a Tree View as the navigational component.

2. Next, we need to link the Label to the alarm Tag, but first we'll need a custom property. In the Property Editor, right click on the Lab
el component, and select on Customizers > Custom Properties. The Custom Properties window will open.

3. To add a custom property, click the Add + icon, and enter the name 'activeAlarms' with an 'integer' data type. Click OK.

Custom Properties

MName

activealarms

Type
Integer

Description

OK

Cancel

=

m

4. You'll find your new custom property in the Property Editor under the Custom Properties category. Now, let's bind our new custom
property, ‘activeAlarms' to the 'Active and Unacked' Tag. Select the binding == icon next to the 'activeAlarms' property. The

Property Binding Window will open.
5. Select Tag type and choose the System > Gateway > Alarming > Active and Unacked Tag.

6. Click OK to save.
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Vision Property Editor
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Cursor Default v & i ~ & Alarming
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7. Now, let's display the number of alarms that are active on the Label. Bind the Text property of the Label to the following expression.
Click on the binding == icon for the Text property and select the Expression binding type.

8. Copy and paste the following expression in the Expression area. You'll notice the the expression contains a literal string value *
Active Alarms." Click OK twice.

{Root Container.Active Al arms.activeAl arms} + " Active Al arns"

Property Binding: Root Container.Active Alarm X

Tag Expression

Tag Binds to an expression involving any number of components' properties and/or tags
Indirect Tag
Property Expression
Property %
sqQL +

1 {Root Container.Active Alarm.activeAlarms} + " Active Alarms" ~ [=

Named Query b3
DE Browse

SQL Query

® No Binding

You can also create the expression by navigating to the custom property (i.e., activeAlarms). Ignition will build the expression for

you. Click on the binding == icon for the Text property and click on Expression. Click the Property [l icon and select the active
Alarms property, then click OK to save the property. Click OK again to save your binding.
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9. The last thing to do is setup a style to make the Active Alarms label stand out on the Navigation window. Let's change the color to
something bright and make it blink. Right click on the Label and select Customizers > Style Customizer.
10. For the Driving Property, select ‘activeAlarms.' For the Available Properties, select (one at a time): Background Color, Foregro

=Y

und Color, Border and Visible, and click on the green arrow pointing to the right and add them to the Used Properties list.

3 style for Active Alarm *
Data Quality Available Properties: Used Properties:
Fill Background Cursor = Background Color
Image Path Data Quality Border
Text Disabled Image Path =Y Foreground Color
Visible Enabled Visible
Fill Background -
Font
Horizontal Alignment v

11. Under the Styles section, click on the Add + icon twice times to add two Values. Click the Expand ¥ jconto open and
customize the style for the Active Alarm Label. Set the following values for Styles:

Value 0

Background Color: Red
Border: Etched (Raised)
Foreground Color: White
Visible: check the box

Value 1
Click the Animate box. Use the green plus icon to add 2 animation steps. Change the values to

Step 1 Duration: 1000
Background Color: Red
Border: Etched (Raised)
Foreground Color: White
Visible: check the box

Step 2 Duration: 1000
Background Color: Yellow
Border: Etched (Raised)
Foreground Color: Black



Visible: check the box

Click OK.
Style for Label b4
Data Quality Available Properties: Used Properties:
Fill Background Cursor & Background Color
Data Quality Border
Disabled Image Path Foreground Color
Enabled Visible
Fill Background
Font
Horizontal Alianment o
Value Preview
0 12 Active Alarms A~
Animate
Background Color Border Foreground Color Visible
I .. | FrchediRaised)  w v & m
1 12 Active Alarms ~
2 Animate
Step Duration (ms) | Background Color Border Foreground Color | Visible =
1000 | 5. | ciched (Raised) ~ - @
1000 v &,/ | Etched (Raised) « /_ % B
+ |0 W
0K Cancel

Now, you have a label on the Navigation window that provides an active alarm count and blinks when there is an active alarm.
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Vision Alarm Journal Table - Common Tasks

The Alarm Journal Table has a lot of configuration options that can be used to do things like filter

the list of alarms being displayed, to changing how the component displays them. Each of the .

pages in this section goes over setting up various aspects of the Alarm Journal Table. Note that an On this page
Alarm Journal must first be set up with a valid database connection for the Alarm Journal Table to

see alarm history from the database.

Vision Alarm Journal - General Filtering * Vision Alarm
Journal - General
o ) . ) Filtering
The Alarm Journal Table component has many built in properties that allow you to filter on various ® \Vision Alarm
parts of an alarm. Learn about the different built in filtering options that the Alarm Journal Table Journal - Filter on
provides. Associated Data

® Vision Alarm
Journal - Filter on

Vision Alarm Journal - Filter on Associated Data « Vision Al
Journal - Focusing

The Alarm Journal Table provides the ability to write scripts to filter the alarm history being on Alarms

displayed. While the script can filter on any properties of the alarm, this page goes over how to ® Vision Alarm

filter on the user created associated data properties. Journal - Row Styles

® Vision Alarm
Journal - Searching

Vision Alarm Journal - Filter on Date Range

The Alarm Journal has start and end date properties that determine the time range from which to grab the alarm history. This can be bound
to a Date Range component that allows you to filter for specific alarm events by choosing a start date and end date.

Vision Alarm Journal - Focusing on Alarms

Sometimes, it may be useful to see only specific events in the history. Without changing the filters, the Alarm Journal Table allows you to focu
s on a specific alarm, and see all instances of it by filtering out other events.

Vision Alarm Journal - Row Styles

The Alarm Journal Table colors each row a specific way depending on what type of event it is. These Row Styles can be completely
configured, allowing you to not only change the colors and fonts for different events, but also to setup rows styles on based on other
properties as well.

Vision Alarm Journal - Searching

The Alarm Journal Table has a built in search tool that allows you to search for specific events based on a set of keywords or priorities.

In This Section ...
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Vision Alarm Journal - General Filtering

G} Alarm Journal Profile

To view alarm history, an Alarm Journal Profile must be created first before logging
alarms to the database.

Alarm Journal Table Filtering

Ignition provides a host of filters to view alarm history data in the Designer and Vision Client. Not
only can you filter the Alarm Journal Table on a date range to see alarm history data within a
specific time period, but there are also a number of other filters you can use as well.

In the Designer you can filter alarms using the filter properties in the Property Editor. In the Vision

Client, you can filter alarms by clicking on the Filter icon at the bottom of the Alarm Journal
Table.

Filtering in the Designer

In the Designer, drag an Alarm Journal Table component into your window. By default, Ignition
filters on four different type of alarm events: System Events, Active Events, Cleared Events and
Acked Events. It also filters on all alarm priorities ranging from Diagnostic to Critical. In the
Property Editor you can see each type of alarm event. You can show only those alarm events you
want to see by checking the specified alarm event and leaving the other events unchecked.

When an Alarm Journal Table component is initially placed on a Vision window, the
table displays the last 8 hours of alarm events stored in the Alarm Journal Profile. From
here, you can filter alarms using the host of filtering properties in the Property Editor to
expand or narrow the list of alarms.

On this page

® Alarm Journal Table
Filtering
® Filtering in the
Designer
® Filtering in the
Client
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Alarm Journal -
General Filtering

Watch the Video
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You can also filter on Source Path, Priority, Display Path properties, and even create your own Search String. In the following example,
we searched the Display Path for 'Sine' and 'Speed' and applied a basic filter to show only Active and Acked events as you can see by
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the different alarm state colors. We also set the Priority to see 'Medium' to 'Critical' alarms. You can see that all the 'Sine' and 'Speed’
results are shown in the 'Display Path' column of the journal table.

In Preview Mode and in the Vision Client, you can right click in the column header to show or hide columns, reorganize the columns, and
resize the columns. You can also sort by column by simply left clicking, or sort by multiple columns by holding the Ctrl key while clicking the
column headers. You will see small numbers next to the column header to indicate the sort order and direction (ascending vs descending).
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121 E— R A 5 |84s20,3:43PM Sine/Sine0/High level Active Critical 6.169 High level
D En 7 | 8/4/20,3:43 PM Sine/Sine0/High level Ack Critical High level
7 8/4/20, 3:43 PM Sine/Sine2/Low Level Active Critical 19.8676 Low Level
}» Behavior 1
» Data EL 8/4/20, 3:43 PM Sine/Sine2/Low Level Ack Critical Low Level
E 8/4/20, 3:42 PM Speed/High Speed Active Critical 109 High Speed
} Appearance -
Fir 8/4/20, 3:42 PM Speed/High Speed Active Critical 110 High Speed
~ Filters 7
o 1 | 8/4/20,3:41 PM Sine/Sine0/High level Active Critical 32.656 High level
System Event: @ . . .
ystem Events e T 8/4/20, 3:41 PM Sine/Sine0/High level Ack Critical High level
e E.L 8/4/20, 3:38 PM Sine/Sine0/High level Active Critical 6.4931 High level
Cleared Events false @| | - B8/4/20,3:38PM Sine/Sine0/High level Ack Critical High level
‘Acked Events true | |7 | 8/4/20,3:38 PM Sine/Sine1/High Level Active High 86.8982 High Level
7 8/4/20,3:38 PM Sine/Sine1/High Level Ack High High Level
Source Filter s e ]
1 8/4/20, 3:36 PM Sine/Sine0/High level Active Critical 32.4087 High level
ey ) (|
Provider Filter # 29| g 8/4/20, 3:36 PM Sine/Sine0/High level Ack Critical High level
I Display Path Filter ~ *Sine* *Speed* I se| |1 8Mr0 335PM Sine/Sine2/Low Level Active Critical 205186 Low Level
Search String #ea| | ] | 8/4120,335PM Sine/Sine2/Low Level Ack Critical Low Level
8/4/20, 3:33 PM Sine/Sine0/High level Active Critical 6.8397 High level
Min Priority Medium v &2 [3] |
o]
Max Priority Critical veo||" 636events ¢ L P

You can also filter alarms based on a Tag Path and Tag Provider. If you configure alarms in particular folders, you can use the Source Filter
to find alarms by Tag Path. In this example, *Sinel* was entered using wildcards in the Source Path field to find all the 'Sinel' alarms that

are Active and Acked in all the 'Sine' folders with a Priority of ‘Medium' to 'Critical.’

Project Browser o - X L M nnn o Itih By 28 I 2t nn o n . IFid L
Q Al
] Event Time Source Path Event State Priority Event Value Label
T Dar;kf\:acrmst . "1 2 8/4/20, 10:08 AM providefault/tag:Sine/Sine1:/alm:High Level |  Active High 81.6444 High Level B
oot Container
I... 9 ey o] Nk 8/4/20, 10:08 AM providefault/tag:Sine/Sine1:/alm:High Level | Ack High High Level
T | 8/4/20,10:01 AM prov.default/tag:Sine/Sine1:/alm:High Level |  Active High 80.8118 High Level
Vision Property Editor 2 - XY 8201001 AM | providefault:tagSinesSinet Jalm:High Level |  Ack High High Level
18] 12 S =E % 7 B/4/20,9:53 AM prov.default/tag:Sine/Sine1:/alm:High Level |  Active High 81.8684 High Level
» Common 7 | B4/20,9:53 AM prov.default:tag:Sine/Sine1:/alm:High Level | Ack High High Level
» Behavior B 8/4/20, 9:46 AM prov.default/tag:Sine/Sine1:/alm:High Level | Active High 81.0597 High Level
» Data 5_ 8/4/20, 9:46 AM providefault/tag:Sine/Sine1:/alm:High Level | Ack High High Level
a
» Appearance 1 8/4/20,9:39 AM prov.default/tag:Sine/Sine1:/alm:High Level | Active High 82.1636 High Level
- Filters 1 B/4/20,9:39 AM prov.default/tag:Sine/Sine1:/alm:High Level | Ack High High Level
] B/4/20,9:32 AM prov.default/tag:Sine/Sine1:/alm:High Level | Active High 81.3958 High Level
System Events false [==]
3] BA4/20,932AM prov.default/tag:Sine/Sine1:/alm:High Level | Ack High High Level
Active Events true 2 0 8/420,9:25 AM prov.default/tag:Sine/Sine1:/alm:High Level | Active High 80.4957 High Level
Cleared Events false ©D| | 7 | 8/4/20,9:25AM provdefault/tag:SinesSine1:/alm:High Level | Ack High High Level
Acked Events true G| | 1 8/4/20,9:18 AM prov.default/tag:Sine/Sine1:/alm:High Level | Active High 81.5334 High Level
I Source Rlter Fr—— 7 eo] |1 8/4/20,9:18 AM prov.default/tag:Sine/Sine1:/alm:High Level | Ack High High Level
& 8/4/20,9:10 AM prov.default/tag:Sine/Sine1:/alm:High Level | Active High 80.6651 High Level
Provider Filter ] }
| 8/4/20,9:10 AM prov:default:tag:Sine/Sine1:/alm:High Level | Ack High High Level
Display Path Filter s e ] 8/4/20,9:03 AM providefault/tag:Sine/Sine1:/alm:High Level | Active High 81.6941 High Level
Search String s e | ] 8420, 9:03AM prov:default:tag:Sine/Sine1:/alm:High Level | Ack High High Level
Min Priority Medium veo 5 8/4/20, 8:56 AM providefault/tag:Sine/Sine1:/alm:High Level | Active High 80.8385 High Level ]
[
Max Priority Critical v e a_ 134 events * PP

You can also filter on alarms by Name using the Display Path filter, which is the alarm name that was setup when you configured the alarm.
In this example, 'High Speed' was entered in the Display Path field to find all the alarms in the system with a ‘High Speed' name, and a Pri
ority of '"Medium' to ‘Critical.’
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Vision Property Editor g - X T T L T - S S - T T S SO L P S S T I L LI T I
15| 1 A 9 = = —
Event Time Source Path Display Path Name Event State Priority EventValue
» Data ] | B/4/20,454PM provdefaultftag:Speed:/alm:High Speed  Speed/High Speed | High Speed Active Critical 112
» Appearance 1 | 8/4/20,454PM  prov.default:/tag:Speed:/alm:High Speed  Speed/High Speed | High Speed Ack Critical
- Filters T 8/4/20, 454 PM  prov:default:/tag:Speed:/alm:High Speed  Speed/High Speed | High Speed Active Critical 102
[ ’ . . . . ’
System Events false o g 8/4/20, 4:54 PM  prov:defaulttag:Speed/alm:High Speed  Speed/High Speed | High Speed Ack Critical
7 | 8/4/20,4:53PM  provdefaultftag:Speed:/alm:High Speed  Speed/High Speed | High Speed Active Critical 110
Active Events true (==}
7 |8/4/20,4:53PM  providefaultftag:Speed/alm:High Speed  Speed/High Speed | High Speed Active Critical 105
Cleared Events false 11 B/4/20,342PM  provdefault/tagSpeedi/alm:High Speed  Speed/High Speed | High Speed Active Critical 109
Acked Events true (=] { 8/4/20,3:42 PM  providefault:tag:Speed/alm:High Speed  Speed/High Speed | High Speed Active Critical 110
a
Source Filter -] ]
Provider Filter -] 9
I Display Path Fiter ~ *High Speed* ra c—:l ]
3]
Search String -] &
Min Priority Medium v G 1 DEELE ¢ PP
Max Priority Critical v @D ]

You can also create your own Search String to find specific alarms, events, and conditions. In this example, 'High Speed' and 'High Level'

were entered

in the Search String field to find all alarms that matched the string criteria.

Vision Property Editor a - X oo i n Bl nn [ [E e nn Erinn i nn
= | s = = |5 . 5 = - =
B4 SEn 1] Event Time Display Path Name Event State Priority Event Value
» Common ] 8/4/20, 4:56 PM Sine/Sined/High level High level Ack Critical &
} Behavior ] |8/4/20,4:56 PM Sine/Sine1/High Level High Level Active High 88.8315
» Data T B/4/20,456 PM Sine/Sine1/High Level High Level Ack High
» Appearance o 8/4/20,454PM Speed/High Speed High Speed Active Critical 112
+ Filters 1 |8/4/20,454 PM Speed/High Speed High Speed Ack Critical
System Events false e | ] 8/4/20, 454 PM Speed/High Speed High Speed Active Critical 102
8/4/20, 4:54 PM Speed/High Speed High Speed Ack Critical
Active Event: ! e ]
ctive Fvents rue gl 8/4/20, 453 PM Sine/Sined/High level High level Active Critical 57323
Cleared Events false 9 o 8/4/20, 4:53 PM Sine/Sine0/High level High level Ack Critical
Acked Events true GD - ] | 8/4/20,453PM Speed/High Speed High Speed Active Critical 110
Source ilter F e | ] |8/4/20,453PM Speed/High Speed High Speed Active Critical 105
3 N 1 8/4/20, 451 PM Sine/SineD/High level High level Active Critical 32,987
Provider Filter s e 3 A . . -
o] | 8/4/20,451 PM Sine/SineD/High level High level Ack Critical
Display Path Filter 7€ 18420, 4:49 PM Sine/Sine1/HighLevel  High Level Active High 87.9436
Search String *High Speed*, *High Level* c—:l 1 |8/4/20,4:49 PM Sine/Sine1/High Level High Level Ack High
Min Priority Medium v e 8/4/20, 4:48 PM Sine/Sined/High level High level Active Critical 6.0588
o . ] | 8/4/20,4:48 PM Sine/Sined/High level High level Ack Critical
Max Priority Critical M o I PSSR i AR i deeen Mimk et s itinmt — v
~ Deprecated 1 526 events * )0 F?

Filtering in the Client

You can filter alarms in the Vision Client using the Filter tab by clicking on the Filter ? icon at the bottom of the Alarm Journal

Table. Let's filter on Priority using the Filter tab. When you first open the Alarm Journal Table, it displays every single alarm on all the
priorities from Diagnostic to Critical. If all you want to display is High to Critical alarms, select ‘High’ from the first Priority dropdown on the
left and ‘Critical’ from the second dropdown box. You'll notice a Search field and System, Active, Cleared and Acked alarm events are
also available to filter alarms.



In this example, we set the Search filter to find all 'Sine0' Active and Acked alarm events with a Priority of 'Critical." To close the Filter

tab, click on the Filter ?icon or the Expand ¥ icon.

Event Time Display Path Name Event State Priority Event Value
8/4/20, 4:58 PM SinefSine0/High level High level Ack Critical =
8/4/20, 4:56 PM SinefSine0/High level High level Active Critical 33.2311
8/4/20, 4:56 PM SinefSine0/High level High level Ack Critical
8/4/20, 4:53 PM SinefSine0/High level High level Active Critical 5.7323
8/4/20, 4:53 PM Sine/Sine0/High level High level Ack Critical
8/4/20, 4:51 PM Sine/Sine0/High level High level Active Critical 32,0987
8/4/20, 4:51 PM Sine/Sine0/High level High level Ack Critical
8/4/20, 4:48 PM Sine/Sine0/High level High level Active Critical 6.0588
8/4/20, 4:48 PM SinefSine0/High level High level Ack Critical

Filter ¥
Search
Priority
:
System Events Active Events Cleared Events Acked Events
false true false true
384 events & PP

All of the Alarm Journal Filter properties are bindable so you can design your Visions windows and let the operator choose and filter the
alarm data based on how they want it displayed.

Related Topics ...

® Configuring Alarms
® Alarm Journal


https://legacy-docs.inductiveautomation.com/display/DOC80/Configuring+Alarms
https://legacy-docs.inductiveautomation.com/display/DOC80/Alarm+Journal

Vision Alarm Journal - Filter on Associated Data

1 Configuration of Alarm Journal Profile, Alarms and Associated Data .
. . _ On this page
This section assumes that an Alarm Journal Profile, alarms, and associated data are

already configured before filtering on associated data in the Alarm Journal Table. To
learn more, go to the Configuring Alarms, Alarm Associated Data, and Alarm Journal
pages.

® Set Up the Alarm
Journal to Filter on

Just like the Alarm Status Table you can filter the Alarm Journal Table based on associated data Associated Data

that you added to your alarms.

Set Up the Alarm Journal to Filter on
Associated Data

. R | _ @ INDUCTIV]
It's a common design practice to associate alarm groupings on associated data of an alarm. If you

create alarm groupings on associated data of an alarm, you'll most definitely want to filter on your U NIVE RS I']
associated data in the Alarm Journal Table. Associated data is outside the Source Path and

Display Path, and scripting gives you the ability to filter on associated data using the ‘filterAlarm' e

xtension function. It also gives you the freedom to filter on anything that you want, such as alarms

in another area of the plant or for a certain set of alarms. The script is only going to show you the Alarm Journal -

alarms matching the associated data. You can also add other filters as well. Eilter on

In the following example, we'll use the 'filterAlarm' extension function to filter on associated data, Associated Data
but first we need to add associated data on an existing alarm.

Watch the Video

1. This example uses a Memory Tag called 'Speed' that has an alarm configured called ‘High Speed'. An asssociated data property
was added to the alarm called 'Group' with a static value of 'Production.' You can filter on what is shown in the alarm list of the
Alarm Journal Table based on the associated data. In this example, we are going to filter on a 'Group' called 'Production.'


https://www.inductiveuniversity.com/videos/alarm-journal-filter-on-associated-data/8.0/8.0
https://legacy-docs.inductiveautomation.com/display/DOC80/Configuring+Alarms
https://legacy-docs.inductiveautomation.com/display/DOC80/Alarm+Associated+Data
https://legacy-docs.inductiveautomation.com/display/DOC80/Alarm+Journal
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2. Once your associated data is configured in your alarm, setup your script to filter for all the alarms in your history that have the
associated data named 'Group' with a value of 'Production.' Right click on your Alarm Journal Table component and select Scripti
ng. The Component Scripting window will open.

3. On the left side of the window under the Extension Functions folder, click ‘filterAlarm.’'

4. Check Enabled to enable the script, and enter the code you want to filter on for your associated data. The script used in this
example is shown below. If you want to use this example, copy the code from the code block and paste it at the end of the script and
click OK to save your script.

group = al arnEvent. get ("G oup")

if group == "Production":
return True

return Fal se

................1


https://legacy-docs.inductiveautomation.com/display/DOC80/Alarm+Associated+Data

&% Component Scripting [Alarm Journal] - m] *

& Event Handlers < B3 Enabled
>

b i focus

def filterAlarm(self, alarmEvent): &
b il key 2 wirn
b W mouse 3 Called for each event loaded into the alarm status table. Return false to
» i mouseMotion 4 hide this event from the table. This code is executed in a background
» i propertyChange 5 thread.
& Extension Functions b
J¥ createPopupMenu U Arguments:
I 8 self: A reference to the component that is invoking this function.
9 alarmevent: The alarm event itself. Call
/v onDoubleClicked . .
10 alarmEvent.get( 'propertyName’) to inspect. Common properties: 'name’,
& Custom Methods , e
11 source', 'priority’.
+ 12
13 group = alarmEvent.get("Group")
14 if group == "Production”:
15 return TTue
16 return False

0K Apply Cancel

5. The filterAlarm script will find every alarm matching 'Production’ and return 'true' and display the alarms in the journal table. If the
associated data does not match 'Production,’ it will return ‘false' and no alarms will be displayed in the journal table.

Refreshing the Data in the Alarm Journal Table

By default, the Alarm Journal Table does not refresh the data in the table automatically if you are working in the Designer.
Toggle one of the filters on the table to refresh the data and you'll see the table refresh with your associated alarm data. If
you are opening a Client window, the data will automatically refresh.

The alarm list below shows all the alarms with associated data filtering for the 'Group' called 'Production’ within the dates displayed
on the Date Range component.

4| 8 6/24/19 - 6/25/19 @ |y
| — !
T s s e
May 31 Jun 5 Jun 10 Jun 15 Jun 20 Junzg Jun 30
Event Time Display Path Name Event Value EventState Priority
6/25/19,1:07PM  Speed/High Speed High Speed 122 Active High =
6/25/19, 1:06 PM  Speed/High Speed High Speed 97 Clear High
6/25/19, 1:06 PM  Speed/High Speed High Speed Ack High
6/25/19, 1:06 PM  Writeable/WriteableInteger1/Low Tank Level  LowTank Level 15 Active Critical
6/25/19, 1:06 PM  Writeable/WriteableInteger1/Low Tank Level  LowTank Level 66 Clear Critical
6/25/19, 1:05PM  Writeable/WriteableIntegeri/Low Tank Level  Low Tank Level Ack Critical
6/25/19, 8:44 AM  Speed/High Speed High Speed 132 Active High
6/25/19, 8:43 AM  Speed/High Speed High Speed 99 Clear High
6/25/19, 8:43AM  Speed/High Speed High Speed Ack High
6/25/19, 8:43 AM  Writeable/WriteableInteger1/Low Tank Level  LowTank Level 18 Active Critical .
36 events ® 2 P

6. As long as the 'filterAlarm' script is enabled, the Alarm Journal Table will display all alarms matching the criteria for the associated
data. To disable the script, open the ‘filterAlarm' and uncheck Enabled.

Related Topics ...

® Configuring Alarms
® Alarm Associated Data
® Vision Alarm Journal - Filter on Date Range


https://legacy-docs.inductiveautomation.com/display/DOC80/Configuring+Alarms
https://legacy-docs.inductiveautomation.com/display/DOC80/Alarm+Associated+Data




Vision Alarm Journal - Filter on Date Range

G} Alarm Journal Profile and Alarms Configuration

This section assumes that an Alarm Journal Profile and alarms are already configured
before proceeding with filtering alarms using a date range. To learn more about alarms,

go to Configuring Alarms and Alarm Journal pages.

Alarm Journal Table

INDUCTIV]
UNIVERSIT

D

Alarm Journal -
Filter on Date

The Alarm Journal Table displays the complete history of all alarms within a specific time

period. Ignition offers several types of date pickers under the Calendar tab of the Component

Range

Palette, but it's far easier and more common to use the Date Range component for filtering alarms

over time.

Watch the Video

When the Alarm Journal Table component is initially placed on a window, the component shows
the last 8 hours of alarm events stored in the Alarm Journal Profile. Typically, operators want to
filter alarm events within a specific time period rather than scroll through a long list of alarm
events. Selecting Start and End Dates is very easy using a Date Range component.

Setting up Alarm Journal Table to Filter on Date Range

The Start Date and End Date are built into the Date Range component so you can select the Start Date and End Date all in one place.

1. In the Designer, drag the Date Range component from the Component Palette to your window and place it above your Alarm Journal

Table.
4| @ 8/5/2012 AM - B/6/20 12 AIVI| & ([p
P

[ | [ 1

I I I f [ I |
Aug 2 Aug 3 Aug 4 Aug 5 Aug & Aug 7

Event Time Display Path Event State Priority Event Value EventId
8/5/20, 9:06 AM Sine/Sine0/High level  Clear Critical 13.0643 fdeba141-08e2-4783-9a8d-a36bed... ~
8/5/20, 9:05 AM Sine/Sine2/Low Level Active Critical 21.7653 0f767980-6ff8-4132-Ofcc-d4884ec?...
8/5/20, 9:05 AM Sine/Sine2/Low Level Ack Critical 8fd5852b-cdb7-4a03-806a-dc44098...
8/5/20, 9:04 AM Sine/Sine1/High Level  Active High 84.4660 ee99alae-a622-4bel-accb-c28ch2...
8/5/20, 9:04 AM Sine/Sine1/High Level  Ack High 71698964-8bes-48d2-b469-adob5e...
8/5/20, 9:03 AM Sine/Sine0/High level  Active Critical 7.892 fdeba141-08e2-4783-9a8d-a36bad...
8/5/20, 9:03 AM Sine/Sine0/High level  Ack Critical f568601b-f2de-4774-9e51-20782f1...
8/5/20, 9:03 AM Sine/Sine0/High level  Clear Critical 27.3364 cc0fc783-7394-4e509-0c22-254828...
8/5/20, 9:02 AM Sine/Sine1/High Level  Clear High 66.3631 8682d4d5-b5d2-4f51-9aeB-77fea34...
1,081 events ® 2o P

2. Link the Alarm Journal Table component to the Date Range component beginning with the Start Date.

a. Select the Alarm Journal Table component, click the Start Date binding == icon. The Property Binding window will

open.

b. Click the Property binding type.
c. Select the Date Range component's Start Date.
d. Click OK.


https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Date+Range
https://legacy-docs.inductiveautomation.com/display/DOC80/Alarm+Journal#AlarmJournal-CreatinganAlarmJournalProfile
https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Date+Range
https://www.inductiveuniversity.com/videos/alarm-journal-filter-on-date-range/8.0/8.0
https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Date+Range
https://legacy-docs.inductiveautomation.com/display/DOC80/Configuring+Alarms
https://legacy-docs.inductiveautomation.com/display/DOC80/Alarm+Journal
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4/ 8 8/3/20 - 8/5/20 & |p
~ [ Alarm Status2 &
~ [ Root Container [ L |
| | | l | | T
||| Alarm Journal € 6 i Jul'16 Jul 21 1ul 26 Jul 31 ugh
5 Date Range B e
B - . P
Vision Property Editor F_x | Event Time EventId Display Path Event State Priority !
m=T . PPa—— | 8/5/20, 8:41 AM 9daad31a-29be-4638-a567-24225edeefdc  Sine/Sine0/High level Ack Critical )
£ 2| = - ]
Bk = \] PRSSSE ECT———— — critical !
=lCommon Property Binding: Root Container Alarm Journal X | Cloar High 1
]
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3. Now, let's link the Alarm Journal Table to the Date Range component's End Date.

a. Select the Alarm Journal Table component, click the End Date binding == icon. The Property Binding window will open.
b. Click the Property binding type.
c. Select the End Date for the Date Range component.
d. Click OK.
File Edit View Project Component Alignment Shape Tools Help
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| o | \ | \ =
[l [ | Alarm journal G2 6 Jurn Jul'16 Juiz1 10l 26 Jui31 ughs
& Date Range sy s 2
Ty — | EventTime EventId Display Path EventState  Priority |
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Tag Property ]
Enabled Be o) Clear Critical by
o Tag Binds te another compenent's property in the same window Active High ]
Visible [ true e . — ]
Indirect Tag 4 g 1
Border Other Barder _ Jizges) , Choose Property Active Critical 3
~ Behavior D537 ) Date Range A | Ak critical )
Journal Name <auto> Pl Expression B Name (string) ® P g‘;i
Start Date 5 08/03/2020 00:00: w visible pooeary || free et
Read Timeout 60,000 & Named Query
W Quter Range Start (Date)
Touchscreen Mode single-Click ) DB Browse i
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4. The Alarm Journal Table will refresh with all alarm events within that time period. Click on Preview Mode and drag the slider on a
specified date range on the timeline. You can drag or stretch the selection box around the timeline. The selected date range is
always a whole number of units, where the unit is determined by the current zoom level. You can also zoom in or out on specific
time periods to see the alarm events that exist in the alarm history table.



4 = 8/5/2012 AM - 8/5/2011 PM N
| 1 !

Au:; 2 ' Au:; 3 ' ' Au:; s T Au:; 5 ' ' Au:; 6 ' Au:; 7

Event Time Event Id Display Path Event State  Priority
8/5/20, 8:58 AM 320304ec-eab8-4042-9cf8-17ch3a944af2 Sine/Sine0/High level Active Critical s
8/5/20, 8:58 AM 43556908-85b4-4228-89bf-6937fc8cc3ed Sine/Sine0/High level Ack Critical
8/5/20, 8:58 AM 206e29f0-3ece-4080-9eas-ee5c23146226 Sine/Sine0/High level Clear Critical
8/5/20, 8:57 AM 8682d4d5-b5d2-4f51-9ae8-77fea347b05a Sine/Sine1/High Level Active High
8/5/20, 8:57 AM 867dfe3a-df3d-4242-91f2-e9e02cfedf24 Sine/Sine1/High Level Ack High
8/5/20, 8:56 AM 206e29f0-3ece-4080-9eas-ee5c23146226 Sine/Sine0/High level Active Critical
8/5/20, 8:56 AM 1cf37a29-9f4f-4ff2-a5b0-23a99fd1 c2bf Sine/Sine0/High level Ack Critical
8/5/20, 8:56 AM 6fc7d382-6cas-4de4-97a9-c012023fed2e Sine/Sine2/Low Level Active Critical
8/5/20, B:56 AM 73b0cc70-f763-4dff-9222-362428584704 Sine/Sine2/Low Level Ack Critical .
1,068 events ¢ 2B

1 Refreshing New Alarm Events

Alarm Journal Table fetches data only when the window is first opened and when the Start or End Dates change. To see
new alarm events come into the table, use the slider to change the dates.

Related Topics ...

® Vision - Date Range Component


https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Date+Range

Vision Alarm Journal - Focusing on Alarms

The Alarm Journal Table can focus on specific events in the alarm list. The Focus feature filters
out alarms while reducing the number of alarm events displayed in the Alarm Journal Table, thus,
allowing you to view specific instances of an alarm source. You can focus on one Target Alarm
Source or the Target Event Id to look at when alarms occur. It's a nice way of filtering through the
Alarm Journal Table without having to scroll through the entire list of alarms to match up the Alarm
Events, Times and States since the Active, the Cleared and the Acknowledged states are not
going to be in sequential order depending on when the event times actually happened.

The Alarm Journal Table shows you a complete history of all alarm events within a specific time
period which can be quite large. The following examples will show you how to use the focus
feature to pare down the list of alarm events and to focus strictly on those alarms of interest to you.

Using the Focus Feature

The Alarm Journal Table can become quite large with alarm events over a period of time. The Foc
us feature allows you to focus in on one specific alarm and view the history for that alarm using Tar
get Alarm Source and Target Event Id. Notice, the examples on this page are using the Date
Range component to focus on the Target Alarm Source and Target Event Id within a given time
period.

Target Alarm Source

If you want to see alarms from just a single Source Path, select any alarm event in the journal table, click on the Focus Q icon, and choose
Target Alarm Source. This returns the complete alarm history of that Source Path within that given time range. Note, make sure to have

On this page

® Using the Focus
Feature
® Target Alarm
Source
® Target Event Id

your Source Path column set in the journal table. Refer to Alarm Journal Table Component for more information on configuring table

columns.

In this example, we focused on the High Speed alarm with a source path: prov: defaul t: /t ag: Speed: / al m H gh Speed.

4 = 6/26/19 12 AM - 6/26/19 11 PM g | p
I 1 ]
Jur||22 ' Jun|23 ‘ Junl24 ' Junl25 ‘ Jun‘EG ' T JunIZ? ‘ Junl28 '
Event Time Source Path . Display Path EventValue EventState Priority
6/26/19, 1:27 PM  providefault/tag:Motors/Motor 1/Amps:/alm:Low Amps Motors/Motor 1/Amps/Low Amps 50 Active Critical |~
6/26/19, 1:27 PM  prov:default/tag:Motors/Motor 1/Amps:/alm:Low Amps Motors/Motor 1/Amps/Low Amps Ack Critical
6/26/19, 1:27 PM  prov:defaulti/tag:Motor Plant/Motor Z/Amps:/alm:Low Amps ~ Motor Plant/Motor 2/Amps/Low Amps 24 Active Critical
6/26/19,1:27 PM  providefault:/tag:Motor Plant/Motor 2/Amps:/alm:Low Amps ~ Motor Plant/Metor 2/Amps/Low Amps Ack Critical
6/26/19, 1:27 PM  providefault/tag:Motors/Motor 1/Amps:/alm:Low Amps Motors/Motor 1/Amps/Low Amps 53 Clear Critical
6/26/19,1:27 PM  prov:default:/tag:Motors/Motor 1/Amps:/alm:Low Amps Motors/Motor 1/Amps/Low Amps 47 Active Critical
6/26/19,1:27 PM  providefault:/tag:Motors/Motor 1/Amps:/alm:Low Amps Motors/Metor 1/Amps/Low Amps Ack Critical
6/26/19, 1:27 PM  providefault/tag:Speed:/alm:High Speed Speed/High Speed 107 Active High |
6/26/19, 1:27 PM  prov:default/tag:Motor Plant/Motor 2/Amps:/falm:Low Amps ~ Motor Plant/Motor 2/Amps/Low Amps 28 Clear Critical
6/26/19, 1:27 PM  prov:default/tag:Ramp/Ramp8:/alm:0OPC Alarm Ramp/Ramp8/0PC Alarm 37302 Active High -
23,318 events o 0 B
I Target Alarm Source I
Target Event Id

Once the Target Alarm Source option was clicked, all alarm events from the selected Source Path were displayed in the journal table within

the specified date range, including any changes to the state, as well as acknowledgments.
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4 = 6/26/19 12 AM - 6/26/19 11 PM @ P
| — |
_Iun|22 I I Jun|23 I I Junl?_-’l I I Jun|25 I I Junl?_ﬁ I f Junl?_? I I _IunIEE I I
Event Time Source Path Display Path Event V... Event State  Priority
6/26/19,1:53 PM  prov:default/tag:Speed:/alm:High Speed Speed/High Speed 101 Active High
6/26/19, 1:53 PM  prowvidefaulttag:Speed./alm:High Speed Speed/High Speed 99 Clear High
6/26/19,1:51 PM  prowv:default/tag:Speed:/alm:High Speed Speed/High Speed Ack High
6/26/19, 1:48 PM  prowvidefaultitag:Speed.falm:High Speed Speed/High Speed 103 Active High
6/26/19, 1:48 PM  prov:default/tag:Speed:/alm:High Speed Speed/High Speed 96 Clear High
6/26/19, 1:48 PM  prowdefaultftag:Speedyalm:High Speed Speed/High Speed Ack High
6/26/19,1:27 PM  prov:default/tag:Speed:/alm:High Speed Speed/High Speed 107 Active High
6/26/19,1:27 PM  prowv:default:tag:Speed./alm:High Speed Speed/High Speed 90 Clear High
6/26/19,1:26 PM  prowv:defaulti/tag:Speed:/alm:High Speed Speed/High Speed Ack High
9 events }-) ?’

To remove the Focus, click on the Focus L 4 icon again, and you will see all alarms events in the journal table refresh within the given date
range.

Target Event Id

In this example, Mot or s/ Mot or 1/ Anmps/ Low Anps dat ed 6/26/19 at 1:59 PMwith an Active event state was selected and the Tar
get Event Id option was chosen. Note, make sure you have the Event Id column set in the journal table. Refer to Alarm Journal Table
Component for more information on configuring table columns.

4 = 6/26/19 8 AM - 6/26/19 3 PM A
| — |
| o o 1 o o 1 0 o 1 o o 1 "—T" 1 o o 1 o o
Jun 22 Jun 23 Jun 24 Jun 25 Jun 26 Jun 27 Jun 28
Event Time EventId Display Path Event Value Event State Priority
6/26/19,1:59 PM  5d5a562a-10a5-424b-81e5-2c61f2621eeb  Motors/Motor 1/Amps/Low Amps 46 Active Critical |~
6/26/19,1:59 PM  b3aflbca-2a9d-4d22-b769-91a407f39646  Motors/Motor 1/Amps/Low Amps Ack Critical
6/26/19,1:59 PM  f818582¢-5297-4f1a-8193-a0320578407a  Motors/Motor 1/Amps/Low Amps 51 Clear Critical
6/26/19,1:50 PM  ca433c63-acf0-4ebc-bofe-1d7284800e47 Motors/Motor 3/Amps/Low Amps 46 Active Critical
6/26/19,1:59 PM  f3f1cddb-91bc-4e83-9a87-7903e3b3547e  Motors/Motor 3/Amps/Low Amps Ack Critical
6/26/19,1:59 PM  f818582c-5297-4f13-8193-a0320578407a  Motors/Motor 1/Amps/Low Amps 48 Active Critical |
6/26/19,1:59 PM  89d89f8b-2ff3-4aa5-9c21-4cddaabl 7fea Motors/Motor 1/Amps/Low Amps Ack Critical
6/26/19,1:58 PM  ac1a8c0f-ec26-45f0-a1bb-ec10d318ea%a Motors/Motor 4/Amps/Low Amps 51 Clear Critical
6/26/19,1:58 PM  2d4a7902-ba33-472b-8d39-1025a8901a13 Motors/Motor 1/Amps/Low Amps 54 Clear Critical
9,136 events a0 %
| Target Alarm Source
I Target Event Id I

The Target Event Id returned all the alarms events with that specific Event Id during within the given date range. You can see when the alarm
went Active, Cleared, and Acknowledged.
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4| & 6/26/19 8 AM - 6/26/19 3 PM @ b
| m—
|I 0 o 1 0 0 1 0 0 1 0 0 1 l—l 1 0 0 1 0 0 I
Jun 22 Jun 23 Jun 24 Jun 25 Jun 26 * Jun 27 Jun 28
Event Time EventId Display Path EventValue EventState Priority
6/26/19, 2202 PM  f818582c-5297-4f13-8193-a0320578407a Motors/Motor 1/Amps/Low Amps Ack Critical
6/26/19,1:59 PM  f818582c-5297-4f13-8193-a0320578407a  Motors/Motor 1/Amps/Low Amps 51 Clear Critical
6/26/19,1:59 PM  fB18582¢-5297-4f13-8193-a0320578407a  Motors/Motor 1/Amps/Low Amps 48 Active Critical
3 events ® P2 D

Click the Focus @ icon to remove the focus, and you will see all alarms events in the journal table refresh within the given date range.



Vision Alarm Journal - Row Styles

The Alarm Journal Table allows you customize row styles for different states of alarm history. Just
like the Alarm Status Table, the Alarm Journal Table comes with a particular set of colors .
associated with each of the alarm states as shown in the image below. You can change these On this page
colors for each of the states by going to the Alarms Styles Customizer that the Alarm Journal Table

component provides.

4= 6/26/19 - 6/28/19 Nl
I f I 1 P
L]
Jun Juns Jun 11 Jun 16 Jun21 wn2s T Jul 1 CUStOlelng Alarm
Row Styles
Event Time Display Path Name  Eventvalue EventState Priority ° :
6/28/19, 10:33AM  Motors/Motor 1/Amps/LowAmps  LowAmps 52 Clear Critical Creatlng Row
6/28/19, 10:53AM  Ramp/Ramp8/OPC Alarm OPCAlarm 3027467  Active High Sty|es for
6/28/19, 10:53AM  Ramp/Ramp8/OPC Alarm QPC Alarm Ack High .
6/28/19, 10:53AM  Motors/Motor 1/Amps/LowAmps  LowAmps 46 Active Critical Different Alarm
6/28/19, 10:53AM  Motors/Motor 1/Amps/Low Amps  Low Amps. Ack Critical States
6/28/19, 10:53 AM Motors/Motor 1/Amps/Low Amps. Low Amps. 52 Clear Critical
6/28/19, 10:53AM  Ramp/Ramp8/OPC Alarm OPCAlarm 1693867  Clear High
6/28/19, 10:53AM  Motor Plant/Motor 2/Amps/LowA.. LowAmps 20 Active Critical
6/28/19, 10:53AM  Motor Plant/Motor 2/Amps/Low ... Low Amps Ack Critical .
89,279 events ¢ PP
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Alarm Journal -
Row Styles

Watch the Video

Customizing Alarm Row Styles

Alarm Row Styles is where you can modify an existing row style, add more styles, or delete a style. The Alarm Row Styles Customizer gives
you a head start for building a new expression. The expression allows you to do any evaluation you want using any filter properties of the
alarm such as Priority, State, Display Path, Active Time, and Clear Time.

In the Designer, right click on the Alarm Journal Table component, go to Customizers > Alarm Row Styles to see the default row styles.
Alarm Row Styles is an ordered list and each style has an expression. How it works is, the first style that returns ‘True’ for a given alarm is
the one that is going to be used. So you want to make sure the order is the correct order that you want. If you want to change the order,

select a row and click on the up or down arrow ﬁ “ icons. Click on each of the row styles to view the expression associated with the row
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style.

Alarm Row Styles >

Row Styles

{isSystemEvent}

{eventState}="Active' |

{eventState}='Clear’

{eventState}="Ack’

X + &=

Expression Standard Blink
1 {eventState}="Active’ ~ | Foreground Fereground
I -
Background Background
v o
Font Font
{ » -
o] Cancel

Creating Row Styles for Different Alarm States

The main reason to create a new row style is for overlapping conditions for styling. Let's create another state alarm with a new row style and
state.

1. With the Alarm Row Styles customizer open, click on the Add + icon.
2. By default, the new alarm state is added to the bottom of the list. The following expression creates a new state for alarms 'Ack by
the user admin.' Copy and paste the expression into the Expression area of the Row Styles window.

3. To make this alarm state catch the attention of the operator, let's make the row style standout by making it blink. Make the
foreground color '‘Black' and the background color 'Yellow." Check the Blink box and make the foreground color '‘Black' and
background color 'Red.’

4. Move the new state for 'Ack by the user admin' above the 'Ack’ state so it gets evaluated first, otherwise if ‘Ack’ state is evaluated
first, it will become 'True' first and the new state 'Ack by the user admin' will never be evaluated.

5. Press OK to save your updates.



S Alarm Row Styles

*

Row Styles
{isSystemEvent}
{eventState}="Active’

{eventState}='Clear’

X + @ =

{ackUser}='usr-prov.default/usr:admin’ |
{eventstate}="Ack'

Expression Standard
1 {ackUser}='usr-prov.default:/usr:admin' |~ | Foreground Foreground
I - N
Background Background
* &, v o
Font Font
¥ A
3 3 -

Now, when the user ‘admin' acknowledges an alarm, it will blink yellow and red in the Alarm Journal Table.

1= 6/28/19 - 6/28/19 e |»
—
[ I [ ]
i i R o o T
May 31 Juns Jun 10 Jun 15 Jun 20 Jun 25 Jun 30
Event Time Source Path Display Path Event Value Event .. Ack'ed By Priority
6/28/19,4:11 PM  prowv.default/tag:Motors/Motor 2/Amps:/alm:Low Amps ~ Motors/Motor 2/Amps/Low Amps Ack Live Even... Critical =
6/28/19,4:10 PM  prowv:default/tag:Motors/Motor 2/Amps:/alm:Low Amps  Motors/Motor 2/Amps/Low Amps 52 Clear Critical
I 6/28/19,4:09PM  prowv:default/tag:Motors/Motor 2/Amps:/alm:Low Amps  Motors/Motor 2/Amps/Low Amps Ack admin Critical I
6/28/19,4:08 PM  prov:default/tag:Motors/Motor 2/Amps:/alm:Low Amps ~ Motors/Motor 2/Amps/Low Amps 46 Active Critical
6/28/19, 408 PM  prowv.default/tag:Motors/Motor 2/Amps:/alm:Low Amps ~ Motors/Motor 2/Amps/Low Amps Ack Live Even... Critical .
2,574 events ¢ 2o D

Refer to the Alarm Event Properties Reference section to learn more about alarm properties and how they are used in the Alarm

Row Style Customizer.
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Vision Alarm Journal - Searching

Using the Search Feature _
On this page

The Alarm Journal Table component can search through alarm history and filter for particular

alarms with any criteria. The Search feature is built into the Alarm Journal Table component and

found on the bottom right side of the table. Click on the Filter ? icon to start your search.

® Using the Search

4 = 6/28/19-6/29/19 & |p Feature
I == |
Jur‘!\ ' ' T Jul‘\ﬁ ' T ‘Junlﬂ ' ' ' ’ Jun‘|6 ' ' T JIH!‘Z\ o ' ' JunIZG ' T ’ Juh
Event Time Display Path Name  EventValue EventState Priority

6/28/19,322PM  Motors/Motor J/AMpSALONAMpS  LowAmps 51 Clear Critical i
6/28/13,322PM  SpeediHigh Speed HighSpeed 95 Clear High
6/28/19,322PM  Motors/Motor AMpSALOWAMpS  LowAmps 49 Active Critical
6/28/19,322PM  Motors/Motor 3/AMPSALOWAMpS  Low Amps Ack Critical
6/28/19,322PM  Ramp/Ramp8/OPC Alarm OPCAlarm 3994667  Active High
6/28/19,322PM  Ramp/Ramp8/OPC Alarm OPC Alarm Ack High
6/28/10,322PM  SpeediHigh Speed High Speed Ack High
6/28/19,322PM  Ramp/Ramp8/OPC Alarm OPCAlarm 2661067  Clear High
6/28/19,322PM  Motors/Motor J/AMpSALOWAMpS  LowAmps 53 Clear Critical v
25,996 events ¢ 0

The Filter tab will open at the bottom of the Journal Table. You can type in any search criteria you want as well as filter on Priority and Event
types. When you hit the carriage return in the Search field, or change the Priority or Event fields, the alarm list will automatically refresh.

This example shows how to find all 'Tank 100" event alarms within the given time period on the Date Range component with a priority of ‘Med
ium' to 'Critical.' You can increase or decrease the size of the Filter window by dragging the top edge up or down. Click either the Expand

% or Filter Eh icons to close the Filter tab window.

9:32:38 AM 7/1/2019

System Events

true

Active Events

true

Cleared Events

true

Acked Events

true

{1 & 6/30/19-7/119 R
| I—
[ | | 1
""'"'"""""""'I—I'T"""'
Jun B Jun13 Jun 18 Jun 23 Jun 28 Jul 3 Jul 8
Event Time Source Path Display Path EventValue EventState Ack'ed By Priority
711719, 913 AM  providefaultftag:Tank Level:/alm:Low SP Tank 100 12 Active High
7/1/19,912 AM  provdefaulti/tag:Tank Level:/alm:High 5P Tank 100 80 Clear High
7/1/19,9:11 AM  prov.defaultitag:Tank Level:/alm:High 5P Tank 100 Ack admin  High
7/1/19,9:07 AM  providefault/tag:Tank Level:/alm:High SP Tank 100 93.2 Active High
7/1/19,9:04 AM  prov.defaultitag:Tank Level:/alm:High 5P Tank 100 77 Clear High
71/19,9:04 AM  providefault/tag:Tank Level:/alm:Low SP Tank 100 99 Clear High
7/1/19,9:04 AM  provdefaulti/tag:Tank Level:/alm:High 5P Tank 100 a9 Active High
71119, 9:02 AM evtAlarms shelved eviAlarms shel... Active Low
7M1/19, 9:01 AM evi:Alarms Shelved eviAlarms Shel... Active Low
Filter ¥
Search
*Tank 100*
Priority
Medium - to Critical -

9 events

G’j’-—)

This example searches the alarm list for all ‘Motors' alarms with 'Active' events and a priority of ‘High' to 'Critical' within the given time
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period on the Date Range component.

10:46:41 AM 7/1/2019

4 & 6/30/19 - 7/1/19 & | p
| —
[ [ [ |
"""""""""""'I—I'T"""'
Jun g Jun 13 Jun 18 Jun 23 Jun 28 Jul 3 Jul B
Event Time Display Path Name Event Value Event State Priority
701119, 9:46 AM Motors/Motor 6/Amps/Low Amps Low Amps 49 Active Critical ~
771119, 9:46 AM Motors/Motor 1/Amps/Low Amps Low Amps 48 Active Critical
771119, 9:46 AM Motors/Motor 2/Amps/Low Amps Low Amps 49 Active Critical
701119, 9:45 AM Motors/Motor 5/Amps/Low Amps Low Amps 49 Active Critical
701119, 9:45 AM Motors/Motor 6/Amps/Low Amps Low Amps 46 Active Critical
701119, 9:45 AM Motors/Motor 2/Amps/Low Amps Low Amps 49 Active Critical
Filter ¥
Search
*Motors*
Priority
IHigh - to Critical - I
System Events Active Events Cleared Events Acked Events
false true false false
458 events & 0

As you can see, the operator has the ability to search and filter on anything they want by entering the alarm criteria in the Alarm Journal

Table filter area.




Reporting in Vision

Included with the Reporting module are many unique Vision components, all of which are added
into a new Reporting section of the Component Palette. The commonly used Report Viewer allows
you to view your reports within a Vision Client. The others, such as the PDF Viewer and Row
Selector, do not directly interact with a Report, but instead enhance the capabilities of your Vision
Clients.

- @ Reporting
Report Viewer

*q Row Selector
£a Column Selector
U] File Explorer

@ PDF Viewer

Report Viewer

The Report Viewer component provides an easy way to view reports in Vision windows. Once you drag a Report Viewer component onto
your window, you choose the report you want to view from the Report Path property dropdown list. Parameters added during report creation
are provided as properties in the Report Viewer, and will override any default values set in the Report Resource. Scroll down to the bottom of

On this page

Report Viewer

® Report Viewer
Properties

® Using the Report
Viewer

® Save and Printa
Report

Row Selector

Column Selector

PDF Viewer

File Explorer

v,

Reports in Vision
Clients

Watch the Video

the Property Editor and you'll see your report parameters available as properties. The Report Viewer allows you to bind your report

parameters to other components on your window.

INDUCTIV]
UNIVERSIT
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Used Car Inventory
April 2020

@ Ford @ Toyota @ Mercedes @ Buick @ Lexus © |eep

Make Quantity

Ford 13
Toyota 22
Mercedes 2
Buick 6
Lexus 7
Jeep 11
( L
100% v M 101 -+ M

Report Viewer Properties

While you're in the Property Editor, take a moment to scroll through all the Report Viewer properties. You'll notice that you can customize the

visual style of your report by adding page number, change the zoom factor, and the background colors of the report. More information on the
Report Viewer's properties can be found in the the Appendix.

Using the Report Viewer

Once you have your reports designed, you're ready to view them in a Vision window using the Report Viewer component. (You need to have
a report created before you can view it using the Report Viewer. For information on how to design a report, refer to Report Design.
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1. Inthe Designer, drag a Report Viewer component to a window.

2. With the Report Viewer selected, go to the Property Editor and set the Report Path property to display any of your existing reports
from the dropdown list.

Vision Property Editor o _ X

l1g ] 12 = = |w-

~ Common =
Mame Report Viewer P
Visible [ true (o]
Border Other Border « # &2

* Behavior

* Data

Crorran [T

Current Page B Carlnventory Report  |© &
Page Count B CrossTab2 b
Z00m Eactor B CrossTabTable &

: B CrossTab Table 2
} Appearance 4
3. Scroll down to the bottom of the Property Editor, and you'll see Report Parameters. This sample report is using a parameter we
called "maximum." Any events that are longer than the duration set in the maximum parameter are highlighted.

Vision Property Editor a _ X

et = =z|w-

~* Common =
MNarme Report Viewer Fal -]
Visible [ true (]
Border Other Border « # c2

F Behavior

> Data
Report Path Downtime v GO
Current Page 1
Page Count 2
Zoom Factor 1.0 &
Fit Panel false &5

b Appearance

bt hepnrt Parameters

Maximum 2




4. Put the Designer in Preview Mode P to see the report as it would appear in the Client.

Downtime Report

Jun 20, 2019 5:01:PM - Events above 90 seconds are highlighted.

Conveyor Belt - 17 min 13 sec
EStop Pressed - 8 events

1 min & sec 2019-09-18 06:51:29
0 min 33 sec 2019-09-18 O7:10:11
0 min 44 sec 2019-09-18 09:39.47
1 1 min 36 sec 2019-09-18 10:54:35
1 min 4 sec 2019-09-19 03:44:23
1, 1 min 38 sec 2019-09-19 04:21.47
1 min 14 sec 2019-09-19 05:55:17
1 min 16 sec 2019-09-19 06:32.41

Total: 9 min 11 sec

Motor Faulted - 5 events

1 min 19 sec 2019-09-18 05:55:23
1 min & sec 2019-09-18 0B:.06:17
1 1 min 43 sec 2019-09-18 0B:43:41
0 min 52 sec 2019-09-19 03:06:59
1 min 29 sec 2019-09-19 05:36:35

Total: 6 min 29 sec

Hopper Jam - 2 events
0 min 50 sec 2019-09-18 05:36:41
0 min 43 sec 2019-09-19 00:18:41
Total: 1 min 33 sec

100% - T 1/4 - W

Save and Print a Report

In Preview Mode and from the Client, you can right click on the report and print it. You can even save the report to PDF, HTML, or PNG
format.



| | I.I.|1ﬂ.ul.l.l.I.|'zﬂ.ﬂl.l.l.l.|3ﬂ.ul.l.l.l.|dﬂ.ﬂl.
' Downtime Report
1_' Jun 20, 2019 5:03:PM - Events above 90 seconds are highlighted.
1
o] Conveyor Belt - 17 min 13 sec
] EStop Pressed - 8 events
] 1 min & sec
- P 0 min 33 sec
? Print 0 min 44 sec
] Save as PDF i, 1 min 36 sec
- 1 min 4 sec
- save as XLs ., 1 min 38 sec
] Save as HTML 1 min 14 sec
] 5 PNG 1 min 16 sec
3 dveas Total: 9 min 11 sec
0]
7 Motor Faulted - 5 events

Row Selector

The Row Selector component allows users to filter a dataset based on unique values of one or

more columns. Each level in the sorting tree is based on these properties. The user will see a @ IN DUCTIV]
dynamically generated expandable tree that groups their data by any number of choices. As a user U NIVE RS I']
clicks down the tree, objects bound to the dataset will indicate the filtered data.

+ [ Aug 2020
- [ 5th Watch the Video

Row Selector

A common way to filter the data is by time. For example, you can feed the Row Selector an input
dataset that represents a large time range, and have it break it up by Year, Month, and Day. Then
you can power a report with the output dataset that lets the user dynamically create reports for any
time range. When configuring the Row Selector for the first time, you'll notice some default Date
filters in the Row Selector Tree Customizer to help you quickly configure and filter raw data by


https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Row+Selector
https://inductiveuniversity.com/video/row-selector/8.0

time. If you don't want to filter your data by time, then simply delete the default filters and create
your own.

See the Appendix for more information on the Row Selector.

A Row Selector has two important properties: Data In and Data Out. The Row Selector component filters the data in the Data In property
and pushes the filtered result to the Data Out property. Let's configure a Row Selector to filter on some raw data. (This example uses a
Power Table component which gives you the option of using some sample test data, or you can create your own data).

1. Drag a Power Table component on to your window and change the Name of the Power Table to "Data In Table".

2. Scroll down the Property Editor and set the TestData property to 'true’. This will populate the Data property with some test data.
Alternatively, you could manually populate the Data property using either the Dataset Viewer or by creating a binding on the property.

3. Drag a Row Selector component on to your window. With the Row Selector selected, click the Binding icon Ao on the Row
Selector's Data In property.

4. Select the Property Binding Type, and bind it to the Data property in the Data In Table, and click OK.

Property Binding: Root Container.Row Selector *
Tag Property
Tag Binds to another component's property in the same window
Indirect Tag
Tag History Choose Property
Property B Visible (boolean) -
. B Background Color (Color]
Expression
B Styles (Datoset)
= Data Qualiy (nf
sqQL B Quality (QualityCode)
Named Query - Data in Table
B Name (5tring)
DB Browse W Visible (boolean)
SQL Query i
Other B Selected Column (int)
B Selected Row (int)
Cell Update B Cell Span Data (Dataset) -
Functions Root Container.Data in Table.data A
Options
® NoBinding

Bidirectional Overlay Opt-Out

5. Drag another Power Table component on to your window, change the Name to "Data Out Table".
6. With the Data Table Out still selected, bind the Data property to the Row Selector's Data Out property, and click OK.
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Property Binding: Root Container.Data Cut Table *

Tag Property

Tag Binds to another component's property in the same window

Indirect Tag

Tag History B

Property B Background Coler (Color) =
) B Styles (Datoset)

Expression

B Data Quality (int)

B Quality (QualityCode)

sqL b [#] Data inTable
» [ Data Out Table

Named Que
Query  |[=4 Row Selector = B
DB Browse B Name (String)
5QL Query W Visible (boolean
Other - - - -
B Properties Loading (int)
Cell Update b Report Viewer v
Functions Root Container.Row Selector.datalut v
Dptions
® NoBinding

Bidirectional Dverlay Opt-Out

n Cancel

1 Don't worry about the 'Unknown' nodes in the Row Selector component. The Row Selector has three default Date filters
which haven't been configured for your data yet. You will need to reconfigure them, or delete them and configure your own
unique set of filters. Once configured, the '‘Unknown' nodes will disappear.

¢

~ @ All Data
3 Unknown

7. Now let's configure your filters. Right click the Row Selector component and scroll down to Customizers > Row Selector Tree
Customizer.
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1
1
1
I
: A cut trle
1
: A Copy “tri+C
MI W
: i Delete Delete
1
: [=:]
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1
] +H
1
g % B Lok
H. Layout... Ctri+l |
3 Size & Position... “tri+p |
Customizers » | /& RowSelector Tree Customizer Ctri+L
Scripting... trle) [
Security Ctri+E

Translations Ctrl+

FOQ NN

Run Diagnostics

The Row Selector Tree Customizer provides three default Date filters. Here you can customize the parameters of each Date filter or
choose another filter type that is more appropriate for your dataset. Each column on the Data In Table will be listed in the Available
Filters tree, and the types of filters available to each column depends on the datatype of the column.

8. To start customizing, select the first filter, then change the Column Name to Data Column. (This example uses the Date column to
filter on the Month, Day, and Time combination.)
9. Change the Format String to MMMM yyyy.
10. Click OK.

ﬂ Row Selector Tree Customizer X

} @ Int Column 1.Custom Date (Date Column) x Column Name | Date Column - |
@Float Column 2.Day(Date Column) ﬁ

} @ String Column 3.Custom Date (Date Column) " conkat ﬂ
@ Boolean Column > N Format String IMMM YYYY /’I

b HH pate column Reverse Sort

0K Cancel

11. Put your Designer into Preview Mode "



12. Select Month, Day, or Time to filter on. The filtered results are displayed in the Data Out Table. In this example, we filtered on June
20th, so the Data Out Table only contains records that match that date.

Row Selector

B Aug 2020 Int Column Float Column String Column Boolean Column Date Column
i) 5th 58 016 BY1D28FB Aug7,2020 8:58 AM  °
D 8AM 68 055 185DB144 Aug 6, 2020 8:58 AM
: ?;;Lq 38 032 GBFFFC3A Aug 6, 2020 8:58 AM
% 6th 40 002  F3F74C9C Aug 6, 2020 8:58 AM
9 8 AM 26 059  E7A4DACE Aug 6, 2020 8:58 AM
2 9AM 88 041  34BEDB7S Aug6,2020 B:SBAM |
2 10 AM
i) 7th Data Out Table
9 8 AM
% 9 AM Int Column Float Column String Column Boolean Column Date Column
%) 10 AM 58 016 BOID28FS Augs5,2020 8558 AM ©
68 055 185DB144 Aug 5, 2020 9:58 AM
38 032 GBFFFC3A Aug 5, 2020 10:58 AM
40 082  F3F74C9C Aug 6, 2020 8:58 AM
26 059  E7A40ACE Aug 6, 2020 9:58 AM
88 0.41  34BED87S Aug 6, 2020 10:58 AM
51 015  314EBASA Aug7,2020 8:58 AM
a4 0.02 178D7C94 Aug 7, 2020 9:58 AM
5 074 BIABB4EG Aug 7, 2020 10:58 AM

1 When designing your report window, it's not necessary to display the Data In Table only the Data Out Table. You also don't need a
component to house the data: the Data In property on the Row Selector could simply retrieve the raw data with a binding.

Here are a few more Row Selector examples:

® A Line Graph bound to a Row Selector - Set up grouping to be first by month and year, then day, then hour, like the example above.
Clicking on a month and year will dynamically update the graph for that time period. Further clicking to a specific day or hour will re-
filter the graph for that period.

* A Report Viewer bound to a Row Selector - Grouping by department (String) would allow selection by department, automatically
regenerating the Report on selection.

® An "Alarm History" Table bound to a Row Selector - This could first be broken down severity level (Integer), then broken into "Alarm
Acknowledged" / "Not Acknowledged" (Boolean based). Clicking "Severity 3" would filter the table to all Severity 3 alarms. Selecting
"Unacknowledged" would then filter the table to Unacknowledged alarms of Severity 3.

Column Selector
The Column Selector is similar to the Row Selector except that instead of filtering rows, it filters out @ IN DUCTIV]

entire columns from the output dataset. Each column from the input dataset is shown as a
checkbox and allows users to show or hide variables in the datasets via the checkboxes, then U N’IVE RS I']
output the resulting dataset.

The Column Selector allows users to choose which columns in a dataset they wish to use. If an
object is bound to the Column Selector it will update itself whenever a user checks or unchecks a
column. This allows users to dynamically show or hide Table columns, "pens" on a graph, data in a
Report Viewer, or any other component set up to use a dataset.

Column Selector

Watch the Video

Drag a Power Table component on to your window and change the Name of the Power Table to "Data In Table".

Scroll down the Property Editor and set the TestData property to True. This will populate the Data property with some test data.

3. Drag a Column Selector component on to your window. With the Column Selector selected, click the Binding icon ® on the
Column Selector's Data In property.

4. Select the Property Binding Type and bind it to the Data property in the Data In Table, and click OK.

N
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Property Binding: Root Container.Column Selector >
Tag Property
Tag Binds to another component's property in the same window
Indirect Tag
Tag History Choose Property
R + [ Data in Table ~
B Name (5tring)
Expression

B Visible (boolean)

sQL B Selected Column (int)
W Selected Row (int)

Named Query B Cell Span Data (Dotoset)
DB Browse B View Dataset (Dotoset)
SQL Query [ | Data_QuaIlty int)
- B Quality (QualityCode)

& B Properties Loading (int)
Cell Update b [ Data Qut Table @ B v
Functions Root Container.Data in Table.data -

Dptions

No Bindi . .

R T Bidirectional Overlay Opt-Out

n Cancel
|

5. Drag another Power Table component on to your window, change the Name to "Data Out Table".
6. Bind the Data of the Data Out Table property to the Column Selector Data Out property, and click OK.

Property Binding: Root Container.Data Cut Table >
Tag Property
Tag Binds to another component's property in the same window
Indirect Tag
Tag History Choose Prop-ert?'
Property B Data Quality (int) -
) B Quality (QualityCode)
Expression b Label
b o Label
sQL b owe Label 2
Named b [F] Data inTable
amed Query b [ Data Qut Table = g
DB Browse « £ Column Selector = g5
SQL Query B Mame (String)
B Visi
Other Visible (boolean)
B Dataln (Dotaset
Cell Update =
Functions Root Container.Column Selector.Data_out -
Options
No Bindin L
® 9 Bidirectional Overlay Opt-Out
n Cancel




10.
11.

12.

Put your Designer into Preview Mode " In Preview Mode, you can can hide specific columns by unchecking the boxes in the

Column Selector.

Use the check boxes to select columns you want displayed or hidden. In this example, we hid the Boolean and Int columns as

shown in the Data Out Table.

Column Selector

Boolean Column
Date Column
Float Column
Int Column
String Column

Data In Table

Int Column Float Column String Colu...
41 0.27  6B354C0F
29 0.21 63828E0B
28 0.09  610794D0
26 019  6F7782A2
21 1 AFBO20EB
50 0.57 2D98AESA
88 053  27232AFB
92 0.38  C4BO3DFD
49 0.78 GFBCFR4CE
Data Out Table
Float Column String Column
0.27 6B3534C0F
0.21 6382BE0B
0.09  610794D0
019  6F7782A2
1 AF8020E8
0.57  2D9BAESA
053  27232AFB
0.38  C4BO3DFD

Boolean Col... Date Column
Jun 19, 2019 ...
Jun 19, 2019 ..
Jun 19, 2019 ..
Jun 21, 2019 ...
Jun 20, 2019 ...
Jun 20, 2019 ...
Jun 20, 2019 ..
Jun 20, 2019 ..
Jun 21, 2019 ...

Date Column
Jun 19,2019 1:12 AM
Jun 19, 2019 4:12 AM
Juni 19, 2019 1:12 PM
Juni 21, 2019 4:12 PM
Jun 20,2019 1:12 AM
Jun 20, 2019 412 AM
Jun 20,2019 1:12 PM
Jun 20,2019 412 PM

If you want to customize the column display for all users, put the Designer back into Design mode.
Right click on the Column Selector and choose Customizers > Column Selector Customizer.

Click the Excluded from Selection box next to any column that you don't want displayed. The "Excluded from Selection" option

determines if the user is allowed to hide the column from the client via the Column Selector.

Click OK.

Data

+
®
i
3

[ Column Selector Panel Customizer

<

Grouping Title | Data

Int Column
Float Column
string Column
Boolean Column
Date Column

Display

Int Column
Float Column
string Column
Boolean Column
Date Column

Excluded from
Selection?

oK Cancel




13. Now, the columns are excluded from the selection in the Customizer (Int and Boolean columns) and are not displayed in the Column
Selector of the Client and prevented from being hidden by the user.

Column Selector DataIn Table

Date Column Int Column Float Column String Colu... Boolean Col... Date Column
floatColimny 41 0.27 6B35ACOF Jun19,2019.. [»
String Column

29 0.21 63828E0B Jun 19,2019 ..

28 0.09  610794D0 Jun 19,2019 ..

26 019  6F7782A2 Jun 21,2019 ..

21 1 AF8020EB Jun 20,2019 ...

50 0.57  2D9BAESA Jun 20,2019 ...

88 053  27232AFB Jun 20,2019 ...

92 0.38 C4BO3DFD Jun 20,2019 ...

49 0.78 GFBCF4CE Jun21,2019.. |«

Data Out Table

Int Column Float Column String Colu... Boolean Col... Date Column
41 0.27  6B354C0F Jun19,2019.. =
29 0.21 63828E0B Jun 19,2019 ..
28 0.09  610794D0 Jun 19,2019 ..
26 019  6F7782A2 Jun 21,2019 ..
21 1 AF8020EB Jun 20,2019 ...
50 0.57  2D9BAESA Jun 20,2019 ...
88 053  27232AFB Jun 20,2019 ...
92 0.28 C4BO3DFD Jun 20, 2019 ..

See the Appendix for more information on the Column Selector.

PDF Viewer

The PDF Viewer allows you to take PDF files and embed them into your Ignition Client. This can allows you to view PDF documents without
having to leave the Ignition Client, perfect when running a client at full screen, or to view any reports that were saved in PDF format.


https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Column+Selector
https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+PDF+Viewer

Bead =k === -

Ll

A 2O

BRQOUNnaG®

Reporting

Overview

The banilign Feporting Madule makes erealing professional reporls easy with a rich library of leaks nchiding:

imagas, pranhs, 1akkes, and basic shaps took. The Reparting Module alows yau 4 ceale your own cistan

reoits on th fly of ganarats tham hased on & schadula, Dsta i inboducsed thicugh lgatian, providing access
galpbase

to any 508

Tha Repart Schatular allaws autamalic mrar generation and autamated distriution. Access io v repors is
avallabl:ihrn.nghm:wh-bmeﬂ Janiticn rungme. a e pm..n.-.gﬂ h

from s based o netwark

uses of tynamic repors:

= Froduction managemant
= Invankary iracking
Effciency manitcring
Histarical jrandirg

) Il your [
prirer lrnndhrsnd can assily ba exporied (o 8 variety of farnats nnuﬂu‘g PDE. Here ara gome common

On this page ...

. Demview

« Barafits

Feabures

= Intuitive Regort Design

= Powerful Components

= Reporiing Module Components
for the Vislon Module

s Scheduled Reporl Execulion

= Supports Multiple File Formats

Scaipling in the Reporting Module

Trial Mode: Functonality

Y

" annl.imeﬂa:kirg * Legac.r Reports
= Quality assurance
= Data sralysis
S @ inductive
autamation
o W
- ,h\-,_ _-"..I,
E '\\\ _,\jw&’j
SRR
Page 1/3 |D 4D e
File Explorer
The File Explorer component displays a file system tree structure that allows users to navigate
around various folders. It can be rooted to any folder including shared network folders, and can INDUCTIV]
filter file types by their file extension like 'pdf." The File Explorer is typically used in conjunction _\ ,_ UNIVE RSI']

with the PDF Viewer component in order to create a PDF viewing window. This is very useful for

viewing documents from within a project.

Command  Windows  Help
- Ignition Decuments
Ignition Modules-overview.pdf
E] Reporting.pdf

B welcome - Ignition User Manual 8.0 .pdf
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File Explorer and
PDF Viewer

Watch the Video

Let's setup the File Explorer and the PDF Viewer to create a window to view a PDF documents.

1. In Designer, drag a File Explorer component and PDF Viewer component on to a window and place them side by side.
2. Select the PDF Viewer component and click the binding icon &= next to the File Path property.
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3. Select the Property binding type, and drill down to the File Explorer Selected Path property. Click OK.

Vizion Property Editar g - X
= n = = | ¥
12 12 = =T
~ Common 2
Name PDF Viewer Pl
Visible B true 5]
Border Other Border v 7 (o]
¥ Data
mc:\Re ports\Car Inventory Rpt.pdf /’E
~ Appearance Property Binding: Reot Container,PDF Viewer X
Page Fit Mode
Propert
Page View Mode| Tag perty
Ta Binds to another component's property in the same window
Toolbar Visible g
Utility Visible Indirect Tag
Choose Property
Property
) B Data Quality (int) -
Expression

B Quality (QualityCode)

~ g File Explorer e B§

sQL B MName (String)
B Visible (boolean)

Named Query | |_

DB Browse B Selected Path Is File (boolean) “

SQL Query Root Container.File Explorer.selectedPath v
Options

® NoBinding

Bidirectional Overlay Opt-Out

4. Next, select the File Explorer component. In the Vision Property Editor, set the Selected Path property to a folder path. You can
type in a path or bind the root directory by clicking on the binding icon &= for the Selected Path as shown in the image below. The
Root Directory restricts which directories are accessible on the component. This is typically used to restrict access to a particular

folder so that the user doesn't have access to the entire file system. All folders nested within the Root Directory can be accessed on
the component.

1 If you set the File Explorer's Root Directory to a network folder, all clients will be able to access documents within all
folders in that network folder.
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Property Choose Property
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Expression
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b gy File Explorer 2 B§
sqL ~ € PDF Viewer &2 B
B Name (String)

B Visible (hoolean)

SQL Query Root Container.PDF Viewer.filePath -

Named Query

Options

® NoBinding Bidirectional Overlay Opt-Out

n Cancel

5. To filter for only PDF file types, enter 'pdf' (without quotes) in the File Extension Filter property, otherwise, all file types will be
displayed inside the Root Directory.

* Behavior
File extension filter |pdf ]
Root Directory -

6. In Preview Mode, click on one of the reports in your Root Directory. The PDF Viewer works by passing the file path of the file you
selected to the PDF Viewer. You'll also notice several PDF Viewer properties that drive the appearance of the PDF Viewer: Page Fit
Mode, Hide or Show Toolbar, Utility Bar, Highlight, Select, Save, Print, and more.

1 Clicking on the Save icon in the runtime saves a copy of the report to the client computer, not the Ignition Gateway.
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Vision Client Tags

Client Tags, as the name implies, are only available for use in Clients. Their values are isolated to
a Client runtime. All clients will have the same list of client Tags, however, the actual values are
unique and independent for each running Client. In other words, even though client Tags are
created in the Designer, each client will create their own instances. This makes them very useful
as in-project variables for passing information between screens, and between other parts of the
clients, such as scripting.

Client Tags support most of the data types that standard Tags do (including datasets), but
excluding the array types. Additionally, Client Tags do not have a Tag Group property, so the
value will only update when the polling property executes, or a reference in the Client Tag's
expression updates.

Often, users will create parameterized windows that take in a line ID or machine name. A Client
Tag can store this value for indirection to be used across multiple windows without users on
different clients fighting over the current value as they would with a standard Tag.

If you are using Perspective, there are no Client Tags available to a Session. See Session
Properties for a similar system.

Tag Browser o - X
Q o | ¥-8 06|00 B
Tag Value Data Type Traits
» @ Tags
> @ System l"\’

» il Vision Client Tags|

» i All Providers

Expression Type

On this page

® Expression Type
® Create a Client Tag
® Using Vision
Client Tags
® Overriding Vision
Client Tags
® System Client Tags

@ INDUCTIVI
UNIVERSI]

Client Tags

Watch the Video

Client Tags can be configured in one of several ways, based on the Expression Type property. The following options are available.

None: Causes the Tag to behave like a Memory Tag.

Expression: Allows the Tag to utilize Ignition's Expression Language, much like an Expression Tag.

L[]
L]
® Query: Executes a SQL Query, similar to a Query Tag.
® Named Queries: Client Tags may call Named Queries

Create a Client Tag

This example shows how to create a client Tag.

1. From the Tag Browser, right-click on the Vision Client Tags folder and select New Tag > Client Tag. The Tag Editor will open.
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In the Tag Editor enter the Tag hame and the following general properties, then click OK.

Name: Area
Value: Processing
Data Type: String

Tag Editor

= Expression/SQL
4® Tag Events

General Properties

- General Properties
Name
Area
Value

Processing

Enabled
Yes

Data Type
String -

Access Rights
- Read/MWrite

Cancel




3. Anew Tag called Area is created in the Client folder.

Tag Browser o _ X
Q C W-a0 DCc HE
I}, Tag Value Data Type Traits
F i Tags
* I System
~ ' Vision Client Tags
b % Area Processing String
kBl All Providers

Using Vision Client Tags

Once a Client Tag is created, it can be used just like any other Tag. You can drag-and-drop, bind to it, use it in scripting, or add it to a Transac
tion Group.

Overriding Vision Client Tags

When you open a Client, your Vision Client Tags default to the value that was saved in the Designer. If you want to open a Client with
different values in your Client Tags, you can override them in the Vision Client Launcher (either for all applications, or an individual
application). A Client Tag can be overridden in the Client Tag Overrides section of the Vision Client Launcher.

® Use the Settings button to override a client Tag in all applications.
® Select Manage on the individual application to override a tag on that specific application.

The following feature is new in Ignition version 8.0.7
Click here to check out the other new features

Client Tags can be overriden within a folder. You can also pass client Tag overrides with spaces by using a '+' icon as an escape character.
This happens automatically if you are configuring overrides in the Client Launcher.

The following example shows how to override client Tags on a single application.

1. In the Designer, create a client Tag inside a folder and bind it to something that can be displayed on a window. This example has

two Tags: one Tag is directly under Vision Client Tags folder, and another one under a nested folder. Each TagA tag is bound to a
different Label components.

Tag Browser o - X
a o - & B

Tag Value DataType Traits ~
» i Tags
> W System [client]TagA Wednesday
~ '@ Vision Client Tags
v [ Test
» % Tagh Wednesday String
» % Tagh Wednesday String
+_m All Providers

n_a S

1 qoml

[client]Test/TagA Wednesday

2. Open the Vision Client Launcher. On your application, click the three vertical dots to open the Manage screen.


https://legacy-docs.inductiveautomation.com/display/DOC80/Understanding+Tags
https://legacy-docs.inductiveautomation.com/display/DOC80/Understanding+Transaction+Groups
https://legacy-docs.inductiveautomation.com/display/DOC80/Understanding+Transaction+Groups
https://docs.inductiveautomation.com/display/DOC80/New+in+this+Version#NewinthisVersion-Newin8.0.7

Ignition Vision Client Launcher

*’ Ignition Vision Client Launcher

#: My Applications

() About X} Settings

Add Application(s)

+w CONTROLLER
hitp:#localhost: 8088

Controller

Launch Windowed v

Export

Confidential

Launch Windowed Delete

3. From the Client Tag Overrides section, click the '+" icon on the right side of the table to add a Tag override. In this example, let's
configure two client Tag overrides. The first TagA is for a client Tag directly under Vision Client Tags. Enter the Tag Name and Tag
Value. The second override is for the nested TagA Tag. In the Tag Name, the folder name must precede the Tag name followed by
a forward slash. Notice how the value has a '+' that denotes a space. The launcher will automatically enter the space for you in the
client launcher when you save your updates. Enter the Tag Name (including the folder name) and Tag Value.

Client Tag Overrides

Tag Name Tag Value
Tagh valuei -
TestTagA value+1

4, Click the Save Changes button on the top right corner of the screen. This will take you back to your My Applications screen.
5. From the top menubar, click on Tools > Launch Project > Launch Windowed to launch your application in your client. You will see
the new values that you overrided in the Client Launcher.

bl Confidential - Main Window - O X

Command  Windows  Help

[client] TagA value1

[client]TestTagA value 1

System Client Tags

System Tags provide status about the Ignition system, such as memory usage, performance metrics, and so on. Client-scoped System Tags
provide status information about the Vision Client's system. Every individual Vision client is going to have its own values like IP address,
hosting name, username, and more. You cannot modify Client System Tags. For more information, see System Tags.
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Related Topics ...
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Vision Project Properties

There are a number of properties you can set for your Vision projects within the Designer. For

example, there are properties for setting the touchscreen mode, customizing a client's auto-login, .
or configuring how the clients receive updates, and more. On this page

To access the Project Properties, in the Designer, click on Project tab on the menu bar. Then
select Project Properties.

File Edit  View Component  Alignment ® Vision Design
. : Properties
¥ 1 -
H |« » _ i Commoff | ® Vision General
Praject Browser | O 1 comm Read-Only Properties
= i ® Vision Launching
Q- O 1k  Comm Read/Mrite Properties
= 3 : - ® Vision Login
b g Styles A Project Properties Properties
~ @ Views B Gateway Events ® Vision EermlSSlons
b mm Banners i Properties
& Header [, SessionEvents ¢ Vision Timing
@ fond o g Properties
eader [z, Client Events ® Vision User
) Header : — Interface Properties
) Headel P Preview Mode F5
€ Headet %  Preview Language >
() Side_Mewe
F mm Fages
D) View-Horizontal-Menu-Ex v

Alternatively, you can click on the Project Properties 4 icon at the top of the Project Browser.

Project Browser [, 4
Q- Project Properties .{
Tg [Tarsacton Groups 7
—(&} Vision
& Client Events
b U Windows

™ Main Window
™ window-803 [x]
™ ew-2
> Templates
% Named Queries
4 Reports w




Project properties span several functional areas each containing settings applicable to that area. Scroll down to the Vision section.

7] Project Properties — O x
Project Vision / Design
General
Permissions Window & Template Committing
. Commit on Close Prompt | Always
Designer
o Template Auto-Commit £ On Off
Vision
m Component Manipulation
Constrain to Parent Container Bounds
General . =
Mudge Distance 1 =
Launching Alt-Nudge Distance 10 -5
Loegin Default Component Layout
Permissions Layout Mode
Timing Relative Anchored
User Interface Relative Layout Options
Perspective Maintain Aspect Rafio
Center Leading Trailing
General
o Scale Font
Fermissions
Tag Drop Default Color Mapping
Inactivity Value >= Color +
o I
1
Low Fallback Color: _
oK Apply Cancel

When properties in a section have been updated but not saved yet, the section heading will change to italicized text. In the following
example, changes have been made in the the Vision General, Permissions, and User Interface properties but they have not been saved or
applied yet.



/4 Project Properties - O x
Project A Vision / User Interface
General

o Minimum Size
Permissions Width 800 =
Designer Height 600 -2
Vision Client Background Color
Design v o
General Client Menu
Launching Dialog 12pt bold
Login Hide Menu Bar

o Hide Windows Menu
Permissions

o Touch 5creen Keyboard Width
Timing
750
User Interface
i Docking
Perspective )
Axis Precedence | East/West A
General :
Prevent Popup/Docking Overlap
Permissions . Infinite Desktop
oK Apply Cancel

Vision Design Properties

This section of properties apply to the Vision Client in general.

Window & Template Committing

Property

Commit on Close

Template Auto Commit

Component Manipulation

Constrain to Parent
Container Bounds

Nudge Distance

Alt-Nudge Distance

Description

Prompt - Prompt whether the user wants to commit changes when closing a window or template.
Always - Always commit changes when closing a window or template.

On - Always commit changes when switching to a different window or template.
Off - Do not automatically commit changes when switching to a different window or template.

Disabling the constraint on parent bounds allows you to position components outside of their parents bounds,
which can be helpful in advanced layouts.

The number in this box is the distance (in pixels) that a nudge moves (when using the arrow keys) or resizes a
component.

The number in this box is the distance (in pixels) that an alt-nudge moves (when using the arrow keys plus the
Alt key) or resizes a component.

Default Component Layout



Layout Mode

Relative Layout Options

Anchored Layout
Options

Default Color Mapping

Relative - All newly created components will be configured with a Relative layout, further configured by the Rel
ative Layout Options property.

Anchored - All newly created components will be configured with an Anchored layout, further configured by the
Anchored Layout Options property.

When the Layout Mode property is set to Relative, these options determine the layout options of new compone
nts. For more information, refer to Component Layout.

When the Layout Mode property is set to Anchored, these options determine the layout options of new compo
nents. For more information, refer to Component Layout.

The initial color mapping when configuring a new number-to-color binding.

Vision General Properties

A Project Properties

Project
General
Permissions
Designer

Vision

Design

Launching
Login
Permissions
Timing

User Interface

Perspective

Vision / General

Timezone Behavior
Gateway Timezone -
Motify | ' Push
Touch 5creen
Touch Screen Mode Enabled
15 | Scrollbar Width (pixels)
Touch Screen Mode Active on Startup

Data
Disable Tag History Data Cache

oK Apply Cancel

General

Property Description

Timezon = The Vision Client can emulate any timezone. By default, it will appear to be in the same timezone as the Gateway Timezone.

e This has the effect of all Clients behaving the same, regardless of the timezone setting on the Client's host operating system.

Behavior = Depending on your project's requirements, this may not be optimal. You can have the Client use the host's timezone by
choosing the Client Timezone option, or you may specify any explicit timezone for all Clients to emulate.

Notify / Updates sent to the Client when a designer Saves the projects can either Notify the user by showing an update banner at the
Push top of the Client, or Push the the changes without warning the users. See Client Update Modes.

Touch Screen

Touch All Clients can operate in touch-screen mode. When enabled, clicking on editable numeric and text entry fields (i.e., Text
Screen Fields, Numeric Text Fields, etc.) will pop up on-screen keyboards that can be used for data entry. You can optionally set the
Mode width of any scrollbars (number of pixels wide/tall).

Enabled

Touch Configures the Clients to start up with the touch-screen mode active.

Screen More details can be found on the Using Touch Screen Mode page.

Mode
Active
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on
Startup

Data

Disable | The Clients normally maintain a cache of data retrieved from Tags History, improving repeat operations on graphs and tables.
Tag Hist = When this option is disabled, no data is cached, and the full queries execute against the Gateway each time data is required.
ory

Data

Cache

Vision Launching Properties

These properties affect the Vision Client's launching process.

41 Project Properties — O =
Project Vision / Launching
General
Permissions Gateway Launch Page
Designer Default Launch Mode | Windowed -
Vision 2 "windowed" Button 2 "Full Screen” Button
Design Hide From Launcher
General Launch Icon

2
Login Windowed Properties
Permissions Vendor
Timing Homepage
User Interface Width 1,024 |2 Height 768 |- =
s sl Screen Index 0 :
Gene.ral. [ start Maximized Start Centered Hide Exit Button
Permissions Client Memory
Tagprop Initial 32M - | Maximum 256M -

“ Apply Cancel

Gateway Launch Page
Property Description

Default Determines the mode for a Client launched from the Launch button that appears next to the project in the Client Launcher.
Launch Available modes are Windowed or Full Screen.
Mode

Window | Each launch mode can also be enabled individually, which allows that mode to appear in the Dropdown list next to the Launch
ed button on the Gateway Home page.
Button



/Full

Screen

Button

Hide

From The following feature is new in Ignition version 8.0.7
Launcher Click here to check out the other new features

This option hides the project from the Client Launcher and prevents the project from being selected in the Vision Client
Launcher.

Launch Icon

Launch | The image specified here is used to represent the project on the launch page and desktop shortcut. This needs to be a path to
Icon an image that has been uploaded to the Gateway. Use the browse button to choose or upload a new image.

Windowed Properties
Vendor This property is displayed as the project is launching through Java Web Start, as well as in the JWS application manager.

Homepa | A URL that is displayed in the JWS application manager.
ge

Width The width of the Client window when launched in Windowed mode.
Height The height of the Client window when launched in Windowed mode.

Screen The number here is the index of the screen to use for Full Screen mode, it starts at 0. This property is not supported on all
Index operating systems.

Start If the box is selected, when the Client is launched in Windowed mode, it starts maximized. Note that this is not the same thing
Maximiz | as Full Screen mode, which is only available when the Client is launched in Full Screen mode. In Full Screen mode, the width,
ed height, and start maximized properties have no effect. When launched in Full Screen mode, the user is given an Exit button on

the login screen by default. For terminals where the application should not be exited, this button can be removed by checking
the Hide Exit Button box.

Start If the box is selected, when the Client is launched in Windowed mode, it starts centered.This property is ignored if Start
Centered | Maximized is enabled.

Hide If the box is selected, when the Client is launched in Full Screen mode, the exit button is hidden to prevent the application from
Exit closing.
Button

Client Memory

Initial Governs how the Client use RAM resources on its host machine. The initial memory setting is how much memory the Client will
require on startup. While this is typically left alone, boosting it a bit can improve performance somewhat.

Maximum  Governs how the Client use RAM resources on its host machine. The maximum memory setting sets a cap on how much
memory the Java VM is allowed to use. When you launch a Client on a machine with plenty of RAM, you'll also need to boost
this setting to allow the Client to use more RAM.

Vision Login Properties

These properties affect how the Vision Client's login process behaves and appears. @ IN DUC TIV]
UNIVERSI]

Customizing Client
Login Screen

Watch the Video
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A Project Properties — u] x
Project Vision / Login
General A
Permissions Login Screen
Designer Welcome Message
Vision
Design Welcome Image =
General
Username Text Username
Launching
m Password Text Password
Permissions Login Button Text Login
Timing Show Locale Selector Automatic v
User Interface Auto Login
Perspective Enable Auto-Login
General Username admin
Permissions Password T
Tag Drop Password (repeat) | ¥¥iEEdEx
550 Login
Enable 550 Login .
oK Apply Cancel
Login Screen
Property Description
Welcome The message that appears in the upper-left corner of the Login screen. If left blank, no message is displayed. (HTML
Message formatting is allowed).
Welcome The image that appears in the upper-left corner of the Login screen. If left blank, uses a default image.
Image

The following feature is new in Ignition version 8.0.3
Click here to check out the other new features

Images are resized/forced to fit into a square format. If you use a more rectangular image, the scaling on the image will
automatically be adjusted.

RCWW_Project_75_Test - O *

RCWW_Project_75_Test

Username

Password

automation

/ @ inductive

Ignition'.

by et asrthn

Username The text that appears next to the username field.
Text

Password
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Text

Login
Button Text

The text that appears next to the password field.

The text that appears on the Login button.

Show Determines if the Locale Selector should appear on the Login screen. This property interacts with Ignition's Localization
Locale system.
Selector

® Automatic - Show the selector if more than a single Languages exists in the project.

® Show - Always show the selector, regardless of how many Languages exist.

® Hide - Never show the selector.
Auto Login
Enable By enabling auto-login, you can have the launched Client skip the login process. The Client will log in behind the scenes
Auto-Login using the credentials supplied here. If they fail, the login screen will be presented.

Property Description

Username User name of the user to automatically log in when Client is launched.

Password Password of the user to automatically log in when Client is launched.

Password (repeat) Password of the user to automatically log in when Client is launched.

See also Setting Up Auto Login.

SSO Login
Enable Enable Single Sign-On for the project. The Project's default Authentication Profile must use Active Directory, and SSO must
SSO Login be enabled in the Profile. See Active Directory Authentication for more details.

Vision Permissions Properties

These properties allow you to limit the Client's ability to perform certain tasks. The tasks are
grouped by category. Access can be configured statically for all users, or require specific roles.

INDUCTIV]
UNIVERSIT

D

 Project Properties

Project
General
Permissions
Designer
Vision
Design
General
Launching
Login
Timing

User Interface
Perspective
General

Permissions

[m} x

Vision / Permissions

Enable? Required Client Roles

Client Permissions

Alarm Management Administrator|

Datasource Management
Device Management Watch the Vldeo
DNP3 Management
Legacy Database Access
OPC Server Management
SFC Management

Tag Editing

Translation Management

User Management

Enable All / Disable All
0K

Apply Cancel

Permissions

Property Description

Enable? | Determines if the Client has access to this category. If unselected, the category will be disabled in the Client for all users. If
selected, the Required Client Roles text field will also be used to determine if the Client has access.

Require | A comma separated list of Managing Users and Roles and/or Security Zones that have access to the category while the Enab

d Client | led checkbox is selected. While these fields have focus, the down arrow key on the keyboard may be pressed to make a list

Roles of available roles appear. There are several ways to use roles and zones in this field, and they can be used together in the

comma separated list.
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® Blank Field - anyone can use this, regardless of their roles.
® Role name - users with this role can use this regardless of their zone.
* roleName@zoneName - users must have this role AND be logged in from this zone.

(D When creating a new project, all of these settings will be disabled by default.

Categor = The following is a list of the initial categories. Note that the categories you see in your Designer are dependent on which

y modules are installed on the Gateway. Additionally, third-party modules can add to this list.

Descripti

ons
Category Description
Alarm Allows the Client to cancel, shelve, and acknowledge alarms. Applies to both local and remote Alarms.
Management

Datasource Allows the Client to modify Gateway datasource connections.
Management

Device Allows the Client to modify device connections.
Management

DNP3 Allows the Client to freeze DNP3 operations via scripting.
Management

Legacy Allows Clients to run queries directly against the database. This doesn't effect named queries.
Database
Access

(D With this setting off, all Query Bindings will cause a red overlay on the component in the Client but
not the Designer.

Running queries directly in the Client is inherently insecure, which is why this setting exists. It is
recommended to use Named Queries instead of query bindings and leave this setting off.

OPC Server | Allows the Client to modify OPC server connections.
Management

SFC Allows the Client to start or stop Sequential Function Charts.
Management

Tag Editing Allows the Client to add, edit, or delete Tags through scripting.

Translation Allows the Client to modify translations in the localization system.
Management

User Allows the Client to modify schedules, holidays, and users through scripting or components.
Management

The image below contains the following configuration: Alarm Management is only available if the logged in users have the
"Administrator" or the "Operator" role (regardless of their current zone), Datasource Management has been disabled for all
users, and Device Management is available if the logged in user has the "Administrator” role and the Client is in the Security Z
one named "Default".



41 Project Properties

Project Vision / Permissions
General

P Enable?
Permissions
Designer 4 Alarm Management
Vision Datasource Management
Design [Z Device Management
General 2 DNP3 Management
Launching =

4| Legacy Database Access
Login

m L4 OPC Server Management

Ld SFC Management

Timing

User Interface &2 TagEditing

Perspective 2 Translation Management
General [E user Management
Permissions

Enable All / Disable All

Required Client Roles

Administrator, Operator

Administrator@Default

Apply

00 0000CO0OGGOGO

Cancel

Vision Timing Properties

These properties affect the Vision Client polling rate and timeout settings.

/A Project Properties - [m] X
Project Vision / Timing
General
Permissions Polling Base Rate
Designer 5,000 -5
Vision Connect Timeout
Design 10,000 [-&
General Read Timeout
S
Launching 60,000 =
Login OPC Browse Timeout
a
Permissions 120,000 -5
Timing Connection Concurrency
Limit Concurrent Connections =
oK Apply Cancel
Timing

Property Description

Polling The base rate, in milliseconds, for all polling bindings.

Base
Rate

INDUCTIV]I
“nezz- UNIVERSI]

i

Setting Project
Polling Base Rate

Watch the Video

Connect = The maximum amount of time to wait for connections to the Gateway to be established. Specified in milliseconds.

Timeout

Read The maximum amount of time for socket connection to the Gateway to remain open. Specified in milliseconds.
Timeout

OPC Maximum amount of time, in milliseconds, to wait for the response to a request. (default: 120,000)

Browse
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Timeout

Connecti = By default, Clients are not limited by the number of concurrent connections to the Gateway. These connections are used to

on send Tag writes, return database results, as well as any other action that requires information to be passed between the Gatew
Concurr | ay and the Client. Depending on what is running in the Client, your network's bandwidth could be hindered. Enabling this
ency property will limit the amount of concurrent connections the Client can maintain. Note that this may negatively impact Client perf

ormance, but is usually preferable on busy networks.

Vision User Interface Properties

H Project Properties

Project.
General
Permissions
Designer
Vision
Design
General
Launching
Login
Permissions

Timing

Perspective
General
Permissions

TagDrop

Vision / User Interface

Minimum Size
Width 800
Height 600

Ap| 4l

Client Background Calor
-
Client Menu

Dialog 12pt bold

Hide Menu Bar

Hide Windows Menu
Touch Screen Keyboard Width

75%

Docking
Axis Precedence East/West v

Prevent Popup/Docking Overlap
Infinite Desktop

These properties affect how the Vision Client appears and behaves while it is running. @ INDUCTIV]

- a pad

UNIVERSI]
Setting Client
Minimum Size

Watch the Video

oK Apply cancel

User Interface

Property Description

Minimu Typically, a Vision Client is designed to run on multiple different resolution and sizes of monitors. The various component

m Size layout features help design elastic screens, but sometimes you need to set a lower bound as to how small you'll allow the Client
's usable area to shrink. This is what the Minimum Size settings are for. You can see these settings visually represented in the
Designer as lines on the Vision workspace when the Root Container is smaller than the configured Minimum Size..

Whenever the usable space shrinks smaller than these bounds, scrollbars will appear, capping the Width and Height to these
minimums. This defaults to 800 x 600. In the image below, the project was set to a minimum size of 400 x 300. Since the
window is smaller, the outline is visible.
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Client This option allows you to specify the color of the Vision workspace which will be visible when not obscured by windows.
Backgro
und
Color
Client These options change the appearance of the Client Menu:
Menu
Client Menu

Property Description

Menu Changes the font type, font style, and font size of the Menu Bar.

Font

Hide Hides the entire Menu Bar in the Client. Usually enabled in situations where users should not be able to close
Menu the client. Changes to this setting are applied on client startup, meaning clients will need to be relaunched after
Bar changing this setting.

Hide Hides the automatically-generated "Windows" menu that lets users switch between open windows. Enabled
Window = when users should not be able to close windows in the Client.

s Menu

See also Menubar Scripts.

Touch Determines how wide the Touch Screen Keyboard should appear in the Client. Percentage of the client window the touch
Sceen screen keyboard displays.

Keyboar

d Width

Docking | Docked windows are locked to the edges of the Client and fill all the space on that edge. Docking options are:

Docking

Property Description

Axis Defines which axis takes precedence for docked windows. (i.e., East/ West or North/South). When windows are
Precede @ docked on adjacent sides, this property determines which sides should take precedence. When set to "East
nce /West", windows docked to the East or West sides will expand vertically from the top to the bottom of the Client,

and will push any North or South docked windows out of the way.

Prevent = By default, popup windows are not allowed to overlap any docked window. Disabling this property will allow
Popup Popup windows to be placed on top of docked windows in the client.

/Docking

Overlap

Infinite
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Desktop | If true, the desktop area will be expanded if floating windows are dragged out of frames. If false, popups are
prevented from being dragged beyond the bounds of a window so they don't get distorted.

Related Topics ...

® Client Update Modes

® Using Touch Screen Mode

® Working with Components

® Docked Windows - Axis Precedence

In This Section ...
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Client Update Modes

Notify Versus Push _
On this page
When a Client is launched, the most recent version of the project is used. If you make changes to
the project and save the changes (by doing a File > Save) while a Client is open, the Client is
notified about the updates. The Clients can receive the updates in two different modes: Notify or P

ush mode.
. _ ® Notify Versus Push
Noltlf-y ‘ ‘ ) ® Setting Client
This is the default mode to automatically notify operators when project updates are Update Modes

available. In this mode, every time you update a project in the Designer and save the
changes, Clients will display an orange information bar at the top of their display. This
orange bar notifies the operator that an update is available. By clicking on the notification
banner, the new project modifications are downloaded and applied.

o @ INDUCTIVI
UNIVERSIT

Command  Windows  Help

® Push
When you save your changes in the Designer, this mode automatically pushes all project About Client
changes and updates to all running clients with no operator interaction, that is, the new
version is downloaded and applied automatically. This is often desirable when a Client is Updates

running in a situation where keyword and mouse access is inconvenient, such as in a
large overhead display.

Watch the Video

1 This property (and many other project properties) are only read when a client is launched. When you change from Notify to Push
Mode, client updates will not get pushed when you save, clients need to be re-launched to start using the Push Update Mode.

Setting Client Update Modes

This example shows how to change the Client Update Mode.

1. In the Project Browser of the Designer, select Project > Properties from the top menubar. The Project Properties window will
open.

2. Under the Vision folder, select General, set either Notify or Push as your Client Update Mode. The default is set to Notify.

3. Click OK.


https://www.inductiveuniversity.com/video/about-client-updates/8.0

4 Project Properties — O >
Project A Vision / General
General
Permissions Timezone Behavior
Designer Gateway Timezone
Vision IO Wotify (' Push I
Design [ Touch Screen
| Touch Screen Mode Enabled|
e U T
Launching L S
Touch Screen Mode Active on Startup
Login
| Data
Permissions Disable Tag History Data Cache
Timing
User Interface |
| oK || Apply i Cancel I

Now, in the Client (with Update Mode set to Notify), the operator will have to click the banner to update the Client.

SIP_test - Main Window — O e

Command  Windows  Help

3 Project update available. Click here to update.

==

East

M)

Reservoir

0 25 50 75 100 0 25 50 75 100

River City
Waste Water
TREATMENT




Then the operator clicks Update on the confirmation message.

Update Available ot
There is a more recent version of this application available.

This application has been updated on the Gateway.
Click 'Update’ to update this application.

Now the client version is updated with the most recent version of the application.

Related Topics ...

® Using Touch Screen Mode
® Vision Project Properties



Setting Up Auto Login

Client Auto Login

Clients can log in automatically when launched, once you specify the Auto Login settings in the Cli
ent/Login section of the Project Properties window. This is typically used in situations where the
client should login with a low access user, such as a 'guest' account.

Set the Clients to Automatically Login

In this example, we will set the project properties to allow Ignition clients to automatically login.

1. In Designer, go to Project > Properties.
The Project Properties window is displayed.

2. Scroll down to Vision > Login.
3. Click the Enable Auto-Login checkbox.
4. Enter a Username and Password.
5. Click OK.
A Project Properties - [u] X
Project Vision / Login
General
Permissions Login Screen
Designer Welcome Message
Vision
Design Welcome Image ]
General
Username Text Username
Launching
Password Text Password
Permissions Login Button Text Login
Timing Show Locale Selector | Automatic -

User Interface ‘Auto Login

Perspective Enable Auto-Login

General Username quest

Permissions Password | eereees

Tag Drop

Password (repeat) | Fxrxrear

550 Login
Enable 550 Login

o IR

6. Select the File > Save All to save your changes to the Gateway and your project.

Z|=8 Edit  View  Project Com

MNew b
W Open.
H  saveAll
H  Save..
B  SaveAs.
1 Update Project
A Import.
2 Export..
< Exit

When in a client that has auto login setup, if the user accidentally logs out there is a button on the
login screen to allow the user to enter in the auto login credentials. That way there is no need for
them to know any login credentials.

On this page

® Client Auto Login
® Set the Clients to
Automatically
Login

@ INDUCTIVI
UNIVERSI]

Setting up Client
Auto Login

Watch the Video
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Username

Password

Language

English -

Related Topics ...

® Gateway Backup and Restore


https://legacy-docs.inductiveautomation.com/display/DOC80/Gateway+Backup+and+Restore

Using Touch Screen Mode

It is very common to deploy Ignition Vision projects on touchscreen computers, such as industrial
panel-PCs acting as Human Machine Interface (HMI) or Operator Interface Terminal (OIT). In
situations where the PC does not have a keyboard attached, Touch Screen Mode can be used to
assist with user-input. For this reason, all of the Input components in Vision are touchscreen-
enabled.

Under normal circumstances, you don't have to do anything special other than enable Touch
Screen Mode on your project. This will allow the operator to activate Touch Screen Mode when
they log in. You can also enable Touch Screen Mode via scripting.

Simply click in the Username field and the Touch Screen keyboard will appear. Enter your
Username and click enter, do the same for your Password, and then click Login.

L / Parameters and UDTs
L]

Username

admin

Password

1/2|3[(4|5[(6]|7(8]9|0]-|=]Backsp
Tabjg|w|e|r|t|y|luflijJo|p|[[]]1]\
Ca.lafs|d|flglh]j[k]l|;]"
shift |z {x|c|v|b|n|m|,|[.]|/ Shift
Space « > Cancel

Touch Screen-enabled Input components all have an expert level property called Touch Screen
Mode. This property has three settings:

® Single-Click: The keyboard will appear on a single click

® Double-Click: The keyboard will only appear after a double-click

®* None: Disable touch screen support on the component. The component will no longer
invoke the touch screen keyboard.

Enabling Touch Screen Mode

On this page

® Enabling Touch
Screen Mode

® |nvoke the Touch
Screen Keyboard
with Scripting

® To Change the Size
of the Touch Screen
Keyboard

@ INDUCTIVI
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Using Touchscreen
Mode

Watch the Video

Touch Screen support is built into Ignition. Turn it on through the Project Properties or scripting in the Designer.

1. From the Project Browser, click onthe Project Properties 3 icon, or from the menubar go to Project > Project Properties.

The Project Properties window is displayed.

2. Scroll down to Vision > General page, to see the Touch Screen options.

® Touch Screen Mode Enabled: By default, this is enabled, which means an operator can activate the mode on the startup
screen. All Clients can operate in touch screen mode. When Touch Screen mode is enabled, clicking on nhumeric and
text entry boxes will pop up on-screen keyboards that can be used for data entry. You can optionally set the width of any

scrollbars (number of pixels wide/tall)

® Touch Screen Mode Active on Startup: This option sets the Clients to start up with the touch-screen mode active.

3. Change the settings as desired then click OK.

1. Comm Read/Write

Make sure Comm Read/Write is enabled in Project Properties of the Designer.


https://www.inductiveuniversity.com/video/using-touchscreen-mode/8.0
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/A Project Properties — O X

[ Project ~] Vision / General
| General
Permissions Timezone Behavior
| Designer Gateway Timezone -
. Vision ; Motify Push
Design | Touch Screen

m Touch Screen Mode Enabled

15 | Scrollbar Width (pixels)

Launching :
) Touch Screen Mode Active on Startup
Login
Data
Permissions Disable Tag History Data Cache
Timing
User Interface ol

0K Apply Cancel

These settings are helpful for mixed-use projects, that is, those that are launched on both touch screen devices and traditional
computers and laptops. Once Touch Screen Mode is enabled through Project Properties, the Touch Screen icon will appear on top
right corner of the project login screen. Click in any of the login fields to bring up the Touch Screen keyboard.

Parameters and UDTs

Toggle to enable or disable touchscreen mode

Username

Password

gnitior/ {35 ductve

et st

Invoke the Touch Screen Keyboard with Scripting

To handle touch screen logic via scripting, the general pattern is to respond to a mouse event, popup up a keyboard, and then set the
component's value to whatever was entered in the keyboard. For example, for a text field, you would write a script like this:



if system gui.isTouchscreenMdeEnabl ed():
! current Text = event.source.text
i newText = system gui.showTouchscreenKeyboard(current Text) !

See also: system.gui.setTouchscreenModeEnabled

To Change the Size of the Touch Screen Keyboard

You can control the size of the Touch Screen keyboard that is displayed in a Vision Client.

1. In the Designer, go to Project Properties > Vision > User Interface.
2. Change the percentage for the Touch Screen Keyboard Width property to anything you want.

4 Project Properties — O x
Project Vision / User Interface
General
A Minimum Size
Permissions ]
Width 800 -2
Designer :
Height 600 -5
Vision

Client Background Color

General
_ Client Menu
Launching -
_ Dialog 12pt bold
Lagin
o Hide Menu Bar
Fermissions Hide Windows Menu
Timing

Touch Screen Keyboard Width

User Interface 7506

Perspective Docking

General Axis Precedence | East/West -
Permissions (2 Prevent Popup/Docking Overlap
Tag Drop 4 Infinite Desktop

OK Apply Cancel

3. When you launch a Vision Client, the Touch Screen keyboard will be displayed in the default percentage of 75%. After you're logged
into the client, the Touch Screen keyboard will be set at the value you entered into the Touch Screen Keyboard Width property field.


https://legacy-docs.inductiveautomation.com/display/DOC80/system.gui.setTouchscreenModeEnabled

Alphanumeric Keyboard

Command  Windows  Help

n?-/

Main Window

Ignitio

& autom;

Helle World

Schedule Management

Hello World
1(12]3

Roster Managemen

User Management

Tank Details

415

/ Shift
Cancel

The following feature is new in Ignition version 8.0.4

Click here to check out the other new features

The Touch Screen Keyboard Width setting controls both the alphanumeric keyboard and the numeric keypad.

Numeric Keypad

Command Windows Help

Ignition

Main Window

Schedule Management

Roster Management

User Management

Measurements

Tank Details

1,535,099
8 9
5 6
2 3

1,535,000

Related Topics ...

® Setting Up Auto Login
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Common Tasks in Vision

This section contains examples for items we've identified as "common" tasks: undertakings that
many users are looking to utilize when first starting out with a specific module or feature in Ignition
. Additionally, this section aims to demystify some of the more complex or abstract tasks that our

users may encounter. On this page

The examples in this section are self-contained explanations that may touch upon many other
areas of Ignition . While they are typically focused on a single goal or end result, they can easily
be expanded or modified after the fact. In essence, they serve as a great starting point for users

new to Ignition, as well as experienced users that need to get acquainted with a new or unfamiliar
feature. ® Component

Animation
Below is a list of common tasks related to this section of the manual. ¢ Custom Input
Template
® Client Tags for
. . Indirection
Component Animation * High Performance
HMI Techniques
® Open Dynamic
Windows on Startup
Tank Cutaways

Creating animation within a Vision project. The Component Animation page walks through the
different ways to animate graphics on a window. The different methods vary in complexity and .
offer different solutions for different needs.

Custom Input Template

Creating a simple template that can be used many times to create simple user input fields. The Custom Input Template is relatively simple to
put together, but can be a powerful tool that can quickly build out screens that are heavy on user input.

Client Tags for Indirection

Vision Client Tags can be used as a variable across all windows to indirectly point to a set of Tags, such as an area of the plant. For
example, setting up Client Tags for Indirection can enable the user to choose an area of the plant from a Dropdown List component, and
have Ignition display the correct windows for that area.

High Performance HMI Techniques

Using techniques that relay information more quickly than standard a P&ID display. High Performance HMI Techniques help create simpler
screens that have much less noise and useless "fluff" that takes up screen space. The suggestions and examples help guide better practices
to increase efficiency and performance across any industry.

Open Dynamic Windows on Startup

It can sometimes be necessary to Open Dynamic Windows on Startup, so that certain users see one set of windows while other users with
potentially different privileges sees a different set. While it is easy to set a window to open on startup, that same window will always open for
anybody that logs in to the project. By utilizing scripting with the Client Event Startup Script, what windows get open can be customized
based on any criteria.

Tank Cutaways

The Tank Cutaways in Symbol Factory may seem like just a random shape, but they can be used to remove parts of other SVG diagrams to
create a way to "look inside" the tank or other machine and view information like how much material is available.


https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+Windows#VisionWindows-OpenonStartup

In This Section ...



Component Animation

Making Components Move _
On this page
Animation can be a useful tool to help visualize what is happening at any given time. Animations
make it easy to tell if a machine is running, or a conveyor is moving with a quick glance at the
screen, and it can help highlight which components aren't currently in use. There are two main
ways of creating animation: actually moving all or part of a component, or cycling through a few

different static images of a component that give the illusion of moving. Each method has its e Making

advantages. For example, making a dump truck move forward and backwards may be better Components Move
accomplished with actually moving the component. It would be fairly simple to make the whole e Animation in
component move forward on its x coordinate, and then back the same amount. But, if the truck Scripting

was instead stationary, and just its bed were moving up and down to simulate the truck dumping e Components that

its cargo, it may be difficult to seamlessly move the component, since it would not just be moving Actually Move

on one axis, but would require careful rotation and movement combined. In this instance, it would * Giving the lllusion of

be far easier to create a few static images of the truck with its bed in various states, and then cycle

through those images fairly quickly so it looks like it is moving. Let's go over both methods below. Moving

Animation in Scripting
The best way of moving components around on the screen is using the scripting function system. @ IN DUCTIV]

gui.transform. This function can move and resize components from a Python script. It provides U NIVERS I']
many options for moving and resizing components, all in one simple scripting function. This can be
called on a property change when a user enters a new value, or based on other conditions that
happen on the window.

Component
Animation

Watch the Video

Components that Actually Move

To actually move components around during runtime usually involves binding all or part of an image or SVG to the value property of a timer
or signal generator. The Symbol Factory Enhanced components all contain an Angle property. Binding the Angle property of a spinning part
of a motor can help us visualize when the motor is running or not.

1 When searching Symbol Factory, make sure to select the Enhanced radio button in the search window. The enhanced symbols
have groupings that enable you to more easily animate them.
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1. Pick out a component that you would like to animate. For this example, we used the Single Stage Compressor from Symbol
Factory. You will also want to drag a Timer component onto your window.

g

1. In the Project Browser, click the Expand ’ icon to expand the Single Stage Compressor component. You will notice that the whole
component is made up of many smaller pieces. We want to select the piece called Group_Ilmpeller.

Project Browser O - X [ P P L T
Q- Filt Al
* [] Root Container Al

g Single stage compressor
¥ Aw Group_COmpressor_Box
{5 Ellipse
I.. b— &y Group_Impeller
b 4w Group_Inner_Sphere
b dm Group_Outer_Exhaust ]
b 4w Group_Port
b 4w Group_Support
& Timer »

Sp]

£l

2. In the Property Editor, bind the Group_Ilmpeller's Angle property to the Value property of the Timer.



Property Binding: Root Container.5ingle stage compressor.Group_lmpeller X

Tag Property
Tag Binds to another component's property in the same window
Indirect Tag
Choose Prope
Property perty

s Group_Impeller 2 B§ "
Expression  Group_Inner_Sphere

b
b
b x Group_Outer_Exhaust
b
b

sQL A, Group_Port

A Group_Support
Named Query - 4} Pupp
DB Browse

B Delay(ms) {int)
SQL Query B Initial Delay (ms) (int)
B Running? (boolean)

Root Container.Timer.value v

Options

No Bindi . .
® NeBinding Bidirecticnal Overlay Opt-Out

3. We now need to modify the properties of the Timer to ensure a good rotation. Select the Timer component, and set the Delay (ms)
to 200, the Step By to 10, and the Bound to 360.
4. Set the Timer's Running? property to True.

Vision Property Editor g _ X TN B R

H —r  — = i
15 12 = =X |- .

] uEe

~ Common ] ﬂhl/[d’ -

MName Timer & || ] 'I_i_I‘
~ Behavior m
Delay (ms) 200|c2 g__
Initial Delay (ms) 1,000 €| |
Running? |L] true e |
'bata 7]
0
Value 300 & 9]
Step by 10l | | ]
Bound 3602 | |

5. Put the Designer in Preview Mode and your Compressor symbol component will now animate. You can adjust the Delay (ms) to be
lower or higher to adjust the speed at which the component rotates.

Giving the lllusion of Moving

With this method, you can make components look like they are moving without actually moving anything. What we do here is duplicate the
component multiple times and modify each component to be a little different than the others, and then show and hide them in the correct
order to make it seem like they move.



The following example uses a Signal Generator component to drive the animation, but any incrementing value can be used, such as the
Value property on a Timer component, an accumulating value in a PLC, or the current time in seconds.

1. Pick out a component to animate. For this example, we chose the Horizontal Conveyor with Perspective from the Symbol Factory.
We also placed a signal generator symbol on the window.

J00080008800080080Q0E -

2. Duplicate this component 10 times for a total of 11 conveyors on the window.

3. Select the first instance of the component then choose Component > Ungroup.
4. In the Project Browser, expand the Group_Conveyor_Belt. Select Path 5.

Project Browser g - X [ P R LU T
Q. Filter A B

+ [] Root Container ~
[ii] Bar Chart
s Group
s Group 1 T
s Group_Axial o]
A Group_Conveyor_Belt d
£5 Path
£9 Path 1
£5 Path 2
25 Path 3 - b —
25 Path4 L Gl fogeedt)
| [ | ] | [spahs |l
£5 Path 6
b % Group_Inner_Area
b A5 Group_Wheel
b A Horizontal conveyor with perspective 1

{4 v v w

AARAGARAAAGAANA
JUUPURIIIY

5. Move Path 5 to the left and then move Path 4 the same distance to the left. In this example, we moved them both an equal distance
left so that the leftmost component is on the left edge of the conveyor.

GG

00000000000000000000

6. Repeat this with the rest of the components, except move them slightly to the right of the previous instance. Notice how the gray
bars slowly move from left to right over all the components when viewed in sequence.
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7.
8.

10.

11.

12.

13.
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Select each Conveyor image individually select Component > Group.
Next, select the first Conveyor from the Project Browser (the one that has the bars on the far left), and place an expression binding
on its Visible property that looks like this:

i f({Root Container.Signal Generator.value} =0, 1, 0)

Duplicated this across all of the conveyors, but increment the first number by 1 each time. The last conveyor (the one that has the
bars on the far right) should have the following expression:

i f({Root Container.Signal Generator.value} = 10, 1, 0)

. Repeat Step 8 across all of the conveyors, but increment the first number by 1 each time. The last conveyor (the one that has the

bars on the far right) should have the following expression:

i f({Root Container.Signal Generator.value} = 10, 1, 0)

Next, stack all of the conveyer images them all on top of each other exactly. This is easily done by selecting all of the conveyors,

going into the Alignment menu, then selecting Align Centers Horizontal I'D icon and Align Centers Vertical icon.
Select the Signal Generator component. Set the Signal Type to Ramp, the Period to 1000, the Values/Period to 11, the Upper
Bound to 11, and the Lower Bound to O.

Set the Running? property of the Signal Generator to True and it will now cycle through showing all of the conveyors, which will
make it look like it is moving.

Save the project.



Custom Input Template

Sometimes you may need to have text fields in your project for the user to input data. Rather than
copying and pasting these text fields into each window, you can create a template that includes a
single label and text field. Parameters can then be passed in so that the label and text can be used
for different types of input. The template can then contain an expression to validate that there is
data in the text field. This template can be reused many times on multiple windows to allow users
to input data.

Custom Input Template Example

In this example, we'll create a template containing a Label and Text Field components. We'll add
two parameters to be passed into the components. We will also copy the expression in the code
block below to let the user know that there is data in the text field. Once you get the template
created, you can copy the template to a window and test it out.

1. In the Project Browser, right-click Templates and select New Template.

2. Right-click on New Template and click Rename to change its name it to something
meaningful such as Text Entry.

3. To add a parameter, right-click the checkered area and select Customizers > Custom
Properties.

4. In the Custom Properties window, add two Template Parameters by clicking the Add

+ icon twice and entering the following:

1st Parameter
Name: display
Type: String

2nd Parameter
Name: text
Type: String

[0 Custom Properties X

Template Parameters

Name Type Descripti... | Drop Tar...

display String

ErmEE .

Internal Properties

Name Type Description +

=[]

5. Click OK.

6. From the Component Palette, drag a Text Field and a Label to the checkered area of the
template, resizing so that the label and the text box occupy the majority of the space.

L T

7. Select the Label component, go to the Property Editor, and click on the Binding &

of the Text property. The Property Binding window is displayed.

icon

On this page

® Custom Input
Template Example

@ INDUCTIVI
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Custom Input
Template

Watch the Video
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8.

10.

11.

12.

13.
14.
15.

In the Property Binding window, click on the Property binding type, choose the display p
roperty. Make sure the Bidirectional box is not selected, and click OK. Don't worry if the
label on the template disappears. It is simply displaying the value of the display custom
property, which is currently blank.

[ Property Binding: Text Entry.Label 2 X
Tag Property
Tag Binds to another component's property in the same window
Indirect Tag
Property Choose Property
Expression - [ Texentry
B Name (String)
& instarce Name (sting)
sQL [
W text (String)
Named Quel
v b v Label2
De Browse b £ Test Field
SQLQuery
Text Entry.Display -

Options

LT verly Opco

n Cancel

. Now select the Text Field component, go to Property Editor, and click on the Binding

&2 icon of the Text property.
In the Property Binding window, click on the Property binding type, choose the text prop
erty. Make sure the Bidirectional box is selected, and click OK.

72 Property Binding: Text Entry.Text Field X
Tag Property
Tag Binds to another component's property in the same window
Indirect Tag
e Choose Property
I+ [ Text Entry ]

Expression
B Name (string)
® Instance Name (5ing)

soL W Display (string)

Named Query e Labelz e
DB Brawse ~ [ Text Field
SQL Query ® Name (string)
= Visible (boolean)
W Text (String) i

Text Entry.text -

options

S overy Ope

Next, make the background color of the Text Field change depending on whether the user
entered a text value or not. While the Text Field component is still selected, go to Propert
y Editor, and click on the binding icon of the Background property.

In the Property Binding window, click on the Expression binding type, and copy and
paste in the following expression.

Expression - Input Validation

/1l Inside the if statenent is the len and the trimfunctions
that are avail abl e when doi ng expressi on bindi ngs.

/1 The trimfunction will trimthe blank spaces fromthe text
therefore validating that there is actual text rather than
spaces.

/1 The len function will count the length of the recently
trimred text.

/1 The if statenents asks the question: Is the length of the
trimred text greater than zero?

if(len(trim{textBox.Text Field.text}))>0,col or(255, 255, 255),
col or (255,0,0))

Click OK.

Close the template, click Save on the top menubar, and click Save again.

To test it out, drag a few of the Text Entry templates from Project Browser to your
window. Notice that the text field is red because it is expecting some data.



Mame

16. Inthe Property Editor, go to the display custom property and enter something like Name.
Do something similar for the other templates. Notice how the label gets filled in with the
data we entered.

17.

Vision Property Editor

12 1 = =

} Common

¥ Behavior

» Appearance

~ Template Properties
display

text

Name

Sally Stevens

Sally Stevens

Put the Designer into Preview Mode, and enter in some values into the text fields. Notice
that the background color changed to white, and the information that was entered is now
in the text property that can be bidirectionally bound so that it writes to a Tag or used in a

script.

Vision Property Editor

IERNY = =

» Common

} Behavior

» Appearance

~ Template Properties
display.

text

T -

Name

James Joy




Client Tags for Indirection

Vision Client Tags can be used as a variable across all windows to indirectly point to a set of Tags,
such as an area of the plant. Suppose that a window has a Dropdown List component that allows .
a user to select different areas of the plant. If the drop-down is bidirectionally bound to a Client On this page
Tag's selected string value property, the user can change the drop-down's value, therefore

resulting in the indirect binding throughout the project reflecting the change in the Client Tag.

The Client Tag can be bound to a custom property on a window's Root Container. This Custom
property can be bound to the Client Tag. The components inside the window can have indirect

bindings on their properties that leverage the Custom property on the window. Therefore, the * C"‘?”t T_ag
components on the window will be dependent on the Client Tag. Client Tags are managed inside I.r]dlrect!on Example
the Client, therefore each Client will be independent of other Clients. J\?St:(ng Your

or

@ INDUCTIVI
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Using Client Tags
for Indirection

Watch the Video

Client Tag Indirection Example

In this example, we will setup Client Tags for indirection which can be shared between different windows in our project.

1. We need two windows and a way to navigate between them. If you don't already have a project that meets this criteria, create a new
project using the Vision Tab Nav project template.


https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+Component+Customizers#VisionComponentCustomizers-CustomProperties
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7] Open/Create Project - O X

Ignition_‘/designer

oy i or

& Back New Project Setup

Project Name

A_New_Project ()

Project Title

User Source

default v

Default Database

MySQL =

Default Tag Provider

default v

Parent Project

v Inheritable Project (O

Project Template

! Perspective Menu Nav
Perspective Web Nav
Perspective Widget Dashboard
Vision 2-Tier Tab Nav

Vision Tab Nav

Vision Tree Nav

2. Add a Client Tag. In the Tag Browser, right click on Vision Client Tags, then choose New Tag > Client Tag.



Tag Browser
Q C |\ ¥-8 06 90 | H
Tag Value Data Type
* W Tags
¢ I System

i Vision Clioauiany

» i All Providi #

e

@

[i]

de  Cut Ctrl+X

A Copy Ctrl+C

W Paste Ctrl+v
Vision PrnpertyEti .+ . o
o | 8 | = W  NewTag i@ MNewFolder
' ® Mult-instance Wizard W ClientTag

=

)

Restart Tag
2 Refresh Providers

3. Name the Tag Machine Number and set the Value to 1.

Tag Editor X
h<

. s General Properties
= Expression/SQL

4" Tag Events
i Tag General Properties

Name

Machine Number

Value

Data Type Enabled Access Rights

Integer v Yes v Read/Write -

“ Apply Cancel

4. Add a window to show data based on the Client Tag. Create a new window named Machine Overview.
5. Next, we'll add a Custom Property to the Root Container of the window.
a. In the Project Browser, select the Root Container for the Machine Overview window.
b. Right click on the desktop and choose Customizers > Custom Properties.
c. Click the Add icon.
d. Enter MachineNumberRef as the name, and make sure the Type is Integer. Click OK to save the new custom property.




Customn Properties

>
Name Type Description +

MachineNumberRef [T .
m

oK Cancel

6. Next we'll bind the custom property to the Client Tag. In the Project Browser, select the Root Container for the Machine Overview
window.
a. In the Vision Property Editor, click on the Binding ==
b. Choose the Tag binding type.
c. Select the Machine Number Vision Client Tag.
d. Click OK to save the binding.

icon next to the MachineNumberRef custom property.

Visian Property Editor g - X Property Binding: Root Container X
15| 1 E— G /R

~ common RIS

Name Root Container -] Tag Binds to a tag
Visible [ true @ Indirect Tag
» i Tags
Border Other Border v S Property ) : Sysgtem
]
Mouseover Text -] Expression ~ '@ Vision Client Tags
Machine Number

Sl Bitrue 2 Property v m All Providers

Cursor Default = sQL [client]Machine Number -
* Behavior Named Query
M Data . Options

rowse -

» Appearance [ Bidirectional Fallback Delay 25 : Overlay Opt-Out
» Deprecated SQL Query

~ Custom Properties

7. Drag a Label component onto the window. Next we'll add an Expression binding to show the page title.

a. In the Vision Property Editor, click on the Binding == icon next to the Text property.
b. Choose the Expression binding type. Enter the following expression:

. "Machine "+{Root Container.Mchi neNunber Ref}+" Overview'




Property Binding: Root Container.Label x

Tag

Tag

Indirect Tag
Property
Expression
Froperty

sQL

Named Query
DB Browse

SQL Query

Expression

Binds to an expression involving any number of components' properties
and/or tags

Expression

1 "Machine "+{Root Container.MachineNumberRef}+" Overview" ~ | E

& No Binding

c. Click OK to save the binding.

S

S T . S B
& Machine 1 Overview >
- £ B

8. Next we'll set up an LED Display component for the value.

a.

©TQo OT

. Click on the Tag
. Click OK to save the Tag path.

Drag an LED Display component onto the window.

. Click on the Binding &2 icon next to the Value property.
. Select the Indirect Tag binding type.

icon. Navigate to a Tag you want to use. We used the Sinel tag from the simulator.



f. Next, click the Insert Property Value

E

Property Binding: Root Container.LED Display
Tag Indirect Tag
Tag Binds to a tag dynamically using indirection (a.k.a parameterization)
Indirect Tag
Property Q  anindirect Tag § [ Choose Tag x
Expression rts of the tag'
p = : o - ' Tags -
For instance, yol _ .
Property hen defi ha il _Generic_
sqL (iR T v im Alarm Data
» AU
Named Query Indirect Tag Path » i Compressors
» il General
DB Browse » i InstFolder
SOL Query References » i Machine 100
+ i@ Motor Plant
Ref. # » @ Motors
» i@ Plant Motors
» il Ramp
» i@ Random
Options » i Realistic
- R » i Sensor Types
® NoBinding Bidirectional Fall - 1 Sine
> % Sined
b % Sine2 v
[default]Sine/Sinel -
| — |

-

Cancel

icon.

g. Choose the MachineNumberRef property from the root container. Click OK.




Property Binding: Root Container.LED Display *

Tag Indirect Tag
Tag Binds to a tag dynamically using indirection (a.k.a parameterization)
| Choose Prope X

Property Q@ Anindire| 9 Perty X
Expression parts of f| [+ [_] Machine Overview W.
Property EIF::_I « [] Root Container % and

ndey B Name (Strin
sqL (String)

Visible (hoolean)

Indirect Tag Pa
Named Query 9 Background Color (Color)

|
| . —
DE Browse [default]s B Styles (Dataset) ‘
| B Data Quality (int)
|

Quality (QualityCode) E
O e |

SQL Query References

} EEELED Display W
L b wer Label € BS =

Options

® NoBinding Bidvecigy Root Container.MachineNumberRef -

Cancel
Cancel
L

h. In the Indirect Tag Path field, delete the "1" before the {1}.

Indirect Tag Path

[default]Sim_Generica’SineIfSine{l} * =

i. Click OK to save the binding.
j- Save your project.

9. Next we'll make a details screen so we can switch between the two. In the Project Browser, right click on the Machine Overview
window and select Duplicate.



Project Browser o _ XX

Q- Filte Project Properties
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10. Rename the copy as "Machine Details."
11. On the Machine Details window, select the Label component.

12. Click on the Binding =) icon next to the Text property. Change the word "Overview" to "Details." Edit the Expression binding as

follows:
"Machi ne "+{Root Contai ner. Machi neNunber Ref}+" Detail s"
Property Binding: Root Container.Label X
Tag Expression
Tag Binds to an expression involving any number of components' properties
and/or tags
Indirect Tag
Property Expression
m 1 "Machine "+{Root Container.MachineNumberRef}+" e
Froperty >
sqQL n
Named Query >3
DE Browse
SQL Query
& No Binding
n Cancel
| |




13. On the LED Display, update the Indirect Tag binding on the Value property to point to the Ramp Tag instead of the Sine Tags.
a. Select a Ramp tag from the Tag selector and click OK.

Property Binding: Root Container.LED Display x
Tag Indirect Tag
Tag Binds to a tag dynamically using indirection (a.k.a parameterization)
Indirect Tag
Property [v] . o : . %
¥ AnIndirect Tag Binding lets you bind to a tag dynamically, where
Expression parts of the tag's path are defined by properties on your window.
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then def umber}
sQL ~ 'mw Tags -~
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& NoBinding Bidirectig P ~| Lout
[default]Ramp/Rampl -
n Cancel Cancel

E

b. Click the Insert Property Value icon. Choose the MachineNumberRef property from the root container and click OK.
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c. Inthe Indirect Tag Path field, delete the "1" before the {1}. Click OK to save the binding.

Indirect Tag Path

[default]Sirn_Genericharn;[.fRarnp{l}

L J

14. Next we'll add the two new windows to the Navigation. Open the Navigation window.
a. Right click on the Tab Strip component and select Tab Strip Customizer.
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b. Inthe Tab Strip Customizer, click on the Empty tab. Change the Window name and the display name to "Machine
Overview."

c. Click the Add Tab button. Change the Window name and the display name to "Machine Details."

d. Click OK to save the changes to the Tab Strip.
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Orientation N . - -
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Top -
Navigation Mode
Swap Windows = Window Name Background Color Background Color
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. Dialog Dialog
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Text Alignment Text Offset - & S
Center v = Use Gradient [ Use Gradient
Text Padding Intertab Space TabIcon TabTcon
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Rounding Radius
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15. Add a way to change the Client Tag value in the Client. There are two ways to do this:
a. Drag a Numeric Text Field component onto the Navigation window, and then drag the Machine Number Client Tag onto
the Numeric Text Field component.
b. If your Header doesn't have a background component, you can just simply drag the Machine Number Tag directly onto the
window and select Control > Numeric Text Field.
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Display 3
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16. Save the project.

Testing Your Work

Remember that the point of a Client Tag is to have different values across multiple Clients, so there is no way to test it in the Designer. To
test the functionality of this example, do the following:

Open two Vision Clients.

In the first Client, change the Client Tag Value from "1" to "2" in the header.

Click between the Machine Overview and Machine Details screen. Notice that they are both showing the Tags for Machine 2.
Switch to the second Client. Notice that the Machine Overview and Machine Details screens still show the Tags for Machine 1.

pPONPE



High Performance HMI Techniques

About High Performance HMI Techniques

High performance HMI techniques and practices call for designs and displays which help the On thlS page
viewer make the best decision in the shortest amount of time after interacting with the HMI.

High performance HMIs often look basic and simplistic. They typically use gray-scale colors rather
than the traditional graphics and bright colors for their displays. Conceptually, the High
Performance HMI operates under the idea of visually contrasting critical and non-critical states. .

The power of this design philosophy is when something does go wrong, a high performance HMI ﬁbOfUt High HMI

will quickly guide the user to the source of the problem. eriormance
Techniques

Here is a comparison of a traditional HMI next to a high performance HMI. : Lriggltlonal HMI

Performance HMI
® Use of Color
® Colors and Alarm
Indicators
® Technical
Considerations
with Colors
® Accommodating
Color Blind
Viewers
® Alarm Indicator
® Reducing
Ambiguity

Traditional HMI High Performance HMI

BukTanks
Temp N N
%% %%

rrrrr

Temp  100.00°F

Humdty  7843%| o

In Ignition, you create the high performance HMIs by using components such as moving analog indicators, sparkline charts, and radar charts.

Moving Analog Indicator Sparkline Chart Radar Chart

FeedB
53.0%

Feed C
50.0%

Feed D
50.0%

90.5 psi


https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Moving+Analog+Indicator
https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Sparkline+Chart
https://legacy-docs.inductiveautomation.com/display/DOC80/Vision+-+Radar+Chart
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Use of Color

Colors are an important consideration when designing a high performance HMI. Gray-scale colors

are used instead of the traditional bright red, green, and blue colors. @ IN DUC TIV]
The person that designs the HMI must understand the diverse audience that may view the HMI. U NIVE RS II]
For example, an operator may look at a motor on a traditional HMI. If it the HMI has colored the
motor green, the operator may conclude that the motor is running. However, if a maintenance
technician looks at the same motor, he may conclude that the motor is not faulted. These are
logical conclusions. They reflect the respective interest of the person viewing the HMI where the
operator wants the motor to run and the maintenance technician wants it to be working.

Use of Color

Watch the Video

In reality, the motor is simply "scheduled" to run, meaning when it runs depends on its control
mechanism. For example, the motor may run when there is product on the line or boxes on the
conveyor. In other words, the motor may be periodically starting and stopping automatically.

A high performance HMI can eliminate this confusion by introducing a color that signifies a state of
"scheduled." A common high performance HMI practice is to use a dark gray to signify a
"scheduled" state for equipment. This color should never compete with more alerting colors that
"pop" from the HMI resulting in the viewer's eye's being drawn to the portion of the HMI where the
problem may be occurring.

Colors and Alarm Indicators

Color can play an important role in how an operator responds when problems do occur. High performance HMI design refrains from coloring
equipment when the equipment is in a state of fault. For example, some equipment may still run when faulted. Instead, an optimized solution
is to place an alarm indicator near the equipment in such a way that when the equipment is undergoing some fault, the alarm indicator
renders with the appropriate color and shape. The object and the consequential color should signify the most important alarm state occurring
for the equipment at that current time.

Technical Considerations with Colors

Some HMIs in industrial settings may temporarily lose their ability to render color because of various environmental factors. High
performance HMI design incorporates this possibility by encouraging the use of descriptive text with color. For example, motors of two
different colors may look the same on a color deficient HMI resulting in confusion for the viewer. Even worse, the viewer may misinterpret the
motor state and assume everything is fine. However, if each motor has a descriptive text such as "Motor 1 is Faulted" and "Motor 2 is
Running", the problem associated with a faulty HMI failing to display color is largely reduced by the HMI's high performance design.

Accommodating Color Blind Viewers

Common color combinations such as red and green and blue and purple cannot adequately be distinguished by those with color blindness.
High performance HMI design accommodates color blind uses by combining colors with descriptive text as well as incorporating alarm
indicators in unique shapes.


https://inductiveuniversity.com/video/use-of-color/8.0

Alarm Indicator

The high performance HMI design techniques make use of an object called the Alarm Indicator w
hich displays a colored shape when there is a problem. This works well with the high performance
HMIs as color is only used when there is a problem. The Alarm Indicator can contain descriptive
text in addition to the shape and color, and is usually placed near the component that is causing
the problem. You can import the Alarm Indicator, shown in the example below, from Ignition
Exchange.

The Alarm Indicator represents different levels of alarm with different shapes, color, and
descriptive text. For example, a motor that exists in an industrial setting is monitored by a high
performance HMI. There are two alarms on the motor. The first is a critical alarm associated with
the motor becoming seized, will display as a red rectangle with the letter 1. The second is a high
priority alarm associated with the motor when overheating, will display as a yellow triangle with the
number 2. An Alarm Indicator is placed near the motor, positioned in such a way to clearly show
motor that the indicator is referring to.

Given this scenario, a high performance HMI will show the Alarm Indicator as in the following
examples:

Example 1 Example 2
The motor is critically faulted. This is the Motor is overheating resulting in a high
highest priority. alarm.

.' é‘

Reducing Ambiguity

@ INDUCTIVI
UNIVERSI]

Alarm Indicator

Watch the Video

A high performance HMI design technique to reduce ambiguity incorporates a line from the Alarm Indicator to the object experiencing the
alarm. The following example shows how a simple dotted line can ensure that the viewer associates the correct Alarm Indicator with the

correct motor.


https://legacy-docs.inductiveautomation.com/display/DOC80/Ignition+Exchange
https://legacy-docs.inductiveautomation.com/display/DOC80/Ignition+Exchange
https://inductiveuniversity.com/video/alarm-indicator/8.0

Open Dynamic Windows on Startup

Sometimes a project needs to change its startup windows depending on who logged in, what
security roles they have, or what computer the Client is launched on. In these cases, rather than

setting a static startup window, you can write a Client Startup Script that uses the SySt em nav
library to open a dynamic set of windows based on hostname, IP address, and user who logged in.

This means you will remove the Open on Startup option from some or all of your windows and use
a Client Startup Script to determine which windows will be opened. Typically, you will set your
navigation window to Open on Startup, but decide on a main window in the startup script. The
example below checks the users role before opening a window.

Code Snippet - Client Startup Role Check

# Checks the users role and opens a nmain w ndow depending on the role

# Grabs a list of the users roles
roles = system security.getRol es()

# Checks if they have Administrator role

if "Administrator' in rol

es:

# Checks if they have QOperator role

elif '"Operator' in roles:

system nav. openW ndow(' Operator Screen')

# 1f they have neither Adm nistrator or Operator

el se:

syst em nav. openW ndow(' Wl cone Screen')

.
: syst em nav. openW ndow(' Admi ni strator Screen') H
= i

@ INDUCTIV]I
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Open Dynamic
Window(s) on
Startup

Watch the Video

EL Client Event Scripts

Client Event Scripts
(2 Shutdown

[l Shutdown-Intercept
Keystroke

& Timer

[3» Tag Change

[¥] Menubar

@k Message

Client Startup Script

Project startup script that runs in each Client

1# Checks the users role and opens a main window d
2
71 .

3# Grabs a list of the users roles

410les = system.security.getRoles()
5
6 # Checks If they have Administrator role

7if 'Administrator' in roles:

8 system.nav.openWindow('Administrator Screen')
9
10 # Checks If they have Operator role

11elif 'Operater’ in roles:

12 system.nav.openWindow( 'Operator Screen')

13

14 # If they have neither Administrator or Operatoz
15 else:

16 system.nav.openWindow( 'Welcome Screen')

Cancel



https://inductiveuniversity.com/videos/open-dynamic-windows-on-startup/8.0




Tank Cutaway

The Symbol Factory images in the Basic > Tank Cutaways category work well when combined
with the other symbols, especially tanks from the Tank Category. Use the following technique to
make a dynamic cutaway tank display:

1. From your Symbol Factory SVG symbols, drag a Tank and a Cutaway symbol onto the IN DUC TIV]
window. (We used tank 3 and jagged cut-away 2.) U NIVE RS I-]

2. Align the cutaway symbol on the tank where you'd like the cutaway to be placed.

File  Edit View Project Component Alignment Shape Tools  Help
B« 4|3 58 @ % 4 0-»|F-F Q|0 ¥ 5
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Watch the Video

L

3. Select the tank symbol first, and then select the cutaway while holding CTRL to select
both symbols.

4. Click the Difference b icon to use the cutaway symbol to make it appear that the area
of the tank is cut away.

File Edit View Project Component Alignment Shape Teols  Help
MM« + % 5% @ (% 1B 0-»|F-2Q = x5
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5. Place a Level Indicator component (drag from the Component Palette) on the area
removed by the cutaway.

File  Edit View Project Component Alignment Shape Tools  Help
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e
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6. With the Level Indicator selected, in the Property Editor, enter a value for the Value
property, or use a binding to put a value on the Level Indicator.


https://www.inductiveuniversity.com/video/tank-cutaway/8.0
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7. Choose Alignment > Move Back Dto put the Level Indicator behind the tank.
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8. This is an optional step, but you can select the tank, including all the graphics, right click
and Group them so now they can move around as one unit. You can even make a
template out of it, so you can use it multiple times.

Related Topics ...

® Symbol Factory


https://legacy-docs.inductiveautomation.com/display/DOC80/Symbol+Factory

Dropdown List Example

Dropdown lists are used when you want to select a single item from a list of options. The
Dropdown component is under the Input section of the component palette. Simply drag it on to
your window. The most important property of a Dropdown component is the Data property. Itis a
Dataset that contains one or more rows of data. Each of the rows are different options that you

e}
see on the component. Select the Dropdown component and click on the Dataset Viewer Ba icon
for the Data property to manually add some options.

Vision Property Editor o - X

12| 1} = =2 | T

~ Data -
Data |Dataset [OR = 2C] —:l‘
Selected Value -1 &2
Selected String Value -
Selected Label <Select One= -]
Quality -]

Data Property's Dataset Modes

There are three modes you can use the Data property’s dataset: a number/label pair, a single

On this page

® Data Property's
Dataset Modes
® Number/Label
Pair
® Single Label
Column
® Code/Label Pair
® Setting Dropdown
Options
® Displaying Multiple
Columns in a
Downdown List

@ INDUCTIV]I
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label column, and a code/label pair. Which mode is used depends on what columns are in the Data
property’s dataset, and will determine the values of the Selected Value, Selected String Value an
d Selected Label properties. Any additional columns that are added to the dataset will not affect
these properties.

Dropdown

Watch the Video

Number/Label Pair

In the Number/Label Pair mode, the first column of the Dataset is an integer (often an id) and the
second column is a string (often a label). The first column is the Value column which is invisible to
the user and is usually used in binding. The second column is the Label column and is visible to
the user in the dropdown list.

In this example, the dataset has two rows. Under the Value column, you see the integers '1' and '2'
respectively. Under the Label column, you see the '‘Realtime’ and 'Historical' options.

[77) Dataset Editor b4
Value Label =
1 Realtime
2 | Historical .
[
i)
]
Column Mame: - Column Type: -—
n Cancel



https://inductiveuniversity.com/video/dropdown/8.0

In Preview Mode, select from the list of dropdown options. Notice, you can only see the options in
the Label column. Select the 'Realtime’ option. You can see under the Data property section, the
Selected Value is '1' which is the first (integer) column in the dataset and is not visible to

users. The Selected String Value and the Selected Label are the same and show the 'Realtime’
option which is the second (string) column in the dataset.

File  Edit View Project Component Alignment Shape Tools Help
ERI] EROI IR X2 |

Project Browser a - X Lo M
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Single Label Column

The Single Label Column mode you can use is a string/string combination which are two columns that are both strings.

1. In the Dataset Editor, remove the Value column from our example by selecting a cell in that column and clicking on the Vertical
Delete 1IN icon.

=
2. Add another column by clicking on the Vertical Add 1§ icon.
3. Call the new column '‘Code,' set the column position to '0" and make it a 'String.' Click OK. Both columns are now strings.

Dataset Editor *
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[
Name | Code © Position|0 ¥

Type |Date
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Double

Boolean

Column Name: —— Column Type: —

n Cancel

4. Under the 'Code’' column enter 'v1' and 'v2." Click OK.




5.

")) Dataset Editor e
Code Label =
V1 Realtime
V2 Historical +

[[H
Y
]
Column Name: - Column Type: —-
n Cancel

1 Because we added the 'Code’ column in position '0," the users will see the same two options in the dropdown
list: 'Realtime’ and 'Historical." If you see 'vl' and 'v2' instead, that means your 'Code' column is not the first column.

In Preview Mode, click on 'Historical' and you can see the Selected String Value is 'v2' because the value is in the first column
and the Selected Label is'Historical.'

Fle Edit Wiew Project Component Alignment Shape Tools  Help
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Vision Property Editor g _ X R T R L
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Selected Value 0ea | ] -
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Code/Label Pair

The Code/Label Pair mode simply uses a one string column.

1.

In the Dataset Editor, remove the Code column from our example by selecting a cell in
that column and clicking on the Vertical Delete 08T jcon.

. You are going to see the same two options in the Dataset Viewer: ‘Realtime’ and ‘Histori

cal’

1 This only applies if there is exactly one column in this dataset.
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In Preview Mode, select the ‘Realtime’ option. You will see the same value in the Select

3.
ed Label and Selected String Value properties since there is only the one column.
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Setting Dropdown Options
Now, you can set these dropdown options manually or bind the Data property. In this example, you can take a Dropdown List on the window
and bind the Data property using a SQL query.

1. Select the Dropdown component, and click on the binding &= icon for the Data property.
2. Select the SQL Query Binding Type and enter a query that brings back an ID and Name from one of your tables in the database.
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3. Click OK to see all the options that came back from the database.
4. In Preview Mode, select any one of these options and you can see the Selected Value, Selected String Value, and Selected
Label as shown in the following example.
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Displaying Multiple Columns in a Downdown
List

Another feature of the Dropdown List component is you can show more than one column to a user.

1. Drag another Dropdown component to your window.

2. Go to the Dataset Viewer and add some options manually. Instead of having only one or
two columns you can add as many as you want. The first column needs to be either an int
eger or a string. Any additional columns will show up in the dropdown.

a. Open the Dataset View, under Value, enter ‘1’ and ‘2.’

b. Under Label, enter ‘Realtime’ and ‘Historical.’

c. Add another column and call it ‘Col3’ in 'Position 2', and make it a string and
click Add Column.

d. Under Col3, enter ‘This is real’ and ‘This is historical'.

e. Click OK.
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3. In the Property Editor, set the Dropdown Display Mode to ‘Table’ to see both columns.
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4. Now you can see Label and Col3 and select between those different rows. It's a nice way
to show more information in the Dropdown list. The Selected Value, Selected String
Value, and Selected Label properties will behave the same as previous examples

ignoring any columns beyond the second.
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Multi-Monitor Clients

Multiple Desktops

In some situations, such as control rooms, or workstations with multiple monitors, it may be
preferable to have clients open on several monitors so that different windows are simultaneously in
view. Instead of opening several different clients, it is possible to open a single client, and spawn
multiple desktops through scripting. Desktops are additional workspaces where windows may be
opened. They are similar in functionality to a standalone Client in that they may be positioned and
resized independently of other desktops and Clients, but share a session ID with the initial Client
that launched the desktop.

Client Tags and Property Values

The value of Client Tags are shared between each desktop. This provides an easy method to
change values on one desktop from another without interacting with other Clients: simply write to a
Client Tag.

Desktops act as separate clients in regard to property values. For example, if a Text Field is
placed on a window, and multiple Desktops open that same window, values entered into one
Desktop will not overwrite the other Text Fields. If synchronization on these components is
preferred, then simply bind the property to a Tag.

Handles

When creating a new desktop, an optional handle may be assigned to the desktop. This acts as a
name, or reference to the desktop. If a handle is not provided, then the desktop may be referenced
by the screen index. Handles and indices are useful when trying to interact with specific desktops
from a Python script.

Spotting the Primary Desktop
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Watch the Video

When multiple desktops are open, it is important to know that only the primary desktop will have a menu bar. Additionally, the title bar on the
client will show the name of the project. Additional Desktops will instead show the handle or index of the Desktop by default. However, a

custom title may be used when the desktop is invoked.

Below we see two desktops. The highlighted desktop is displaying the title of the project. Because this is the primary desktop, a menu bar is
present. The other desktop was given a title of "Secondary Desktop”. A menu bar is not present because this desktop is not the primary.

Command  Windows  Help



https://www.inductiveuniversity.com/video/multi-monitor-clients/8.0

Project Updates

When a project update is pushed to a Client, the Update banner will only appear on the Primary Desktop (assuming the Update Mode of the
project is set to Notify). Updating the Primary Desktop will also push the changes to all other local desktop, so there is no need to update
each desktop individually.

Opening Another Desktop

Another Desktop may be opened by calling system.gui.openDesktop:

¢ #This will open a new desktop without any windows, and a nane of "O" H
i system gui . openDeskt op() H

However, without specifying which windows to open, the desktop will open without any opened windows. It is recommended to specify at
least one window, a title, and a handle for the new desktop. Assuming a window exists at the path "Main Windows/Main Window", the
following would open a new desktop, open the specified window, and specify a title and handle for the window.

#Create a |list of window paths to open in the new desktop
wi ndowToQpen = ["Main Wndow']

#Def i nes a name for the Desktop, which will be used as both the the title and handl e of the w ndow.
name = "Secondary Desktop"

#Creates a new desktop. The desktop will open the wi ndows |isted above.
syst em gui . openDeskt op(w ndows=wi ndowToOpen, title=name, handl e=nane)

Navigating Windows in Desktops

Functions for the gui and nav scripting modules will execute in the Desktop that originated the call: If the Primary Desktop calls system.nav.
swapTo, then the Primary Desktop will swap to a new window, but all other desktops will remain unaffected. However, it is possible for a
script on one Desktop to force a navigation or GUI change on another Desktop with the following functions:

® system.gui.desktop
® system.nav.desktop

# to open a popup in your second desktop
# if you are identifying desktops by nunber, they are zero indexed
syst em nav. deskt op(1). openW ndow( ' Popups/ Popup')

Additional scripting functions that interact with desktops exist in the gui and nav scripting modules. Please see the Scripting Functions in the
Appendix for more details.

Opening a Desktop on Each Monitor

Sometimes you may want your client to open a new desktop on each of your other monitors. It's pretty simple to get all of your monitors and
open a client on each, but then you will have two on your main monitor. The following code block shows you how to skip the primary monitor
and even how to open specific windows on each new desktop. This example assumes you have a 'Main Window/Overview' window, and
that window has a custom string property in the root container named 'Display' to pass values into. Bind a label component to that custom
property to easily check your script. This script is best placed in a Client Startup Script to open a client for each monitor on startup.

# Get the screen information for all of your nonitors.
screensDat aset = system gui . get Screens()

# Open the first window of the project in the (current) primary nonitor.
screenl ndex = screensDataset[0][0]

nmoni tor Num = screenl ndex + 1

pri maryScreenText = 'This is Mnitor %' %onitor Num

system nav. swapTo(' Mai n W ndows/ Overvi ew , {'Display':primaryScreenText})

# Step through all of the screen information, starting with index 1 instead of 0.
for screenDetails in screensDataset[1:]:

# unpacks the tuple that is returned for each of the nonitors present. Consists of screen index,
wi dth, and hei ght of the screen.


https://legacy-docs.inductiveautomation.com/display/DOC80/system.gui.openDesktop
https://legacy-docs.inductiveautomation.com/display/DOC80/system.nav.swapTo
https://legacy-docs.inductiveautomation.com/display/DOC80/system.nav.swapTo
https://legacy-docs.inductiveautomation.com/display/DOC80/system.gui.desktop
https://legacy-docs.inductiveautomation.com/display/DOC80/system.nav.desktop
https://legacy-docs.inductiveautomation.com/display/DOC80/Scripting+Functions

screenl ndex, screenWdth, screenHei ght = screenDetails
nmoni t or Num = screenl ndex + 1
screenText = "This is Mnitor %" %onitor Num

# Open an enpty franme on the next nonitor. !
# Assign a handl e and apply the width/height for the nonitor you are opening on
handl eName = "Monitor %" %vonitor Num i
system gui . openDeskt op(screen=scr eenl ndex, handl e=handl eNane, wi dt h=screenW dt h,
hei ght =scr eenHei ght) H

# Open the Main Wndow on this new desktop and pass the paraneters needed.
syst em nav. deskt op( handl eNane) . swapTo(' Mai n W ndows/ Overview , {' Display':screenText})

Related Topics ...

® system.gui.openDesktop
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